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マニュアルの使い方
オーナーズマニュアルは、次の3冊で構成されています。各オーナーズマニュアルの役割をご理解いただいた上
で、上手にお使いください。

オーナーズマニュアル　ベーシックガイド

本機をお使いいただく前に覚えておいて欲しいこと、使用上のご注意、接続の方法から、演奏の体験、音のしく
みなどについて説明しています。

■第1章　セットアップ！VL1-m
各部の名称や接続の方法、お使いになる前に覚えておいて欲しいことを説明します。はじめて本機に触れる方
は、必ずお読みください。

■第2章　はじめてのVL1-m
演奏の体験、デモ演奏の方法や基本的な操作を説明します。はじめて本機に触れる方は、必ずお読みください。

■第3章　VL1-mを知る － パート1
本機の基本的な概念やコントローラーの役割を説明します。はじめて本機に触れる方は、必ずお読みください。

■第4章　VL1-mを知る － パート2
本機の音源のしくみを詳しく説明します。音色のエディットを始める前にお読みください。

オーナーズマニュアル　リファレンス（本書）

音色やコントローラーの設定を変更する方法を説明しています。必要に応じて、辞書のようにご活用ください。

■第1章　プレイ＆エディットの基礎知識
演奏やエディット作業の基本的な操作や、覚えておいて欲しい知識、概念などを説明します。はじめてエディッ
トを行う方は、必ずお読みください。

■第2章　プレイモード
通常の演奏を行うプレイモードでの操作を、詳しく説明します。必要に応じてお読みください。

■第3章　エディットモード － コモンエディット
エディットモードのコモンエディット（2つのエレメントに共通の設定）の操作を、詳しく説明します。必要に
応じてお読みください。

■第4章　エディットモード － エレメントエディット
エディットモードのエレメントエディットの操作を、詳しく説明します。必要に応じてお読みください。

■第5章　ユーティリティモード
全体のチューニングや、MIDIのセットアップ、バルクデータの送受信、フロッピーディスクの管理など、ユー
ティリティモードでの操作を、詳しく説明します。必要に応じてお読みください。

■付録、用語解説
エラーメッセージが表示されたり、トラブルが発生したときの対処の方法などを説明します。また、用語解説も
用意してありますので、わからない用語が出てきたら、必要に応じてお使いください。

オーナーズマニュアル　セッティングリスト

工場出荷時に用意されているボイスのリストや、機能の一覧などを紹介しています。
必要に応じてお使いください。
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表記について
本書では、次のようなマークを使って、ボタンや説明内容を表します。

PLAY

パネル上のボタンを示します。枠の中の文字は、パネル上に茶色または赤色で印刷さ
れている文字です。ファンクションボタン F1 ～ F8 に対応する機能を示す場
合には、 F1 （Com）のようにかっこ内にその機能を表記します。

注意事項を示します。大切なデータをなくしたりしないよう、必ずお読みください。

参考となる記述を示します。応用的な操作や、関連することがらを説明します。必要
に応じてお読みください。

手順を示します。その機能を実行するときは、この手順にしたがって操作を進めてく
ださい。

各機能を解説する記述を示します。

「→ P.●●」
関連した機能や項目の記載ページを示します。必要に応じて参照してください。

また、各機能の説明の先頭では、次のような形式で重要な項目を表記します。

EDIT / COM / MISC / SETTING：セッティング

EDIT  → F1 （Com）→ F1 （Misc）→ 1: Setting → ENTER

アサインモード、ピッチベンドモード、サステインを設定します。

Assign Mode Bottom Note, Top Note, Last Note
Pitchbend Mode Normal, Bottom, Top
Sustain off, on

表示される画面

その機能の概要その機能に入るまでの手順機能の名称

設定範囲
設定する項目名
（画面に表示される　
　通りに記載します）

（工場出荷時には黒地に白文字の表示になっていますが、
　本書では、見やすさを優先して反転してあります）
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この章では、演奏やエディットの基本的な操作や、覚えておいて欲しい知
識、概念などを説明します。はじめてボイスのエディットに挑戦する方
は、必ずお読みください。
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モードと階層構造
ベーシックガイドでも説明しましたが、もう一度「モード」という用語を復習しましょう。また、各モードでの
「階層構造」という考え方もあわせて説明します。

モード

モードは、本機の現在の状態を示す言葉です。モードによって操作できることが異な
ります。
モードの切り換えには、3つのモードボタンを使います。

■プレイモード

主に通常の演奏を行うモードです。
外部MIDI機器の鍵盤やコントローラーを使った演奏をはじめ、ボイスの切り換え
や、コントローラーの設定状況の確認、クイックエディット（コントロールナンバー
＝016、017のコントロールチェンジデータを使った一時的なボイスのエディット）な
どを行うことができます。

■エディットモード

ボイスのエディットを行うモードです。
ボイスやコントローラーの割り当て、エフェクトの設定などをエディットすることが
できます。

■ユーティリティモード

全ボイスに共通のセッティングをするモードです。
マスターチューニングやMIDI、画面表示、ブレスコントローラーカーブなどをセッ
ティングします。
※プログラムチェンジは、どのモードの状態でも受信します。

階層構造について

各モードの中には、数多くの設定項目があります。
これらの数多くの項目を効率良く、かつわかりやすく設定していけるように、「階層
構造」というしくみを使って画面が構成されています。
「階層構造」は、ちょうど「木」のように太い幹から細い枝まで分岐していくようなも
のです。
たとえば、次の図は、エディットモードの階層構造です。
エディットモードは、コモンエディット、エレメント1（または2）エディットに分か
れ、さらにコモンエディットは、ミスレイニアスとエフェクトに分かれ、さらにミス
レイニアスは、セッティングとコントローラー、エレメントピッチなど‥に分かれて
います。そしてそれぞれの画面で必要に応じて設定や選択をしていきます。

モードと階層構造
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第
１
章

モードと階層構造

また、同じところから分岐した各ブロックのことを「階層」と呼びます。さらにその
階層に分岐する前の階層を「上の階層」、そこから分岐する階層を「下の階層」と呼び
ます。
たとえば、「エフェクト」の上の階層は「コモンエディット」の階層、下の階層は
「セッティング」「モジュレーションエフェクト」「フィードバックディレイ」‥の階
層となります。

エレメント2エディット�

エディットモード�

コモンエディット�

エレメント1エディット�

セッティング�

ミスレイニアス� コントローラー�

エレメントピッチ�

セッティング�

モジュレーションエフェクト�

フィードバックディレイ�

プレッシャー�

アンブシュア�

ピッチ�

セッティング�

ブレスノイズ�

エフェクト�

コントローラー�

ミスレイニアス�

スロートフォルマント�

ハーモニックエンハンサー�

ダイナミックフィルター�
モディファイア�
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画面の構成
プレイモードやエディットモードでは、多くの画面を切り換えながら操作を進めていきます。
ここでは、各モードに共通する画面の見方を解説します。それぞれのモード、機能で表示される個別の画面に
ついては、第2章以降で詳しく説明します。

プレイモードの画面の例

エディットモード（コモンエディット）の画面の例

エディットモード（エレメントエディット）の画面の例

一番上の行（1行目）

「モード名／階層名／階層名／階層名‥‥」の形式で、現在の画面の位置を示しま
す。
上記の画面の場合、「PLAY」の表示は、現在プレイモードにいることを示します。
「EDIT／COM／MISC／SETTING」は、現在エディットモードの、コモンエディット
のミスレイニアス、セッティングの設定画面にいることを示します。
「EDIT／E1／CTRL／PRESSURE」は、現在エディットモードの、エレメントエ
ディット（エレメント1）の、コントローラーのプレッシャーの設定画面にいることを
示します。
当然、深い階層に入れば入るほど、この部分の表示は長くなっていきます。

画面の構成



第1章　プレイ&エディットの基礎知識　　13

第
１
章

画面の構成

2行目

プレイモードでは、現在選択されているボイスの番号が表示されます。エディット
モードでは、その番号とともにボイス名（エレメントエディットではさらにエレメン
ト名も）が表示されます。

状況によっては、ボイス番号の前に「E」の反転表示のマークが出ることがあります。

「E」の反転表示は、そのボイスがエディットされていて、まだストア（保存）されて
いないことを示します。プレイモードでクイックエディットを行ったり、エディット
モードに入って何かの設定を変更すると、ストアを実行するまでこのマークが表示さ
れます。
また、ストアをしないでプレイモードに戻ったときも、ストアするか、ボイスを切り
換えるまでこの表示は残ります。

エディットモードでは、2行目の一番右には、「1」または「1 2」という反転表示の数
字が表示されます。これは、現在選択されているボイスで使用しているエレメントを
示します。「1」は1エレメントだけを使ったボイス、「1 2」は2つのエレメントを使っ
たボイスです。反転表示になっていない場合には、一時的にそのエレメントがオフに
なっていることを示します。この機能についても、この章の後半で説明します。

一番下の行

ファンクションボタン F1 ～ F8 に割り当てられている機能を表示します。
ファンクションボタンの機能は、メニューの選択や反転表示の移動、別の機能への
ジャンプなどさまざまです。

Ａ０１（００１）：ＡｌｔｏＳａｘ　／Ｅ１：ＡｌｔｏＳａｘ�

ボイス番号�ボイス通し番号� ボイス名� エレメント名�

これ以降はエディット�
モードでのみ表示�

これ以降はエディットモードの�
エレメントエディットのみ表示�
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画面の構成

ポップアップウィンドウ（ウィンドウ）

機能によっては、次のような画面が表示されることがあります。

このように他の画面の上に重なって表示される画面のことを、「ポップアップウィン
ドウ」あるいは略して「ウィンドウ」と呼びます。
さらに、このウィンドウが、いくつも重なって表示されることもあります。



第1章　プレイ&エディットの基礎知識　　15

第
１
章

基本的な操作
ここでは、各モードに共通の基本的な操作方法をまとめて説明します。

モードを切り換える

プレイモード、エディットモード、ユーティリティモードを切り換えるときは、
PLAY 、 EDIT 、 UTILITY のボタンを使います。

特殊な場合を除いて、どんな階層にいてもこの3つのボタンでモードを切り換えるこ
とができます。

メニューから選択する

そこから先の機能が、いくつにも分岐している場合には、次のようなメニューが表示
されます。本機では、このようなメニューを選択しながら、順番に深い階層の設定画
面に入っていきます。
この例はエディットモードのコモンエディット、ミスレイニアスのメニューです。

このメニューの中から、目的の機能へ進む操作には、次の3種類の方法があります。

■ダイアルを使う方法

ダイアルを回し、目的の機能に反転表示（カーソル）を合わせた後、 ENTER を押しま
す。

■カーソルボタン（ ）を使う方法

カーソルボタンを使って、目的の機能に反転表示（カーソル）を合わせた後、 ENTER

を押します。

■ INC DEC を使う方法

INC または DEC を使って、目的の機能に反転表示（カーソル）を合わせた後、
ENTER を押します。

基本的な操作
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メニューを切り換える

機能によっては、次のようにメニューが何画面にも分かれている場合があります。
この例はエディットモードのエレメントエディットのメニューです。

コントローラーのメニュー

ミスレイニアスのメニュー

モディファイアのメニュー

エンベロープのメニュー

このような場合には、ファンクションボタンを使ってメニューを切り換えます。
この例では、 F1 ～ F4 のファンクションボタンに各メニューが割り当てられ
ています。 F1 （Ctrl）を押すとコントローラーのメニューに切り換わります。同
様に F2 （Misc）を押すとミスレイニアスのメニューに、 F3 （Modi）を押すと
モディファイアのメニューに、 F4 （Env）を押すとエンベロープのメニューに切
り換わります。
また、現在表示中のメニューに対応するファンクションボタン表示が反転表示になり
ます。

階層をさかのぼる

メニューから機能を選択して、各機能の画面を表示した後、再びメニューに戻りたい
場合には、 EXIT を押します。1回押すたびに1階層ずつ上の画面に戻ります。
また、ポップアップウィンドウなどが表示されているときも、この EXIT を押すこ
とで、元の状態に戻ることができます。

基本的な操作
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前後のページに移動する

画面によっては、ファンクションボタンの行に「Fpag」「Bpag」という文字が表示さ
れます。これは、フォワードページ、バックワードページの略で、次ページ、前ページ
という意味です。

このファンクションボタン F6 （Bpag） F7 （Fpag）を使うと、上の階層のメ
ニューに戻ることなく、同じ階層のとなりの機能に直接移動することができます。

関連するページに移動する

画面によっては、ファンクションボタンの行の右端に「Para」「Ctrl」などという文字
が表示されます。この機能を使うと、全く別の階層にある「関連するページ」に直接
移動することができます。
たとえば、次の画面は、「コントローラー」の「ビブラート」の設定画面です。

この画面で、ファンクションボタン F8 （Para）を押すと、階層の異なる「エンベ
ロープ」の「ビブラート」の画面に直接移動することができます。

また、この画面でファンクションボタン F8 （Ctrl）を押すと、元の「コントロー
ラー」の「ビブラート」の画面に戻ってくることができます。

ひとつ上の階層のメニュー�

画面B画面A 画面C
Bpag

Fpag

Bpag

Fpag

EXITENTER
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カーソルを移動する

1つの画面内で設定する項目は、1項目とは限りません。複数の項目を設定していくた
めには、カーソル移動（反転表示の部分を動かす操作）という操作が必要となりま
す。次の例は、エディットモード、コモンエディットのコントローラーの設定画面で
す。

カーソル移動には、次の方法を使います。

■カーソルボタン（ ）を使う方法

カーソルボタンを使って、目的の項目にカーソルを移動します。

数値を変更する

目的の項目にカーソルを移動したら、今度はその設定を変更します。ここでは、数値
項目（「0～127」や「-64～63」などの数値で設定する項目）の変更方法を説明します。
次の画面の「Gain」の項目は、「0～127」の範囲で指定する数値項目です。

数値項目の変更方法には、次の2種類があります。

■ダイアルを使う方法

ダイアルを時計方向に回すと、数値が増えます。逆に回すと数値が減ります。
ダイアルを速く回すと値が大きく変化します。

■ INC DEC を使う方法

INC を押すと、1つずつ数値が増えます。 DEC を押すと、1つずつ数値が減りま
す。ボタンを押し続けると連続して数値が変化します。
また、 INC または DEC を押したまま、残りのもう一方のボタンを押すことで、
数値を高速に増減することもできます。たとえば、 INC を押したまま DEC を押
すと、数値が素早く増えていきます。

基本的な操作
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設定値を変更する

機能によっては、いくつかの設定値（または選択肢）の中から目的のものを選ぶとい
う項目も出てきます。たとえば、次の画面の「Portamento Mode」の項目は、「Full
Time」か「Fingered」かを選択する項目です。この他にも「on」と「off」を選択する項
目や、3つ以上の設定値から1つを選択するような項目もあります。

設定値の変更方法には、数値と同様に次の2種類があります。

■ダイアルを使う方法

ダイアルを回して、設定を選択します。

■ INC DEC を使う方法

INC または DEC を押して設定を選択します。



20　　第1章　プレイ&エディットの基礎知識

文字を入力する

ボイス名やエレメント名、ファイル名などを設定するときには、文字を入力する操作
が必要になります。次の画面は、エディットモードに入ると最初に表示される画面で
す。（カーソルはボイス名（ボイスネーム）の位置にあります）

文字を入力する項目にカーソルがある場合には、上図のように F8 （Name）とい
うファンクションボタンが使えるようになります。（ただし、ファンクションボタン
の番号は異なる場合もあります）

この F8 （Name）（または ENTER ）を押すと、次のようなウィンドウが表示されま
す。（ファイル名を指定するときは、MS-DOSに準拠した文字が表示されます）

このウィンドウが文字を入力するためのウィンドウです。
次のような操作で文字を入力します。

■文字を変更する

ダイアルを回したり、 INC や DEC を押すと、カーソルのある文字が変更されま
す。
アルファベット以外にも、数字、記号などが使えます。
（ファイル名を指定するときは、MS-DOSに準拠した文字が使用可能となります）

■カーソルを左右に移動する

カーソルボタン（ ）を押すと、カーソルが左右に移動します。

■スペース（空白）を入力する

ファンクションボタンの F2 （Spc）を押すと、カーソルのある文字がスペースに
変更され、1文字分右にカーソルが移動します。

■全部の文字を消去する

ファンクションボタンの F3 （Clr）を押すと、その項目の全部の文字が消去され、
カーソルが先頭の位置に戻ります。

■文字入力を終了する

ENTER を押すと、文字入力を終了し、元の画面に戻ります。

基本的な操作
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ボイスエディットについて
ここでは、ボイスエディットをはじめる前に、必ず覚えておいて欲しいことを説明します。
特に、ストア、コンペア、リコール、コピー（ボイスコピー、エレメントコピー）の操作は、エディットを進める
上でかかせない操作です。いつでも使えるようにしておいてください。

ボイスエディットの進め方

別冊の「ベーシックガイド」でも説明したように、本機では、白紙の状態からボイス
を作り上げていくことはできません。
したがって、ボイスエディットは、供給された物理モデルを基にして、解放された設
定項目をエディットしていくという形になります。
また、エディットしたボイスは、ストア（保存）の操作をすることで正式にボイスと
して保存されます。

ボイスのエディットの進め方には、次の2つの方法があります。

■エディットモードでのエディット

エディットモードで行う通常のエディットです。
エディットモードに入って、任意の設定項目を変更したり、他のボイスのエレメント
や各種設定をコピーしたりしながら、エディットを進めていきます。

プレイモードでボイスを切り換える�

エディットモードに入り、必要に応じて�
他のボイスの設定やエレメントをコピーする�

任意の項目をエディットする�

任意のボイス番号にストアする�
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ボイスエディットについて

■クイックエディット

プレイモードで行えるエディットです。
コントロールナンバー＝016、017の2つのコントロールチェンジには、あらかじめ特
定の設定項目を割り当てておくことができます。プレイモードでの演奏中、外部
MIDI機器からこれらのコントロールチェンジデータを受信するとこの設定が変更さ
れ、音が変化します。（→別冊のベーシックガイド：P. 48）

クイックエディットでコントロールする設定項目の変更は、「エディットモード」で
の「クイックエディットアサイン」で行います。（→P. 65）

プレイモードで任意のボイスに切り換える�

コントロールチェンジを使ってエディットする�

任意のボイス番号にストアする�
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ストアの操作

ストアの操作は、ボイスをエディットする上で一番重要な操作です。
ストアするのを忘れて、別のボイスを選んでしまうと、せっかくエディットしたボイ
スが消えて（元のボイスに戻って）しまいます。
ここでは、ストアの操作を説明します。

注　意

・ストアを実行すると、もともとその番号にあったボイスは消されてしまいます。も
し、そのボイスもとっておきたい場合には、ストアを実行する前にフロッピーディ
スクにセーブしておいてください。（→ P. 204）

・ストアは、プレイモードまたはエディットモードでのみ実行できます。ユーティリ
ティモードでは実行できません。

・ユーティリティのメモリープロテクトがオンになっている場合、ストアは実行でき
ません。このときは次の操作を行ってください。（ストア後、必要に応じてプロテク
トをオンに戻してください）

1. UTILITY を押します。
2. F1 （Sys）を押します。
3. カーソルボタンで「5: Miscellaneous」に反転表示を移動します。
4. ENTER を押します。
5. カーソルボタンで「Memory Protect =」の「on」に反転表示を移動します。
6. DEC を押します。
7. EXIT を押します。

・フロッピーディスクにも、ボイスを保存（セーブ）することができますが、エディッ
トしたボイスを直接保存することはできません。いったん本体にストアした後に、
この操作が可能になります。（→ P. 204）

参　考

・ストアするのを忘れてプレイモードに戻り、別のボイスに切り換えてしまった場合、エ
ディットしたボイスはエディット前のボイスに戻ってしまいます。しかし、この場合には、
後述の「リコール」の機能を使って、エディット後のボイスに戻すことができます。（→ P.
210）

・任意のボイスを、別のボイス番号にコピーする場合も、ストアの機能を使います。コピーし
たいボイスを選択した後、このストアの操作でコピー先を選択し、実行します。



24　　第1章　プレイ&エディットの基礎知識

手　順

1. STORE を押します。
▼次のようなウィンドウが表示されます。

2. ダイアルやカーソルボタン、 INC DEC を使って、ストア先となるボイス
番号にカーソルを合わせます。

この状態で F6 （123...）を押すとボイス番号順の表示に、 F7 （ABC...）
を押すとボイス名のアルファベット順の表示に切り換わります。（このとき
「Now sorting!」と表示され、少し時間がかかる場合があります）

また、 INC を押しながら DEC を押したり、 DEC を押しながら INC

を押すことで、高速にカーソルを移動することができます。

▼ストア先のボイスにカーソルを合わせたら、次の手順に進みます。

3. ENTER を押します。
▼確認のメッセージが表示されます。（ユーティリティのコンファームがオフ

になっている場合には、確認のメッセージは表示されません（→ P. 193））

4. INC を押します。
ストアを中止したい場合には、 INC のかわりに DEC を押します。
▼ストアが実行されます。

5. EXIT を押します。
▼元の画面に戻り、ストアしたボイスが選択された状態になります。

ボイスエディットについて
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コンペアの操作

コンペアは、ボイスのエディット中に、「エディット中の音」と「エディット前の音」
とを聴き比べるための機能です。
基にしたボイスに対して、どのくらい変化したかを確認するときに便利な機能です。

注　意

・コンペア中（エディット前の音が呼び出されている状態のとき）には、エディット
できません。

・エディットモードに入った後、まだエディットしていない状態では、コンペアは使
えません。

手　順

1. エディット中に EDIT を押します。
▼エディットランプが点滅をはじめ、画面左上に「COMP」と表示されます。

2. 外部MIDI機器の鍵盤を弾いて、エディット前の音を確認します。
▼エディット前の音の確認が終わったら、次の手順に進みます。

3. もう一度、 EDIT を押します。
▼コンペアが解除され、元のエディット状態に戻ります。
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コピーの操作について

エディットモードでは、他のボイスやエディットする前の元のボイスなどから、さま
ざまなデータをコピーすることができます。
まず、次のルールを覚えておいてください。

・コピーは、エディットモードでのみ行うことができます。
・ある階層の画面でコピーを行うと、その下の階層に含まれる全データがコピーされ
ます。

・ COPY を押すと、その画面に応じて、コピーのウィンドウが表示されます。
・コピーのウィンドウが表示されているときには、常にカーソルのあるデータがコ
ピーされた状態の音（コピー実行後の音）が出ます。したがって、カーソルを動かし
て音を確認しながら、目的のデータを捜すことができます。（これを「オーディショ
ン機能」と呼びます）

・コピーのウィンドウが表示されているとき、 F6 （123...）を押すとボイス番号順
の表示に、 F7 （ABC...）を押すとボイス名のアルファベット順の表示に切り換
わります。（このとき「Now sorting!」と表示され、少し時間がかかる場合がありま
す）

・ INC を押しながら DEC を押したり、 DEC を押しながら INC を押すこと
で、高速にカーソルを移動することができます。

・ ENTER を押すと、コピーが実行されます。
・ EXIT を押すと、コピーを中止し、元の状態に戻ります。

コピーには、とても多くの画面があります。ここでは、代表的な「コモンデータのコ
ピー」と「エレメントデータのコピー」という2種類のコピーの操作を説明します。

コモンデータのコピー

1つまたは2つのエレメントに共通の設定「コモンエディット」に含まれる全データを
コピーします。コモンエディットの一部のデータだけをコピーしたい場合には、その
目的の階層の画面を表示してから同様の操作を行います。

手　順

1. エディットの最初の画面を表示させます。
EXIT を何回か押すと、この画面になります。

2. 「Voice Name」「Key Mode」「Voice Mode」のいずれかにカーソルを移動し
ます。
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3. COPY を押します。
▼コピーのウィンドウが表示されます。

4. ダイアルやカーソルボタン、 INC DEC を使って、コピーするボイス（コ
ピー元のボイス）を選択します。
選択したボイスの全コモンデータが、現在のボイスにコピーされることになり
ます。

外部MIDI機器の鍵盤を弾くと、現在カーソルのあるボイスのデータをコピー
した場合に得られる音を確認することができます。

コピーのウィンドウが表示された時点では、「＊」のついたボイスが選択され
ます。この「＊」のついたボイスは現在のボイスですが、これを選択してコ
ピーを実行すると、エディット前のコモンデータをコピーすることができま
す。（すなわち、コモンエディットを変更する前の状態に戻すことができま
す）

F6 （123...）を押すとボイス番号順の表示に、 F7 （ABC...）を押すとボ
イス名のアルファベット順の表示に切り換わります。（このとき「Now
sorting!」と表示され、少し時間がかかる場合があります）
また、 INC を押しながら DEC を押したり、 DEC を押しながら INC

を押すことで、高速にカーソルを移動することができます。

5. ENTER を押します。
▼コピーが実行され、元の画面に戻ります。
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エレメントデータのコピー

他のボイス、またはエディット前のボイスのエレメントデータをコピーします。エレ
メントの一部のデータだけをコピーしたい場合には、その目的の階層の画面を表示し
てから同様の操作を行います。

手　順

1. エディットの最初の画面を表示させます。
EXIT を何回か押すと、この画面になります。

2. 「E1 Name」または「E2 Name」にカーソルを移動します。
3. COPY を押します。

▼コピーのウィンドウが表示されます。

4. ダイアルやカーソルボタン、 INC DEC を使って、コピーするエレメント
（コピー元のエレメント）を選択します。
選択したエレメントの全データが、現在のエレメントにコピーされることにな
ります。

外部MIDI機器の鍵盤を弾くと、現在カーソルのあるエレメントのデータをコ
ピーした場合に得られる音を確認することができます。

コピーのウィンドウが表示された時点では、「＊」のついたエレメントが選択
されます。この「＊」のついたエレメントは現在のボイスで使用しているエレ
メントですが、これを選択してコピーを実行すると、エディット前のエレメン
トデータをコピーすることができます。（すなわち、エレメントエディットを
行う前の状態に戻すことができます）

F3 （E2またはE1）を押すと、現在エディット中のもう片方のエレメント
データをコピーしてくることができます。
もう一度、 F3 を押すと、元の状態に戻ります。
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F6 （123...）を押すとボイス番号順の表示に、 F7 （ABC...）を押すとエ
レメント名のアルファベット順の表示に切り換わります。（このとき「Now
sorting!」と表示され、少し時間がかかる場合があります）
また、 INC を押しながら DEC を押したり、 DEC を押しながら INC

を押すことで、高速にカーソルを移動することができます。

5. ENTER を押します。
▼コピーが実行され、元の画面に戻ります。
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リコールの操作

ボイスをエディットした後、ストアしないままプレイモードに戻り、別のボイスに切
り換えると、エディットした音は消えてしまいます。（エディット前の音に戻ってし
まいます）
たとえば、A01のボイスをエディットしたとしましょう。エディット後、ストアする
前にプレイモードに戻ってA02のボイスに切り換えました。そして、再びA01に切り
換えたとき、出てくる音はエディット前の音で、エディットの反映された音は消えて
しまっています。
リコールは、このような場合に、エディットされた音を再び呼び戻す機能です。
また、本機は外部MIDI機器からプログラムチェンジを受信すると、エディット中で
あってもボイスが切り換わります。このようなときにも、エディット中だったボイス
はリコールの操作で呼び戻すことができます。

手　順

1. UTILITY を押します。
▼ユーティリティモードに移ります。

2. F4 （Recl）を押します。
▼次のようなウィンドウが表示されます。

3. ENTER を押します。
▼確認のメッセージが表示されます。（ユーティリティのコンファームがオフ

になっている場合には、確認のメッセージは表示されません（→ P. 193））

4. INC を押します。
リコールを中止したい場合には、 INC のかわりに DEC を押します。
▼リコールが実行されます。

ボイスエディットについて
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参　考

・本体内部では、次のようにデータが格納、移動されます。

A01 A02 A03 A04 A05 H16

ボイスメモリー�

エディットバッファー�

リコールバッファー� コンペアバッファー�

エディットバッファーに入っている�
データで音が出ます�

ボイスを選択� ストア�

エディットは、エディットバッファー内の�
データに対して行われます�

エディットバッファーのデータ�
がストアされていない状態で、�
他のボイスを選択すると、それ�
までエディットバッファーに入�
っていたデータはリコールバッ�
ファーに移動します� リコール�

�

コンペア�

コンペア解除�

コンペアを行うと、エディットバッフ�
ァーのデータがコンペアバッファーに�
移動するとともに、エディットバッフ�
ァーにボイスメモリーから元のボイス�
データが読み込まれます�
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エディットをしやすくするための機能

次に紹介する機能は、ボイスのエディットを進めやすくするための機能です。

■エレメントセレクト（ELEMENT SELECT）

F5 ＋ （E1） F5 ＋ （E2）

・エレメントのエディット中に、エレメント1とエレメント2を切り換えます。たとえ
ば、エレメント1の設定画面で、 F5 を押しながら を押すと、エレメント2の
同じ設定画面が表示されます。 F5 を押しながら を押すと、元の画面に戻り
ます。

・1つのエレメントしか使っていないボイスの場合には、この機能は働きません。

■エレメントオン／オフ（ELEMENT ON/OFF）

F5 ＋ （E1） F5 ＋ （E2）

・一時的に、エレメント1またはエレメント2の発音を中止します。どちらか片方のエ
レメントの音だけを確認したい場合に使います。

・ F5 を押しながら や ボタンを押すたびに、交互にオン／オフが切り換わ
ります。画面右上の「1」または「2」が反転表示になっているときはオン（発音す
る）の状態、通常表示になっているときはオフ（発音しない）の状態です。

参　考

・これらの機能は、あくまでもエディットをしやすくするために用意されている機能です。こ
れらのボタンの状況がボイスのデータとしてストアされたりすることはありません。

・エディットモード以外では、これらの機能は使用できません。
・エレメントオン／オフはプレイモードに戻ると、自動的にオンとなります。
・本機には、エディット中一時的にエフェクトをオン／オフしたり、モディファイアをオン／
オフする機能はありません。
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ボイスのエディットを進めていく上で、「キースケール」（略して「KSC」）という設
定がよく出てきます。
この機能は、弾く鍵盤の音程によって、任意の数値（設定）を変化させるための設定
です。
たとえば、「C-1以下、C7以上では音量が小さい。G2とB4に音量のピークがある」と
いう楽器を想定したときには、キースケールを使って、次のように「アンプリチュー
ド」（音量）を設定しておきます。（太い線が音量のカーブを示します）

この図で、点線（音量が80のところの横線）は「基準値」を示します。
「BP1」～「BP8」と示されているのは、「ブレークポイント」です。それぞれのブレー
クポイントは、「音程」と「基準値からの変化量」で設定します。
この図の場合、次のような設定になっています。

・基準値 ‥　80
・ブレークポイント1 ‥　音　程：C-1 変化量：-45 （音量：80-45=35）
・ブレークポイント2 ‥　音　程：B-1 変化量：-20 （音量：80-20=60）
・ブレークポイント3 ‥　音　程：C1 変化量：0 （音量：80+0=80）
・ブレークポイント4 ‥　音　程：G2 変化量：20 （音量：80+20=100）
・ブレークポイント5 ‥　音　程：B3 変化量：0 （音量：80+0=80）
・ブレークポイント6 ‥　音　程：B4 変化量：30 （音量：80+30=110）
・ブレークポイント7 ‥　音　程：A5 変化量：5 （音量：80+5=85）
・ブレークポイント8 ‥　音　程：C7 変化量：-30 （音量：80-30=50）

ブレークポイント以外の音程では、前後のブレークポイントを直線で結んだ高さの音
量となります。
また、一番小さい番号のブレークポイントより下の音程では、そのブレークポイント
と同じ音量となります。同様に一番大きい番号のブレークポイントより上の音程で
は、そのブレークポイントと同じ音量となります。

ボイスエディットについて

C2 C3 C4 C5 C6 C7 C8C-1 C0C-2 G8

音量�

音程�

0

127

BP1

BP3

BP5

BP6

BP8

80

BP2

BP4

BP7

C1
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ここでは、アンプリチュードを例にして説明しましたが、この他にもブレスノイズや
ダイナミックフィルター、ビブラートなど、さまざまな機能をキースケールで変化さ
せることができます。
また、ブレークポイントの数は、機能によって異なります。
各キースケールの設定方法については、第4章以降で説明します。

注　意

・各ブレークポイントは、1から順番に高い音程になっていくように設定します。
・ブレークポイントの「基準値からの変化量」は、絶対的なもの（基準値に数値を加え
るだけのもの）と、相対的なもの（基準値を適当な割合で変化させるもの）がありま
す。これは、機能によって異なります。

・基準値に変化幅を加えた値が、有効な範囲を超える場合には、最大または最小の設
定となります。

参　考

・キースケールの設定画面に入ると、縦の点線が表示されています。これは、電源投入後の最
新の押鍵情報を表わしています。この画面で、外部MIDI機器の鍵盤を弾くと、グラフの中で
の鍵盤位置が確認できます。

・各ブレークポイントの「音程」の部分が反転表示になっているときには、外部MIDI機器の鍵
盤を使って音程を入力することができます。 F8 （Kbd）を押した後、任意の鍵盤を弾い
てください。

・連続する複数のブレークポイント（たとえばBP2とBP3とBP4）を同じ音程に設定することも
できます。ただし、実際に使用されるレベル（音量）は、一番小さい番号のブレークポイント
と一番大きい番号のブレークポイントとなります。

C2 C3 C4 C5 C6 C7 C8C-1 C0C-2 G8

音量�

音程�

0

127

BP1
BP3

BP5

BP6 BP8
BP2

BP4
BP7

C1
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VL1とVL1-mの異なる点

■VL1からVL1-mになり追加された機能

・プログラムチェンジテーブル（→P.190）
・サウンド（→P.41）
・WXリップ（→P.188）
・モニター（→P.50）

■VL1からVL1-mになり変更された機能

・コンティニュアススライダー→クイックエディット（→P.40）
・バンクボタンによるバンク切り換え→ INC ＋ DEC によるバンク切り換え　
（→別冊のベーシックガイド：P.32）

■VL1からVL1-mになり削除された機能

・キーボードトランスポーズ
・オクターブスイッチ
・アサイナブルコントローラー
・ベロシティ／アフタータッチカーブ

VL1とVL1-mのデータ互換

■システムエクスクルーシブメッセージの互換性

・形状による違い（キーボードと音源モジュール）から発生するシステムデータの一
部を除いてバルクデータには互換があります。

・VL1-mのクイックエディットは、コントロールチェンジの016、017のデータやVL1
のCS1、CS2のパラメーターチェンジを受信できます。

■同梱されているボイスディスクの互換性

・VL1の「CUSTOMER.ALL」および「FACTORY .ALL」の2ファイルは、VL1-mの
「FULLCTRL.ALL」および「STANDARD.ALL」の2ファイルとシステムデータの一
部を除き、同じ内容のファイルです。
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この章では、実際に演奏を行うためのプレイモードの操作を説明します。
ボイス名を一覧表示させたり、コントローラーの設定を確認したりするこ
とができます。



38　　第2章　プレイモード

プレイモードの機能
プレイモードは、通常の演奏を行うモードです。

・プレイモードの機能

Play （→ P. 40）
Directory （→ P. 42）
Controller View 1 （→ P. 44）
Controller View 2 （→ P. 45）
Controller View 3 （→ P. 46）
Controller View 4 （→ P. 47）
Controller View 5 （→ P. 48）
Quick Edit View （→ P. 49）
Monitor （→ P. 50）

プレイモードの機能

エディットモード�

ユーティリティモード�

コモンエディット� ミスレイニアス�

エフェクト�

エレメントエディット� コントローラー�

ミスレイニアス�

モディファイア�

エンベロープ�

システム�

MIDIバルクダンプ�

ディスク�

エディットリコール�

デモ�

プレイモード�
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解　説

・プレイモードでは、次のような操作が可能です。

■演奏する

外部MIDI機器の鍵盤やコントローラー、シーケンサーなどを使って、演奏をするこ
とができます。また、 ENTER （SOUND）を押すと、C4の音程で発音します。

■ボイスを選択する

ダイアルや INC DEC などを使って、演奏するボイスを切り換えることができま
す。

■コントローラーの設定を見る

ブレスコントローラーや外部MIDI機器のフットコントローラー、モジュレーション
ホイールなどに割り当てられている機能を表示し、確認することができます。また、
そのコントローラーのエディット画面に直接移動することもできます。

■クイックエディットを行う

外部MIDI機器からコントロールナンバー＝016、017のコントロールチェンジデータ
を送り込むことで、直接ボイスをエディットすることができます。また、クイックエ
ディットを行ったボイスをストアすることもできます。

■MIDI情報の受信状況を見る

外部MIDI機器から受信しているコントロールチェンジなどのデータをリアルタイム
にモニターすることができます。

参　考

・プログラムチェンジは、プレイモードに限らず、エディットモード、ユーティリティモード
でも受信します。（設定に応じて、ボイスも切り換えます）

・同様に、システムエクスクルーシブメッセージも、どのモードでも受信します。
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PLAY：プレイ

PLAY

通常の演奏を行う状態です。

Program Number A01 ～ H16

解　説

・実際に演奏を行うためのモードです。
・ボイスの切り換え方法については、「手順」をご覧ください。
・現在選択されているボイス番号は、画面の2行目に表示されます。
・画面右上には、リバーブレーションのオン／オフとステレオ／モノラル出力の状態
が表示されます。（この設定はユーティリティの「TG Setting」（→ P. 188）で行い
ます）

・画面中央には、大きな文字で現在選択されているボイス名が表示されます。
・ボイス名の右側には、上段（エレメント1）下段（エレメント2）にそれぞれのエレメ
ントの発音に重要な役割をはたすコントローラーが表示されます。

・ボイス名の下には、そのボイスのキーモード（Mono, Poly, Unison）とボイスモード
（Single, Dual）が表示されます。

・その下には、エレメント1、2の名前、さらにその下には、3つのエフェクト（モジュ
レーションエフェクト、フィードバックディレイ、リバーブレーション）の設定が
表示されます。

■クイックエディットについて

・プレイモードでは、クイックエディットを行うことができます。
・クイックエディットは、ボイスごとによくエディットするパラメーターを、コント
ロールナンバー＝016、017に割り当てておくことで、演奏中にでもエディットを可
能にする便利な機能です。ただし、コントロールチェンジデータを受信するとすぐ
に変化がはじまるわけではなく、元々のボイスまたはエレメントの設定値と同じ値
になった時点から変化がはじまります。これは、突然音が大きく変化してしまうこ
とを避けるためです。

・クイックエディットに割り当てられている機能は、ボイスによって異なります。
（割り当てないようにすることもできます）

・クイックエディットを行った場合、画面はプレイモードのままですが、内部的には
エディットモードで設定を変更したときと同じ状態になります。（画面のボイス番
号の前に「E」の反転表示が出ます）

・クイックエディットを行ったボイスを保存したい場合には、そのままストア（→ P.
23）の操作を行ってください。

プレイモードの機能
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■サウンド機能について

・このプレイの画面が表示されているときに限り、 ENTER （SOUND）を押すと選択
されているボイスが鳴ります。ただし、音程は「C4」に固定です。また、音を確認し
やすくするために、各コントローラーのアサインは一時的に無効となります。

参　考

・ F1 （Cnt1）～ F5 （Cnt5）、 F6 （QED）、 F7 （Moni）を押して、コントロー
ラー、クイックエディットの設定やMIDIの状態を見ることができます。（→ P. 44）

・ F8 （Dir）を押して、ボイスの一覧を見る（あるいはボイスを切り換える）ことができま
す。（→ P. 42）

手　順

■ダイアルでボイスを切り換える方法

1． ダイアルを回します。
▼1～128のボイス通し番号にしたがって、連続してボイスが切り換わります。

時計回りで+1、反時計回りで-1となります。

■ INC DEC でボイスを切り換える方法

1． INC または DEC を押します。
▼1～128のボイス通し番号にしたがって、ボイス番号が増減します。

■バンクを切り換える方法

1． DEC を押しながら INC 、または INC を押しながら DEC を押しま
す。
▼ボイス番号が16ずつ増減し、バンクが切り換わります。

■プログラムチェンジ情報でボイスを切り換える方法

1． 外部MIDI機器側でプログラムチェンジを送信します。
▼設定されているプログラムチェンジテーブルにしたがって、ボイスが切り換

わります。なお、プログラムチェンジはどのモードでも受信します。
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PLAY / DIRECTORY：ディレクトリー

PLAY  → F8 （Dir）

ボイスの一覧を表示し、ボイスを切り換えます。

Program Number A01 ～ H16

解　説

・ボイスの一覧を表示します。
・この状態のまま、演奏やクイックエディット（→ P. 40）を行うこともできます。
・現在選択されているボイス番号、ボイス名は、画面の2行目に表示されます。一覧の
中でも反転表示されます。

・ボイスの切り換え方法については、下記の「手順」をご覧ください。
・ EXIT または PLAY を押すと、一覧表示を終了し、元の画面に戻ります。

参　考

・ F1 （Cnt1）～ F5 （Cnt5）、 F6 （QED）、 F7 （Moni）を押して、コントロー
ラー、クイックエディットの設定やMIDIの状態を見ることができます。（→ P. 44）

手　順

■ダイアルでボイスを切り換える方法

1． ダイアルを回します。
▼1～128のボイス通し番号にしたがって、連続してボイスが切り換わります。

時計回りで+1、反時計回りで-1となります。

■ INC DEC でボイスを切り換える方法

1． INC または DEC を押します。
▼1～128のボイス通し番号にしたがって、ボイス番号が増減します。

■ でボイスを切り換える方法

1． カーソルボタン（ ）で目的のボイスに反転表示を移動します。

2． ENTER を押します。
▼選択したボイスに切り換わります。この方法でバンクを切り換えることはで

きません。

プレイモードの機能
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■バンクを切り換える方法

1． DEC を押しながら INC 、または INC を押しながら DEC を押しま
す。
▼ボイス番号が16ずつ増減し、バンクが切り換わります。

■プログラムチェンジ情報でボイスを切り換える方法

1． 外部MIDI機器側でプログラムチェンジを送信します。
▼設定されているプログラムチェンジテーブルにしたがって、ボイスが切り換

わります。なお、プログラムチェンジはどのモードでも受信します。

ただし、MIDIバンクセレクト情報では、本機のバンクは切り換わりません。

プレイモードの機能
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PLAY / CONTROLLER VIEW 1：コントローラービュー1

PLAY  → F1 （Cnt1）

プレッシャー、アンブシュア、ピッチ、ビブラートが、どのコントローラーに割り当てられているか表示します。

設定項目はありません

解　説

・演奏中に変化させたい機能が、どのコントローラーに割り当てられているか、確認
するときに使う機能です。

・この状態のまま、演奏やクイックエディット（→ P. 40）を行うことができます。た
だし、ボイスの切り換えはできません。

・画面の表には、エレメント1、2それぞれのプレッシャー、アンブシュア、ピッチ、ビ
ブラートが、どのコントローラーに割り当てられているかを表示します。機能がコ
ントローラーに割り当てられていない場合には、「off」と表示されます。

・ EXIT または PLAY を押すと、通常のプレイ画面に戻ります。
・カーソルボタンやダイアル、 INC DEC などを使って、反転表示を任意の位置
に移動し、 EDIT を押すと、そのコントローラーを設定するエディット画面に移り
ます。（「off」の表示でもエディットに移ることができます）

参　考

・ F2 （Cnt2）～ F5 （Cnt5）、 F6 （QED）、 F7 （Moni）を押して、コントロー
ラー、クイックエディットの設定やMIDIの状態を見ることができます。

・ F8 （Dir）を押して、ボイスの一覧を見ることができます。（→ P. 42）
・各機能のコントローラーを変更する場合は、以下のページをご覧ください。
・プレッシャー（→ P. 92）
・アンブシュア（→ P. 93）
・ピッチ（→ P. 95）
・ビブラート（→ P. 97）

プレイモードの機能
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PLAY / CONTROLLER VIEW 2：コントローラービュー2

PLAY  → F2 （Cnt2）

タンギング、アンプリチュード、スクリーム、ブレスノイズが、どのコントローラーに割り当てられているか表示します。

設定項目はありません

解　説

・演奏中に変化させたい機能が、どのコントローラーに割り当てられているか、確認
するときに使う機能です。

・この状態のまま、演奏やクイックエディット（→ P. 40）を行うことができます。た
だし、ボイスの切り換えはできません。

・画面の表には、エレメント1、2それぞれのタンギング、アンプリチュード、スクリー
ム、ブレスノイズが、どのコントローラーに割り当てられているかを表示します。
機能がコントローラーに割り当てられていない場合には、「off」と表示されます。

・ EXIT または PLAY を押すと、通常のプレイ画面に戻ります。
・カーソルボタンやダイアル、 INC DEC などを使って、反転表示を任意の位置
に移動し、 EDIT を押すと、そのコントローラーを設定するエディット画面に移り
ます。（「off」の表示でもエディットに移ることができます）

参　考

・ F1 （Cnt1）、 F3 （Cnt3）～ F5 （Cnt5）、 F6 （QED）、 F7 （Moni）を
押して、コントローラー、クイックエディットの設定やMIDIの状態を見ることができます。

・ F8 （Dir）を押して、ボイスの一覧を見ることができます。（→ P. 42）
・各機能のコントローラーを変更する場合は、以下のページをご覧ください。
・タンギング（→ P. 98）
・アンプリチュード（→ P. 99）
・スクリーム（→ P. 100）
・ブレスノイズ（→ P. 101）

プレイモードの機能
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PLAY / CONTROLLER VIEW 3：コントローラービュー3

PLAY  → F3 （Cnt3）

グロウル、スロート、ダイナミックフィルター、ハーモニックエンハンサーが、どのコントローラーに割り当てられているか表示します。

設定項目はありません

解　説

・演奏中に変化させたい機能が、どのコントローラーに割り当てられているか、確認
するときに使う機能です。

・この状態のまま、演奏やクイックエディット（→ P. 40）を行うことができます。た
だし、ボイスの切り換えはできません。

・画面の表には、エレメント1、2それぞれのグロウル、スロート、ダイナミックフィル
ター、ハーモニックエンハンサーが、どのコントローラーに割り当てられているか
を表示します。機能がコントローラーに割り当てられていない場合には、「off」と
表示されます。

・ EXIT または PLAY を押すと、通常のプレイ画面に戻ります。
・カーソルボタンやダイアル、 INC DEC などを使って、反転表示を任意の位置
に移動し、 EDIT を押すと、そのコントローラーを設定するエディット画面に移り
ます。（「off」の表示でもエディットに移ることができます）

参　考

・ F1 （Cnt1）、 F2 （Cnt2）、 F4 （Cnt4）、 F5 （Cnt5）、 F6 （QED）、
F7 （Moni）を押して、コントローラー、クイックエディットの設定やMIDIの状態を見る

ことができます。
・ F8 （Dir）を押して、ボイスの一覧を見ることができます。（→ P. 42）
・各機能を変化させるコントローラーを変更する場合は、以下のページをご覧ください。
・グロウル（→ P. 102）
・スロートフォルマント（→ P. 104）
・ダイナミックフィルター（→ P. 106）
・ハーモニックエンハンサー（→ P. 107）

プレイモードの機能
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PLAY / CONTROLLER VIEW 4：コントローラービュー4

PLAY  → F4 （Cnt4）

ダンピング、アブソープションが、どのコントローラーに割り当てられているか表示します。

設定項目はありません

解　説

・演奏中に変化させたい機能が、どのコントローラーに割り当てられているか、確認
するときに使う機能です。

・この状態のまま、演奏やクイックエディット（→ P. 40）を行うことができます。た
だし、ボイスの切り換えはできません。

・画面の表には、エレメント1、2それぞれのダンピング、アブソープションが、どのコ
ントローラーに割り当てられているかを表示します。機能がコントローラーに割り
当てられていない場合には、「off」と表示されます。

・ EXIT または PLAY を押すと、通常のプレイ画面に戻ります。
・カーソルボタンやダイアル、 INC DEC などを使って、反転表示を任意の位置
に移動し、 EDIT を押すと、そのコントローラーを設定するエディット画面に移り
ます。（「off」の表示でもエディットに移ることができます）

参　考

・ F1 （Cnt1）～ F3 （Cnt3）、 F5 （Cnt5）、 F6 （QED）、 F7 （Moni）を
押して、コントローラー、クイックエディットの設定やMIDIの状態を見ることができます。

・ F8 （Dir）を押して、ボイスの一覧を見ることができます。（→ P. 42）
・各機能を変化させるコントローラーを変更する場合は、以下のページをご覧ください。
・ダンピング（→ P. 109）
・アブソープション（→ P. 110）

プレイモードの機能
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PLAY / CONTROLLER VIEW 5：コントローラービュー5

PLAY  → F5 （Cnt5）

ポリフォニー、サステイン、ピッチベンドモード、ポルタメントモード、エフェクトの設定を表示します。

設定項目はありません

解　説

・演奏中に、任意の機能がどのような設定になっているか、確認するときに使う機能
です。

・この状態のまま、演奏やクイックエディット（→ P. 40）を行うことができます。た
だし、ボイスの切り換えはできません。

・画面の表には、ポリフォニーコントロール（offまたはコントローラー）、サステイ
ンのオン／オフ、ピッチベンドモード（Normal, Low, High）、ポルタメントモード
（Full Time, Fingered）とポルタメントのタイムMIDIコントロールのオン／オフ、エ
フェクトのコントローラーソースおよびコントローラーデスティネーションを表示
します。

・ EXIT または PLAY を押すと、通常のプレイ画面に戻ります。
・カーソルボタンやダイアル、 INC DEC などを使って、反転表示を任意の位置
に移動し、 EDIT を押すと、そのコントローラーを設定するエディット画面に移り
ます。（「off」の表示でもエディットに移ることができます）

参　考

・ F1 （Cnt1）～ F4 （Cnt4）、 F6 （QED）、 F7 （Moni）を押して、コントロー
ラー、クイックエディットの設定やMIDIの状態を見ることができます。

・ F8 （Dir）を押して、ボイスの一覧を見ることができます。（→ P. 42）
・各機能の設定を変更する場合は、以下のページをご覧ください。
・ポリフォニーコントロール（→ P. 58）
・サステイン（→ P. 57）
・ピッチベンドモード（→ P. 57）
・ポルタメントモード／タイムMIDIコントロール（→ P. 62）
・エフェクトコントロール（→ P. 67）

プレイモードの機能
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PLAY / QUICK EDIT｠VIEW：クイックエディットビュー

PLAY  → F6 （QED）

クイックエディットの設定および状態を表示します。

設定項目はありません

解　説

・クイックエディットは、ボイスごとによくエディットするパラメーターをコント
ロールチェンジ＝016、017に割り当てておくことで、演奏中でもエディットを可能
にする便利な機能です。

・演奏中に、そのクイックエディットがどのような設定になっているか、確認すると
きに使う機能です。

・この状態のまま、演奏やクイックエディット（→ P. 40）を行うことができます。ま
た、この状態でプログラムチェンジ情報を使ってボイスを切り換えることができま
す。

・3行目には、各クイックエディットに割り当てられている設定項目の名前が表示さ
れます。

・画面中央の横棒グラフには、現在受信中のコントロールナンバー＝016、017のコン
トロールチェンジの値が表示されます。まだ受信していないときは左端（0）に位置
します。グラフの上側の数字と短い縦線は、ボイス自身の持つ設定値を示していま
す。コントロールチェンジのデータが、この短い縦線を通過した時点から、コント
ロールチェンジデータによるコントロールが可能になります。（通過するまでは、
ボイスの設定値のままとなります）また、クイックエディットで2つのエレメントの
設定を同時にコントロールする場合には、グラフの下側にも数字と短い縦線が表示
されます。この場合には、上側にはエレメント1の設定が、下側にはエレメント2の
設定が表示されます。

・ EXIT または PLAY を押すと、通常のプレイ画面に戻ります。
・この画面の状態で EDIT を押すと、クイックエディットの設定を行うエディット
画面に移ります。

注　意

・クイックエディットに何も設定項目が割り当てられていない場合（offと表示されて
いる場合）には、コントロールチェンジを受信しても画面に変化はありません。

参　考

・ F1 （Cnt1）～ F5 （Cnt5）、 F7 （Moni）を押して、コントローラーの設定や
MIDIの状態を見ることができます。

・ F8 （Dir）を押して、ボイスの一覧を見ることができます。（→ P. 42）
・クイックエディットの設定を変更する場合は、以下のページをご覧ください。
・クイックエディットアサイン（→ P. 65）

プレイモードの機能
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PLAY / MONITOR：モニター

PLAY  → F7 （Moni）

外部MIDI機器やブレスコントローラーから受信しているMIDI情報を表示します。

Control Change off, 001～119

解　説

・本機に接続されているブレスコントローラーや、外部MIDI機器の鍵盤、コントロー
ラーから送り込まれたMIDIチャンネルメッセージをリアルタイムに表示します。

・表示されるデータは、次の8種類です。なお、表示の反転している部分には、ダイア
ルや INC または DEC を使って、表示させたいコントロールチェンジ情報の任
意の番号を設定することができます。

コントロールチェンジ（Control Change：コントロールナンバー=off, 001～119)
モジュレーションホイール（Modulation：コントロールナンバー=001)
ブレスコントローラー（Breath Con：コントロールナンバー=002)
フットコントローラー（Foot Contr：コントロールナンバー=004)
メインボリューム（Main Volume：コントロールナンバー=007)
ピッチベンド（Pitch Bend)
アフタータッチ（After Touch）
ノート（Note：音程とベロシティ）

・この状態のまま、演奏やクイックエディット（→ P. 40）を行うことができます。た
だし、ボイスの切り換えはできません。

・ EXIT または PLAY を押すと、通常のプレイ画面に戻ります。

注　意

・この画面状態のときは、表示を優先させるため、一部のコントロールデータに限り
音への影響が遅れる場合があります。通常の演奏時は、 EXIT を押してプレイ画面
に戻ってください。

参　考

・ピッチベンドは、中央（0）が本来の音程を示します。
・ F1 （Cnt1）～ F5 （Cnt5）、 F6 （QED）を押して、コントローラーやクイックエ
ディットの設定状況を見ることができます。

・ F8 （Dir）を押して、ボイスの一覧を見ることができます。（→ P. 42）

プレイモードの機能



この章では、エディットモードにはじめて入ったときに表示される画面で
のボイス名やキーモード、ボイスモードを設定する操作と、コモンエ
ディットの機能を説明します。コモンエディットでは、ボイス全体に関す
る設定や、2つのエレメントに共通の設定などを行います。
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エディットモードの最初の画面
エディットモードに入ると、最初にボイスの基本的な部分（ボイス名やキーモード、ボイスモード、エレメント
名）を設定するための画面が表示されます。

ただし、エディットモードでエディットした後、ストアしないでプレイモードに移っていた場合（「E」の反転
マークがボイス番号の前に表示されている場合）、 EDIT を押すと、プレイモードに移る直前に表示されてい
たエディットモードの画面に戻ります。
また、コモンエディットやエレメントエディットを行った後、 EXIT を何回か押すと、必ずこの画面に戻りま
す。

参　考

・エディット中には、 F5 を押しながら を押すことで、一時的なエレメントの切り換
えやオン／オフを行いながら作業を進めていくことができます。（→ P. 32）

・エディット中に、コンペアの機能を使って、エディット前の音と、エディット後の音を聴き
比べることもできます。（→ P. 25）

エディットモードの最初の画面

プレイモード�

ユーティリティモード�

コモンエディット� ミスレイニアス�

エフェクト�

エレメントエディット� コントローラー�

ミスレイニアス�

モディファイア�

エンベロープ�

システム�

MIDIバルクダンプ�

ディスク�

エディットリコール�

デモ�

エディットモード�

この階層で表示される画面です
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EDIT：エディット

EDIT

ボイス名、キーモード、ボイスモード、エレメント名を設定します。

Voice Name 10文字まで
Key Mode Mono, Poly, Unison
Voice Mode Single, Dual
E1 Name, E2 Name 10文字まで

解　説

・ボイスの一番基本的な設定を行います。
・ボイス名（Voice Name）は、ボイスの名前です。ボイス名の入力方法については、第
1章の「文字入力の方法」（→ P. 20）をご覧ください。

・キーモード（Key Mode）と、ボイスモード（Voice Mode）では、2つのエレメントを
使って、どのように音を出すかを設定します。

　Key Mode=Mono Voice Mode=Single の場合
1種類のエレメントの音だけが出ます。和音は出ません。

　Key Mode=Poly Voice Mode=Single の場合
1種類のエレメントの音だけが出ます。2音までの和音が出ます。

　Key Mode=Unison Voice Mode=Single の場合
1つの鍵盤を弾いたときには、同じ設定の2エレメントの音が同時に出ま
す。2音の和音を弾いたときには、1音につき1エレメントの音が出ます。

　Key Mode=Mono Voice Mode=Dual の場合および
　Key Mode=Poly Voice Mode=Dual の場合

異なる設定の2エレメントの音が同時に出ます。和音は出ません。
　Key Mode=Unison Voice Mode=Dual の場合

1つの鍵盤を弾いたときには、異なる設定の2エレメントの音が同時に出
ます。2音の和音を弾いたときには、高い方の音はエレメント1、低い方
の音はエレメント2の音が出ます。

エディットモードの最初の画面

Key Mode

Voice Mode

Poly Unison

Single

Dual

Mono

Sax

Sax Bass

Sax SaxSax Sax

Sax BassSax Bass

Sax Sax



54　　第3章　エディットモード － コモンエディット

・エレメント名（E1 Name, E2 Name）は、各エレメントの名前です。ボイスモードで
「Single」を選択した場合には、エレメント1のエレメント名のみを設定します。エ
レメント名の入力方法については、第1章の「文字を入力する」（→ P. 20）をご覧く
ださい。また、文字入力のウィンドウで、 F4 （Auto）を押すと、そのときのボイ
ス名をそのままエレメント名としてコピーします。ただし、ボイスモードが「Dual」
の場合には、ボイス名の後ろに「A」または「B」が付けられます。

・スワップ機能を使うと、エレメント1とエレメント2を、そっくり（全ての設定を含
めて）入れ換えることができます。この機能を使うときは、 F7 （Swap）を押し
てください。この機能は、Key Mode=Unison、Voice Mode=Dualで2つのノートオン
情報を使い、2種類の音を同時に出すとき、高音と低音の音色を交換するときなどに
使います。

参　考

・ボイスモード、キーモードの設定は、ボイスの性格を決定づける部分です。どんなとき、どん
な風に演奏するのかを十分考えて選んでください。

・2和音が出せる状態で、2つのノートオン情報を受信したまま、3つ目のノートオン情報を受信
すると、次のようになります。

　Key Mode=Unison Voice Mode=Single または Dual の場合
受信している3つのノートオン情報のうち、最高の音と最低の音だけが出ます。中間の
ノートオン情報での音は出ません。

　Key Mode=Poly Voice Mode=Single の場合
　 アサインモード（→ P. 57）が、Bottom Noteの場合には、受信している3つのノートオン

情報のうち、最低の音と最後に受信した音だけが出ます。ただし、最後に受信した音が
最低音の場合には、直前の最低音は消えてしまいます。

　 アサインモードが、Top Note（またはTop Note＊）の場合には、受信している3つのノー
トオン情報のうち、最高の音と最後に受信した音だけが出ます。ただし、最後に受信し
た音が最高音の場合には、直前の最高音は消えてしまいます。

・キーモードが「Single」の場合でも、音を出さない（表示もされない）エレメント2の方にも
データは保管されています。したがって、スワップ機能を使うと、テンポラリメモリーのよ
うにエレメント2を使うことができます。

エディットモードの最初の画面
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コモンエディットについて
エディットモードに入ると、最初にボイスの基本的な部分（ボイス名やキーモード、ボイスモード、エレメント
名）を設定するための画面（→ P. 52）が表示されます。

この画面で、 F1 （Com）を押すと、コモンエディットのメニューが表示されます。
コモンエディットでは、各種コントローラーの基本的な設定や、エレメント間のチューニングやレベルの調整、
エフェクトの設定などを行います。

コモンエディットの階層から、「ミスレイニアス（その他という意味）」、「エフェクト」の2種類に分かれます。
この2種類のメニューを切り換えるには、 F1 （Misc） F2 （Efct）を使います。

参　考

・エディット中には、 F5 を押しながら を押すことで、一時的なエレメントの切り換
えやオン／オフを行いながら作業を進めていくことができます。（→ P. 32）

・エディット中に、コンペアの機能を使って、エディット前の音と、エディット後の音を聴き
比べることもできます。（→ P. 25）

コモンエディットについて
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コモンエディットのミスレイニアスでは、各種コントローラーの基本的な設定や、エレメント間のチューニン
グやレベルの調整、コンティニュアススライダーの設定などを行います。

・コモンエディットのミスレイニアスの機能

1: Setteing （→ P. 57）
2: Controller （→ P. 58）
3: Element Pitch （→ P. 59）
4: Element Level & Pan （→ P. 60）
5: Portamento （→ P. 62）
6: Micro Tuning （→ P. 63）
7: Quick Edit Assign （→ P. 65）

コモンエディット － ミスレイニアスの機能

プレイモード�

エディットモード�
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EDIT / COM / MISC / SETTING：セッティング

EDIT  → F1 （Com）→ F1 （Misc）→ 1: Setting → ENTER

アサインモード、ピッチベンドモード、サステインを設定します。

Assign Mode Bottom Note, Top Note,
Last Note（Top Note＊）

Pitchbend Mode Normal, Bottom, Top
Sustain off, on

解　説

・アサインモード（Assign Mode）は、ノートオン情報を受信したときに、音源がどの
ように発音するかの設定です。

・キーモードが「Mono」のとき、「Bottom Note」を選択した場合には、そのタイミン
グで最も低いノートオン情報で発音します。「Top Note」を選択した場合には、その
タイミングで最も高いノートオン情報で発音します。「Last Note」を選択した場合
には、そのタイミングで最も後に弾かれたノートオン情報で発音します。

・キーモードが「Poly」のときは、すでに2つの音が出ている状態で、3つ目の鍵盤を弾
いたときの発音を設定します（→ P. 53）。キーモードが「Poly」のときは、「Last
Note」は選択できません。選択しようとすると「Top Note＊」と表示され、「Top
Note」と同じ設定になります。

・ピッチベンドモード（Pitchbend Mode）では、キーモードが「Poly」または「Unison」
になっている状態で、2和音を弾いたときのピッチベンドホイールの効果のかかり
方を選択します。「Norma l」を選択すると2つの音とも音程が上下します。
「Bottom」を選択すると、低い方の音程だけが上下します。「Top」を選択すると、高
い方の音程だけが上下します。

・サステイン（Sustain）は、外部MIDI信号のサステイン情報を受けるかどうかの選択
です。「on」を選択すると、鍵盤を押さえた後、サステインオンの信号を受信してい
る間、キーオンの状態が持続します。

注　意

・キーモードが「Unison」に設定されている場合には、アサインモードの設定は無効
となり、どの設定にしてもそのタイミングの最低と最高のノートオン情報で発音し
ます。

・キーモードが「Mono」に設定されている場合には、ピッチベンドモードの設定は無
効となります。
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EDIT / COM / MISC / CONTROLLER：コントローラー

EDIT  → F1 （Com）→ F1 （Misc）→ 2: Controller → ENTER

ブレスアタックとタッチEGの特性、ポリフォニーコントロールを設定します。

Breath Attack Time 5 msec ～ 1.24 sec
Breath Attack Gain 0 ～ 127
Touch EG Time 5 msec ～ 1.24 sec
Polyphony Ctrl off, Modulation Wheel ～ 119

解　説

・ブレスアタックタイム（Breath Attack Time）とブレスアタックゲイン（Breath Attack
Gain）では、ブレスコントローラーのブレスアタックの特性を設定します。ブレス
コントローラー自体は、息を吹き込む強さだけをデータとして送り出す装置です
が、本機では、連続したこのデータからその「変化速度」を読み取ることができるよ
うになっています。これが、ブレスアタックです。（→ 別冊のベーシックガイド：
P. 45）ブレスアタックタイムを大きくすると、反応が遅くなります。ブレスアタッ
クゲインを大きくすると変化量が大きくなります。

・タッチEGタイム（Touch EG Time）では、タッチEGの反応の速さを設定します。
タッチEGは、鍵盤を弾いた瞬間のベロシティと、アフタータッチとを捕間するコン
トロールデータです。（→ 別冊のベーシックガイド：P. 47）タッチタイムを大きく
するほど、反応が遅くなります。

・ポリフォニーコントロール（Polyphony Ctrl）では、演奏中にキーモード（→ P. 53）
の「Mono」と「Poly」を切り換えるためのコントローラーを選択します。使用しな
い場合は、「off」を選択します。また、この機能が使えるのはキーモードが「Poly」
に設定されている場合だけです。

注　意

・キーモードが「Mono」または「Unison」に設定されている場合には、ポリフォニー
コントロールは「off」となり、変更できません。

参　考

・ブレスアタックは、息を吹き込む強さの変化速度だけを読みとっているわけですから、「全
く息を吹き込んでいない状態」と「連続して同じ強さの息を吹き込んでいる状態」とは、同じ
ということになります。

・ブレスアタックの効き方は、ブレスコントローラーのカーブの設定に影響されます。（→ P.
191）
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EDIT / COM / MISC / ELEMENT PITCH：エレメントピッチ

EDIT  → F1 （Com）→ F1 （Misc）→ 3: Element Pitch → ENTER

各エレメントのデチューンとノートシフト、ランダムピッチを設定します。

Element1 Detune -7 ～ 7
                Note Shift -64 ～ 63
                Random Pitch 0 ～ 7
Element2 Detune -7 ～ 7
                Note Shift -64 ～ 63
                Random Pitch 0 ～ 7

解　説

・2つのエレメントそれぞれのチューニングの微調整、ノートシフト、ランダムピッチ
を設定します。

・エレメント1デチューン（Element1 Detune）、エレメント2デチューン（Element2
Detune）では、各エレメントのチューニングを微妙に上下します。プラスの数値で
は音程が上がり、マイナスの数値では音程が下がります。

・エレメント1ノートシフト（Element1 Note Shift）、エレメント2ノートシフト
（Element2 Note Shift）では、各エレメントの音程を半音単位で上下します。プラス
の数値では音程が上がり、マイナスの数値では音程が下がります。

・ランダムピッチ（Random Pitch）では、エレメントの音程をランダムにずらす設定
を行います。数値を上げるほど、ずれが大きくなります。

注　意

・ボイスモードが「Single」に設定されている場合には、エレメント2の各設定は表示
されません。

・キーモードが「Unison」の場合には、エレメント2に関してデチューンのみが表示さ
れます。デチューン以外の設定はエレメント1と同じ設定となります。

参　考

・デチューン、ノートシフトは、一般的なチューニングというよりも、音程を微妙にずらして、
拡がりのある音を作り出したり、オクターブずらしたり、1キーで和音を出したりするために
用意されている機能です。演奏するホールの生ピアノに合わせてチューニングをするような
場合には、「マスターチューニング」（→ P. 188）の機能を使ってください。

・デチューン、ノートシフトはマスターチューニングを元にして変更されます。
・ランダムピッチは、音程の安定しない自然楽器などをシミュレートするような場合にも、有
効に使うことができます。
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EDIT / COM / MISC / ELEMENT LEVEL & PAN：エレメントレベル＆パン

EDIT  → F1 （Com）→ F1 （Misc）→ 4: Element Level&Pan → ENTER

各エレメントのレベルとパンを設定します。

Element1 Level 0 ～ 127
                Pan L -64 ～ 63
                Pan R -64 ～ 63
Element2 Level 0 ～ 127
                Pan L -64 ～ 63
                Pan R -64 ～ 63

解　説

・2つのエレメントそれぞれの出力レベル（音量）、パンポット（定位）を設定します。
また、各項目の右側には、設定がスライドバーで表示されます。

・エレメント1レベル（Element1 Level）、エレメント2レベル（Element2 Level）では、
各エレメントのレベルを設定します。数値が大きいほどレベルが上がります。

・エレメント1パンL, R（Pan L, Pan R）、エレメント2パンL, R（Pan L, Pan R）では、
各エレメントから出力された左チャンネルの信号、右チャンネルの信号を、それぞ
れどこに定位させるかを設定します。

・通常はパンLを「-64」に、パンRを「63」にしておきます。このときは、次の図のよう
に、エレメントで設定されたステレオ感のまま、出力されます。

コモンエディット － ミスレイニアスの機能

-64 630

エレメントの左チャンネル�
の出力がここに定位�

エレメントの右チャンネル�
の出力がここに定位�

左スピーカー� 右スピーカー�
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・これをパンLを「-64」に、パンRを「0」にすると、次の図のように、エレメントで設
定されたステレオ感が、左半分にかたよって出力されます。

・また、パンL、パンRをともに「0」にすると、次の図のように、エレメントで設定さ
れたステレオ感が失われて中央から出力されます。

注　意

・ボイスモードが「Single」に設定されている場合には、エレメント2の各設定は表示
されません。

・ユーティリティの「TG Setting」（→ P. 188）のOutputの設定がMonauralになってい
る場合は、パンの設定は効果がありません。

参　考

・レベル設定は、各エレメント間の音量バランスを調節するとともに、ボイス間のボリューム
の調整にも活用してください。（ボイスを切り換えた途端、音量が大きくなったり、小さく
なったりしないようにうまく調節してください）

-64 630

エレメントの左チャンネル�
の出力がここに定位�

エレメントの右チャンネル�
の出力がここに定位�

左スピーカー� 右スピーカー�

-64 630

エレメントの左右チャンネル�
の出力がここに定位�

左スピーカー� 右スピーカー�
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EDIT / COM / MISC / PORTAMENTO：ポルタメント

EDIT  → F1 （Com）→ F1 （Misc）→ 5: Portamento → ENTER

ポルタメントを設定します。

Portamento Mode Full Time, Fingered
Time MIDI Control off, on
Time 0 ～ 127
Element 1 off, on
Element 2 off, on

解　説

・ポルタメントは、直前に受信した音程から、新しく受信した音程まで、なめらかに
音程が変化する機能です。

・ポルタメントモード（Portamento Mode）で「Full Time」を選択すると、MIDI情報の
ポルタメントがオンのとき、直前に受信したノートオンからでも次のノートオンま
でポルタメントがかかります。「Fingered」を選択すると、MIDI情報のポルタメント
のオン／オフに関係なく直前に受信したノートオンのままで、次のノートオンを受
信したときにだけポルタメントがかかります。

・タイムMIDIコントロール（Time MIDI Control）では、外部のMIDI機器から送信され
るポルタメントタイム情報でポルタメントタイムをコントロールするかどうかを選
択します。「off」を選択した場合、次の「ポルタメントタイム」の設定が有効になり
ます。

・ポルタメントタイム（Time）では、音程変化の速さを設定します。数値が大きいほ
ど、ゆっくりとした音程変化となります。

・エレメント1、2（Element 1, 2）では、各エレメントのポルタメントのオン／オフを
選択します。「on」を選択したエレメントにだけポルタメントの効果がかかります。

注　意

・キーモードが「Poly」または「Unison」に設定されている場合には、ポルタメント
モードは「Full Time」となり、変更できません。

・ボイスモードが「Single」に設定されている場合には、エレメント2の設定は表示さ
れません。

・タイムMIDIコントロールが「on」になっている場合には、ポルタメントタイムの表
示は消えます。

参　考

・ポルタメントモードが「Full Time」のとき、コントロールチェンジ（065）で、ポルタメントを
オン／オフできます。

・ポルタメントモードが「Fingered」のとき、コントロールチェンジ（065）のオン／オフは無視
されます。
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EDIT / COM / MISC / MICRO TUNING：マイクロチューニング

EDIT  → F1 （Com）→ F1 （Misc）→ 6: Micro Tuning → ENTER

各エレメントごとにマイクロチューニングを設定します。

Element 1 off, I-1, I-2, P-1 ～ P-54
Element 2 off, I-1, I-2, P-1 ～ P-54

解　説

・各エレメントの調律を選択します。
・エレメント1、2（Element 1、2）では、使用する調律を次のいずれかから選択しま
す。「off」を選択した場合には、通常のシンセサイザーと同じ平均律が使用されま
す。

■off ：Equal Temperament　（平均律）
12のすべて等しい半音で構成されます。転調も完全に自由です。

■I-1、I-2 ：インターナルマイクロチューニング
音色ディスクのシステムデータで供給されるチューニングデータです。

■P-1 ～ P-12 ：PureMaj＝Pure Major　C ～ B　（純正律：長調）　および
■P-13 ～ P-24 ：PureMin＝Pure Minor　A ～ Aフラット　（純正律：短調）

金管楽器の音律で、自然倍音を基準とするため、合奏時の和音は濁りのないき
れいなものとなります。ただし、移調の際には、音律を変える必要がありま
す。

■P-25 ～ P-36 ：MeanTon＝Mean Tone　C ～ B　（ミーントーン）
ピタゴリアン音律の3度が不純である問題点を解決した音律です。

■P-37 ～ P-48 ：Pythago＝Pythagorean　C ～ B　（ピタゴリアン）
ギリシャ時代の音律で、ローマ人に継承され、グレゴリオ聖歌や吟遊詩人に伝
わった音律です。

■P-49 ：Werckmeist＝Werckmeister　（ヴェルクマイスター）　および
■P-50 ：Kirnberger＝Kirnberger　（キルンベルガー）　および
■P-51 ：Vallot&Yng＝Vallotti & Young　（バロッティ＆ヤング）

調性的音律と呼ばれており、移調の際に調律を変える必要がありません。しか
し、演奏する際の調号（シャープやフラット）が増えるにしたがい、和音はよ
り緊張感を持ち、旋律はより美しくなるという特長を持っています。つまり転
調によって曲想を大きく変えることができます。クラシックの名曲にはこれら
の音律を使ったものが多数を占めます。

■P-52 ：1/4 Shift＝1/4 Shifted Equal
全体に1/4音上げた平均律です。通常の平均律と混ぜて使用すると非常に緊張
感のある音となります。
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■P-53 ＝1/4 Tone
鍵盤上の半音が1/2半音となる調律です。

■P-54 ＝1/8 Tone
鍵盤上の半音が1/4半音となる調律です。

注　意

・マイクロチューニングによっては、ピッチの算出が不安定となり正しい音程が出な
いときがあります。

・P-1～P-51では、Aの音程を基準にしており、すべての音域のAが平均律のAと同じ
ピッチになります。

・P-53、P-54では、C3の音程を基準として、本機の左端のC2を中心にプログラムされ
ています。

・ボイスモードが「Single」に設定されている場合には、エレメント2の設定は表示さ
れません。

・インターナルマイクロチューニングを本機でエディットすることはできません。た
だし、SY99またはSY77などからマイクロチューニングのデータをMIDIバルクデー
タやパラメーターチェンジとして送り込むことで使用することは可能です。
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EDIT / COM / MISC / QUICK EDIT ASSIGN：クイックエディットアサイン

EDIT  → F1 （Com）→ 7: Quick Edit Assign → ENTER

クイックエディットの機能を設定します。

QED1（CC16） off, Com, E1, E2, Both
および任意の設定項目を選択

QED2（CC17） off, Com, E1, E2, Both
および任意の設定項目を選択

解　説

・クイックエディット1（QED1）とクイックエディット2（QED2）に、コモンエディッ
トまたはエレメントエディットの設定項目を割り当てます。

・プレイモード（あるいはエディットモードやユーティリティモード）で、コント
ロールナンバー＝016、017のコントロールチェンジデータを受信すると、ここで割
り当てた項目の設定をエディットすることができます。

・「Com」「E1」「E2」「Both」のいずれかを選択した後、反転表示を右側に移動して、
実際にコントロールする項目を選択します。

・「Com」はコモンエディットの中の設定項目、「E1」はエレメント1の設定項目、
「E2」はエレメント2の設定項目を示します。「Both」はエレメント1、2の同じ設定
項目を同時にコントロールするときに選択します。

・クイックエディットを使用しない場合には、「off」を選択します。

注　意

・ボイスをクイックエディットした場合、通常のエディットと同じようにストアを実
行しないと、その設定は保存されません。

参　考

・プレイモードでは、 F6 「Quick Edit View」の機能を使って、クイックエディットの状態
を確認することができます。（→ P. 49）
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コモンエディット － エフェクトの機能
コモンエディットのエフェクトでは、各エレメントの出力を最終的に加工するエフェクト（モジュレーション
エフェクト、フィードバックディレイ、リバーブレーション）の設定を行います。

・コモンエディットのエフェクトの機能

1: Setting （→ P. 67）
2: Modulation Effect （→ P. 69）
3: Feedback Delay （→ P. 76）
4: Reverberation （→ P. 84）

コモンエディット － エフェクトの機能

プレイモード�

エディットモード�

ユーティリティモード�

コモンエディット�

エレメントエディット� コントローラー�

ミスレイニアス�

モディファイア�

エンベロープ�

システム�

MIDIバルクダンプ�

ディスク�

エディットリコール�

デモ�

ミスレイニアス�

エフェクト�
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EDIT / COM / EFFECT / SETTING：セッティング

EDIT  → F1 （Com）→ F2 （Efct）→ 1: Setting → ENTER

フィードバックディレイとリバーブレーションの接続方法とエフェクトコントローラーを設定します。

Feedback Delay / Reverb. Mode
Serial, Parallel

Destination Effect off,
Flanger Freq,
Pitch Chg WetDry
Dist Presence
FBD Send Level
REV Send Level
ただし、各エフェクトがoffの場合に
は、「～ isn't used」と表示されます

Controller off,
Modulation Wheel ～ Velocity

解　説

・エフェクト全体の設定を行います。
・フィードバックディレイ、リバーブレーションモード（Feedback Delay / Reverb.
Mode）では、モジュレーションエフェクトから出力された音を、どのようにフィー
ドバックディレイ、リバーブレーションに送り込むかを設定します。次の図のよう
に「シリアル（Serial）」の場合には直列、「パラレル（Parallel）」の場合には並列に
接続します。

モジュレーション�
エフェクト�

シリアル（Serial）の場合�

フィードバック�
ディレイ� リバーブレーション�

R

L

R

L

モジュレーション�
エフェクト�

パラレル（Parallel）の場合�

エ
レ
メ
ン
ト
か
ら�

ア
ウ
ト
プ
ッ
ト
端
子
へ�

フィードバック�
ディレイ�

R

L

R

L

リバーブレーション�
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・デスティネーションエフェクト（Destination Effect）では、コントローラーでエフェ
クト効果のかかり具合をコントロールするエフェクトとその設定項目を選択しま
す。たとえばここで「FBD Send Level」を選択し、次のコントローラーで「Modulation
Wheel」を選択した場合には、外部MIDI機器のモジュレーションホイールを使っ
て、フィードバックディレイの効果の大きさ（ディレイ音の大きさ）をコントロー
ルすることができます。

・コントローラー（Controller）では、エフェクトの設定をコントロールするコント
ローラーソースを選択します。コントローラーソースを使わない場合は、「off」を
選択します。

コモンエディット － エフェクトの機能
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EDIT / COM / EFFECT / MODULATION EFFECT：モジュレーションエフェクト

EDIT  → F1 （Com）→ F2 （Efct）→ 2: Modulation Effect → ENTER

モジュレーションエフェクト（オフ、フランジャー、ピッチチェンジまたはディストーション）を選択します。

Modulation Effect Type off, Flanger, Pitch change,
Distortion

詳細の設定は、次ページ以降を参照

解　説

・モジュレーションエフェクトタイプ（Modulation Effect Type）では、モジュレーショ
ンエフェクトを、次の中から選択します。

オフ（off） モジュレーションエフェクトを使いません。
フランジャー（Flanger） 拡がりのあるうねりを作り出すエフェクトです。
ピッチチェンジ（Pitch Change）音程をずらした音を加えるエフェクトです。
ディストーション（Distortion） 音を歪ませるエフェクトです。

・「off」以外を選択すると、その下に各エフェクトの細かい設定項目が表示されま
す。これらの設定項目については、次ページ以降をご覧ください。
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コモンエディット － エフェクトの機能

EDIT / COM / EFFECT / MODULATION EFFECT（Flanger）：フランジャー

EDIT  → F1 （Com）→ F2 （Efct）→ 2: Modulation Effect → ENTER  → Modulation Effect Type=Flangerを選択

フランジャーを設定します。

Element on/off 1:    2: off, on
Wave Triangle, Sine, Random
Freq. 0.057 ～ 40.0 Hz

（Random選択時は0.229～160.0 Hz）
Depth 0 ～ 100 %
Delay 0.33 ～ 32.87 ms
Phase -180.0 ～ 180.0 deg
FB Gain -100 ～ 100 %
High 0.1 ～ 1.0
Analog Feel 0 ～ 10
Wet / Dry Balance 0 ～ 100 %

解　説

・モジュレーションエフェクトで、フランジャーを選択し、その細かい設定を行いま
す。

・設定する項目が多いため、画面は2ページに分かれています。次ページを表示させる
ときは F2 （▼）を、前ページに戻すときは F1 （▲）を押します。

・エレメントオン／オフ（Element on/off）は、各エレメントの出力をフランジャーに
通すか、通さないかの設定です。フランジャーに通す場合には、「on」を選択しま
す。

・ウェーブ（Wave）では、フランジャー効果（うねり）の形状を三角波（Triangle）、サ
イン波（Sine）、ランダムに変化する形（Random）の中から選択します。

・フリケンシー（Freq.）では、フランジャー効果のスピードを設定します。数値が大
きいほど速いゆれとなります。

・デプス（Depth）では、フランジャー効果のかかり具合を設定します。数値が大きい
ほど、深い効果がかかります。

・ディレイ（Delay）では、フランジャー効果の遅延時間を設定します。数値が大きい
ほど、遅延時間が大きくなり、強い効果となります。

・フェイズ（Phase）では、左右の変調波の位相差を設定します。絶対値を大きくする
ほど拡がりが増し、「0」にすると、モノラルになります。

・フィードバックゲイン（FB Gain）では、フィードバックの大きさを設定します。絶
対値が大きいほど、フランジャー特有の周波数のピークが強調されます。

・ハイ（High）では、フィードバックの音色を設定します。数値が小さいほど、高音の
ピークが弱くなります。
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・アナログフィール（Analog Feel）は、アナログフランジャー特有のゆれをシミュ
レーションする設定です。数値が大きいほど、強い効果が得られます。

・ウェットドライバランス（Wet / Dry Balance）では、フランジャーの効果のかかっ
ていない音と、フランジャーのかかった音とのバランスを調節します。数値が大き
いほど、フランジャーのかかった音が大きくなります。「0」を設定すると、フラン
ジャーの効果はなくなります。

参　考

・フランジャーはステレオイン、ステレオアウトで、次のように信号が流れます。

R R

L L

フランジャー�

フランジャー�

入力� 出力�
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EDIT / COM / EFFECT / MODULATION EFFECT（Pitch Change）：ピッチチェンジ

EDIT  → F1 （Com）→ F2 （Efct）→ 2: Modulation Effect → ENTER  → Modulation Effect Type=Pitch Changeを選択

ピッチチェンジを設定します。

Element on/off 1:    2: off, on
Mode Monaural, Stereo
1（L）Pitch -12 ～ 12
1（L）Fine -100 ～ 100
1（L）Output 0 ～ 100 %
Wet / Dry Balance 0 ～ 100 %
2（R）Pitch -12 ～ 12
2（R）Fine -100 ～ 100
2（R）Output 0 ～ 100 %

解　説

・モジュレーションエフェクトで、ピッチチェンジを選択し、その細かい設定を行い
ます。

・設定する項目が多いため、画面は2ページに分かれています。次ページを表示させる
ときは F2 （▼）を、前ページに戻すときは F1 （▲）を押します。

・エレメントオン／オフ（Element on/off）は、各エレメントの出力をピッチチェンジ
に通すか、通さないかの設定です。ピッチチェンジに通す場合には、「on」を選択し
ます。

・モード（Mode）では、元の音のL／Rのピッチをそれぞれ独立して変化させる
（Stereo）か、元の音をミックスしてピッチを変化させる（Monaural）かを選択しま
す。ピッチチェンジには、音程を変化させるための装置が2台入っています。モード
で「Monaural」を選択した場合には、それぞれをピッチチェンジ1、ピッチチェンジ
2として以降の設定を行います。「Stereo」を選択した場合には、それぞれをピッチ
チェンジL、ピッチチェンジRとして以降の設定を行います。

・1（L）ピッチ、2（R）ピッチ（1 Pitch, 2 Pitch または L Pitch, R Pitch）では、各ピッチ
チェンジの音程変化の幅を半音単位で設定します。プラスの数値で音程が上がり、
マイナスの数値で音程が下がります。

・1（L）ファイン、2（R）ファイン（1 Fine, 2 Fine または L Fine, R Fine）では、各ピッ
チチェンジの音程変化の幅をセント（1セントは半音の100分の1）単位で設定しま
す。プラスの数値で音程が上がり、マイナスの数値で音程が下がります。

・1（L）アウトプット、2（R）アウトプット（1 Output, 2 Output または L Output, R
Output）では、各ピッチチェンジの出力レベルを設定します。数値が大きいほど、レ
ベルが上がります。

コモンエディット － エフェクトの機能
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・ウェットドライバランス（Wet / Dry Balance）では、ピッチチェンジの効果のかかっ
ていない音と、ピッチチェンジのかかった音とのバランスを調節します。数値が大
きいほど、ピッチチェンジのかかった音が大きくなります。「0」を設定すると、
ピッチチェンジの効果はなくなります。

参　考

・ピッチチェンジは、次のように信号が流れます。

R R

L L

ピッチチェンジ 2

ピッチチェンジ 1

入力� 出力�

R R

L L

ピッチチェンジ L

ピッチチェンジ R

入力� 出力�

Mode = Monaural の場合�

Mode = Stereo の場合�
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EDIT / COM / EFFECT / MODULATION EFFECT（Distortion）：ディストーション

EDIT  → F1 （Com）→ F2 （Efct）→ 2: Modulation Effect → ENTER  → Modulation Effect Type=Distortionを選択

ディストーションを設定します。

Element on/off 1:    2: off, on
Overdrive 0 ～ 100 %
Device Transistor, Vintage Tube,

Distortion 1, Distortion 2, Fuzz
Output Level 0 ～ 100 %
Speaker Flat, Stack, Combo, Twin,

Radio, Megaphone
Presence -10 ～ 10

解　説

・モジュレーションエフェクトで、ディストーションを選択し、その細かい設定を行
います。

・設定する項目が多いため、画面は2ページに分かれています。次ページを表示させる
ときは F2 （▼）を、前ページに戻すときは F1 （▲）を押します。

・エレメントオン／オフ（Element on/off）は、各エレメントの出力をディストーショ
ンに通すか、通さないかの設定です。ディストーションに通す場合には、「on」を選
択します。

・オーバードライブ（Overdrive）では、歪みの大きさを設定します。数値が大きいほ
ど、歪みが大きくなります。

・デバイス（Device）では、どんな装置でディストーションをかけた音にするかを、ト
ランジスター、ビンテージチューブ、ディストーション1、ディストーション2、ファ
ズの中から選択します。

・アウトプットレベル（Output Level）では、ディストーションのかかった音の最終的
な出力レベルを設定します。数値が大きいほど、音が大きくなります。

・スピーカー（Speaker）では、どんなスピーカーで出した音に近付けるかを、フラッ
ト、スタック、コンボ、ツイン、ラジオ、メガホンの中から選択します。

・プレゼンス（Presence）では、音の鮮やかさを設定します。数値が大きいほど、高音
域のはっきりとした鮮やかな音になります。

コモンエディット － エフェクトの機能
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・ディストーションは、次のように信号が流れます。

コモンエディット － エフェクトの機能

R R

L L

ディストーション�入力� 出力�
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コモンエディット － エフェクトの機能

EDIT / COM / EFFECT / FEEDBACK DELAY：フィードバックディレイ

EDIT  → F1 （Com）→ F2 （Efct）→ 3: Feedback Delay → ENTER

フィードバックディレイを設定します。

Delay Type off, Mono,   L,R,   L,C,R
詳細の設定は、次ページ以降を参照

解　説

・ディレイタイプ（Delay Type）では、フィードバックディレイのタイプを、次の中か
ら選択します。

オフ（off） フィードバックディレイを使いません。
モノ（Mono） モノラルの1系統のディレイです。
L, R 左右の2系統のディレイです。
L, C, R 左右および中央の3系統のディレイです。

・「off」以外を選択すると、その下に各ディレイの細かい設定項目が表示されます。
これらの設定項目については、次ページ以降をご覧ください。

・各タイプのディレイを設定するときには、「～～Time」という遅延時間を設定する
項目が表示されます。この項目に反転表示があるときには、 F8 （Calc）の機能
を使うことができます。この機能は、曲のテンポと音符の長さから、その音符に等
しい遅延時間を計算するための機能です。この機能の操作方法については、次ペー
ジの手順をご覧ください。
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■曲のテンポからディレイタイムを計算させる方法

1． ディレイタイムの数値に反転表示を移動します。
▼画面最下行に「Calc」が表示されます。

2． F8 （Calc）を押します。
▼「TIME CALCULATION」というタイトルのウィンドウが表示されます。

3． ダイアルなどを使って、曲のテンポを設定します。
曲のテンポは4分音符が、1分間に何回数えられるかという数値で指定します。
▼テンポを設定すると、自動的にその下に計算されたディレイタイムが表示さ

れます。

4． F3 ～ F7 を使って、ディレイしたい音符を選択します。
▼選択した音符に見合った、ディレイタイムが表示されます。

5． ENTER を押します。
▼ウィンドウが消え、設定したディレイタイムが入力されます。

コモンエディット － エフェクトの機能
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コモンエディット － エフェクトの機能

EDIT / COM / EFFECT / FEEDBACK DELAY（Mono）：モノ

EDIT  → F1 （Com）→ F2 （Efct）→ 3: Feedback Delay → ENTER  → Delay Type=Monoを選択

モノラルタイプのフィードバックディレイを設定します。

Return 0 ～ 100 %
FB Delay Time 0 ～ 1024 ms
FB Gain 0 ～ 100 %
High 0.1 ～ 1.0
Delay Time 0 ～ 1024ms
Level 0 ～ 100 %

解　説

・フィードバックディレイで、タイプ「Mono」を選択し、その細かい設定を行いま
す。

・設定する項目が多いため、画面は2ページに分かれています。次ページを表示させる
ときは F2 （▼）を、前ページに戻すときは F1 （▲）を押します。

・リターン（Return）では、最終的にディレイした音をどれだけ元の音に重ねるかを設
定します。数値が大きいほど、ディレイ音が大きくなります。

・フィードバックディレイタイム（FB Delay Time）では、繰り返しの周期をミリ秒単
位で設定します。数値が大きいほど、繰り返し周期が長くなります。

・フィードバックゲイン（FB Gain）では、ディレイ音のフィードバックの繰り返しの
大きさを設定します。数値が大きいほど、ディレイの繰り返し回数が増えます。

・ハイ（High）では、ディレイの音色を設定します。数値が小さいほど、ディレイを繰
り返すにしたがって、だんだん高音がカットされていきます。

・ディレイタイム（Delay Time）では、1回目のディレイの遅延時間を、ミリ秒単位で
設定します。数値が大きいほど、遅延時間が長くなります。

・レベル（Level）では、ディレイ音の出力レベルを設定します。数値が大きいほど、
ディレイ音が大きくなります。

音量�

時間�

元の音�

ディレイタイム� フィードバック ディレイタイム�

レベル�
減衰のしかた：�

フィードバックゲイン�
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・「～～ Time」の項目に反転表示があるときには、曲のテンポ、音符から遅延時間を計算させ
ることができます。（→ P. 77）

・フィードバックディレイ（モノ）は、次のように信号が流れます。

コモンエディット － エフェクトの機能

R R

L L

フィードバックディレイ�入力� 出力�
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コモンエディット － エフェクトの機能

EDIT / COM / EFFECT / FEEDBACK DELAY（L, R）：L, R

EDIT  → F1 （Com）→ F2 （Efct）→ 3: Feedback Delay → ENTER  → Delay Type=L,Rを選択

L, Rタイプのフィードバックディレイを設定します。

Return 0 ～ 100 %
Lch Delay Time 0 ～ 512 ms
       Level 0 ～ 100 %
Lch FB Gain 0 ～ 100 %
       High 0.1 ～ 1.0
Rch Delay Time 0 ～ 512 ms
       Level 0 ～ 100 %
Rch FB Gain 0 ～ 100 %
       High 0.1 ～ 1.0

解　説

・フィードバックディレイで、タイプ「L, R」を選択し、その細かい設定を行います。
・設定する項目が多いため、画面は2ページに分かれています。次ページを表示させる
ときは F2 （▼）を、前ページに戻すときは F1 （▲）を押します。

・リターン（Return）では、最終的にディレイした音をどれだけ元の音に重ねるかを設
定します。数値が大きいほど、ディレイ音が大きくなります。

・Lチャンネルディレイタイム（Lch Delay Time）、Rチャンネルディレイタイム（Rch
Delay Time）では、左右それぞれのディレイの繰り返し周期を、ミリ秒単位で設定
します。数値が大きいほど、繰り返し周期が長くなります。

・Lチャンネルレベル、Rチャンネルレベル（Level）では、左右それぞれのディレイ音
の出力レベルを設定します。数値が大きいほど、ディレイ音が大きくなります。

・Lチャンネルフィードバックゲイン（Lch FB Gain）、Rチャンネルフィードバックゲ
イン（Rch FB Gain）では、左右それぞれのディレイ音のフィードバックの大きさを
設定します。数値が大きいほど、ディレイの繰り返し回数が増えます。

・Lチャンネルハイ、Rチャンネルハイ（High）では、左右それぞれのディレイの音色
を設定します。数値が小さいほど、ディレイを繰り返すにしたがって、だんだん高
音がカットされていきます。
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参　考

・「～～ Time」の項目に反転表示があるときには、曲のテンポ、音符から遅延時間を計算させ
ることができます。（→ P. 77）

・フィードバックディレイ（L, R）は、次のように信号が流れます。

コモンエディット － エフェクトの機能

R R

L L

フィードバックディレイ�

入力� 出力�

フィードバックディレイ�
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EDIT / COM / EFFECT / FEEDBACK DELAY（L, C, R）：L, C, R

EDIT  → F1 （Com）→ F2 （Efct）→ 3: Feedback Delay → ENTER  → Delay Type=L,C,Rを選択

L, C, Rタイプのフィードバックディレイを設定します。

Return 0 ～ 100 %
FB Delay Time 0 ～ 1024ms
FB Gain 0 ～ 100 %
High 0.1 ～ 1.0
Lch Delay Time 0 ～ 1024ms
Lch Level 0 ～ 100 %
Cch Delay Time 0 ～ 1024ms
Cch Level 0 ～ 100 %
Rch Delay Time 0 ～ 1024ms
Rch Level 0 ～ 100 %

解　説

・フィードバックディレイで、タイプ「L, C, R」を選択し、その細かい設定を行いま
す。

・設定する項目が多いため、画面は2ページに分かれています。次ページを表示させる
ときは F2 （▼）を、前ページに戻すときは F1 （▲）を押します。

・リターン（Return）では、最終的にディレイした音をどれだけ元の音に重ねるかを設
定します。数値が大きいほど、ディレイ音が大きくなります。

・フィードバックディレイタイム（FB Delay Time）では、ディレイ音の繰り返し周期
をミリ秒単位で設定します。数値が大きいほど、繰り返し周期が長くなります。

・フィードバックゲイン（FB Gain）では、ディレイ音のフィードバックの大きさを設
定します。数値が大きいほど、ディレイの繰り返し回数が増えます。

・ハイ（High）では、ディレイの音色を設定します。数値が小さいほど、ディレイを繰
り返すにしたがって、だんだん高音がカットされていきます。

・Lチャンネルディレイタイム（Lch Delay Time）、Cチャンネルディレイタイム（Cch
Delay Time）、Rチャンネルディレイタイム（Rch Delay Time）では、左、中央、右そ
れぞれのディレイの1回目の遅延時間をミリ秒単位で設定します。数値が大きいほ
ど、遅延時間が長くなります。

・Lチャンネルレベル（Lch Level）、Cチャンネルレベル（Cch Level）、Rチャンネルレ
ベル（Rch Level）では、左、中央、右それぞれのディレイ音の出力レベルを設定しま
す。数値が大きいほど、ディレイ音が大きくなります。

コモンエディット － エフェクトの機能
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参　考

・「～～ Time」の項目に反転表示があるときには、曲のテンポ、音符から遅延時間を計算させ
ることができます。（→ P. 77）

・フィードバックディレイ（L, C, R）は、次のように信号が流れます。

R R
R

C

L
L L

フィードバックディレイ�入力� 出力�
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コモンエディット － エフェクトの機能

EDIT / COM / EFFECT / REVERBERATION：リバーブレーション

EDIT  → F1 （Com）→ F2 （Efct）→ 4: Reverberation → ENTER

リバーブのタイプの選択や細かい設定を行います。

Reverb Type off, Hall1, Hall2, Room1,
Room2, Studio, Plate, Space,
Reverse

Return 0 ～ 100 %
Reverb Time 0.05 ～ 100.0 sec
Reverb Time Boost 0 ～ 10
High Control 0.1 ～ 1.0
Diffusion 0 ～ 10
Initial Delay 0 ～ 405 ms
Feel 0 ～ 3
Bass -21 ～ 12
Treble -21 ～ 12

解　説

・拡がりのある反響音を作り出すためのリバーブの設定を行います。
・設定する項目が多いため、画面は2ページに分かれています。次ページを表示させる
ときは F2 （▼）を、前ページに戻すときは F1 （▲）を押します。

・リバーブタイプ（Reverb Type）では、反響の種類を選択します。ホールやルーム、ス
タジオ、リバースなどの中から選択します。（次ページの「参考」を参照）

・リターン（Return）では、最終的にリバーブの音をどれだけ元の音に重ねるかを設定
します。数値が大きいほど、リバーブ音が大きくなります。

・リバーブタイム（Reverb Time）では、反響の長さを設定します。数値が大きいほ
ど、反響が長くなります。

・リバーブタイムブースト（Reverb Time Boost）では、余韻の長さを設定します。数
値が大きいほど、かすかな余韻の長さが増します。

・ハイコントロール（High Control）では、リバーブ音の音色を設定します。数値が小
さいほど、高音の減衰の大きいリバーブ音となります。

レベル�

時間�

リバーブ�

リバーブタイムブースト�
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・ディフュージョン（Diffusion）では、リバーブ音の左右への拡がりを設定します。数
値が大きいほど、拡がりが増します。（標準は「5」です）

・イニシャルディレイ（Initial Delay）では、初期反射音までの遅延時間（リバーブ音
が出はじめるまでの時間）を設定します。数値が大きいほど、初期反射音までの時
間が長くなります。

・フィール（Feel）では、選ばれたリバーブに対して、デンシティや響きの異なる4種
類のバリエーションを選択します。

・ベース（Bass）では、低音域の音色を設定します。数値が大きいほど、低音域が強調
されます。

・トレブル（Treble）では、高音域の音色を設定します。数値が大きいほど、高音域が
強調されます。

参　考

・リバーブレーションは、次のように信号が流れます。

・各リバーブタイプは、次のような特徴を持ちます。

Hall1

一般的なホールの残響です。フィールを上げるにしたがって、デンシティが上がり、
細かいテクスチュアが増え、また、空間感が広くなります。特にフィールが「3」のと
き開放感のある残響となります。

Hall2

低音域の響きが豊かなホールの残響です。フィールによる変化は「Hall1」と似ていま
す。

Room1

アンビエンス的な効果を持つ部屋の残響です。フィールが「0」「1」のとき部屋鳴りが
大きく、「2」「3」では小さくなっています。また、「0」「2」では、デンシティによる
響きが抑えめで、「1」「3」では多くなります。

Room2

中くらいの大きさの部屋の残響です。フィールが「0」「1」「2」では、値が増えるにつ
れてデンシティ感が増します。「3」は、「2」に比べて少し響きを抑えた感じです。

R R

L L

リバーブレーション�入力� 出力�
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Studio

低域の響きを抑えたレコーディングスタジオの残響です。フィールが大きくなるにし
たがって、デンシティによる響きが増します。「3」では特に響きが多くなっていま
す。

Plate

鉄板リバーブで得られる残響音です。良くヴォーカルに用いられます。フィール「1」
から「3」にかけて主に低域の響きが増加し、重い感じになります。「1」では、鉄板を
ダンプした感じになります。「0」は「1」に比べてやや粗いですが、より拡がった感じ
になります。

Space

非常に広い空間の残響を作り出します。Hall2に比べ、より密度の濃い残響です。
フィールが「0」から「2」に上がるにしたがって、中域の密度が増します。フィール
「3」は「2」よりも高域の伸びが良く、低域の響きを抑えた感じです。

Reverse

通常の残響効果の逆転したエンベロープを持つ特殊なリバーブタイプです。フィール
の「0」は中高域の響きが少なく、落ち着いた感じ、「1」はフラットな特性、「2」は中
高域の響きが増えていく特殊なリバース音、「3」はさらに極端になっています。

コモンエディット － エフェクトの機能



この章では、エディットモードの中のエレメントエディットの機能を説明
します。エレメントエディットでは、ボイスを構成する2つ（あるいは1
つ）のエレメントの音色をエディットしていきます。エレメントエディッ
トは、コントローラー、ミスレイニアス、モディファイア、エンベロープ
の4つに分かれています。
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エレメントエディットについて
エディットモードに入ると、最初にボイスの基本的な部分（ボイス名やキーモード、ボイスモード、エレメント
名）を設定するための画面（→ P. 52）が表示されます。

この画面で、 F2 （E1）または F3 （E2）を押すと、エレメントエディットのメニューが表示されます。

メニューには、コントローラー、ミスレイニアス（その他という意味）、エレメントエフェクト、エンベロープ
の4種類があります。この4種類のメニューを切り換えるには、 F1 （Ctrl） F2 （Misc） F3 （Modi）

F4 （Env）を使います。

参　考

・エディット中には、 F5 を押しながら を押すことで、一時的なエレメントの切り換
えやオン／オフを行いながら作業を進めていくことができます。（→ P. 32）

・エディット中に、コンペアの機能を使って、エディット前の音と、エディット後の音を聴き
比べることもできます。（→ P. 25）

エレメントエディットについて
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エレメントエディット － コントローラーの機能
エレメントエディットの F1 （Cont）：コントローラーでは、各機能をどのコントローラーに割り当てるかを
設定します。

・エレメントエディットのコントローラーの機能

1: Pressr （Pressure） （→ P. 92）
2: Embchr （Embouchure） （→ P. 93）
3: Pitch （Pitch） （→ P. 95）
4: Vibrato （Vibrato） （→ P. 97）
5: Tnguing （Tonguing） （→ P. 98）
6: Ampltd （Amplitude） （→ P. 99）
7: Scream （Scream） （→ P. 100）
8: B.Noise （Breath noise） （→ P. 101）
9: Growl （Growl） （→ P. 102）
10: Throat （Throat formant） （→ P. 104）
11: D.Filtr （Dynamic filter） （→ P. 106）
12: H.Enhnc （Harmonic Enhancer） （→ P. 107）
13: Damping（Damping） （→ P. 109）
14: Absrptn （Absorption） （→ P. 110）

参　考

・コントローラーのメニュー画面から、 F8 （S&R）を使って、どのコントローラーソースに、どの
コントローラーデスティネーションが割り当てられているか参照することができます。（次ページ）

プレイモード�

エディットモード�

ユーティリティモード�

コモンエディット�

エレメントエディット�

ミスレイニアス�

モディファイア�

エンベロープ�

システム�

MIDIバルクダンプ�

ディスク�

エディットリコール�

デモ�

ミスレイニアス�

エフェクト�

コントローラー�
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EDIT / E1 or E2 / CTRL / SEARCH & REPLACE：サーチ＆リプレース

EDIT  → F2 （E1）または F3 （E2）→ F1 （Ctrl）→ F8 （S&R）

コントローラーの設定状況を確認したり、変更したりします。

Ctrl. Source off,
Modulation Wheel ～ Touch EG

解　説

・現在、どのコントローラー（コントローラーソース）にどんな機能（コントローラー
デスティネーション）が割り当てられているかを一覧で表示します。

・この画面が表示されている状態で、 F6 （Prev）、 F7 （Next）を押すと、コン
トローラー順に、現在割り当てられている機能が表示され、確認することができま
す。（使われていないコントローラーはとばされます）

・現在、あるコントローラーに割り当てられている機能を、別のコントローラーに割
り当て直すこともできます。たとえば、現在フットコントローラーに割り当てられ
ている機能をまとめてモジュレーションホイールに割り当てることができます。こ
のとき、元々モジュレーションホイールに割り当てられていた機能もそのまま残り
ます。この操作については、次ページの手順をご覧ください。

参　考

・ F8 （S&R）を押す前の画面（コントローラーのメニュー画面）で、任意の機能にカーソ
ルを移動してから、 F8 （S&R）を押すと、その機能が割り当てられているコントロー
ラーの画面が自動的に表示されます。

エレメントエディット － コントローラーの機能
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手　順

1. F8 （S&R）を押します。
▼コントローラーソースに割り当てられている、コントローラーデスティネー

ションが表示されます。

2. F6 （Prev）、 F7 （Next）を使って、コントローラーを切り換えます。
▼切り換えたコントローラーソースに割り当てられているコントローラーデ

スティネーションが表示されます。

ここで選択したコントローラーに割り当てられている機能を、別のコントロー
ラーに割り当てます。

3. ダイアルや INC または DEC を使って、新しいコントローラーを選択しま
す。
▼コントローラーソースの表示が点滅し、元々そのコントローラーに割り当て

られている機能は通常の表示で、新しく追加する機能は反転表示で示されま
す。

4. ENTER を押します。
▼コントローラーソースの点滅が止まり、機能の割り当てが実行されます。

5. EXIT を押します。
▼サーチ＆リプレースのウィンドウが閉じます。
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エレメントエディット － コントローラーの機能

EDIT / E1 or E2 / CTRL / PRESSURE：プレッシャー

EDIT  → F2 （E1）または F3 （E2）→ F1 （Ctrl）→ 01: Pressr → ENTER

プレッシャーをコントロールするコントローラーを設定します。

Controller off,
Modulation Wheel ～ Touch EG

Depth -127 ～ 127
Curve -16 ～ 16

解　説

・プレッシャー（管楽器に息を吹き込む強さ、または擦弦楽器の弦をこする速さ）を
コントロールするためのコントローラーを選択し、その特性を設定します。（→ 別
冊のベーシックガイド：P. 66）

・プレッシャーは、音量だけではなく、音色や音程にも影響を与えます。
・本機のボイスでは、最大のプレッシャーのときに鍵盤の正しい音程を出すように
セッティングされています。

・コントローラー（Controller）では、プレッシャーを割り当てるコントローラー（コ
ントロールソース）を選択します。「off」を選択すると、プレッシャーはコントロー
ラーでコントロールできなくなります。（常に最大のプレッシャーとなります）

・デプス（Depth）では、プレッシャーの変化の大きさを設定します。プラスの数値を
設定すると、コントローラーを上げる（たとえばモジュレーションホイールを奥に
回す、フットコントローラーを踏み込む）ほどプレッシャーが大きくなります。マ
イナスの数値を設定すると、コントローラーを上げるほどプレッシャーが小さくな
ります。

・カーブ（Curve）では、コントローラーを動かしたとき、どのようにプレッシャーが
変化するかを設定します。デプスがプラスの数値の場合、カーブにプラスの数値を
設定すると、コントローラーの後半での変化が大きくなり、マイナスの数値を設定
すると、コントローラーの前半での変化が大きくなります。また、デプスがマイナ
スの数値の場合は逆になります。

・画面にはデプスとカーブの設定によるグラフが表示されます。（横軸がコントロー
ラーの変化量、縦軸がプレッシャーの変化量です）

参　考

・実際に音源へ伝えられるプレッシャーの値は、ここで選択したコントローラー（「off」も含
む）から出力される値に、エンベロープのプレッシャー（→ P. 161）の値を合成したものとな
ります。

・ F7 （FPag: Forward Page）を押すと、アンブシュアの設定画面に移ります。
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EDIT / E1 or E2 / CTRL / EMBOUCHURE：アンブシュア

EDIT  → F2 （E1）または F3 （E2）→ F1 （Ctrl）→ 02: Embchr → ENTER

アンブシュアをコントロールするコントローラーを設定します。

Controller off,
 Modulation Wheel ～ Touch EG

Upper Depth -127 ～ 127
Lower Depth -127 ～ 127
Mode Center Base, Minimum Base

解　説

・アンブシュア（管楽器のリードを締め付ける強さや口の構え、または擦弦楽器の弓
で弦を押さえる強さ）をコントロールするためのコントローラーを選択し、その特
性を設定します。（→ 別冊のベーシックガイド：P. 66）

・アンブシュアは、音色を中心に影響を与えますが、楽器によっては音量や音程にも
影響を与えます。

・本機のボイスでは、中央のアンブシュアのとき、鍵盤の正しい音程（あるいは標準
的な音）を出すようにセッティングされています。

・コントローラー（Controller）では、アンブシュアを割り当てるコントローラー（コ
ントロールソース）を選択します。「off」を選択すると、アンブシュアはコントロー
ラーでコントロールできなくなります。（常に中央のアンブシュアとなります）

・アッパーデプス（Upper Depth）では、コントローラーを最大に上げた状態（たとえ
ばモジュレーションホイールを一番奥に回した状態）でのアンブシュアの変化幅を
設定します。プラスの数値を設定すると、コントローラーを上げるほどアンブシュ
アが強くなります。マイナスの数値を設定すると、コントローラーを上げるほどア
ンブシュアが弱くなります。また、この設定を変化させると、次のロワーデプスの
数値も自動的に変更されます。（プラスマイナスが逆転した数値です）

・ロワーデプス（Lower Depth）では、コントローラーを最大に下げた状態でのアンブ
シュアの変化幅を設定します。プラスの数値を設定すると、コントローラーを下げ
るほどアンブシュアが強くなります。マイナスの数値を設定すると、コントロー
ラーを下げるほどアンブシュアが弱くなります。

・モード（Mode）では、アンブシュアの標準値（標準的な音の出る強さ）をコント
ローラーのどの位置に設定するかを選択します。「Center Base」を選択した場合に
は、コントローラーを中央にしたとき標準値となり、コントローラーを上下するこ
とで、標準値から強弱両方向のコントロールをすることができます。「Minimum
Base」を選択した場合には、コントローラーを一番下げたときに標準値となりま
す。この場合には、ロワーデプスは表示されません。
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参　考

・センタークリックがあり、上下両方向にコントロールできるコントローラーの場合には、
モードで「Center Base」を選択します。また、アフタータッチやブレスコントローラーなどの
ように中央の状態を得るのが困難なコントローラーの場合には、「Minimum Base」を選択し
ます。

・実際に音源へ伝えられるアンブシュアの値は、ここで選択したコントローラー（「off」も含
む）から出力される値に、エンベロープのアンブシュア＆ピッチ（→ P. 163）の値を合成した
ものとなります。

・アンブシュアは、サックスなどのシャクリ（グライドやベンディングとも呼ぶ）を演出する
ときにも有効に活用することができます。

・ F6 （BPag: Backward Page）を押すと、プレッシャーの設定画面に移ります。
・ F7 （FPag: Forward Page）を押すと、ピッチの設定画面に移ります。

エレメントエディット － コントローラーの機能
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エレメントエディット － コントローラーの機能

EDIT / E1 or E2 / CTRL / PITCH：ピッチ

EDIT  → F2 （E1）または F3 （E2）→ F1 （Ctrl）→ 03: Pitch → ENTER

ピッチをコントロールするコントローラーを設定します。

Controller off,
Modulation Wheel ～ Touch EG

Upper Depth -12 ～ 12
Lower Depth -12 ～ 12
Mode Center Base, Minimum Base

解　説

・ピッチ（音程：管または弦の長さ）をコントロールするためのコントローラーを選
択し、その特性を設定します。（→ 別冊のベーシックガイド：P. 69）

・ピッチは、純粋に音程だけに影響を与えます。

・コントローラー（Controller）では、ピッチを割り当てるコントローラー（コント
ロールソース）を選択します。「off」を選択すると、ピッチはコントローラーでコン
トロールできなくなります。（常に鍵盤通りのピッチとなります）

・アッパーデプス（Upper Depth）では、コントローラーを最大に上げた状態（たとえ
ばピッチベンドホイールを一番奥に回した状態）でのピッチの変化幅を、半音単位
で設定します。プラスの数値を設定すると、コントローラーを上げるほど高い音に
なります。マイナスの数値を設定すると、コントローラーを上げるほど低い音にな
ります。また、この設定を変化させると、次のロワーデプスの数値も自動的に変更
されます。（プラスマイナスが逆転した数値です）

・ロワーデプス（Lower Depth）では、コントローラーを最大に下げた状態でのピッチ
の変化幅を設定します。プラスの数値を設定すると、コントローラーを下げるほど
高い音になります。マイナスの数値を設定すると、コントローラーを下げるほど低
い音になります。

・モード（Mode）では、ピッチの標準値（鍵盤と同じ音程）をコントローラーのどの
位置に設定するかを選択します。「Center Base」を選択した場合には、コントロー
ラーを中央にしたとき標準値となり、コントローラーを上下することで、標準値か
ら高低両方向のピッチコントロールをすることができます。「Minimum Base」を選
択した場合には、コントローラーを一番下げたときに標準値となります。この場合
には、ロワーデプスは表示されません。
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参　考

・センタークリックがあり、上下両方向にコントロールできるコントローラーの場合には、
モードで「Center Base」を選択します。また、アフタータッチやブレスコントローラーなどの
ように中央の状態を得るのが困難なコントローラーの場合には、「Minimum Base」を選択し
ます。

・実際に音源へ伝えられるピッチの値は、ここで選択したコントローラー（「off」も含む）から
出力される値に、エンベロープのアンブシュア＆ピッチ（→ P. 163）の値を合成したものと
なります。

・普通のシンセサイザーのような単調なピッチベンドを使いたいときは、このピッチだけをコ
ントローラー（ピッチベンドホイールなど）に割り当てます。音色変化を伴う自然楽器らし
いピッチベンドを使いたいときは、ピッチに加えてアンブシュアも同じコントローラーに割
り当てます。

・ F6 （BPag: Backward Page）を押すと、アンブシュアの設定画面に移ります。
・ F7 （FPag: Forward Page）を押すと、ビブラートの設定画面に移ります。

エレメントエディット － コントローラーの機能
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第
４
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エレメントエディット － コントローラーの機能

EDIT / E1 or E2 / CTRL / VIBRATO：ビブラート

EDIT  → F2 （E1）または F3 （E2）→ F1 （Ctrl）→ 04: Vibrato → ENTER

ビブラートをコントロールするコントローラーを設定します。

Controller off,
Modulation Wheel ～ Touch EG

Depth -127 ～ 127

解　説

・ビブラート（音程および音色の周期的変化：ピッチとアンブシュアの周期的変化で
表現）をコントロールするためのコントローラーを選択し、その特性を設定しま
す。（→ 別冊のベーシックガイド：P. 66, 69）

・コントローラー（Controller）では、ビブラートを割り当てるコントローラー（コン
トロールソース）を選択します。「off」を選択すると、ビブラートはコントローラー
でコントロールできなくなります。

・デプス（Depth）では、ビブラートの変化の大きさを設定します。プラスの数値を設
定すると、コントローラーを上げる（たとえばモジュレーションホイールを奥に回
す、フットコントローラーを踏み込む）ほどビブラートが大きくなります。マイナ
スの数値を設定すると、コントローラーを下げるほどビブラートが大きくなりま
す。

・ F8 （Para）を押すと、ゆれのスピードや効果のかかり方など、ビブラートの細
かい設定を行うための画面（エンベロープのビブラート（→ P. 168））に移動するこ
とができます。

注　意

・エンベロープのビブラートの設定で、ビブラートデプスが「0」になっている場合
や、デプストゥーアンブシュアとデプストゥーピッチがともに「0」になっている場
合には、コントローラーでビブラートのコントロールはできません。

参　考

・ F6 （BPag: Backward Page）を押すと、ピッチの設定画面に移ります。
・ F7 （FPag: Forward Page）を押すと、タンギングの設定画面に移ります。



98　　第4章　エディットモード － エレメントエディット

エレメントエディット － コントローラーの機能

EDIT / E1 or E2 / CTRL / TONGUING：タンギング

EDIT  → F2 （E1）または F3 （E2）→ F1 （Ctrl）→ 05: Tnguing → ENTER

タンギングをコントロールするコントローラーを設定します。

Controller off,
Modulation Wheel ～ Touch EG

Depth -127 ～ 127
Curve -16 ～ 16

解　説

・タンギング（管楽器でいうハーフタンギング奏法をシミュレートしたブライトネス
に近い変化：リードの動きを規制することで表現）をコントロールするためのコン
トローラーを選択し、その特性を設定します。（→ 別冊のベーシックガイド：P. 67）

・本機では、タンギングが割り当てられているコントローラーを最大にしたとき、標
準的な音色（タンギングされない音）を出すようになっています。（デプスがプラス
の数値の場合）

・コントローラー（Controller）では、タンギングを割り当てるコントローラー（コン
トロールソース）を選択します。「off」を選択すると、タンギングはコントローラー
でコントロールできなくなります。（常にタンギングされない状態となります）

・デプス（Depth）では、タンギングの変化の大きさを設定します。プラスの数値を設
定すると、コントローラーを下げる（たとえばモジュレーションホイールを手前に
戻す、フットコントローラーを戻す）ほどタンギングによって音が出にくくなりま
す。マイナスの数値を設定すると、コントローラーを上げるほどタンギングによる
リードの抑制がなくなり、自然な形で音が鳴ります。

・カーブ（Curve）では、コントローラーを動かしたとき、どのようにタンギングが変
化するかを設定します。デプスがプラスの数値の場合、カーブにプラスの数値を設
定すると、コントローラーの後半での変化が大きくなり、マイナスの数値を設定す
ると、コントローラーの前半での変化が大きくなります。また、デプスがマイナス
の数値の場合は逆になります。

・画面にはデプスとカーブの設定によるグラフが表示されます。（横軸がコントロー
ラーの変化量、縦軸がタンギングの変化量です）

参　考

・タンギングは、特にサックスなどのボイスで効果的です。
・ F6 （BPag: Backward Page）を押すと、ビブラートの設定画面に移ります。
・ F7 （FPag: Forward Page）を押すと、アンプリチュードの設定画面に移ります。
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エレメントエディット － コントローラーの機能

EDIT / E1 or E2 / CTRL / AMPLITUDE：アンプリチュード

EDIT  → F2 （E1）または F3 （E2）→ F1 （Ctrl）→ 06: Ampltd → ENTER

アンプリチュードをコントロールするコントローラーを設定します。

Controller off,
Modulation Wheel ～ Touch EG

Depth -127 ～ 127
Curve -16 ～ 16

解　説

・アンプリチュード（プレッシャーなどとは異なり、音色、音程変化を伴わない音量
変化）をコントロールするためのコントローラーを選択し、その特性を設定しま
す。

・コントローラー（Controller）では、アンプリチュードを割り当てるコントローラー
（コントロールソース）を選択します。「off」を選択すると、アンプリチュードはコ
ントローラーでコントロールできなくなります。

・デプス（Depth）では、アンプリチュードの変化の大きさを設定します。プラスの数
値を設定すると、コントローラーを上げる（たとえばモジュレーションホイールを
奥に回す、フットコントローラーを踏み込む）ほどアンプリチュードが大きくなり
ます。マイナスの数値を設定すると、コントローラーを下げるほどアンプリチュー
ドが大きくなります。

・カーブ（Curve）では、コントローラーを動かしたとき、どのようにアンプリチュー
ドが変化するかを設定します。デプスがプラスの数値の場合、カーブにプラスの数
値を設定すると、コントローラーの後半での変化が大きくなり、マイナスの数値を
設定すると、コントローラーの前半での変化が大きくなります。また、デプスがマ
イナスの数値の場合は逆になります。

・画面にはデプスとカーブの設定によるグラフが表示されます。（横軸がコントロー
ラーの変化量、縦軸がアンプリチュードの変化量です）

参　考

・実際にアンプリチュードで音量を変化させる地点は、モディファイアのダイナミックフィル
ターとイコライザーの間です。したがって、その後ろに位置するモディファイアのインパル
スエキスパンダーやレゾネーターの効果は、そのまま活かされます。これに対して、MIDIの
ボリュームコントロール（コントロールチェンジナンバー＝007）は、最終の出力をコント
ロールするため、インパルスエキスパンダーやレゾネーターの余韻まで含めて、音量が変
わってしまいます。

・また、エフェクトは、このモディファイアのさらに後ろにありますので、ディストーション
のドライブ（歪み方）を、このアンプリチュードのコントロールで動的に変化させることも
可能です。

・ F6 （BPag: Backward Page）を押すと、タンギングの設定画面に移ります。
・ F7 （FPag: Forward Page）を押すと、スクリームの設定画面に移ります。
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エレメントエディット － コントローラーの機能

EDIT / E1 or E2 / CTRL / SCREAM：スクリーム

EDIT  → F2 （E1）または F3 （E2）→ F1 （Ctrl）→ 07: Scream → ENTER

スクリームをコントロールするコントローラーを設定します。

Controller off,
Modulation Wheel ～ Touch EG

Depth -127 ～ 127
Curve -16 ～ 16
Value 0 ～ 127

解　説

・スクリーム（叫び声のように荒っぽく乱れた音色変化：ドライバーの働きを極端に
強調することで表現）をコントロールするためのコントローラーを選択し、その特
性を設定します。（→ 別冊のベーシックガイド：P. 67）

・ただし、減衰系のボイスでは、倍音の豊富な音に変化します。（叫び声のようになる
前に減衰してしまうため）

・コントローラー（Controller）では、スクリームを割り当てるコントローラー（コン
トロールソース）を選択します。「off」を選択すると、スクリームはコントローラー
でコントロールできなくなります。

・デプス（Depth）では、スクリームの変化の大きさを設定します。プラスの数値を設
定すると、コントローラーを上げる（たとえばモジュレーションホイールを奥に回
す、フットコントローラーを踏み込む）ほどスクリームが大きくなります。マイナ
スの数値を設定すると、コントローラーを下げるほどスクリームが大きくなりま
す。

・カーブ（Curve）では、コントローラーを動かしたとき、どのようにスクリームが変
化するかを設定します。デプスがプラスの数値の場合、カーブにプラスの数値を設
定すると、コントローラーの後半での変化が大きくなり、マイナスの数値を設定す
ると、コントローラーの前半での変化が大きくなります。また、デプスがマイナス
の数値の場合は逆になります。

・バリュー（Value）では、コントローラーで「off」を選択した場合のスクリームの大
きさを調節します。したがって、常にここで設定したスクリームがかかることにな
ります。数値が大きいほど、スクリームが大きくなります。

・画面にはデプスとカーブの設定によるグラフが表示されます。（横軸がコントロー
ラーの変化量、縦軸がスクリームの変化量です）

参　考

・ F6 （BPag: Backward Page）を押すと、アンプリチュードの設定画面に移ります。
・ F7 （FPag: Forward Page）を押すと、ブレスノイズの設定画面に移ります。
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エレメントエディット － コントローラーの機能

EDIT / E1 or E2 / CTRL / BREATH NOISE：ブレスノイズ

EDIT  → F2 （E1）または F3 （E2）→ F1 （Ctrl）→ 08: B.Noise → ENTER

ブレスノイズをコントロールするコントローラーを設定します。

Controller off,
 Modulation Wheel ～ Touch EG

Depth -127 ～ 127
Curve -16 ～ 16
Value 0 ～ 127

解　説

・ブレスノイズ（息もれの音）をコントロールするためのコントローラーを選択し、
その特性を設定します。（→ 別冊のベーシックガイド：P. 67）

・コントローラー（Controller）では、ブレスノイズを割り当てるコントローラー（コ
ントロールソース）を選択します。「off」を選択すると、ブレスノイズはコントロー
ラーでコントロールできなくなります。

・カーブ（Curve）では、コントローラーを動かしたとき、どのようにブレスノイズが
変化するかを設定します。デプスがプラスの数値の場合、カーブにプラスの数値を
設定すると、コントローラーの後半での変化が大きくなり、マイナスの数値を設定
すると、コントローラーの前半での変化が大きくなります。また、デプスがマイナ
スの数値の場合は逆になります。

・デプス（Depth）では、ブレスノイズの変化の大きさを設定します。プラスの数値を
設定すると、コントローラーを上げる（たとえばモジュレーションホイールを奥に
回す、フットコントローラーを踏み込む）ほどブレスノイズが大きくなります。マ
イナスの数値を設定すると、コントローラーを下げるほどブレスノイズが大きくな
ります。

・バリュー（Value）では、コントローラーで「off」を選択した場合のブレスノイズの
大きさを調節します。したがって、常にここで設定したブレスノイズがかかること
になります。数値が大きいほど、ブレスノイズが大きくなります。

・画面にはデプスとカーブの設定によるグラフが表示されます。（横軸がコントロー
ラーの変化量、縦軸がブレスノイズの変化量です）

・ F8 （Para）を押すと、ブレスノイズの細かい設定を行うための画面（ミスレイ
ニアス のブレスノイズ（→ P. 113））に移動することができます。

注　意

・ミスレイニアス のブレスノイズの設定で、レベルが「0」になっている場合、および
コントロールバランスが「63」（最大に「Slit」側）になっている場合には、コント
ローラーでブレスノイズのコントロールはできません。

参　考

・ F6 （BPag: Backward Page）を押すと、スクリームの設定画面に移ります。
・ F7 （FPag: Forward Page）を押すと、グロウルの設定画面に移ります。
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エレメントエディット － コントローラーの機能

EDIT / E1 or E2 / CTRL / GROWL：グロウル

EDIT  → F2 （E1）または F3 （E2）→ F1 （Ctrl）→ 09: Growl → ENTER

グロウルをコントロールするコントローラーを設定します。

Controller off,
Modulation Wheel ～ Touch EG

Depth -127 ～ 127
Curve -16 ～ 16
Value 0 ～ 127

解　説

・グロウル（音量、音色の周期的なゆれ：プレッシャーとブレスノイズを周期的変化
させることで表現）をコントロールするためのコントローラーを選択し、その特性
を設定します。（→ 別冊のベーシックガイド：P. 67）

・コントローラー（Controller）では、グロウルを割り当てるコントローラー（コント
ロールソース）を選択します。「off」を選択すると、グロウルはコントローラーでコ
ントロールできなくなります。

・デプス（Depth）では、グロウルの変化の大きさを設定します。プラスの数値を設定
すると、コントローラーを上げる（たとえばモジュレーションホイールを奥に回
す、フットコントローラーを踏み込む）ほどグロウルが大きくなります。マイナス
の数値を設定すると、コントローラーを下げるほどグロウルが大きくなります。

・カーブ（Curve）では、コントローラーを動かしたとき、どのようにグロウルが変化
するかを設定します。デプスがプラスの数値の場合、カーブにプラスの数値を設定
すると、コントローラーの後半での変化が大きくなり、マイナスの数値を設定する
と、コントローラーの前半での変化が大きくなります。また、デプスがマイナスの
数値の場合は逆になります。

・バリュー（Value）では、コントローラーで「off」を選択した場合のグロウルの大き
さを調節します。したがって、常にここで設定したグロウルがかかることになりま
す。数値が大きいほど、グロウルが大きくなります。

・画面にはデプスとカーブの設定によるグラフが表示されます。（横軸がコントロー
ラーの変化量、縦軸がグロウルの変化量です）

・ F8 （Para）を押すと、グロウルの細かい設定を行うための画面（エンベロープ
のグロウル（→ P. 174））に移動することができます。
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注　意

・エンベロープのグロウルの設定で、デプストゥープレッシャーとデプストゥーブレ
スノイズがともに「0」になっている場合には、コントローラーでグロウルのコント
ロールはできません。

・ミスレイニアス のブレスノイズの設定（→ P. 113）で、レベルが「0」またはコント
ロールバランスが「63」になっている場合、ブレスノイズにグロウル効果はかかり
ません。

参　考

・ F6 （BPag: Backward Page）を押すと、ブレスノイズの設定画面に移ります。
・ F7 （FPag: Forward Page）を押すと、スロートフォルマントの設定画面に移ります。
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エレメントエディット － コントローラーの機能

EDIT / E1 or E2 / CTRL / THROAT FORMANT：スロートフォルマント

EDIT  → F2 （E1）または F3 （E2）→ F1 （Ctrl）→ 10: Throat → ENTER

スロートフォルマントをコントロールするコントローラーを設定します。

Controller off,
Modulation Wheel ～ Touch EG

Depth -127 ～ 127
Curve -16 ～ 16
Value 0 ～ 127

解　説

・スロートフォルマント（喉の状態による音程、音色変化）をコントロールするため
のコントローラーを選択し、その特性を設定します。（→ 別冊のベーシックガイ
ド：P. 67）

・コントローラー（Controller）では、スロートフォルマントを割り当てるコントロー
ラー（コントロールソース）を選択します。「off」を選択すると、スロートフォルマ
ントはコントローラーでコントロールできなくなります。

・カーブ（Curve）では、コントローラーを動かしたとき、どのようにスロートフォル
マントが変化するかを設定します。デプスがプラスの数値の場合、カーブにプラス
の数値を設定すると、コントローラーの後半での変化が大きくなり、マイナスの数
値を設定すると、コントローラーの前半での変化が大きくなります。また、デプス
がマイナスの数値の場合は逆になります。

・デプス（Depth）では、スロートフォルマントの変化の大きさを設定します。プラス
の数値を設定すると、コントローラーを上げる（たとえばモジュレーションホイー
ルを奥に回す、フットコントローラーを踏み込む）ほどスロートフォルマントが大
きくなります。マイナスの数値を設定すると、コントローラーを下げるほどスロー
トフォルマントが大きくなります。

・バリュー（Value）では、コントローラーで「off」を選択した場合のスロートフォル
マントの大きさを調節します。したがって、常にここで設定したスロートフォルマ
ントがかかることになります。数値が大きいほど、スロートフォルマントが大きく
なります。

・画面にはデプスとカーブの設定によるグラフが表示されます。（横軸がコントロー
ラーの変化量、縦軸がスロートフォルマントの変化量です）

・ F8 （Para）を押すと、スロートフォルマントの細かい設定を行うための画面
（ミスレイニアスのスロートフォルマント（→ P. 118））に移動することができま
す。
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注　意

・ミスレイニアスのスロートフォルマントの設定で、アマウントやインテンスが「0」
になっている場合には、コントローラーでスロートフォルマントをコントロールす
ることはできません。

参　考

・ F6 （BPag: Backward Page）を押すと、グロウルの設定画面に移ります。
・ F7 （FPag: Forward Page）を押すと、ダイナミックフィルターの設定画面に移ります。

エレメントエディット － コントローラーの機能
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エレメントエディット － コントローラーの機能

EDIT / E1 or E2 / CTRL / DYNAMIC FILTER：ダイナミックフィルター

EDIT  → F2 （E1）または F3 （E2）→ F1 （Ctrl）→ 11: D.Filtr → ENTER

ダイナミックフィルターをコントロールするコントローラーを設定します。

Controller off,
Modulation Wheel ～ Touch EG

Depth -127 ～ 127
Curve -16 ～ 16

解　説

・ダイナミックフィルターのカットオフフリケンシーをコントロールするためのコン
トローラーを選択し、その特性を設定します。（→ 別冊のベーシックガイド：P. 74）

・コントローラー（Controller）では、ダイナミックフィルターのフリケンシーを割り
当てるコントローラー（コントロールソース）を選択します。「off」を選択すると、
ダイナミックフィルターはコントローラーでコントロールできなくなります。

・デプス（Depth）では、ダイナミックフィルターのカットオフフリケンシーの変化幅
を設定します。プラスの数値を設定すると、コントローラーを上げる（たとえばモ
ジュレーションホイールを奥に回す、フットコントローラーを踏み込む）ほどカッ
トオフフリケンシーが上がります。マイナスの数値を設定すると、コントローラー
を上げるほどカットオフフリケンシーが下がります。また、最大、最小の127、-127
のとき、8オクターブの変化幅となります。

・カーブ（Curve）では、コントローラーを動かしたとき、どのようにカットオフフリ
ケンシーが変化するかを設定します。デプスがプラスの数値の場合、カーブにプラ
スの数値を設定すると、コントローラーの後半での変化が大きくなり、マイナスの
数値を設定すると、コントローラーの前半での変化が大きくなります。また、デプ
スがマイナスの数値の場合は逆になります。

・ F8 （Para）を押すと、ダイナミックフィルターの細かい設定を行うための画面
（モディファイアのダイナミックフィルター（→ P. 147））に移動することができま
す。

注　意

・モディファイアのダイナミックフィルターの設定で、バランスが「-64」（Dryのみ）
になっている場合には、コントローラーでダイナミックフィルターをコントロール
することはできません。

参　考

・ F6 （BPag: Backward Page）を押すと、スロートフォルマントの設定画面に移ります。
・ F7 （FPag: Forward Page）を押すと、ハーモニックエンハンサーの設定画面に移ります。
・実際のカットオフフリケンシーは、ここで設定したコントローラーによって出力される値
と、モディファイアのダイナミックフィルターのカットオフフリケンシーの値と、アンプリ
チュード＆フィルターのEGの出力の合成されたものとなります。
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EDIT / E1 or E2 / CTRL / HARMONIC ENHANCER：ハーモニックエンハンサー

EDIT  → F2 （E1）または F3 （E2）→ F1 （Ctrl）→ 12: H.Enhnc → ENTER

ハーモニックエンハンサーのバランスをコントロールするコントローラーを設定します。

Controller off,
Modulation Wheel ～ Touch EG

Depth -127 ～ 127
Curve -16 ～ 16

解　説

・ハーモニックエンハンサーのバランス（ウェット／ドライバランス）をコントロー
ルするためのコントローラーを選択し、その特性を設定します。（→ 別冊のベー
シックガイド：P. 72）

・コントローラー（Controller）では、ハーモニックエンハンサーのバランスをコント
ロールするコントローラー（コントロールソース）を選択します。「off」を選択する
と、ハーモニックエンハンサーはコントローラーでコントロールできなくなり、バ
ランスはハーモニックエンハンサーで設定されている値となります。

・デプス（Depth）では、バランスの変化の大きさを設定します。プラスの数値を設定
すると、コントローラーを上げる（たとえばモジュレーションホイールを奥に回
す、フットコントローラーを踏み込む）ほどウェット（効果が大）になります。コン
トローラーを最大にしたとき、ハーモニックエンハンサーで設定されているバラン
スの値となります。マイナスの数値を設定すると、コントローラーを上げるほどド
ライ（効果が小）になります。コントローラーを最小にしたとき、ハーモニックエン
ハンサーで設定されているバランスの値となります。

・カーブ（Curve）では、コントローラーを動かしたとき、どのようにバランスが変化
するかを設定します。デプスがプラスの数値の場合、カーブにプラスの数値を設定
すると、コントローラーの後半での変化が大きくなり、マイナスの数値を設定する
と、コントローラーの前半での変化が大きくなります。また、デプスがマイナスの
数値の場合は逆になります。

・画面にはデプスとカーブの設定によるグラフが表示されます。（横軸がコントロー
ラーの変化量、縦軸がバランスの変化量です）

・ F8 （Para）を押すと、ハーモニックエンハンサーの細かい設定を行うための画
面（モディファイアのハーモニックエンハンサー（→ P. 134））に移動することがで
きます。
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注　意

・モディファイアのハーモニックエンハンサーの設定で、バランスが「-64」（Dryの
み）になっている場合には、コントローラーでハーモニックエンハンサーをコント
ロールすることはできません。

参　考

・ F6 （BPag: Backward Page）を押すと、ダイナミックフィルターの設定画面に移ります。
・ F7 （FPag: Forward Page）を押すと、ダンピングの設定画面に移ります。

エレメントエディット － コントローラーの機能
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EDIT / E1 or E2 / CTRL / DAMPING：ダンピング

EDIT  → F2 （E1）または F3 （E2）→ F1 （Ctrl）→ 13: Damping → ENTER

ダンピングをコントロールするコントローラーを設定します。

Controller off,
Modulation Wheel ～ Touch EG

Depth -127 ～ 127
Curve -16 ～ 16

解　説

・ダンピング（管楽器の管内でのエネルギー損失、弦の空気摩擦によるエネルギー損
失：主に音量の損失となる）をコントロールするためのコントローラーを選択し、
その特性を設定します。（→ 別冊のベーシックガイド：P. 69）

・本機では、ダンピングが割り当てられているコントローラーを最大にしたとき、標
準的な音色（ダンピングされない音）を出すようになっています。（デプスがプラス
の数値の場合）

・コントローラー（Controller）では、ダンピングを割り当てるコントローラー（コン
トロールソース）を選択します。「off」を選択すると、ダンピングはコントローラー
でコントロールできなくなります。

・デプス（Depth）では、ダンピングの変化の大きさを設定します。プラスの数値を設
定すると、コントローラーを下げる（たとえばモジュレーションホイールを手前に
戻す、フットコントローラーを戻す）ほどダンピングが大きく（音が出にくく）なり
ます。マイナスの数値を設定すると、コントローラーを上げるほどダンピングが大
きくなります。

・カーブ（Curve）では、コントローラーを動かしたとき、どのようにダンピングが変
化するかを設定します。デプスがプラスの数値の場合、カーブにプラスの数値を設
定すると、コントローラーの後半での変化が大きくなり、マイナスの数値を設定す
ると、コントローラーの前半での変化が大きくなります。また、デプスがマイナス
の数値の場合は逆になります。

・画面にはデプスとカーブの設定によるグラフが表示されます。（横軸がコントロー
ラーの変化量、縦軸がダンピングの変化量です）

参　考

・持続系のボイスで、ダンピングを大きくすると弱々しい音になります。また、ピッチが変化
することもあります。

・減衰系のボイスで、ダンピングを大きくすると減衰時間が速くなります。
・ F6 （BPag: Backward Page）を押すと、ハーモニックエンハンサーの設定画面に移りま
す。

・ F7 （FPag: Forward Page）を押すと、アブソープションの設定画面に移ります。



110　　第4章　エディットモード － エレメントエディット

エレメントエディット － コントローラーの機能

EDIT / E1 or E2 / CTRL / ABSORPTION：アブソープション

EDIT  → F2 （E1）または F3 （E2）→ F1 （Ctrl）→ 14: Absrptn → ENTER

アブソープションをコントロールするコントローラーを設定します。

Controller off,
Modulation Wheel ～ Touch EG

Depth -127 ～ 127
Curve -16 ～ 16

解　説

・アブソープション（空気中への伝達時におこる高域成分の損失）をコントロールす
るためのコントローラーを選択し、その特性を設定します。（→ 別冊のベーシック
ガイド：P. 69）

・本機では、アブソープションが割り当てられているコントローラーを最大にしたと
き、標準的な音色（アブソープションされない音）を出すようになっています。（デ
プスがプラスの数値の場合）

・コントローラー（Controller）では、アブソープションを割り当てるコントローラー
（コントロールソース）を選択します。「off」を選択すると、アブソープションはコ
ントローラーでコントロールできなくなります。

・デプス（Depth）では、アブソープションの変化の大きさを設定します。プラスの数
値を設定すると、コントローラーを下げる（たとえばモジュレーションホイールを
手前に戻す、フットコントローラーを戻す）ほどアブソープションが大きく（音が
出にくく）なります。マイナスの数値を設定すると、コントローラーを上げるほど
アブソープションが大きくなります。

・カーブ（Curve）では、コントローラーを動かしたとき、どのようにアブソープショ
ンが変化するかを設定します。デプスがプラスの数値の場合、カーブにプラスの数
値を設定すると、コントローラーの後半での変化が大きくなり、マイナスの数値を
設定すると、コントローラーの前半での変化が大きくなります。また、デプスがマ
イナスの数値の場合は逆になります。

・画面にはデプスとカーブの設定によるグラフが表示されます。（横軸がコントロー
ラーの変化量、縦軸がアブソープションの変化量です）

参　考

・アブソープションによって、ピッチも変化します。
・アブソープションは、ギターなどの弦楽器を手でミュートしたときの音を作り出すときや、
管楽器のベルの開口面積を大きくしたような効果を出すことができます。

・ F6 （BPag: Backward Page）を押すと、ダンピングの設定画面に移ります。
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エレメントエディット － ミスレイニアスの機能
エレメントエディットの F2 （Misc）：ミスレイニアス（その他という意味）では、ブレスノイズやスロート
フォルマント、ミキシングなどを設定します。

・エレメントエディットのミスレイニアスの機能

1: Setting （→ P. 112）
2: Breath Noise （→ P. 113）
3: Throat Formant （→ P. 118）
4: Mixing （→ P. 125）
5: Amplitude （→ P. 131）
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エレメントエディット － ミスレイニアスの機能

EDIT / E1 or E2 / MISC / SETTING：セッティング

EDIT  → F2 （E1）または F3 （E2）→ F2 （Misc）→ 1: Setting → ENTER

トリガーモード、クロスフェードスピード、インターポレートスピードを設定します。

Trigger Mode Single, Multi
Xfade Speed Fastest, 0.09 ～ 390 msec
Interpolate Speed Fastest, 0.09 ～ 6.35 msec

解　説

・トリガーモード（Trigger Mode）では、アタック部分の再現方法を設定します。
「Single」の場合には、弾いた鍵盤を押さえたまま、次の鍵盤を弾くと、新しい音の
アタック部は再現されません。「Multi」の場合には、新しい音のアタック部が再現
されます。

・クロスフェードスピード（Xfade Speed）では、ある鍵盤を弾いた後、次の鍵盤を弾
いたときに、音程が生楽器のよう自然に切り替わる設定を行います。数値を上げる
ほど、変化の時間が長くなります。（長すぎるとアタックが不安定になることがあ
りますので、通常は1～2 msec ぐらいにしておきます）

・インターポレートスピード（Interpolate Speed）では、プレッシャーやアンプリ
チュードの変化速度を設定します。数値を上げるほど、ゆっくりと立ち上がる音と
なります。通常は、1～2 msec ぐらいにしておきます。（減衰系のボイスでは多少短
めにします）

参　考

・トリガーモードで「Single」を選択すると、プリングオフ、ハンマリングオンなどの演奏表現
を再現することができます。

・クロスフェードは、トーンホール切り換え（管楽器の押さえる穴を変更する）などを再現す
るのに適しています。これに対して、ポルタメントは、トロンボーンのように連続して管長
を変化させる場合に適しています。（→ P. 62）
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EDIT / E1 or E2 / MISC / BREATH NOISE：ブレスノイズ

EDIT  → F2 （E1）または F3 （E2）→ F2 （Misc）→ 2: Breath Noise → ENTER

ブレスノイズを設定します。

Level 0 ～ 127
Slit Drive 0 ～ 32
Control Balance -64 ～ 63
HPF Cutoff Freq 31.1 Hz ～ 21.6 kHz
LPF Cutoff Freq 31.1 Hz ～ 24.0 kHz
Key On Reset off, on

解　説

・ブレスノイズによる音色、音量などの変化を設定します。
・レベル（Level）では、ブレスノイズの出力レベルを設定します。数値が大きいほ
ど、ブレスノイズが大きくなります。

・スリットドライブ（Slit Drive）では、スリット（空気の流入するすきまの幅）を使っ
て内部的に計算するブレスノイズの振幅を設定します。数値が小さいほど、ブレス
ノイズが大きく、粗くなります。

・コントロールバランス（Control Balance）では、ブレスノイズの振幅（音量）を決定
する2つの要因のバランスを設定します。「Ctrl」は、ブレスノイズが割り当てられ
たコントローラーでコントロールするブレスノイズの振幅、「Slit」は、スリット
（空気の流入するすきまの幅）を使って内部的に計算する振幅です。

・ハイパスフィルターカットオフフリケンシー（HPF Cutoff Freq）では、ハイパス
フィルター（低い周波数域をカットするフィルター）のカットオフ周波数を設定し
ます。ここで指定した周波数以下のノイズ成分はカットされます。

・ローパスフィルターカットオフフリケンシー（LPF Cutoff Freq）では、ローパスフィ
ルター（高い周波数域をカットするフィルター）のカットオフ周波数を設定しま
す。ここで指定した周波数以上のノイズ成分はカットされます。

・キーオンリセット（Key On Reset）では、ブレスノイズのアタック感を設定します。
「off」を選択すると、新しい音を出すたびにノイズジェネレーターをリセットしな
いので、自然なアタック感が得られます。「on」を選択すると、新しい音を出すたび
にノイズジェネレーターをリセットするため、均質なアタック感が得られます。

エレメントエディット － ミスレイニアスの機能
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エレメントエディット － ミスレイニアスの機能

・設定部分の右側に のマークが付いている項目は、キースケール（音階）によって
設定をコントロールできる項目です。これらの項目が反転表示されているときに
は、 F7 （KSC）または ENTER を押すことで、キースケールを設定する画面に進
むことができます。画面の移動は、次のように行われます。

　Level → F7 （ EXIT で戻る）→  レベルKSC （→ P. 115）

F7 ↓ ↑ F6

　HPF Cutoff Freq → F7 （ EXIT で戻る）→  HPF KSC （→ P. 116）

F7 ↓ ↑ F6

　LPF Cutoff Freq → F7 （ EXIT で戻る）→  LPF KSC （→ P. 117）

・ F8 （Ctrl）を押すと、ブレスノイズをコントロールするコントローラーを設定
するための画面（コントローラーのブレスノイズ（→ P. 101））に移動することがで
きます。

注　意

・コントロールバランスが63（Slit側）になっていると、グロウルのデプストゥーブレ
スノイズの効果はありません。（→ P.174）

・ハイパスフィルターカットオフフリケンシーの設定が、ローパスフィルターカット
オフフリケンシーの設定よりも高い場合には、ブレスノイズがほとんど聴こえなく
なる場合があります。

・ここでの設定で、レベルが「0」になっている場合、およびコントロールバランスが
「63」（最大に「Slit」側）になっている場合には、コントローラーでブレスノイズを
コントロールすることはできません。
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EDIT / E1 or E2 / MISC / BREATH NOISE / KSC：ブレスノイズKSC（レベル）

EDIT  → F2 （E1）または F3 （E2）→ F2 （Misc）→ 2: Breath Noise → ENTER  → Level → F7 （KSC）

ブレスノイズのレベルキースケールを設定します。

Level 0 ～ 127
BP1 ～ 6の音程 C-2 ～ G8
BP1 ～ 6の変化幅 -64 ～ 63

解　説

・ブレスノイズの音量を、キースケール（音階）で変化させるための設定を行います。
・レベル（Level）では、ブレスノイズの出力レベルを設定します。数値が大きいほ
ど、ブレスノイズが大きくなります。この数値は、キースケール設定に入る前の、ブ
レスノイズ設定画面の「Level」の数値と連動しています。また、この数値がブレー
クポイントの基準値となります。

・ブレスノイズのレベルキースケールは、6つのブレークポイント（BP）で設定しま
す。各ブレークポイントは、「音程」と「基準値からの変化量」で設定します。（→ P.
33）

・画面には、音程による変化幅を示すグラフが表示されます。横軸が音程、縦軸がレ
ベルです。点線の横線は「Level」の設定値（基準値）を示します。

・各ブレークポイントの音程の部分が反転表示になっているときには、鍵盤を使って
音程を入力することができます。 F8 （Kbd）を押した後、MIDIキーボードの任
意の鍵盤を弾いてください。

注　意

・ブレークポイント1～6は、順番に音程が上がっていくようにしか設定できません。
・基準値に変化幅を加えた値が、設定範囲（グラフの下端から上端までの範囲）を超
える場合には、最小値または最大値のレベルとなります。

参　考

・ F7 （FPag: Forward Page）を押すと、ハイパスフィルターカットオフフリケンシーのキー
スケール設定画面に移ります。
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エレメントエディット － ミスレイニアスの機能

EDIT / E1 or E2 / MISC / BREATH NOISE / KSC：ブレスノイズKSC（HPF）

EDIT  → F2 （E1）または F3 （E2）→ F2 （Misc）→ 2: Breath Noise → ENTER  → HPF Cutoff Freq → F7 （KSC）

ブレスノイズのハイパスフィルターカットオフフリケンシーキースケールを設定します。

HPF 31.1 Hz ～ 21.6 kHz
BP1、2の音程 C-2 ～ G8
BP1、2の変化幅 -64 ～ 63

解　説

・ブレスノイズのハイパスフィルターカットオフフリケンシーを、キースケール（音
階）で変化させるための設定を行います。

・ハイパスフィルター（HPF）では、ハイパスフィルターのカットオフフリケンシー
を設定します。この数値は、キースケール設定に入る前の、ブレスノイズ設定画面
の「HPF Cutoff Freq」の数値と連動しています。また、この数値がブレークポイント
の基準値となります。

・ハイパスフィルターのカットオフフリケンシーキースケールは、2つのブレークポ
イント（BP）で設定します。各ブレークポイントは、「音程」と「基準値からの変化
量」で設定します。（→ P. 33）（ずれは相対的なものとなります）

・画面には、音程による変化幅を示すグラフが表示されます。横軸が音程、縦軸が
カットオフフリケンシーです。点線の横線は「HPF」の設定値（基準値）を示しま
す。

・各ブレークポイントの音程の部分が反転表示になっているときには、鍵盤を使って
音程を入力することができます。 F8 （Kbd）を押した後、MIDIキーボードの任
意の鍵盤を弾いてください。

注　意

・ブレークポイント1、2は、順番に音程が上がっていくようにしか設定できません。
・基準値に変化幅を加えた値が、設定範囲（グラフの下端から上端までの範囲）を超
える場合には、最小または最大の設定値となります。

参　考

・ F6 （BPag: Backward Page）を押すと、レベルのキースケール設定画面に移ります。
・ F7 （FPag: Forward Page）を押すと、ローパスフィルターカットオフフリケンシーのキー
スケール設定画面に移ります。
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EDIT / E1 or E2 / MISC / BREATH NOISE / KSC：ブレスノイズKSC（LPF）

EDIT  → F2 （E1）または F3 （E2）→ F2 （Misc）→ 2: Breath Noise → ENTER  → LPF Cutoff Freq → F7 （KSC）

ブレスノイズのローパスフィルターカットオフフリケンシーキースケールを設定します。

LPF 31.1 Hz ～ 24.0 kHz
BP1、2の音程 C-2 ～ G8
BP1、2の変化幅 -64 ～ 63

解　説

・ブレスノイズのローパスフィルターカットオフフリケンシーを、キースケール（音
階）で変化させるための設定を行います。

・ローパスフィルター（LPF）では、カットオフフリケンシーを設定します。この数値
は、キースケール設定に入る前の、ブレスノイズ設定画面の「LPF Cutoff Freq」の数
値と連動しています。また、この数値がブレークポイントの基準値となります。

・ローパスフィルターのカットオフフリケンシーキースケールは、2つのブレークポ
イント（BP）で設定します。各ブレークポイントは、「音程」と「基準値からの変化
量」で設定します。（→ P. 33）（ずれは相対的なものとなります）

・画面には、音程による変化幅を示すグラフが表示されます。横軸が音程、縦軸が
カットオフフリケンシーです。点線の横線は「LPF」の設定値（基準値）を示しま
す。

・各ブレークポイントの音程の部分が反転表示になっているときには、鍵盤を使って
音程を入力することができます。 F8 （Kbd）を押した後、MIDIキーボードの任
意の鍵盤を弾いてください。

注　意

・ブレークポイント1、2は、順番に音程が上がっていくようにしか設定できません。
・基準値に変化幅を加えた値が、設定範囲（グラフの下端から上端までの範囲）を超
える場合には、最小または最大の設定値となります。

参　考

・ F6 （BPag: Backward Page）を押すと、ハイパスフィルターカットオフフリケンシーの
キースケール設定画面に移ります。
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EDIT / E1 or E2 / MISC / THROAT FORMANT：スロートフォルマント

EDIT  → F2 （E1）または F3 （E2）→ F2 （Misc）→ 3: Throat Formant → ENTER

スロートフォルマントを設定します。

Pitch Tracking Fixed, KeyTrack
Pitch 23.1 Hz ～ 48.0 kHz

（FixedでIntensが0以上の場合）
11.4 Hz ～ 24.0 kHz
（FixedでIntensが0未満の場合）
-2.0 ～ 1.98 oct（Key Trackの場合）

Amount -64 ～ 63
Intens -127 ～ 127
HPF Cutoff Freq 31.1 Hz ～ 21.6 kHz
LPF Cutoff Freq 31.1 Hz ～ 24.0 kHz

解　説

・スロートフォルマント（喉の奥で鳴るような効果）の特性を設定します。
・ピッチトラッキング（Pitch Tracking）では、スロートフォルマントの効き方を設定
します。「Fixed」を選択した場合には、音程に関係なく一定の音程のスロートフォ
ルマントがかかります。「KeyTrack」を選択すると、音程にしたがったスロート
フォルマントがかかります。

・ピッチ（Pitch）では、スロートフォルマントの音程を設定します。この設定によっ
て、変化する音程の幅、音色などが変化します。ピッチトラッキングで「KeyTrack」
を選択した場合には、弾いた鍵盤の音程からどれだけずらすかを設定します。

・アマウント（Amount）では、スロートフォルマントの音（喉から戻る息）が管に送
り込む空気の流速にどれだけ影響を与えるかを設定します。プラスの数値を設定す
ると、流速を増加させることになり、より強調されたスロートフォルマントがかか
ります。マイナスの数値を設定すると、流速を減少させることになり、暖かなス
ロートフォルマントがかかります。

・インテンシティ（Intens）では、スロートフォルマントの激しさを設定します。数値
をプラスに大きく、またはマイナスに小さくするほど、スロートフォルマントの効
果が現れます。

・ハイパスフィルターカットオフフリケンシー（HPF Cutoff Freq）では、ハイパス
フィルター（低い周波数域をカットするフィルター）のカットオフ周波数を設定し
ます。ここで指定した周波数以下のスロートフォルマントの音はカットされます。

・ローパスフィルターカットオフフリケンシー（LPF Cutoff Freq）では、ローパスフィ
ルター（高い周波数域をカットするフィルター）のカットオフ周波数を設定しま
す。ここで指定した周波数以上のスロートフォルマントの音はカットされます。
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・設定部分の右側に のマークが付いている項目は、キースケール（音階）によって
設定をコントロールできる項目です。これらの項目が反転表示されているときに
は、 F7 （KSC）または ENTER を押すことで、キースケールを設定する画面に進
むことができます。画面の移動は、次のように行われます。

　Pitch → F7 （ EXIT で戻る）→  ピッチKSC （→ P. 120）

F7 ↓ ↑ F6

　Amount → F7 （ EXIT で戻る）→  アマウントKSC （→ P. 121）

F7 ↓ ↑ F6

　Intens → F7 （ EXIT で戻る）→  インテンシティKSC （→ P. 122）

F7 ↓ ↑ F6

　HPF Cutoff Freq → F7 （ EXIT で戻る）→  HPF KSC （→ P. 123）

F7 ↓ ↑ F6

　LPF Cutoff Freq → F7 （ EXIT で戻る）→  LPF KSC （→ P. 124）

・ F8 （Ctrl）を押すと、スロートフォルマントをコントロールするコントロー
ラーを設定するための画面（コントローラーのスロートフォルマント（→ P. 104））
に移動することができます。

注　意

・ここでの設定で、アマウントやインテンシティが「0」になっている場合には、コン
トローラーでスロートフォルマントをコントロールすることはできません。

参　考

・ピッチ、アマウント、インテンシティの設定では、数値の上下によってどういう音になるか
を一概に言うことはできません。実際にいろいろな設定を試しながら設定を進めてくださ
い。

エレメントエディット － ミスレイニアスの機能
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EDIT / E1 or E2 / MISC / THROAT FORMANT / KSC：スロートフォルマントKSC（ピッチ）

EDIT  → F2 （E1）または F3 （E2）→ F2 （Misc）→ 3: Throat Formant → ENTER  → Pitch → F7 （KSC）

スロートフォルマントのピッチキースケールを設定します。

Pitch 23.1 Hz ～ 48.0 kHz
（FixedでIntensが0以上の場合）
11.4 Hz ～ 24.0 kHz
（FixedでIntensが0未満の場合）
-2.0 ～ 1.98 oct（KeyTrackの場合）

BP1 ～ 4の音程 C-2 ～ G8
BP1 ～ 4の変化幅 -127 ～ 127

解　説

・スロートフォルマントのピッチを、キースケール（音階）で変化させるための設定
を行います。

・ピッチ（Pitch）では、スロートフォルマントの音程を設定します。この数値は、キー
スケール設定に入る前の、スロートフォルマント設定画面の「Pitch」の数値と連動
しています。また、この数値がブレークポイントの基準値となります。

・スロートフォルマントのピッチキースケールは、4つのブレークポイント（BP）で設
定します。各ブレークポイントは、「音程」と「基準値からの変化量」で設定しま
す。（→ P. 33）

・画面には、音程による変化幅を示すグラフが表示されます。横軸が音程、縦軸が
ピッチです。点線の横線は「Pitch」の設定値（基準値）を示します。

・各ブレークポイントの音程の部分が反転表示になっているときには、鍵盤を使って
音程を入力することができます。 F8 （Kbd）を押した後、MIDIキーボードの任
意の鍵盤を弾いてください。

注　意

・ブレークポイント1～4は、順番に音程が上がっていくようにしか設定できません。
・基準値に変化幅を加えた値が、設定範囲（グラフの下端から上端までの範囲）を超
える場合には、最小値または最大値となります。

参　考

・ F7 （FPag: Forward Page）を押すと、アマウントのキースケール設定画面に移ります。
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EDIT / E1 or E2 / MISC / THROAT FORMANT / KSC：スロートフォルマントKSC（アマウント）

EDIT  → F2 （E1）または F3 （E2）→ F2 （Misc）→ 3: Throat Formant → ENTER  → Amount → F7 （KSC）

スロートフォルマントのアマウントキースケールを設定します。

Amount -64 ～ 63
BP1 ～ 4の音程 C-2 ～ G8
BP1 ～ 4の変化幅 -64 ～ 63

解　説

・スロートフォルマントのアマウントを、キースケール（音階）で変化させるための
設定を行います。

・アマウント（Amount）では、スロートフォルマントのアマウントを設定します。こ
の数値はキースケール設定に入る前のスロートフォルマント設定画面の「Amount」
の数値と連動しています。また、この数値がブレークポイントの基準値となりま
す。

・スロートフォルマントのアマウントキースケールは、4つのブレークポイント（BP）
で設定します。各ブレークポイントは、「音程」と「基準値からの変化量」で設定し
ます。（→ P. 33）

・画面には、音程による変化幅を示すグラフが表示されます。横軸が音程、縦軸がア
マウントです。点線の横線は「Amount」の設定値（基準値）を示します。

・各ブレークポイントの音程の部分が反転表示になっているときには、鍵盤を使って
音程を入力することができます。 F8 （Kbd）を押した後、MIDIキーボードの任
意の鍵盤を弾いてください。

注　意

・ブレークポイント1～4は、順番に音程が上がっていくようにしか設定できません。
・基準値に変化幅を加えた値が、設定範囲（グラフの下端から上端までの範囲）を超
える場合には、最小値または最大値となります。

参　考

・ F6 （BPag: Backward Page）を押すと、ピッチのキースケール設定画面に移ります。
・ F7 （FPag: Forward Page）を押すと、インテンシティのキースケール設定画面に移りま
す。

エレメントエディット － ミスレイニアスの機能
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EDIT / E1 or E2 / MISC / THROAT FORMANT / KSC：スロートフォルマントKSC（インテンシティ）

EDIT  → F2 （E1）または F3 （E2）→ F2 （Misc）→ 3: Throat Formant → ENTER  → Intens → F7 （KSC）

スロートフォルマントのインテンシティキースケールを設定します。

Intens -127 ～ 127
BP1 ～ 4の音程 C-2 ～ G8
BP1 ～ 4の変化幅 -127 ～ 127

解　説

・スロートフォルマントのインテンシティを、キースケール（音階）で変化させるた
めの設定を行います。

・インテンシティ（Intens）では、スロートフォルマントのインテンシティを設定しま
す。この数値はキースケール設定に入る前のスロートフォルマント設定画面の
「Intens」の数値と連動しています。また、この数値がブレークポイントの基準値と
なります。

・スロートフォルマントのインテンシティキースケールは、4つのブレークポイント
（BP）で設定します。各ブレークポイントは、「音程」と「基準値からの変化量」で
設定します。（→ P. 33）

・画面には、音程による変化幅を示すグラフが表示されます。横軸が音程、縦軸がイ
ンテンシティです。点線の横線は「Intens」の設定値（基準値）を示します。

・各ブレークポイントの音程の部分が反転表示になっているときには、鍵盤を使って
音程を入力することができます。 F8 （Kbd）を押した後、MIDIキーボードの任
意の鍵盤を弾いてください。

注　意

・ブレークポイント1～4は、順番に音程が上がっていくようにしか設定できません。
・基準値に変化幅を加えた値が、設定範囲（グラフの下端から上端までの範囲）を超
える場合には、最小値または最大値となります。

参　考

・ F6 （BPag: Backward Page）を押すと、アマウントのキースケール設定画面に移ります。
・ F7 （FPag: Forward Page）を押すと、ハイパスフィルターカットオフフリケンシーのキー
スケール設定画面に移ります。
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EDIT / E1 or E2 / MISC / THROAT FORMANT / KSC：スロートフォルマントKSC（HPF）

EDIT  → F2 （E1）または F3 （E2）→ F2 （Misc）→ 3: Throat Formant → ENTER  → HPF Cutoff Freq → F7 （KSC）

スロートフォルマントのハイパスフィルターカットオフフリケンシーキースケールを設定します。

HPF 31.1 Hz ～ 21.6 kHz
BP1 ～ 3の音程 C-2 ～ G8
BP1 ～ 3の変化幅 -64 ～ 63

解　説

・スロートフォルマントのハイパスフィルターカットオフフリケンシーを、キース
ケール（音階）で変化させるための設定を行います。

・ハイパスフィルター（HPF）では、ハイパスフィルターのカットオフフリケンシー
を設定します。この数値はキースケール設定に入る前のスロートフォルマント設定
画面の「HPF Cutoff Freq」の数値と連動しています。また、この数値がブレークポイ
ントの基準値となります。

・ハイパスフィルターカットオフフリケンシーのキースケールは、3つのブレークポ
イント（BP）で設定します。各ブレークポイントは、「音程」と「基準値からの変化
量」で設定します。（→ P. 33）（ずれは相対的なものとなります）

・画面には、音程による変化幅を示すグラフが表示されます。横軸が音程、縦軸が
カットオフフリケンシーです。点線の横線は「HPF」の設定値（基準値）を示しま
す。

・各ブレークポイントの音程の部分が反転表示になっているときには、鍵盤を使って
音程を入力することができます。 F8 （Kbd）を押した後、MIDIキーボードの任
意の鍵盤を弾いてください。

注　意

・ブレークポイント1～3は、順番に音程が上がっていくようにしか設定できません。
・基準値に変化幅を加えた値が、設定範囲（グラフの下端から上端までの範囲）を超
える場合には、最小値または最大値となります。

参　考

・ F6 （BPag: Backward Page）を押すと、インテンシティのキースケール設定画面に移りま
す。

・ F7 （FPag: Forward Page）を押すと、ローパスフィルターカットオフフリケンシーのキー
スケール設定画面に移ります。
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エレメントエディット － ミスレイニアスの機能

EDIT / E1 or E2 / MISC / THROAT FORMANT / KSC：スロートフォルマントKSC（LPF）

EDIT  → F2 （E1）または F3 （E2）→ F2 （Misc）→ 3: Throat Formant → ENTER  → LPF Cutoff Freq → F7 （KSC）

スロートフォルマントのローパスフィルターカットオフフリケンシーキースケールを設定します。

LPF 31.1 Hz ～ 24.0 kHz
BP1 ～ 3の音程 C-2 ～ G8
BP1 ～ 3の変化幅 -64 ～ 63

解　説

・スロートフォルマントのローパスフィルターカットオフフリケンシーを、キース
ケール（音階）で変化させるための設定を行います。

・ローパスフィルター（LPF）では、ローパスフィルターのカットオフフリケンシーを
設定します。この数値はキースケール設定に入る前のスロートフォルマント設定画
面の「LPF Cutoff Freq」の数値と連動しています。また、この数値がブレークポイン
トの基準値となります。

・ローパスフィルターカットオフフリケンシーのキースケールは、3つのブレークポ
イント（BP）で設定します。各ブレークポイントは、「音程」と「基準値からの変化
量」で設定します。（→ P. 33）（ずれは相対的なものとなります）

・画面には、音程による変化幅を示すグラフが表示されます。横軸が音程、縦軸が
カットオフフリケンシーです。点線の横線は「LPF」の設定値（基準値）を示しま
す。

・各ブレークポイントの音程の部分が反転表示になっているときには、鍵盤を使って
音程を入力することができます。 F8 （Kbd）を押した後、MIDIキーボードの任
意の鍵盤を弾いてください。

注　意

・ローパスフィルターで「off」が選択されている場合には、キースケールの設定は無
効となります。

・ブレークポイント1～3は、順番に音程が上がっていくようにしか設定できません。
・基準値に変化幅を加えた値が、設定範囲（グラフの下端から上端までの範囲）を超
える場合には、最小値または最大値となります。

参　考

・ F6 （BPag: Backward Page）を押すと、ハイパスフィルターカットオフフリケンシーの
キースケール設定画面に移ります。
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エレメントエディット － ミスレイニアスの機能

EDIT / E1 or E2 / MISC / MIXING：ミキシング

EDIT  → F2 （E1）または F3 （E2）→ F2 （Misc）→ 4: Mixing → ENTER

ドライバー出力、パイプ／ストリング出力、タップアウト出力のミキシングバランスを設定します。

Driver Output 0 ～ 127
Pipe/String Output 0 ～ 127
Tap Output 0 ～ 127
Tap Sign - , +
Tap Setting Variable, Driving Point
Tap Location 0 ～ 99.2 %

解　説

・ドライバーからの出力音、パイプ／ストリングからの出力音、パイプ／ストリング
のタップアウトからの出力音のレベル、タップ音の取り出し方を設定します。

・ドライバーアウトプット（Driver Output）では、ドライバーから出力される音（ドラ
イバー音）の最終的なレベルを設定します。数値が大きいほど、出力レベルが上が
ります。

・パイプ／ストリングアウトプット（Pipe / String Output）では、パイプ／ストリング
から出力される音（パイプ／ストリング音）の最終的なレベルを設定します。数値
が大きいほど、出力レベルが上がります。

・タップアウトプット（Tap Output）では、タップアウトから出力される音（タップ
音）の最終的なレベルを設定します。数値が大きいほど、出力レベルが上がります。

・タップサイン（Tap Sign）では、タップ音の位相（フェイズ）を選択します。「-」を
選択すると、逆相のタップ音となり、フェイズシフター的な効果が生まれます。

・タップセッティング（Tap Setting）では、タップアウトを取り出すポジションを選択
します。「Driving Point」を選択すると、マウスピースの音圧が欲しいときに一番適
当なポイントからタップアウトを取り出します。

・タップロケーション（Tap Location）では、タップセッティングが「Variable」のとき
のタップアウトを取り出すポイントを設定します。タップセッティングが「Driving
Point」のときは表示されません。

ドライバー� パイプ／ストリング�

ミ
キ
シ
ン
グ�

ドライバー音�

タップ音�

パイプ／ストリング音�

モディファイア�

ハーモニックエンハンサー用の信号�
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・設定部分の右側に のマークが付いている項目は、キースケール（音階）によって
設定をコントロールできる項目です。これらの項目が反転表示されているときに
は、 F7 （KSC）を押すことで、キースケールを設定する画面に進むことができ
ます。画面の移動は、次のように行われます。

　Driver Output → F7 （ EXIT で戻る）→  ドライバーアウトプットKSC （→ P. 127）

F7 ↓ ↑ F6

　Pipe/String Output → F7 （ EXIT で戻る）→  パイプ／ストリングアウトプットKSC （→ P. 128）

F7 ↓ ↑ F6

　Tap Output → F7 （ EXIT で戻る）→  タップアウトプットKSC （→ P. 129）

F7 ↓ ↑ F6

　Tap Location → F7 （ EXIT で戻る）→  タップロケーションKSC （→ P. 130）

注　意

・ミキシングされた音はハーモニックエンハンサーのノーマル音になります。した
がって、ドライバーアウトプット、パイプ／ストリングアウトプット、タップアウ
トプットを全て「0」に設定すると、ハーモニックエンハンサーの設定によっては何
も音の出ないエレメントになる場合があります。（→ P.134）

・タップポジションフィックスが「Driving Point」のときでも、タップアウトプット
KSCの画面からタップロケーションKSCの画面に入ることができますが、設定は無
効となります。
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エレメントエディット － ミスレイニアスの機能

EDIT / E1 or E2 / MISC / MIXING / KSC：ミキシングKSC（ドライバーアウトプット）

EDIT  → F2 （E1）または F3 （E2）→ F2 （Misc）→ 4: Mixing → ENTER  → Driver Output → F7 （KSC）

ドライバーアウトプットのレベルキースケールを設定します。

DrvrOut 0 ～ 127
BP1 ～ 6の音程 C-2 ～ G8
BP1 ～ 6の変化幅 -64 ～ 63

解　説

・ドライバーからの出力音のレベルを、キースケール（音階）で変化させるための設
定を行います。

・ドライバーアウトプット（DrvrOut）では、ドライバーアウトプットの出力レベルを
設定します。数値が大きいほど、出力レベルが大きくなります。この数値は、キース
ケール設定に入る前の、ミキシング設定画面の「Driver Output」の数値と連動してい
ます。また、この数値がブレークポイントの基準値となります。

・ドライバーアウトプットのキースケールは、6つのブレークポイント（BP）で設定し
ます。各ブレークポイントは、「音程」と「基準値からの変化量」で設定します。（→
P. 33）

・画面には、音程による変化幅を示すグラフが表示されます。横軸が音程、縦軸がア
ウトプットレベルです。点線の横線は「DrivOut」の設定値（基準値）を示します。

・各ブレークポイントの音程の部分が反転表示になっているときには、鍵盤を使って
音程を入力することができます。 F8 （Kbd）を押した後、MIDIキーボードの任
意の鍵盤を弾いてください。

注　意

・ブレークポイント1～6は、順番に音程が上がっていくようにしか設定できません。
・基準値に変化幅を加えた値が、設定範囲（グラフの下端から上端までの範囲）を超
える場合には、最小値または最大値となります。

参　考

・ F7 （FPag: Forward Page）を押すと、パイプ／ストリングアウトプットのキースケール
設定画面に移ります。
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エレメントエディット － ミスレイニアスの機能

EDIT / E1 or E2 / MISC / MIXING / KSC：ミキシングKSC（パイプ／ストリングアウトプット）

EDIT  → F2 （E1）または F3 （E2）→ F2 （Misc）→ 4: Mixing → ENTER  → Pipe/String Output → F7 （KSC）

パイプ／ストリングアウトプットのレベルキースケールを設定します。

P/S Out 0 ～ 127
BP1 ～ 6の音程 C-2 ～ G8
BP1 ～ 6の変化幅 -64 ～ 63

解　説

・パイプ／ストリングアウトプットのレベルを、キースケール（音階）で変化させる
ための設定を行います。

・パイプ／ストリングアウトプット（P/S Out）では、パイプ／ストリングの出力レベ
ルを設定します。数値が大きいほど、出力レベルが大きくなります。この数値は、
キースケール設定に入る前の、ミキシング設定画面の「Pipe / String Output」の数値
と連動しています。また、この数値がブレークポイントの基準値となります。

・パイプ／ストリングのアウトプットキースケールは、6つのブレークポイント（BP）
で設定します。各ブレークポイントは、「音程」と「基準値からの変化量」で設定し
ます。（→ P. 33）

・画面には、音程による変化幅を示すグラフが表示されます。横軸が音程、縦軸がア
ウトプットレベルです。点線の横線は「P/S Out」の設定値（基準値）を示します。

・各ブレークポイントの音程の部分が反転表示になっているときには、鍵盤を使って
音程を入力することができます。 F8 （Kbd）を押した後、MIDIキーボードの任
意の鍵盤を弾いてください。

注　意

・ブレークポイント1～6は、順番に音程が上がっていくようにしか設定できません。
・基準値に変化幅を加えた値が、設定範囲（グラフの下端から上端までの範囲）を超
える場合には、最小値または最大値となります。

参　考

・ F6 （BPag: Backward Page）を押すと、ドライバーアウトプットのキースケール設定画面
に移ります。

・ F7 （FPag: Forward Page）を押すと、タップアウトプットのキースケール設定画面に移
ります。
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EDIT / E1 or E2 / MISC / MIXING / KSC：ミキシングKSC（タップアウトプット）

EDIT  → F2 （E1）または F3 （E2）→ F2 （Misc）→ 4: Mixing → ENTER  → Tap Output → F7 （KSC）

タップアウトプットのレベルキースケールを設定します。

TapOut 0 ～ 127
BP1 ～ 6の音程 C-2 ～ G8
BP1 ～ 6の変化幅 -64 ～ 63

解　説

・タップアウトプットの音量を、キースケール（音階）で変化させるための設定を行
います。

・タップアウトプット（TapOut）では、タップアウトプットのレベルを設定します。
数値が大きいほど、出力レベルが大きくなります。この数値は、キースケール設定
に入る前の、ミキシング設定画面の「Tap Output」の数値と連動しています。また、
この数値がブレークポイントの基準値となります。

・タップアウトプットのキースケールは、6つのブレークポイント（BP）で設定しま
す。各ブレークポイントは、「音程」と「基準値からの変化量」で設定します。（→ P.
33）

・画面には、音程による変化幅を示すグラフが表示されます。横軸が音程、縦軸がア
ウトプットレベルです。点線の横線は「TapOut」の設定値（基準値）を示します。

・各ブレークポイントの音程の部分が反転表示になっているときには、鍵盤を使って
音程を入力することができます。 F8 （Kbd）を押した後、MIDIキーボードの任
意の鍵盤を弾いてください。

注　意

・ブレークポイント1～6は、順番に音程が上がっていくようにしか設定できません。
・基準値に変化幅を加えた値が、設定範囲（グラフの下端から上端までの範囲）を超
える場合には、最小値または最大値となります。

参　考

・ F6 （BPag: Backward Page）を押すと、パイプ／ストリングアウトプットのキースケール
設定画面に移ります。

・ F7 （FPag: Forward Page）を押すと、タップロケーションのキースケール設定画面に移
ります。ただし、タップポジションフィックスが「Driving Position」になっている場合は、
タップロケーションのキースケール設定画面での設定は無効となります。

エレメントエディット － ミスレイニアスの機能
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EDIT / E1 or E2 / MISC / MIXING / KSC：ミキシングKSC（タップロケーション）

EDIT  → F2 （E1）または F3 （E2）→ F2 （Misc）→ 4: Mixing → ENTER  → Tap Location → F7 （KSC）

タップロケーションのキースケールを設定します。

TapLoc 0 ～ 99.2 %
BP1 ～ 6の音程 C-2 ～ G8
BP1 ～ 6の変化幅 -64 ～ 63

解　説

・タップセッティングが「Variable」に設定されているとき、タップロケーションを
キースケール（音階）で変化させるための設定を行います。

・ロケーション（TapLoc）では、タップロケーションの基準値を設定します。この数
値は、キースケール設定に入る前の、ミキシング設定画面の「Tap Location」の数値
と連動しています。また、この数値がブレークポイントの基準値となります。

・タップロケーションのキースケールは、6つのブレークポイント（BP）で設定しま
す。各ブレークポイントは、「音程」と「基準値からの変化量」で設定します。（→ P.
33）

・画面には、音程による変化幅を示すグラフが表示されます。横軸が音程、縦軸がロ
ケーションです。点線の横線は「TapLoc」の設定値（基準値）を示します。

・各ブレークポイントの音程の部分が反転表示になっているときには、鍵盤を使って
音程を入力することができます。 F8 （Kbd）を押した後、MIDIキーボードの任
意の鍵盤を弾いてください。

注　意

・ブレークポイント1～6は、順番に音程が上がっていくようにしか設定できません。
・基準値に変化幅を加えた値が、設定範囲（グラフの下端から上端までの範囲）を超
える場合には、最小値または最大値となります。

・タップセッティングが「Driving Point」に設定されている場合は、この画面での設定
は無効となります。

参　考

・ F6 （BPag: Backward Page）を押すと、タップアウトプットのキースケール設定画面に移
ります。
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EDIT / E1 or E2 / MISC / AMPLITUDE：アンプリチュード

EDIT  → F2 （E1）または F3 （E2）→ F2 （Misc）→ 5: Amplitude → ENTER

エレメントの最終的なアウトプットレベルを設定します。

Amplitude Level 0 ～ 127

解　説

・アンプリチュードレベル（Amplitude Level）では、ドライバーアウトプット、パイプ
／ストリングアウトプット、タップアウトプットの混ざった、エレメントの出力レ
ベルを設定します。

・アンプリチュードレベルは、キースケール（音階）によって設定をコントロールで
きます。 F7 （KSC）または ENTER を押すと、キースケールを設定する画面に進
みます。この機能については、次ページで説明します。

注　意

・アンプリチュードレベルを「0」に設定すると、何も音の出ないエレメントになりま
す。

エレメントエディット － ミスレイニアスの機能
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EDIT / E1 or E2 / MISC / AMPLITUDE / KSC：アンプリチュードKSC（レベル）

EDIT  → F2 （E1）または F3 （E2）→ F2 （Misc）→ 5: Amplitude → ENTER  → Level → F7 （KSC）

アンプリチュードのレベルキースケールを設定します。

Level 0 ～ 127
BP1 ～ 8の音程 C-2 ～ G8
BP1 ～ 8の変化幅 -64 ～ 63

解　説

・エレメントの音量を、キースケール（音階）で変化させるための設定を行います。
・レベル（Level）では、エレメントの出力レベルを設定します。数値が大きいほど、
出力レベルが大きくなります。この数値は、キースケール設定に入る前の、アンプ
リチュード設定画面の「Total Amplitude Level」の数値と連動しています。また、こ
の数値がブレークポイントの基準値となります。

・アンプリチュードのキースケールは、8つのブレークポイント（BP）で設定します。
各ブレークポイントは、「音程」と「基準値からの変化量」で設定します。（→ P.
33）

・画面には、音程による変化幅を示すグラフが表示されます。横軸が音程、縦軸がレ
ベルです。点線の横線は「Level」の設定値（基準値）を示します。

・各ブレークポイントの音程の部分が反転表示になっているときには、鍵盤を使って
音程を入力することができます。 F8 （Kbd）を押した後、MIDIキーボードの任
意の鍵盤を弾いてください。

・2エレメントのボイスの場合、 F7 （Xfd：クロスフェード）を押すと、選んでい
ないエレメントのアンプリチュードKSCのデータを逆位相に描きます。

注　意

・ブレークポイント1～8は、順番に音程が上がっていくようにしか設定できません。
・基準値に変化幅を加えた値が、設定範囲（グラフの下端から上端までの範囲）を超
える場合には、最小値または最大値のレベルとなります。

エレメントエディット － ミスレイニアスの機能
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エレメントエディット － モディファイアの機能
エレメントエディットの F3 （Modi）：モディファイアは、ドライバー音、パイプ／ストリング音、タップ音
がミキシングされて出力された音に対して、さまざまな加工をする機能です。

・エレメントエディットのモディファイアの機能

1: Harmonic Enhancer （→ P. 134）
2: Dynamic Filter （→ P. 147）
3: Equalizer Auxiliary （→ P. 151）
4: Equalizer Band （→ P. 154）
5: IE & RSN Setting （→ P. 155）
6: Impulse Expander （→ P. 157）
7: Resonator （→ P. 159）

参　考

・各機能では、5つのモディファイアの次の部分を設定します。
ハーモニックエンハンサー ← 1: Harmonic Enhancer
ダイナミックフィルター ← 2: Dynamic Filter
イコライザー ← 3: Equalizer Auxiliary

← 4: Equalizer Band
インパルスエキスパンダー ← 6: Impulse Expander
レゾネーター ← 7: Resonator

・なお、5: IE & RSN Settingでは、インパルスエキスパンダーとレゾネーターのオン／オフや
レベルなどを設定します。

プレイモード�

エディットモード�

ユーティリティモード�

コモンエディット�

エレメントエディット�

モディファイア�

エンベロープ�

システム�

MIDIバルクダンプ�

ディスク�

エディットリコール�

デモ�

ミスレイニアス�

エフェクト�

コントローラー�

ミスレイニアス�
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EDIT / E1 or E2 / MODIFIER / HARMONIC ENHANCER（Carrier）：ハーモニックエンハンサー（キャリア）

EDIT  → F2 （E1）または F3 （E2）→ F3 （Modi）→ 1: Harmonic Enhancer → ENTER  → F1 （Crr）

ハーモニックエンハンサーのキャリアを設定します。

Signal Select Normal, Breath Noise Amp.,
Flow Rate Saturation, Beat,
Slit/Friction, Reed

HPF Cutoff 17.0 Hz ～ 11.2 kHz
Over Drive 0.063 ～ 15.31
Level 0 ～ 127
Balance -64 ～ 63

解　説

・ハーモニックエンハンサーは、ドライバーやパイプ／ストリングから送られた信号
をもとに、キャリアとモジュレーターを設定することで、倍音を豊かにしたり、
オーバードライブ的な効果を作り出す機能です。

・キャリアとモジュレーターの画面切り換えには、 F1 （Crr）と F2 （Mod）を
使います。

・ここでは、キャリア（モジュレーターによって変化させられる基本となる信号）の
設定を行います。

・シグナルセレクト（Signal Select）では、キャリアとして使う信号を次の中から選択
します。

Normal

ミスレイニアスのミキシング（→ P. 125）で設定したミキシング出力（ドライ
バー音、パイプ／ストリング音、タップ音をミキシングした信号）です。

Breath Noise Amp.

ブレスノイズの振幅を計算した結果を示す信号です。後述の「Slit/Friction」が
大きく歪んだ信号ともいえます。ただし、ブレスノイズの「Slit Drive」が0より
大きな値になっていないと音が出ません。（→ P. 113）

エレメントエディット － モディファイアの機能

モジュレーター�
6種類の信号から�
1つを選択�

キャリア�
6種類の信号から�
1つを選択�

モジュレーターによって�
キャリアが変調される�

ドライバー音、パイプ／ストリング音、�
タップ音がミキシングされた音＝ Normal

Wet / Dry�
Balance
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Flow Rate Saturation

マウスピースとリードの間隙の両側の圧力が異なるとき、管を空気が流れま
す。しかし、その圧力差が大きくなるにしたがって、流量が飽和する特性があ
ります。この特性を示す信号です。

Beat

振動するリードが、マウスピースにぶつかるとき生じる信号です。

Slit / Friction

振動するリードとマウスピースとのすきまの面積を示す信号です。

Reed

リードのしなり具合を示す信号です。非常に強くローパスフィルターがかかっ
たような信号です。

・ハイパスフィルターカットオフ（HPF Cutoff）では、ハイパスフィルター（低い周波
数域をカットするフィルター）のカットオフ周波数を設定します。ここで指定した
周波数以下のキャリアの信号がカットされます。

・オーバードライブ（Over Drive）では、キャリアの信号の歪みを設定します。数値を
上げるほど歪みが大きくなります。ただし、1.0以下の設定では歪みません。

・レベル（Level）では、キャリアの出力レベルを設定します。数値が大きいほど、
キャリアの信号が大きくなります。

・バランス（Balance）では、キャリアとモジュレーターによって作り出されたハーモ
ニックエンハンサーの音を、オリジナル音にどれだけ混ぜるかを設定します。数値
が大きくなるほど（グラフの「Wet」側に近付くほど）、ハーモニックエンハンサー
音の割合が増します。また、この数値はモジュレーターの画面の「Balance」の数値
と連動しています。
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エレメントエディット － モディファイアの機能

・設定部分の右側に のマークが付いている項目は、キースケール（音階）によって
設定をコントロールできる項目です。これらの項目が反転表示されているときに
は、 F7 （KSC）または ENTER を押すことで、キースケールを設定する画面に進
むことができます。画面の移動は、次のように行われます。（バランスのキースケー
ルには、キャリア、モジュレーターのどちらの設定画面からでも入ることができま
す）

　HPF Cutoff → F7 （ EXIT で戻る）→  キャリアHPF KSC （→ P. 137）

F7 ↓ ↑ F6

　Over Drive → F7 （ EXIT で戻る）→  キャリアオーバードライブKSC （→ P. 138）

F7 ↓ ↑ F6

　Level → F7 （ EXIT で戻る）→  キャリアレベルKSC （→ P. 139）

F7 ↓ ↑ F6

　  モジュレーターHPF KSC （→ P. 143）

F7 ↓ ↑ F6

　  モジュレーターオーバードライブKSC （→ P. 144）

F7 ↓ ↑ F6

 モジュレーターインデックスKSC （→ P. 145）

F7 ↓ ↑ F6

　Balance → F7 （ EXIT で戻る）→  バランスKSC （→ P. 146）

・ F8 （Ctrl）を押すと、ハーモニックエンハンサーのバランスをコントロールす
るコントローラーを設定するための画面（コントローラーのハーモニックエンハン
サー）に移動することができます。（→ P. 107）

参　考

・サックスのバリバリした音を作りたいとき、キャリアで「Beat」を選択し、バランスを調節す
ると、非常にリアルな音色が得られます。

・生楽器をシミュレーションする場合には、次の2種類のアプローチをお試しください。
　キャリア：ノーマル モジュレーター：ノーマル以外
　 この場合は、ウェット／ドライバランスを100%にして、Indexの値を上げてください。
　キャリア：ノーマル以外 モジュレーター：6種類のどれでも可
　 この場合は、ウェット／ドライバランスを調節して、Indexの値を下げてください。

・キャリアとして「Normal」を選んだ場合には、モジュレーターのインデックスを上げないと
意味がありません。

・ハーモニックエンハンサーをコントローラーに割り当てた場合、この画面のバランスの項目
で設定されている値を上限値として、「-64（全部Dry）」～「上限値」の範囲でバランスをコン
トロールすることができます。
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EDIT / E1 or E2 / MODIFIER / HARMONIC ENHANCER / KSC：ハーモニックエンハンサーKSC（キャリアHPF）

EDIT  → F2 （E1）または F3 （E2）→ F3 （Modi）→ 1: Harmonic Enhancer → ENTER  → F1 （Crr）→ HPF Cutoff → F7 （KSC）

ハーモニックエンハンサーのキャリアのハイパスフィルターカットオフキースケールを設定します。

CrrHPF 17.0 Hz ～ 11.2 kHz
BP1、2の音程 C-2 ～ G8
BP1、2の変化幅 -64 ～ 63

解　説

・ハーモニックエンハンサーのキャリアのハイパスフィルターカットオフフリケン
シーを、キースケール（音階）で変化させるための設定を行います。

・キャリアハイパスフィルター（CrrHPF）では、ハイパスフィルターのカットオフフ
リケンシーを設定します。この数値は、キースケール設定に入る前の、キャリア設
定画面の「HPF Cutoff」の数値と連動しています。また、この数値がブレークポイン
トの基準値となります。

・カットオフフリケンシーキースケールは、2つのブレークポイント（BP）で設定しま
す。各ブレークポイントは、「音程」と「基準値からの変化量」で設定します。（→ P.
33）

・画面には、音程による変化幅を示すグラフが表示されます。横軸が音程、縦軸が
カットオフフリケンシーです。点線の横線は「CrrHPF」の設定値（基準値）を示しま
す。

・各ブレークポイントの音程の部分が反転表示になっているときには、鍵盤を使って
音程を入力することができます。 F8 （Kbd）を押した後、MIDIキーボードの任
意の鍵盤を弾いてください。

注　意

・ブレークポイント1、2は、順番に音程が上がっていくようにしか設定できません。
・基準値に変化幅を加えた値が、設定範囲（グラフの下端から上端までの範囲）を超
える場合には、最小または最大の設定値となります。

参　考

・ F7 （FPag: Forward Page）を押すと、キャリアオーバードライブのキースケール設定画
面に移ります。

エレメントエディット － モディファイアの機能
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EDIT / E1 or E2 / MODIFIER / HARMONIC ENHANCER / KSC：ハーモニックエンハンサーKSC（キャリアオーバードライブ）

EDIT  → F2 （E1）または F3 （E2）→ F3 （Modi）→ 1: Harmonic Enhancer → ENTER  → F1 （Crr）→ Over drive → F7 （KSC）

ハーモニックエンハンサーのキャリアのオーバードライブのキースケールを設定します。

CrrOvr 0.063 ～ 15.31
BP1、2の音程 C-2 ～ G8
BP1、2の変化幅 -64 ～ 63

解　説

・ハーモニックエンハンサーのキャリアのオーバードライブを、キースケール（音
階）で変化させるための設定を行います。

・キャリアオーバードライブ（CrrOvr）では、オーバードライブを設定します。この数
値は、キースケール設定に入る前の、キャリア設定画面の「Over Drive」の数値と連
動しています。また、この数値がブレークポイントの基準値となります。

・オーバードライブキースケールは、2つのブレークポイント（BP）で設定します。各
ブレークポイントは、「音程」と「基準値からの変化量」で設定します。（→ P. 33）

・画面には、音程による変化幅を示すグラフが表示されます。横軸が音程、縦軸が
オーバードライブです。点線の横線は「CrrOvr」の設定値（基準値）を示します。

・各ブレークポイントの音程の部分が反転表示になっているときには、鍵盤を使って
音程を入力することができます。 F8 （Kbd）を押した後、MIDIキーボードの任
意の鍵盤を弾いてください。

注　意

・ブレークポイント1、2は、順番に音程が上がっていくようにしか設定できません。
・基準値に変化幅を加えた値が、設定範囲（グラフの下端から上端までの範囲）を超
える場合には、最小または最大の設定値となります。

参　考

・ F6 （BPag: Backward Page）を押すと、キャリアハイパスフィルターカットオフのキース
ケール設定画面に移ります。

・ F7 （FPag: Forward Page）を押すと、キャリアレベルのキースケール設定画面に移りま
す。

エレメントエディット － モディファイアの機能
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EDIT / E1 or E2 / MODIFIER / HARMONIC ENHANCER / KSC：ハーモニックエンハンサーKSC（キャリアレベル）

EDIT  → F2 （E1）または F3 （E2）→ F3 （Modi）→ 1: Harmonic Enhancer → ENTER  → F1 （Crr）→ Level → F7 （KSC）

ハーモニックエンハンサーのキャリアのレベルキースケールを設定します。

CrrLvl 0 ～ 127
BP1 ～ 4の音程 C-2 ～ G8
BP1 ～ 4の変化幅 -64 ～ 63

解　説

・ハーモニックエンハンサーのキャリアのレベルを、キースケール（音階）で変化さ
せるための設定を行います。

・キャリアレベル（CrrLvl）では、キャリアの出力レベルを設定します。この数値は、
キースケール設定に入る前の、キャリア設定画面の「Level」の数値と連動していま
す。また、この数値がブレークポイントの基準値となります。

・レベルのキースケールは、4つのブレークポイント（BP）で設定します。各ブレーク
ポイントは、「音程」と「基準値からの変化量」で設定します。（→ P. 33）

・画面には、音程による変化幅を示すグラフが表示されます。横軸が音程、縦軸がレ
ベルです。点線の横線は「CrrLvl」の設定値（基準値）を示します。

・各ブレークポイントの音程の部分が反転表示になっているときには、鍵盤を使って
音程を入力することができます。 F8 （Kbd）を押した後、MIDIキーボードの任
意の鍵盤を弾いてください。

注　意

・ブレークポイント1～4は、順番に音程が上がっていくようにしか設定できません。
・基準値に変化幅を加えた値が、設定範囲（グラフの下端から上端までの範囲）を超
える場合には、最小または最大の設定値となります。

参　考

・ F6 （BPag: Backward Page）を押すと、キャリアのオーバードライブのキースケール設定
画面に移ります。

・ F7 （FPag: Forward Page）を押すと、モジュレーターのハイパスフィルターカットオフ
のキースケール設定画面に移ります。

エレメントエディット － モディファイアの機能
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EDIT / E1 or E2 / MODIFIER / HARMONIC ENHANCER（Modulator）：ハーモニックエンハンサー（モジュレーター）

EDIT  → F2 （E1）または F3 （E2）→ F3 （Modi）→ 1: Harmonic Enhancer → ENTER  → F2 （Mod）

ハーモニックエンハンサーのモジュレーターを設定します。

Signal Select Normal, Breath Noise Amp.,
Flow Rate Saturation, Beat,
Slit/Friction, Reed

HPF Cutoff 17.0 Hz ～ 11.2 kHz
Over Drive 0.063 ～ 15.31
Phase 0 ～ 360 deg
Index 0 ～ 127
Balance -64 ～ 63

解　説

・ハーモニックエンハンサーは、ドライバーやパイプ／ストリングから送られた信号
をもとに、キャリアとモジュレーターを設定することで、倍音を豊かにしたり、
オーバードライブ的な効果を作り出す機能です。

・キャリアとモジュレーターの切り換えには、 F1 （Crr）と F2 （Mod）を使い
ます。

・ここでは、モジュレーター（キャリアに対して働きかける信号）の設定を行います。
・シグナルセレクト（Signal Select）では、モジュレーターとして使う信号を次の中か
ら選択します。

Normal

ミスレイニアスのミキシング（→ P. 125）で設定したミキシング出力（ドライ
バー音、パイプ／ストリング音、タップ音をミキシングした信号）です。

Breath Noise Amp.

ブレスノイズの振幅を計算した結果を示す信号です。後述の「Slit/Friction」が
大きく歪んだ信号ともいえます。ただし、ブレスノイズの「Slit Drive」が0より
大きな値になっていないと音が出ません。（→ P. 113）

Flow Rate Saturation

マウスピースとリードの間隙の両側の圧力が異なるとき、管を空気が流れま
す。しかし、その圧力差が大きくなるにしたがって、流量が飽和する特性があ
ります。この特性を示す信号です。

Beat

振動するリードが、マウスピースにぶつかるとき生じる信号です。

Slit / Friction

振動するリードとマウスピースとのすきまの面積を示す信号です。
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Reed

リードのしなり具合を示す信号です。非常に強くローパスフィルターがかかっ
たような信号です。

・ハイパスフィルターカットオフ（HPF Cutoff）では、ハイパスフィルター（低い周波
数域をカットするフィルター）のカットオフ周波数を設定します。ここで指定した
周波数以下のモジュレーターの信号がカットされます。

・オーバードライブ（Over Drive）では、モジュレーターの信号の歪みを設定します。
数値を上げるほど歪みが大きくなります。ただし、1.0以下の設定では歪みません。

・フェイズ（Phase）では、キャリアとモジュレーターの信号の位相差（フェイズ）を
選択します。この数値を変更することで、より大きな倍音変化を生み出すことがで
きます。

・インデックス（Index）では、キャリアへの効果の与え具合を設定します。数値が大
きいほど、キャリアに対するモジュレーターの効果が大きくなります。

・バランス（Balance）では、キャリアとモジュレーターによって作り出されたハーモ
ニックエンハンサーの音を、オリジナル音にどれだけ混ぜるかを設定します。数値
が大きくなるほど（グラフの「Wet」側に近付くほど）、ハーモニックエンハンサー
音の割合が増します。また、この数値はキャリアの画面の「Balance」の数値と連動
しています。

・設定部分の右側に のマークが付いている項目は、キースケール（音階）によって
設定をコントロールできる項目です。これらの項目が反転表示されているときに
は、 F7 （KSC）または ENTER を押すことで、キースケールを設定する画面に進
むことができます。画面の移動は、次のように行われます。（バランスのキースケー
ルには、キャリア、モジュレーターのどちらの設定画面からでも入ることができま
す）

 キャリアHPF KSC （→ P. 137）

F7 ↓ ↑ F6

 キャリアオーバードライブKSC （→ P. 138）

F7 ↓ ↑ F6

キャリアレベルKSC （→ P. 139）

F7 ↓ ↑ F6

　HPF Cutoff → F7 （ EXIT で戻る）→  モジュレーターHPF KSC （→ P. 143）

F7 ↓ ↑ F6

　Over Drive → F7 （ EXIT で戻る）→  モジュレーターオーバードライブKSC （→ P. 144）

F7 ↓ ↑ F6

　Index → F7 （ EXIT で戻る）→  モジュレーターインデックスKSC （→ P. 145）

F7 ↓ ↑ F6

　Balance → F7 （ EXIT で戻る）→  バランスKSC （→ P. 146）
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・ F8 （Ctrl）を押すと、ハーモニックエンハンサーのバランスをコントロールす
るコントローラーを設定するための画面（コントローラーのハーモニックエンハン
サー）に移動することができます。（→ P. 107）

参　考

・ハーモニックエンハンサーをコントローラーに割り当てた場合、この画面のバランスの項目
で設定されている値を上限値として、「-64（全部Dry）」～「上限値」の範囲でバランスをコン
トロールすることができます。
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エレメントエディット － モディファイアの機能

EDIT / E1 or E2 / MODIFIER / HARMONIC ENHANCER / KSC：ハーモニックエンハンサーKSC（モジュレーターHPF）

EDIT  → F2 （E1）または F3 （E2）→ F3 （Modi）→ 1: Harmonic Enhancer → ENTER  → F2 （Mod）→ HPF Cutoff → F7 （KSC）

ハーモニックエンハンサーのモジュレーターのハイパスフィルターカットオフキースケールを設定します。

ModHPF 17.0 Hz ～ 11.2 kHz
BP1、2の音程 C-2 ～ G8
BP1、2の変化幅 -64 ～ 63

解　説

・ハーモニックエンハンサーのモジュレーターのハイパスフィルターカットオフフリ
ケンシーを、キースケール（音階）で変化させるための設定を行います。

・モジュレーターハイパスフィルター（ModHPF）では、ハイパスフィルターのカッ
トオフフリケンシーを設定します。この数値は、キースケール設定に入る前の、モ
ジュレーター設定画面の「HPF Cutoff」の数値と連動しています。また、この数値が
ブレークポイントの基準値となります。

・カットオフフリケンシーキースケールは、2つのブレークポイント（BP）で設定しま
す。各ブレークポイントは、「音程」と「基準値からの変化量」で設定します。（→ P.
33）

・画面には、音程による変化幅を示すグラフが表示されます。横軸が音程、縦軸が
カットオフフリケンシーです。点線の横線は「ModHPF」の設定値（基準値）を示し
ます。

・各ブレークポイントの音程の部分が反転表示になっているときには、鍵盤を使って
音程を入力することができます。 F8 （Kbd）を押した後、MIDIキーボードの任
意の鍵盤を弾いてください。

注　意

・ブレークポイント1、2は、順番に音程が上がっていくようにしか設定できません。
・基準値に変化幅を加えた値が、設定範囲（グラフの下端から上端までの範囲）を超
える場合には、最小または最大の設定値となります。

参　考

・ F6 （BPag: Backward Page）を押すと、キャリアレベルのキースケール設定画面に移りま
す。

・ F7 （FPag: Forward Page）を押すと、モジュレーターオーバードライブのキースケール
設定画面に移ります。
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エレメントエディット － モディファイアの機能

EDIT / E1 or E2 / MODIFIER / HARMONIC ENHANCER / KSC：ハーモニックエンハンサーKSC（モジュレーターオーバードライブ）

EDIT  → F2 （E1）または F3 （E2）→ F3 （Modi）→ 1: Harmonic Enhancer → ENTER  → F2 （Mod）→ Over Drive → F7 （KSC）

ハーモニックエンハンサーのモジュレーターのオーバードライブキースケールを設定します。

ModOvr 0.063 ～ 15.31
BP1、2の音程 C-2 ～ G8
BP1、2の変化幅 -64 ～ 63

解　説

・ハーモニックエンハンサーのモジュレーターのオーバードライブを、キースケール
（音階）で変化させるための設定を行います。

・モジュレーターオーバードライブ（ModOvr）では、オーバードライブを設定しま
す。この数値は、キースケール設定に入る前の、モジュレーター設定画面の「Over
Drive」の数値と連動しています。また、この数値がブレークポイントの基準値とな
ります。

・オーバードライブキースケールは、2つのブレークポイント（BP）で設定します。各
ブレークポイントは、「音程」と「基準値からの変化量」で設定します。（→ P. 33）

・画面には、音程による変化幅を示すグラフが表示されます。横軸が音程、縦軸が
オーバードライブです。点線の横線は「ModOvr」の設定値（基準値）を示します。

・各ブレークポイントの音程の部分が反転表示になっているときには、鍵盤を使って
音程を入力することができます。 F8 （Kbd）を押した後、MIDIキーボードの任
意の鍵盤を弾いてください。

注　意

・ブレークポイント1、2は、順番に音程が上がっていくようにしか設定できません。
・基準値に変化幅を加えた値が、設定範囲（グラフの下端から上端までの範囲）を超
える場合には、最小または最大の設定値となります。

参　考

・ F6 （BPag: Backward Page）を押すと、モジュレーターハイパスフィルターカットオフの
キースケール設定画面に移ります。

・ F7 （FPag: Forward Page）を押すと、インデックスのキースケール設定画面に移ります。
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エレメントエディット － モディファイアの機能

EDIT / E1 or E2 / MODIFIER / HARMONIC ENHANCER / KSC：ハーモニックエンハンサーKSC（インデックス）

EDIT  → F2 （E1）または F3 （E2）→ F3 （Modi）→ 1: Harmonic Enhancer → ENTER  → F2 （Mod）→ Index → F7 （KSC）

ハーモニックエンハンサーのモジュレーターインデックスキースケールを設定します。

ModIdx 0 ～ 127
BP1 ～ 4の音程 C-2 ～ G8
BP1 ～ 4の変化幅 -64 ～ 63

解　説

・ハーモニックエンハンサーのモジュレーターインデックスを、キースケール（音
階）で変化させるための設定を行います。

・モジュレーターインデックス（ModIdx）では、モジュレーターのインデックスを設
定します。この数値は、キースケール設定に入る前の、モジュレーター設定画面の
「Index」の数値と連動しています。また、この数値がブレークポイントの基準値と
なります。

・インデックスキースケールは、4つのブレークポイント（BP）で設定します。各ブ
レークポイントは、「音程」と「基準値からの変化量」で設定します。（→ P. 33）

・画面には、音程による変化幅を示すグラフが表示されます。横軸が音程、縦軸がレ
ベルです。点線の横線は「ModIdx」の設定値（基準値）を示します。

・各ブレークポイントの音程の部分が反転表示になっているときには、鍵盤を使って
音程を入力することができます。 F8 （Kbd）を押した後、MIDIキーボードの任
意の鍵盤を弾いてください。

注　意

・ブレークポイント1～4は、順番に音程が上がっていくようにしか設定できません。
・基準値に変化幅を加えた値が、設定範囲（グラフの下端から上端までの範囲）を超
える場合には、最小または最大の設定値となります。

参　考

・ F6 （BPag: Backward Page）を押すと、モジュレーターオーバードライブのキースケール
設定画面に移ります。

・ F7 （FPag: Forward Page）を押すと、バランスのキースケール設定画面に移ります。
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EDIT / E1 or E2 / MODIFIER / HARMONIC ENHANCER / KSC：ハーモニックエンハンサーKSC（バランス）

EDIT  → F2 （E1）または F3 （E2）→ F3 （Modi）→ 1: Harmonic Enhancer → ENTER  → F1 （Crr）または F2 （Mod）→ Balance → F7 （KSC）

ハーモニックエンハンサーのウェット／ドライバランスのキースケールを設定します。

Balance -64 ～ 63
BP1、2の音程 C-2 ～ G8
BP1、2の変化幅 -64 ～ 63

解　説

・ハーモニックエンハンサーのキャリア／モジュレーターによって生じる音とノーマ
ル音とのバランスを、キースケール（音階）で変化させるための設定を行います。

・バランス（Balance）では、ウェット／ドライバランスを設定します。この数値は、
キースケール設定に入る前の、キャリアおよびモジュレーター設定画面の
「Balance」の数値と連動しています。また、この数値がブレークポイントの基準値
となります。

・バランスは、2つのブレークポイント（BP）で設定します。各ブレークポイントは、
「音程」と「基準値からの変化量」で設定します。（→ P. 33）

・画面には、音程による変化幅を示すグラフが表示されます。横軸が音程、縦軸がバ
ランスです。点線の横線は「Balance」の設定値（基準値）を示します。

・各ブレークポイントの音程の部分が反転表示になっているときには、鍵盤を使って
音程を入力することができます。 F8 （Kbd）を押した後、MIDIキーボードの任
意の鍵盤を弾いてください。

注　意

・ブレークポイント1、2は、順番に音程が上がっていくようにしか設定できません。
・基準値に変化幅を加えた値が、設定範囲（グラフの下端から上端までの範囲）を超
える場合には、最小または最大の設定値となります。

参　考

・ F6 （BPag: Backward Page）を押すと、モジュレーターインデックスのキースケール設定
画面に移ります。

エレメントエディット － モディファイアの機能
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エレメントエディット － モディファイアの機能

EDIT / E1 or E2 / MODIFIER / DYNAMIC FILTER：ダイナミックフィルター

EDIT  → F2 （E1）または F3 （E2）→ F3 （Modi）→ 2: Dynamic Filter → ENTER

ダイナミックフィルターを設定します。

Filter Mode LPF, BPF, HPF, BEF
Input Gain 0 ～ 127
Balance -64 ～ 63
Cutoff Tracking Fixed, KeyTrack
Cutoff Freq. 26.9 Hz ～ 11.9 kHz（Fixedの場合）

-4.00 ～ 3.94 oct（KeyTrackの場合）
Resonance 1.00 ～ 15.67

解　説

・任意の周波数帯域をカットするためのダイナミックフィルターを設定します。

・フィルターモード（Filter Mode）では、使用するフィルターのタイプを選択します。
ローパスフィルター（LPF）は、カットオフフリケンシーで指定した周波数より上の
音をカットするフィルターです。バンドパスフィルター（BPF）は、カットオフフリ
ケンシーで指定した周波数を残し、その上下の音をカットするフィルターです。ハ
イパスフィルター（HPF）は、カットオフフリケンシーで指定した周波数より下の
音をカットするフィルターです。バンドエリミネートフィルター（BEF）は、カット
オフフリケンシーで指定した周波数だけをカットし、その上下の音を残すフィル
ターです。

・インプットゲイン（Input Gain）では、ダイナミックフィルターに入力する音量を設
定します。数値が大きいほど、入力レベルが上がります。

・バランス（Balance）では、ダイナミックフィルターを通した音を、オリジナル音に
どれだけ混ぜるかを設定します。数値が大きくなるほど（グラフの「Wet」側に近付
くほど）、ダイナミックフィルターを通した音の割合が増します。

・カットオフトラッキング（Cutoff Tracking）では、フィルターのカットオフ周波数を
固定するか、音程に合わせて変化させるかを選択します。固定する場合には
「Fixed」を選択します。音程に合わせて変化させる場合には「KeyTrack」を選択し
ます。

・カットオフフリケンシー（Cutoff Freq.）では、フィルターのカットオフ周波数を設
定します。カットオフトラッキングで「Fixed」を選択した場合には、カットオフの
周波数を設定します。「KeyTrack」を選択した場合には、鍵盤の音程に対するオク
ターブでカットオフ周波数を設定します。

・レゾナンス（Resonance）は、フィルターのかかり具合を強調するための機能です。
この数値を大きくするほど、カットオフフリケンシー近辺の周波数帯域が誇張さ
れ、より強いフィルター効果を付けることができます。



148　　第4章　エディットモード － エレメントエディット

・設定部分の右側に のマークが付いている項目は、キースケール（音階）によって
設定をコントロールできる項目です。これらの項目が反転表示されているときに
は、 F7 （KSC）または ENTER を押すことで、キースケールを設定する画面に進
むことができます。画面の移動は、次のように行われます。

　Cutoff Freq → F7 （ EXIT で戻る）→  カットオフ KSC （→ P. 149）

F7 ↓ ↑ F6

　Resonance → F7 （ EXIT で戻る）→  レゾナンスKSC （→ P. 150）

・ F8 （Ctrl）を押すと、ダイナミックフィルターをコントロールするコントロー
ラーを設定するための画面（コントローラーのダイナミックフィルター（→P.
106））に移動することができます。

参　考

・各フィルターのスロープは、BPF、BEFで「-6dB/oct」、LPF、HPFで「-12dB/oct」です。
・ウェット／ドライバランスをうまく調節することで、軽くフィルターをかけることも可能で
す。

・比較的こもった、柔らかい音を作りたいときは、カットオフトラッキングで「KeyTrack」を選
択し、カットオフフリケンシーで基音に近い（0オクターブに近い）値を設定すると効果的で
す。

エレメントエディット － モディファイアの機能
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エレメントエディット － モディファイアの機能

EDIT / E1 or E2 / MODIFIER / DYNAMIC FILTER / KSC：ダイナミックフィルターKSC（カットオフ）

EDIT  → F2 （E1）または F3 （E2）→ F3 （Modi）→ 2: Dynamic Filter → ENTER  → Cutoff Freq. → F7 （KSC）

ダイナミックフィルターのカットオフフリケンシーのキースケールを設定します。

Cutoff 26.9 Hz ～ 11.9 kHz（Fixedの場合）
-4.00 ～ 3.94 oct（KeyTrackの場合）

BP1 ～ 3の音程 C-2 ～ G8
BP1 ～ 3の変化幅 -64 ～ 63

解　説

・ダイナミックフィルターのカットオフフリケンシーを、キースケール（音階）で変
化させるための設定を行います。

・カットオフ（Cutoff）では、カットオフの周波数を設定します。この数値は、キース
ケール設定に入る前の、ダイナミックフィルター設定画面の「Cutoff Freq.」の数値
と連動しています。また、この数値がブレークポイントの基準値となります。

・カットオフフリケンシーキースケールは、3つのブレークポイント（BP）で設定しま
す。各ブレークポイントは、「音程」と「基準値からの変化量」で設定します。（→ P.
33）

・画面には、音程による変化幅を示すグラフが表示されます。横軸が音程、縦軸が
カットオフフリケンシーです。点線の横線は「Cutoff」の設定値（基準値）を示しま
す。

・各ブレークポイントの音程の部分が反転表示になっているときには、鍵盤を使って
音程を入力することができます。 F8 （Kbd）を押した後、MIDIキーボードの任
意の鍵盤を弾いてください。

注　意

・ブレークポイント1～3は、順番に音程が上がっていくようにしか設定できません。
・基準値に変化幅を加えた値が、設定範囲（グラフの下端から上端までの範囲）を超
える場合には、最小または最大の設定値となります。

参　考

・ F7 （FPag: Forward Page）を押すと、レゾナンスのキースケール設定画面に移ります。
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エレメントエディット － モディファイアの機能

EDIT / E1 or E2 / MODIFIER / DYNAMIC FILTER / KSC：ダイナミックフィルターKSC（レゾナンス）

EDIT  → F2 （E1）または F3 （E2）→ F3 （Modi）→ 2: Dynamic Filter → ENTER  → Resonance → F7 （KSC）

ダイナミックフィルターのレゾナンスのキースケールを設定します。

Rez 1.00 ～ 15.67
BP1 ～ 3の音程 C-2 ～ G8
BP1 ～ 3の変化幅 -64 ～ 63

解　説

・ダイナミックフィルターのレゾナンスを、キースケール（音階）で変化させるため
の設定を行います。

・レゾナンス（Rez）では、レゾナンスを設定します。この数値は、キースケール設定
に入る前の、ダイナミックフィルター設定画面の「Resonance」の数値と連動してい
ます。また、この数値がブレークポイントの基準値となります。

・レゾナンスキースケールは、3つのブレークポイント（BP）で設定します。各ブレー
クポイントは、「音程」と「基準値からの変化量」で設定します。（→ P. 33）

・画面には、音程による変化幅を示すグラフが表示されます。横軸が音程、縦軸がレ
ゾナンスです。点線の横線は「Rez」の設定値（基準値）を示します。

・各ブレークポイントの音程の部分が反転表示になっているときには、鍵盤を使って
音程を入力することができます。 F8 （Kbd）を押した後、MIDIキーボードの任
意の鍵盤を弾いてください。

注　意

・ブレークポイント1～3は、順番に音程が上がっていくようにしか設定できません。
・基準値に変化幅を加えた値が、設定範囲（グラフの下端から上端までの範囲）を超
える場合には、最小または最大の設定値となります。

参　考

・ F6 （BPag: Backward Page）を押すと、カットオフフリケンシーのキースケール設定画面
に移ります。
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EDIT / E1 or E2 / MODIFIER / EQUALIZER AUXILIARY：イコライザーオグジリアリー

EDIT  → F2 （E1）または F3 （E2）→ F3 （Modi）→ 3: Equaizer Auxilry → ENTER

イコライザーを設定します。

Input Gain 0 ～ 127
HPF Cutoff Freq. 17.0 Hz ～ 11.2 kHz
LPF Cutoff Freq. 31.1 Hz ～ 24.0 kHz

解　説

・イコライザー（Auxiliary：オグジリアリーは「補助的な」という意味）を設定しま
す。

・インプットゲイン（Input Gain）では、イコライザーに入力する音量を設定します。
数値が大きいほど、入力レベルが上がります。

・ハイパスフィルターカットオフフリケンシー（HPF Cutoff Freq.）では、ハイパス
フィルター（低音域をカットするフィルター）の周波数を設定します。この周波数
以下の音がカットされます。

・ローパスフィルターカットオフフリケンシー（LPF Cutoff Freq.）では、ローパス
フィルター（高音域をカットするフィルター）の周波数を設定します。この周波数
以上の音がカットされます。

・設定部分の右側に のマークが付いている項目は、キースケール（音階）によって
設定をコントロールできる項目です。これらの項目が反転表示されているときに
は、 F7 （KSC）または ENTER を押すことで、キースケールを設定する画面に進
むことができます。画面の移動は、次のように行われます。

　HPF Cutoff Freq → F7 （ EXIT で戻る）→  HPF KSC （→ P. 152）

F7 ↓ ↑ F6

　LPF Cutoff Freq → F7 （ EXIT で戻る）→  LPF KSC （→ P. 153）

エレメントエディット － モディファイアの機能
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エレメントエディット － モディファイアの機能

EDIT / E1 or E2 / MODIFIER / EQUALIZER AUXILIARY / KSC：イコライザーオグジリアリーKSC（HPF）

EDIT  → F2 （E1）または F3 （E2）→ F3 （Modi）→ 3: Equaizer Auxilry → ENTER  → HPF Cutoff Freq. → F7 （KSC）

イコライザーのハイパスフィルターカットオフフリケンシーのキースケールを設定します。

HPF 17.0 Hz ～ 11.2 kHz
BP1 ～ 3の音程 C-2 ～ G8
BP1 ～ 3の変化幅 -64 ～ 63

解　説

・ハイパスフィルターのカットオフフリケンシーを、キースケール（音階）で変化さ
せるための設定を行います。

・ハイパスフィルター（HPF）では、ハイパスフィルターのカットオフフリケンシー
を設定します。この数値は、キースケール設定に入る前の、イコライザー設定画面
の「HPF Cutoff Freq.」の数値と連動しています。また、この数値がブレークポイン
トの基準値となります。

・カットオフフリケンシーキースケールは、3つのブレークポイント（BP）で設定しま
す。各ブレークポイントは、「音程」と「基準値からの変化量」で設定します。（→ P.
33）

・画面には、音程による変化幅を示すグラフが表示されます。横軸が音程、縦軸が
カットオフフリケンシーです。点線の横線は「HPF」の設定値（基準値）を示しま
す。

・各ブレークポイントの音程の部分が反転表示になっているときには、鍵盤を使って
音程を入力することができます。 F8 （Kbd）を押した後、MIDIキーボードの任
意の鍵盤を弾いてください。

注　意

・ブレークポイント1～3は、順番に音程が上がっていくようにしか設定できません。
・基準値に変化幅を加えた値が、設定範囲（グラフの下端から上端までの範囲）を超
える場合には、最小または最大の設定値となります。

参　考

・ F7 （FPag: Forward Page）を押すと、ローパスフィルターのカットオフフリケンシーの
キースケール設定画面に移ります。
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EDIT / E1 or E2 / MODIFIER / EQUALIZER AUXILIARY / KSC：イコライザーオグジリアリーKSC（LPF）

EDIT  → F2 （E1）または F3 （E2）→ F3 （Modi）→ 3: Equaizer Auxilry → ENTER  → LPF Cutoff Freq. → F7 （KSC）

イコライザーのローパスフィルターカットオフフリケンシーのキースケールを設定します。

LPF 31.1 Hz ～ 24.0 kHz
BP1 ～ 3の音程 C-2 ～ G8
BP1 ～ 3の変化幅 -64 ～ 63

解　説

・ローパスフィルターのカットオフフリケンシーを、キースケール（音階）で変化さ
せるための設定を行います。

・ローパスフィルター（LPF）では、ローパスフィルターのカットオフフリケンシーを
設定します。この数値は、キースケール設定に入る前の、イコライザー設定画面の
「LPF Cutoff Freq.」の数値と連動しています。また、この数値がブレークポイント
の基準値となります。

・カットオフフリケンシーキースケールは、3つのブレークポイント（BP）で設定しま
す。各ブレークポイントは、「音程」と「基準値からの変化量」で設定します。（→ P.
33）

・画面には、音程による変化幅を示すグラフが表示されます。横軸が音程、縦軸が
カットオフフリケンシーです。点線の横線は「LPF」の設定値（基準値）を示しま
す。

・各ブレークポイントの音程の部分が反転表示になっているときには、鍵盤を使って
音程を入力することができます。 F8 （Kbd）を押した後、MIDIキーボードの任
意の鍵盤を弾いてください。

注　意

・ブレークポイント1～3は、順番に音程が上がっていくようにしか設定できません。
・基準値に変化幅を加えた値が、設定範囲（グラフの下端から上端までの範囲）を超
える場合には、最小または最大の設定値となります。

参　考

・ F6 （BPag: Backward Page）を押すと、ハイパスフィルターのカットオフフリケンシーの
キースケール設定画面に移ります。



154　　第4章　エディットモード － エレメントエディット

エレメントエディット － モディファイアの機能

EDIT / E1 or E2 / MODIFIER / EQUALIZER BAND：イコライザーバンド

EDIT  → F2 （E1）または F3 （E2）→ F3 （Modi）→ 4: Equalizer Band → ENTER

バンドイコライザーを設定します。

Bnd1   Freq 40.0 ～ 321.0 Hz
Bnd2   Freq 104.0 ～ 838.0 Hz
Bnd3   Freq 248.0 Hz ～ 2.00 kHz
Bnd4   Freq 646.0 Hz ～ 5.21 kHz
Bnd5   Freq 1.54 ～ 10 kHz
Bnd1 ～ 5    Q 0.5 ～ 20.0
Bnd1 ～ 5    Level -24.0 ～ 23.6

解　説

・イコライザーバンドは、一般的にパラメトリックイコライザーと呼ばれるもので、
任意の周波数帯域を強調（ブースト）したり、減衰（カット）させたりする機能で
す。本機には、5素子のパラメトリックイコライザーが内蔵されています。

・バンド1～5フリケンシー（Bnd1～5 Freq）では、それぞれのバンドイコライザーの
周波数ポイントを設定します。

・Q（Bnd1～5 Q）では、強調、減衰を行う幅（帯域幅）を設定します。Qを大きくする
ほど、バンドフリケンシーを中心にしたせまい帯域でイコライズが行われます。逆
にQを小さくすると、バンドフリケンシーを中心にした広い帯域でイコライズが行
われます。

・レベル（Bnd1～5 Level）では、設定されたフリケンシーの帯域を、どのくらい強調
するか、あるいは減衰させるかを設定します。プラスの数値の場合には強調に、マ
イナスの場合は減衰になります。
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EDIT / E1 or E2 / MODIFIER / IE & RSN SETTING：インパルスエキスパンダー＆レゾネーターセッティング

EDIT  → F2 （E1）または F3 （E2）→ F3 （Modi）→ 5: IE & RSN Setting → ENTER

インパルスエキスパンダー、レゾネーターのオン／オフおよび各種レベルを設定します。

IE off, on
RSN off, on
以下の項目は、上記のon, offにより変化します
Dry Level 0 ～ 127
IE Wet Level 0 ～ 127
IE Level Bal -64 ～ 63
RSN Inp Gain 0 ～ 127
RSN Wet Level 0 ～ 127
RSN Level Bal -64 ～ 63

解　説

・インパルスエキスパンダー＆レゾネーターセッティングでは、インパルスエキスパ
ンダーとレゾネーターという2つのエフェクトそれぞれのオン／オフや入出力のバ
ランスなどを設定します。インパルスエキスパンダー、レゾネーターは、管楽器や
弦楽器の「管」あるいは「胴」の共鳴などのクセを再現するためのエフェクトです。

・「IE」と表示されている四角が、インパルスエキスパンダーを示し、「on」または
「off」の切り換えができます。

・「RSN」と表示されている四角が、レゾネーターを示し、「on」または「off」の切り
換えができます。

・ドライレベル（Dry Level）では、インパルスエキスパンダー、レゾネーターを通す
前の音をエレメント出力にどれだけ混ぜるかを設定します。この音は常にセンター
に定位します。数値が大きいほど、混ぜるレベルが大きくなります。

IE�
インパルスエキスパンダー�

RSN�
レゾネーター�

Dry Level

IE Wet Level
IE Level Bal

RSN Inp Gain RSN Wet Level

RSN Level Bal
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・インパルスエキスパンダーウェットレベル（IE Wet Level）では、インパルスエキス
パンダーを通った音（レゾネーターに入る前の音）を、エレメント出力にどれだけ
混ぜるかを設定します。数値が大きいほど、混ぜるレベルが大きくなります。

・インパルスエキスパンダーレベルバランス（IE Level Bal）では、インパルスエキス
パンダーを通った音をエレメント出力に混ぜる際の定位を設定します。プラスの数
値で右寄り、マイナスの数値で左寄りとなります。

・レゾネーターインプットゲイン（RSN Inp Gain）では、レゾネーターの入力レベル
を設定します。数値が大きいほど、レベルが大きくなります。

・レゾネーターウェットレベル（RSN Wet Level）では、レゾネーターを通った音を、
エレメント出力にどれだけ混ぜるかを設定します。数値が大きいほど、混ぜるレベ
ルが大きくなります。

・レゾネーターレベルバランス（RSN Level Bal）では、レゾネーターを通った音の定
位を設定します。プラスの数値で右寄り、マイナスの数値で左寄りとなります。

参　考

・インパルスエキスパンダー、レゾネーターを示す四角の中に反転表示があるときに
は、 F8 （Para）が表示されます。 F8 （Para）を押すと、インパルスエキスパ
ンダーまたはレゾネーターの設定画面に移ります。

・インパルスエキスパンダーは、フェイズキャンセルを活用して響きの効果を作り出
します。したがって、「Dry Level」の数値を上げると、このような、ラフネスを用い
たフェイズキャンセルの効果が半減してしまうことになります。ただし、インパル
スエキスパンダーを単なるディレイとして使用する場合などは、「Dry Level」の数
値を上げることにも意味があります。

・一般的に、インパルスエキスパンダーとレゾネーターを用いて、ビブラートのリア
ルさを表現する場合などは、次のようにセッティングします。

Dry Level ‥0
IE Wet Level ‥64ぐらい
RSN Wet Level ‥127
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EDIT / E1 or E2 / MODIFIER / IMPULSE EXPANDER：インパルスエキスパンダー

EDIT  → F2 （E1）または F3 （E2）→ F3 （Modi）→ 6: Impulse Expander → ENTER

インパルスエキスパンダーを設定します。

Density 0.146 ～ 20.77 msec
Dispersion 4.028 msec ～ 4.000 sec
Roughness 0 ～ 16

解　説

・インパルスエキスパンダーは、おもに音の立上り時や、ビブラート時の管や胴の共
鳴を再現する機能です。レゾネーターに比べて、金属的な響きをすることに特徴が
あります。

・デンシティ（Density）では、音の密度を設定します。実際には、音のザラつきが変化
します。この数値を大きくするほど密度が大きくなります。

・ディスパージョン（Dispersion）では、共鳴の時間を設定します。数値が大きいほ
ど、長く共鳴が響きます。

・ラフネス（Roughness）では、周波数特性のあばれ具合を設定します。数値が大きい
ほど、周波数特性の山と谷の差が大きくなります。

注　意

・インパルスエキスパンダー＆レゾネーターセッティングで、インパルスエキスパン
ダーが「off」になっている場合には、この画面での設定はできません。

・インパルスエキスパンダー＆レゾネーターセッティングのドライレベル（→P.
155）の数値が上がっていると、フェイズキャンセルを起こして、思ったようなイン
パルスエキスパンダーの効果を得られない場合があります。

周波数�

レベル�

ラフネス＝0の場合の周波数特性�

周波数�

レベル�

ラフネス＝16の場合の周波数特性�
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参　考

・インパルスエキスパンダーの出力レベルやバランスは、「5: IE & RSN Setting」（→
P. 155）で設定します。また、 F8 （Set）を押すとその設定画面に移ります。

・デンシティを大きくすると、アーリーリフレクションタイプのリバーブやエコーと
似たような効果を作り出すことができます。

・デンシティに対して、過大なディスパージョンを設定すると、金属的な長い響きを
得ることができます。一般的には、デンシティの設定値の数倍を、ディスパージョ
ンの設定値にすることで、自然な効果を得ることができます。

エレメントエディット － モディファイアの機能
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EDIT / E1 or E2 / MODIFIER / RESONATOR：レゾネーター

EDIT  → F2 （E1）または F3 （E2）→ F3 （Modi）→ 7: Resonator → ENTER

レゾネーターを設定します。

DL 1 ～ 5 0.29 ～ 41.54 msec
Decay Time 4.028 msec ～ 4.000 sec
LPF Cutoff Freq. 31.1 Hz ～ 24.0 kHz
Diffusion 0 ～ 16
Phase -16 ～ 16

解　説

・レゾネーターは、おもに管や胴の「箱鳴り」や「クセのある残響」を再現する機能で
す。インパルスエキスパンダーに比べて、木質な響きを作り出すことに特徴があり
ます。

・レゾネーターは、5本のLPF付きディレイを互いに接続、結合することで構成されま
す。

・ディレイ1～5（DL 1～5）では、5台分のディレイの遅延時間を設定します。実際に
は、この数値によって、楽器の持つクセを作り出します。

・ディケイタイム（Decay Time）では、残響の長さを設定します。数値が大きいほど、
長い残響となります。

・ローパスフィルターカットオフフリケンシー（LPF Cutoff Freq.）では、ローパス
フィルター（高音域をカットするフィルター）の周波数を設定します。この周波数
以上の残響音がカットされます。

・ディフュージョン（Diffusion）では、左右チャンネルへの共鳴音の拡がりを設定し
ます。数値が大きいほど、拡がりが増します。

・フェイズ（Phase）では、共鳴音の定位を設定します。プラスの数値で右から左に拡
がる音、マイナスの数値で左から右に拡がる音となります。

注　意

・インパルスエキスパンダー＆レゾネーターセッティングで、レゾネーターが「off」
になっている場合には、この画面での設定はできません。

参　考

・レゾネーターの出力レベルやバランスは、「5: IE & RSN Setting」（→ P. 155）で設
定します。また、 F8 （Set）を押すとその設定画面に移ります。

・一般的には、楽器そのものの縦横の寸法を、空気の音速（34cm／msec）で割って
ディレイ時間を求め、その数値を2つあるいは3つのディレイに割りふり、微調整を
行うと、自然な共鳴音を作り出すことができます。たとえば、縦68cm、横34cmの胴
を持つ楽器の場合、縦のディレイ時間は68÷34＝2msec、横のディレイ時間は34÷
34＝1msecとなります。
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エレメントエディット － エンベロープの機能
エレメントエディットの F4 （Env）：エンベロープは、プレッシャーやアンブシュア、ビブラート、グロウ
ル、アンプリチュードなどのエンベロープを設定する機能です。

・エレメントエディットのエンベロープの機能

1: Pressure （→ P. 161）
2: Embouchure & Pitch （→ P. 163）
3: Vibrato （→ P. 168）
4: Growl （→ P. 174）
5: Amplitude & Filter （→ P. 176）

エレメントエディット － エンベロープの機能

プレイモード�

エディットモード�

ユーティリティモード�

コモンエディット�

エレメントエディット�

モディファイア�

システム�

MIDIバルクダンプ�

ディスク�

エディットリコール�

デモ�

ミスレイニアス�

エフェクト�

コントローラー�

ミスレイニアス�

エンベロープ�
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エレメントエディット － エンベロープの機能

EDIT / E1 or E2 / ENV / PRESSURE：プレッシャー

EDIT  → F2 （E1）または F3 （E2）→ F4 （Env）→ 1: Pressure → ENTER

プレッシャーの変化のしかたやベロシティによるプレッシャーの変化を設定します。

EG Mode Disable, ADSR, AR
Attack Rate Offset -16 ～ 16
Release Rate Offset -16 ～ 16
Velocity Sens To Level 0 ～ 16
                       To Rate 0 ～ 16

解　説

・ボイスには、あらかじめそのボイスに合ったプレッシャーエンベロープが用意され
ています。この機能は、このプレッシャーエンベロープの使い方と、ベロシティ（鍵
盤を弾く瞬間の強弱）によって、プレッシャーの大きさ（レベル）とその変化の速さ
（レイト）をコントロールするための機能です。

・EGモード（EG Mode）では、プレッシャーの出し方を次の3種類から選択します。

Disable

ボイスが持っているプレッシャーエンベロープを使用しません。常にコント
ローラーの位置によるプレッシャーが出ている状態になります。たとえば、プ
レッシャーがフットコントローラーに割り当てられて、デプスがプラスの数値
の場合、フットコントローラーが一番踏み込まれていると、プレッシャーは常
に最大の状態となります。
プレッシャーがコントローラーに割り当てられていない場合には、常に最大の
プレッシャーとなります。（音が出続ける状態）
また、この「Disable」を選択した場合は、Attack Rate Offset, Release Rate Offset,
Velocity Sens To Level, To Rateの4つの項目の設定は無効となります。

ADSR

あらかじめボイスに設定されているプレッシャーエンベロープのアタック、
ディケイ、サステイン、リリースにしたがってプレッシャーが変化します。

AR

あらかじめボイスに設定されているアタック、リリースにしたがってプレッ
シャーが変化します。（ディケイ、サステインは無視されます）

・アタックレイトオフセット（Attack RateOffset）では、プレッシャーエンベロープの
アタックのスピードを調整します。プラスの数値ではより速いアタックに、マイナ
スの数値では、ゆっくりとしたアタックに変わります。
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・リリースレイトオフセット（Release Rate Offset）では、プレッシャーエンベロープ
のリリースのスピードを調整します。プラスの数値ではより速いリリースに、マイ
ナスの数値では、ゆっくりとしたリリースに変わります。

・ベロシティセンストゥーレベル（Velocity Sens to Level）では、プレッシャーの大き
さとベロシティの対応を設定します。「0」を設定すると、鍵盤を弾く強弱に関係な
く同じ大きさのプレッシャーとなります。「1」以上の数値を設定すると、鍵盤を強
く弾くとより大きなプレッシャー、鍵盤を弱く弾くとより小さなプレッシャーとな
ります。数値が大きいほど、プレッシャーの変化が大きくなります。

・ベロシティセンストゥーレイト（Velocity Sens to Rate）では、プレッシャーの変化
の速さ（アタックレイト、ディケイレイト、リリースレイト）とベロシティの対応を
設定します。「0」を設定すると、鍵盤を弾く強弱に関係なく同じ速さとなります。
「1」以上の数値を設定すると、鍵盤を強く弾くとより速い変化、鍵盤を弱く弾くと
よりゆっくりとした変化となります。数値が大きいほど、速さの変化が大きくなり
ます。

参　考

・EGモードを「Disable」にすると、ブレスコントローラーなどを使って、よりコントロールに
忠実な生楽器らしい表現が可能となります。ただし、それなりの慣れと技術が必要となりま
す。
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EDIT / E1 or E2 / ENV / EMBOUCHURE & PITCH：アンブシュア＆ピッチ

EDIT  → F2 （E1）または F3 （E2）→ F4 （Env）→ 2: Embouchure&Pitch → ENTER

ベロシティによるアンブシュアの変化を設定します。

VlSns To Lvl 0 ～ 16
VlSns To Rate -16 ～ 16
Dpth To Emb 0 ～ 64
Dpth To Ptch 0 ～ 64
Hold Time 0 ～ 127
Initial Lvl -64 ～ 63
Decay Rate 0 ～ 127

解　説

・ボイスには、あらかじめそのボイスに合ったアンブシュア、ピッチエンベロープが
用意されています。この機能は、このアンブシュア、ピッチエンベロープの使い方
と、ベロシティ（鍵盤を弾く瞬間の強弱）によって、その大きさ（レベル）とその変
化の速さ（レイト）をコントロールするための機能です。

・ベロシティセンストゥーレベル（VlSns To Lvl）では、アンブシュア、ピッチとベロ
シティの対応を設定します。「0」を設定すると、アンブシュア、ピッチは鍵盤を弾
く強弱に関係しなくなります。「1」以上の数値を設定すると、鍵盤を強く弾くとよ
り大きなアンブシュア変化、ピッチ変化に、鍵盤を弱く弾くとより小さなアンブ
シュア変化、ピッチ変化となります。

・ベロシティセンストゥーレイト（VlSns to Rate）では、ベロシティとアンブシュア、
ピッチエンベロープの変化の速さ（ディケイレイト）の対応を設定します。「0」を
設定すると、鍵盤を弾く強弱に関係なく一定の速さとなります。「1」以上の数値を
設定すると、鍵盤を強く弾くとより速い変化、鍵盤を弱く弾くとよりゆっくりとし
た変化となります。数値が大きいほど、速さの変化が大きくなります。マイナスの
数値の場合は、この逆の変化となります。

・デプストゥーアンブシュア（Dpth To Emb）では、アンブシュアとピッチエンベロー
プの出力をどのくらいアンブシュアに反映させるかを設定します。数値が大きいほ
ど効果が大きくなります。

・デプストゥーピッチ（Dpth To Ptch）では、アンブシュアとピッチエンベロープの出
力をどのくらいピッチに反映させるかを設定します。数値が大きいほど効果が大き
くなります。

・ホールドタイム（Hold Time）では、鍵盤を弾いた瞬間のアンブシュア、ピッチを持
続する時間を設定します。数値が大きいほど持続する時間が長くなります。

・イニシャルレベル（Initial Lvl）では、鍵盤を弾いた瞬間のアンブシュア、ピッチの
レベルを設定します。数値が大きいほどレベルが大きく（ピッチの場合は音程が高
く）なります。
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・ディケイレイト（Decay Rate）では、アンブシュア、ピッチエンベロープのディケイ
レイト（イニシャルレベルから「0」に変化する速さ）を設定します。数値が大きい
ほど、速い変化となります。

・設定部分の右側に のマークが付いている項目は、キースケール（音階）によって
設定をコントロールできる項目です。これらの項目が反転表示されているときに
は、 F7 （KSC）または ENTER を押すことで、キースケールを設定する画面に進
むことができます。画面の移動は、次のように行われます。

　Hold Time → F7 （ EXIT で戻る）→  ホールドタイムKSC （→ P. 165）

F7 ↓ ↑ F6

　Initial Lvl → F7 （ EXIT で戻る）→  イニシャルレベルKSC （→ P. 166）

F7 ↓ ↑ F6

　Decay Rate → F7 （ EXIT で戻る）→  ディケイレイトKSC （→ P. 167）

注　意

・イニシャルレベルを「0」に設定すると、EGの効果はありません。

エレメントエディット － エンベロープの機能

63
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EDIT / E1 or E2 / ENV / EMBOUCHURE & PITCH / KSC：アンブシュア＆ピッチKSC（ホールドタイム）

EDIT  → F2 （E1）または F3 （E2）→ F4 （Env）→ 2: Embouchure&Pitch → ENTER  → Hold Time → F7 （KSC）

アンブシュア＆ピッチのホールドタイムのキースケールを設定します。

HdTime 0 ～ 127
BP1、2の音程 C-2 ～ G8
BP1、2の変化幅 -64 ～ 63

解　説

・アンブシュア＆ピッチのホールドタイムを、キースケール（音階）で変化させるた
めの設定を行います。

・ホールドタイム（HdTime）では、アンブシュア＆ピッチのホールドタイムを設定し
ます。この数値は、キースケール設定に入る前の、アンブシュア＆ピッチ設定画面
の「Hold Time」の数値と連動しています。また、この数値がブレークポイントの基
準値となります。

・ホールドタイムのキースケールは、2つのブレークポイント（BP）で設定します。各
ブレークポイントは、「音程」と「基準値からの変化量」で設定します。（→ P. 33）

・画面には、音程による変化幅を示すグラフが表示されます。横軸が音程、縦軸が
ホールドタイムです。点線の横線は「HdTime」の設定値（基準値）を示します。

・各ブレークポイントの音程の部分が反転表示になっているときには、鍵盤を使って
音程を入力することができます。 F8 （Kbd）を押した後、MIDIキーボードの任
意の鍵盤を弾いてください。

注　意

・ブレークポイント1、2は、順番に音程が上がっていくようにしか設定できません。
・基準値に変化幅を加えた値が、設定範囲（グラフの下端から上端までの範囲）を超
える場合には、最小または最大の設定値となります。

参　考

・ F7 （FPag: Forward Page）を押すと、イニシャルレベルのキースケール設定画面に移り
ます。

エレメントエディット － エンベロープの機能
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EDIT / E1 or E2 / ENV / EMBOUCHURE & PITCH / KSC：アンブシュア＆ピッチKSC（イニシャルレベル）

EDIT  → F2 （E1）または F3 （E2）→ F4 （Env）→ 2: Embouchure&Pitch → ENTER  → Initial Level → F7 （KSC）

アンブシュア＆ピッチのイニシャルレベルのキースケールを設定します。

IntLvl -64 ～ 63
BP1、2の音程 C-2 ～ G8
BP1、2の変化幅 -64 ～ 63

解　説

・アンブシュア＆ピッチのイニシャルレベルを、キースケール（音階）で変化させる
ための設定を行います。

・イニシャルレベル（IntLvl）では、アンブシュア＆ピッチのイニシャルレベルを設定
します。この数値は、キースケール設定に入る前の、アンブシュア＆ピッチ設定画
面の「Initial Level」の数値と連動しています。また、この数値がブレークポイントの
基準値となります。

・イニシャルレベルのキースケールは、2つのブレークポイント（BP）で設定します。
各ブレークポイントは、「音程」と「基準値からの変化量」で設定します。（→ P.
33）

・画面には、音程による変化幅を示すグラフが表示されます。横軸が音程、縦軸がイ
ニシャルレベルです。点線の横線は「IntLvl」の設定値（基準値）を示します。

・各ブレークポイントの音程の部分が反転表示になっているときには、鍵盤を使って
音程を入力することができます。 F8 （Kbd）を押した後、MIDIキーボードの任
意の鍵盤を弾いてください。

注　意

・ブレークポイント1、2は、順番に音程が上がっていくようにしか設定できません。
・基準値に変化幅を加えた値が、設定範囲（グラフの下端から上端までの範囲）を超
える場合には、最小または最大の設定値となります。

・イニシャルレベルを「0」に設定すると、EGの効果はありません。

参　考

・ F6 （BPag: Backward Page）を押すと、ホールドタイムのキースケール設定画面に移りま
す。

・ F7 （FPag: Forward Page）を押すと、ディケイレイトのキースケール設定画面に移りま
す。

エレメントエディット － エンベロープの機能
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EDIT / E1 or E2 / ENV / EMBOUCHURE & PITCH / KSC：アンブシュア＆ピッチKSC（ディケイレイト）

EDIT  → F2 （E1）または F3 （E2）→ F4 （Env）→ 2: Embouchure&Pitch → ENTER  → Decay Rate → F7 （KSC）

アンブシュア＆ピッチのディケイレイトのキースケールを設定します。

DcRate -64 ～ 63
BP1、2の音程 C-2 ～ G8
BP1、2の変化幅 -64 ～ 63

解　説

・アンブシュア＆ピッチのディケイレイトを、キースケール（音階）で変化させるた
めの設定を行います。

・ディケイレイト（DcRate）では、アンブシュア＆ピッチのディケイレイトを設定し
ます。この数値は、キースケール設定に入る前の、アンブシュア＆ピッチ設定画面
の「Decay Rate」の数値と連動しています。また、この数値がブレークポイントの基
準値となります。

・ディケイレイトのキースケールは、2つのブレークポイント（BP）で設定します。各
ブレークポイントは、「音程」と「基準値からの変化量」で設定します。（→ P. 33）

・画面には、音程による変化幅を示すグラフが表示されます。横軸が音程、縦軸が
ディケイレイトです。点線の横線は「DcRate」の設定値（基準値）を示します。

・各ブレークポイントの音程の部分が反転表示になっているときには、鍵盤を使って
音程を入力することができます。 F8 （Kbd）を押した後、MIDIキーボードの任
意の鍵盤を弾いてください。

注　意

・ブレークポイント1、2は、順番に音程が上がっていくようにしか設定できません。
・基準値に変化幅を加えた値が、設定範囲（グラフの下端から上端までの範囲）を超
える場合には、最小または最大の設定値となります。

参　考

・ F6 （BPag: Backward Page）を押すと、イニシャルレベルのキースケール設定画面に移り
ます。
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EDIT / E1 or E2 / ENV / VIBRATO：ビブラート

EDIT  → F2 （E1）または F3 （E2）→ F4 （Env）→ 3: Vibrato → ENTER

ビブラートのゆれの速さや効果の深さ、効果の対象などを設定します。

Delay Time 0 ～ 127
Attack Rate 0 ～ 127
Sustain Lvl 0 ～ 127
Vibrato Dpth 0 ～ 127
Dpth to Emb 0 ～ 127
Dpth to Ptch 0 ～ 127
Offset -127 ～ 127
Randomness 0 ～ 10
Speed 0 ～ 127
Speed Shift 0 ～ 8

解　説

・コントローラーに関係なく常時ビブラートをかけるための設定（ビブラートEGの
設定）や、ビブラートをかける対象、ゆれの速さなど（ビブラートLFOの設定）を設
定するための機能です。

・以下のディレイタイム、アタックレイト、サステインレベルの3つは、常時ビブラー
トをかけておくための設定です。コントローラーでのビブラートコントロールには
影響しません。

・ディレイタイム（Delay Time）では、鍵盤を弾いた後、少し遅れてビブラートがかか
りはじめるための遅延時間を設定します。数値が大きいほど、遅れが大きくなりま
す。

・アタックレイト（Attack Rate）では、ビブラートの開始時にだんだんビブラートが
深くなっていく速さを設定します。数値が小さいほど、ゆっくりとビブラートがか
かりはじめます。

・サステインレベル（Sustain Lvl）では、ビブラートの効果の深さを設定します。数値
が大きいほど、ビブラートが深くなります。コントローラーのみでビブラートをコ
ントロールする場合には、「0」に設定してください。

・ビブラートデプス（Vibrato Dpth）では、効果の深さを設定します。数値が大きいほ
ど、効果が大きくなります。ビブラートデプスは、コントローラーの効果と、EGの
効果の合成にかかります。「0」に設定するとビブラートはかかりません。

・デプストゥーアンブシュア（Depth to Emb）では、アンブシュアのゆれの大きさを
設定します。数値が大きいほど、アンブシュアのゆれが大きくなります。

・デプストゥーピッチ（Depth to Ptch）では、ピッチ（音程）のゆれの大きさを設定し
ます。数値が大きいほど、ピッチのゆれが大きくなります。
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・オフセット（Offset）では、ゆれの中心となる値を設定します。たとえば、デプス
トゥーピッチの数値が上げてある状況で、このオフセットの値を「0」にすると、弾
いた鍵盤の音程を中心にして音程が上下にゆれます。また、同じ状況でオフセット
の値を「127」にすると、弾いた鍵盤よりも高い音程を中心にして音程が上下にゆれ
ます。

・ランダムネス（Randomness）では、ゆれの深さ、スピードをランダムに変化させる
設定です。数値が大きいほど、ランダムなビブラートとなります。

・スピード（Speed）では、ゆれの速さを設定します。数値が大きいほど、速いゆれと
なります。

・スピードシフト（Speed Shift）では、ビブラート用のコントローラーによって、ス
ピードを変化させる幅を設定します。数値が大きいほどスピードが上がります。
（コントローラーを最大にしたとき、「8」で約6倍のスピードになります）

・設定部分の右側に のマークが付いている項目は、キースケール（音階）によって
設定をコントロールできる項目です。これらの項目が反転表示されているときに
は、 F7 （KSC）または ENTER を押すことで、キースケールを設定する画面に進
むことができます。画面の移動は、次のように行われます。

　Delay Time → F7 （ EXIT で戻る）→  ディレイタイムKSC （→ P. 170）

F7 ↓ ↑ F6

　Attack Rate → F7 （ EXIT で戻る）→  アタックレイトKSC （→ P. 171）

F7 ↓ ↑ F6

　Vibrato Dpth → F7 （ EXIT で戻る）→  ビブラートデプスKSC （→ P. 172）

F7 ↓ ↑ F6

　Speed → F7 （ EXIT で戻る）→  スピードKSC （→ P. 173）

・ F8 （Ctrl）を押すと、ビブラートをコントロールするコントローラーを設定す
るための画面（コントローラーのビブラート（→ P. 97））に移動することができま
す。

注　意

・ビブラートデプスが「0」になっていると、コントローラーを使っても一切ビブラー
トがかからなくなります。

・デプストゥーアンブシュアが「0」に設定されている場合には、アンブシュアに対し
てビブラート効果は働かなくなります。

・デプストゥーピッチが「0」に設定されている場合には、ピッチに対してビブラート
効果は働かなくなります。
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EDIT / E1 or E2 / ENV / VIBRATO / KSC：ビブラートKSC（ディレイタイム）

EDIT  → F2 （E1）または F3 （E2）→ F4 （Env）→ 3: Vibrato → ENTER  → Delay Time → F7 （KSC）

ビブラートのディレイタイムのキースケールを設定します。

DlTime 0 ～ 127
BP1、2の音程 C-2 ～ G8
BP1、2の変化幅 -64 ～ 63

解　説

・ビブラートのディレイタイムを、キースケール（音階）で変化させるための設定を
行います。

・ディレイタイム（DlTime）では、ビブラートの遅延時間を設定します。この数値は、
キースケール設定に入る前の、ビブラート設定画面の「Delay Time」の数値と連動
しています。また、この数値がブレークポイントの基準値となります。

・ディレイタイムのキースケールは、2つのブレークポイント（BP）で設定します。各
ブレークポイントは、「音程」と「基準値からの変化量」で設定します。（→ P. 33）

・画面には、音程による変化幅を示すグラフが表示されます。横軸が音程、縦軸が
ディレイタイムです。点線の横線は「DlTime」の設定値（基準値）を示します。

・各ブレークポイントの音程の部分が反転表示になっているときには、鍵盤を使って
音程を入力することができます。 F8 （Kbd）を押した後、MIDIキーボードの任
意の鍵盤を弾いてください。

注　意

・ブレークポイント1、2は、順番に音程が上がっていくようにしか設定できません。
・基準値に変化幅を加えた値が、設定範囲（グラフの下端から上端までの範囲）を超
える場合には、最小または最大の設定値となります。

参　考

・ F7 （FPag: Forward Page）を押すと、アタックレイトのキースケール設定画面に移りま
す。
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EDIT / E1 or E2 / ENV / VIBRATO / KSC：ビブラートKSC（アタックレイト）

EDIT  → F2 （E1）または F3 （E2）→ F4 （Env）→ 3: Vibrato → ENTER  → Attack Rate → F7 （KSC）

ビブラートのアタックレイトのキースケールを設定します。

AtRate 0 ～ 127
BP1、2の音程 C-2 ～ G8
BP1、2の変化幅 -64 ～ 63

解　説

・ビブラートのアタックレイトを、キースケール（音階）で変化させるための設定を
行います。

・アタックレイト（AtRate）では、ビブラートのアタックの速さを設定します。この数
値は、キースケール設定に入る前の、ビブラート設定画面の「Attack Rate」の数値と
連動しています。また、この数値がブレークポイントの基準値となります。

・アタックレイトのキースケールは、2つのブレークポイント（BP）で設定します。各
ブレークポイントは、「音程」と「基準値からの変化量」で設定します。（→ P. 33）

・画面には、音程による変化幅を示すグラフが表示されます。横軸が音程、縦軸がア
タックレイトです。点線の横線は「AtRate」の設定値（基準値）を示します。

・各ブレークポイントの音程の部分が反転表示になっているときには、鍵盤を使って
音程を入力することができます。 F8 （Kbd）を押した後、MIDIキーボードの任
意の鍵盤を弾いてください。

注　意

・ブレークポイント1、2は、順番に音程が上がっていくようにしか設定できません。
・基準値に変化幅を加えた値が、設定範囲（グラフの下端から上端までの範囲）を超
える場合には、最小または最大の設定値となります。

参　考

・ F6 （BPag: Backward Page）を押すと、ディレイタイムのキースケール設定画面に移りま
す。

・ F7 （FPag: Forward Page）を押すと、ビブラートデプスのキースケール設定画面に移り
ます。
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EDIT / E1 or E2 / ENV / VIBRATO / KSC：ビブラートKSC（ビブラートデプス）

EDIT  → F2 （E1）または F3 （E2）→ F4 （Env）→ 3: Vibrato → ENTER  → Vibrato Dpth → F7 （KSC）

ビブラートデプスのキースケールを設定します。

Depth 0 ～ 127
BP1、2の音程 C-2 ～ G8
BP1、2の変化幅 -64 ～ 63

解　説

・ビブラートのデプスを、キースケール（音階）で変化させるための設定を行います。
・デプス（Depth）では、ビブラートの効果の深さを設定します。この数値は、キース
ケール設定に入る前の、ビブラート設定画面の「Vibrato Dpth」の数値と連動してい
ます。また、この数値がブレークポイントの基準値となります。

・ビブラートデプスのキースケールは、2つのブレークポイント（BP）で設定します。
各ブレークポイントは、「音程」と「基準値からの変化量」で設定します。（→ P.
33）

・画面には、音程による変化幅を示すグラフが表示されます。横軸が音程、縦軸がビ
ブラートデプスです。点線の横線は「Depth」の設定値（基準値）を示します。

・各ブレークポイントの音程の部分が反転表示になっているときには、鍵盤を使って
音程を入力することができます。 F8 （Kbd）を押した後、MIDIキーボードの任
意の鍵盤を弾いてください。

注　意

・ブレークポイント1、2は、順番に音程が上がっていくようにしか設定できません。
・基準値に変化幅を加えた値が、設定範囲（グラフの下端から上端までの範囲）を超
える場合には、最小または最大の設定値となります。

参　考

・ F6 （BPag: Backward Page）を押すと、アタックレイトのキースケール設定画面に移りま
す。

・ F7 （FPag: Forward Page）を押すと、スピードのキースケール設定画面に移ります。
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EDIT / E1 or E2 / ENV / VIBRATO / KSC：ビブラートKSC（スピード）

EDIT  → F2 （E1）または F3 （E2）→ F4 （Env）→ 3: Vibrato → ENTER  → Speed → F7 （KSC）

ビブラートのスピードのキースケールを設定します。

Speed 0 ～ 127
BP1、2の音程 C-2 ～ G8
BP1、2の変化幅 -64 ～ 63

解　説

・ビブラートのスピードを、キースケール（音階）で変化させるための設定を行いま
す。

・スピード（Speed）では、ビブラートのスピードを設定します。この数値は、キース
ケール設定に入る前の、ビブラート設定画面の「Speed」の数値と連動しています。
また、この数値がブレークポイントの基準値となります。

・スピードのキースケールは、2つのブレークポイント（BP）で設定します。各ブレー
クポイントは、「音程」と「基準値からの変化量」で設定します。（→ P. 33）

・画面には、音程による変化幅を示すグラフが表示されます。横軸が音程、縦軸がス
ピードです。点線の横線は「Speed」の設定値（基準値）を示します。

・各ブレークポイントの音程の部分が反転表示になっているときには、鍵盤を使って
音程を入力することができます。 F8 （Kbd）を押した後、MIDIキーボードの任
意の鍵盤を弾いてください。

注　意

・ブレークポイント1、2は、順番に音程が上がっていくようにしか設定できません。
・基準値に変化幅を加えた値が、設定範囲（グラフの下端から上端までの範囲）を超
える場合には、最小または最大の設定値となります。

参　考

・ F6 （BPag: Backward Page）を押すと、ビブラートデプスのキースケール設定画面に移り
ます。
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EDIT / E1 or E2 / ENV / GROWL：グロウル

EDIT  → F2 （E1）または F3 （E2）→ F4 （Env）→ 4: Growl → ENTER

グロウルのゆれの速さや効果の深さ、効果の対象などを設定します。

Dpth to Pres 0 ～ 127
Dpth to BNois 0 ～ 127
Offset -127 ～ 127
Vibrato Sync off, on
Speed 0 ～ 127
Randomness 0 ～ 10

解　説

・コントローラーでグロウルをコントロールするとき、そのゆれの速さや効果の深
さ、効果の対象などを設定します。

・デプストゥープレッシャー（Dpth to Pres）では、プレッシャーのゆれの大きさを設
定します。数値が大きいほど、プレッシャーのゆれが大きくなります。

・デプストゥーブレスノイズ（Dpth to BNois）では、ブレスノイズのゆれの大きさを
設定します。数値が大きいほど、ブレスノイズのゆれが大きくなります。

・オフセット（Offset）では、ゆれの中心となる値を設定します。たとえば、デプス
トゥープレッシャーの数値が上げてある状況で、このオフセットの値を「0」にする
と、決められたプレッシャーを中心にしてプレッシャーがゆれます。また、同じ状
況でオフセットをプラスの値にすると、決められたプレッシャーよりも高いプレッ
シャーを中心にゆれます。（ただし最大値は与えられたプレッシャー値です）

・ビブラートシンク（Vibrato Sync）では、グロウルのゆれをビブラートのゆれと同期
させる設定です。「on」を選択した場合には、ビブラートのゆれを使って、グロウル
もゆらすことになります。この場合には、次のスピードとランダムネスは表示され
ません。

・スピード（Speed）では、ゆれの速さを設定します。数値が大きいほど、速いゆれと
なります。

・ランダムネス（Randomness）では、ゆれの深さ、スピードをランダムに変化させる
設定です。数値が大きいほど、ランダムなグロウルとなります。

・設定部分の右側に のマークが付いている項目は、キースケール（音階）によって
設定をコントロールできる項目です。これらの項目が反転表示されているときに
は、 F7 （KSC）または ENTER を押すことで、キースケールを設定する画面に進
むことができます。この機能については、次ページで説明します。

・ F8 （Ctrl）を押すと、グロウルをコントロールするコントローラーを設定する
ための画面（コントローラーのグロウル（→ P. 102））に移動することができます。

注　意

・デプストゥープレッシャー、デプストゥーブレスノイズが、ともに「0」になってい
ると、グロウルがかからなくなります。

・オフセットを「127」にすると、グロウルがかからなくなります。
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EDIT / E1 or E2 / ENV / GROWL / KSC：グロウルKSC（スピード）

EDIT  → F2 （E1）または F3 （E2）→ F4 （Env）→ 4: Growl→ ENTER  → Speed → F7 （KSC）

グロウルのスピードのキースケールを設定します。

Speed 0 ～ 127
BP1、2の音程 C-2 ～ G8
BP1、2の変化幅 -64 ～ 63

解　説

・グロウルのスピードを、キースケール（音階）で変化させるための設定を行います。
・スピード（Speed）では、グロウルのスピードを設定します。この数値は、キース
ケール設定に入る前の、グロウル設定画面の「Speed」の数値と連動しています。ま
た、この数値がブレークポイントの基準値となります。

・スピードのキースケールは、2つのブレークポイント（BP）で設定します。各ブレー
クポイントは、「音程」と「基準値からの変化量」で設定します。（→ P. 33）

・画面には、音程による変化幅を示すグラフが表示されます。横軸が音程、縦軸がス
ピードです。点線の横線は「Speed」の設定値（基準値）を示します。

・各ブレークポイントの音程の部分が反転表示になっているときには、鍵盤を使って
音程を入力することができます。 F8 （Kbd）を押した後、MIDIキーボードの任
意の鍵盤を弾いてください。

注　意

・ブレークポイント1、2は、順番に音程が上がっていくようにしか設定できません。
・基準値に変化幅を加えた値が、設定範囲（グラフの下端から上端までの範囲）を超
える場合には、最小または最大の設定値となります。

エレメントエディット － エンベロープの機能
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EDIT / E1 or E2 / ENV / AMPLITUDE & FILTER（Sens）：アンプリチュード＆フィルター（センシティビティ）

EDIT  → F2 （E1）または F3 （E2）→ F4 （Env）→ 5: Amplitude & Filter → ENTER  → F1 （Sens）

ベロシティによる、アンプリチュードとフィルターの変化を設定します。

Velocity Sens To Level 0 ～ 16
           　        To Rate 0 ～ 16
Depth To Amplitude 0 ～ 127
 　　  To Filter -127 ～ 127

解　説

・アンプリチュード＆フィルターの機能は、センシティビティを設定するための画面
と、時間的な変化（EG）を設定する画面とに分かれています。この切り換えには、

F1 （Sens）と F2 （EG）を使います。
・このセンシティビティでは、次ページの「EG」で作り上げたアンプリチュード、
フィルター（ダイナミックフィルター）用のエンベロープをどのようにベロシティ
でコントロールするか、またどのくらいアンプリチュードやフィルターに機能させ
るかを設定します。

・ベロシティセンストゥーレベル（Velocity Sens To Level）では、エンベロープのア
タック1、アタック2のレベルとベロシティの対応を設定します。「0」を設定する
と、鍵盤を弾く強弱に関係なく同じレベルとなります。「1」以上の数値を設定する
と、鍵盤を弱く弾くと小さなレベル、鍵盤を強く弾くと大きなレベルとなります。
数値が大きいほど、レベルの変化が大きくなります。

・ベロシティセンストゥーレイト（Velocity Sens To Rate）では、エンベロープのア
タック、ディケイのレイトとベロシティの対応を設定します。「0」を設定すると、
鍵盤を弾く強弱に関係なく同じレイトとなります。「1」以上の数値を設定すると、
鍵盤を弱く弾くとゆっくりとした変化、鍵盤を強く弾くと速い変化となります。数
値が大きいほど、速さ変化が大きくなります。

・デプストゥーアンプリチュード（Depth To Amplitude）では、エンベロープをどのく
らいアンプリチュード（純粋な音量）に反映させるかを設定します。数値が大きい
ほど、エンベロープによるアンプリチュード変化が大きくなります。

・デプストゥーフィルター（Depth To Filter）では、エンベロープをどのくらいダイナ
ミックフィルターのカットオフフリケンシーに反映させるかを設定します。数値が
大きいほど、エンベロープによるダイナミックフィルターの周波数変化が大きくな
ります。また、マイナスの数値では、逆の変化となります。
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EDIT / E1 or E2 / ENV / AMPLITUDE & FILTER（EG）：アンプリチュード＆フィルター（EG）

EDIT  → F2 （E1）または F3 （E2）→ F4 （Env）→ 5: Amplitude & Filter → ENTER  → F2 （EG）

アンプリチュード、フィルターの時間的変化を設定します。

Rate
     Attack 1 0 ～ 127
     Attack 2 0 ～ 127
     Decay 0 ～ 127
     Release 0 ～ 127
Level
     Attack 1 0 ～ 127
     Sustain 0 ～ 127

解　説

・アンプリチュード＆フィルターの機能は、センシティビティを設定するための画面
と、時間的な変化（EG）を設定する画面とに分かれています。この切り換えには、

F1 （Sens）と F2 （EG）を使います。
・ここでは、時間的な変化（EG）の設定を行います。

・レイトのアタック1（Attack 1 ）では、鍵盤を弾いた瞬間（このときレベルは0）から
アタック1レベルに移行する速さを設定します。数値が大きいほど、速い変化となり
ます。

・レイトのアタック2（Attack 2）では、アタック1レベルに達した後、最大レベル（最
大のアンプリチュード）に移行する速さを設定します。数値が大きいほど、速い変
化となります。

・レイトのディケイ（Decay）では、最大レベルに達した後、サステインレベルに移行
する速さを設定します。数値が大きいほど、速い変化となります。

レベル�

時間�

127（固定）�

レベル：アタック1

レベル：サステイン�

鍵盤を離す�

鍵盤を弾く�

レイト：アタック1

レイト：アタック2

レイト：ディケイ�

レイト：リリース�



178　　第4章　エディットモード － エレメントエディット

エレメントエディット － エンベロープの機能

・レイトのリリース（Release）では、鍵盤を離した後、レベル0に移行する速さを設定
します。数値が大きいほど、速い変化となります。

・レベルのアタック1（Attack 1）は、最大レベルになる前のアタック1レイトの目標と
なるレベルです。数値が「127」のとき、最大レベルと同じになります。

・レベルのサステイン（Sustain）は、鍵盤を弾いている間、ずっと持続するレベルで
す。数値が「127」のとき、最大レベルと同じになります。

・設定部分の右側に のマークが付いている項目は、キースケール（音階）によって
設定をコントロールできる項目です。これらの項目が反転表示されているときに
は、 F7 （KSC）または ENTER を押すことで、キースケールを設定する画面に進
むことができます。画面の移動は、次のように行われます。

　Attack1 Rate → F7 （ EXIT で戻る）→  アタック1レイトKSC （→ P.179）

F7 ↓ ↑ F6

　Attack1 Level → F7 （ EXIT で戻る）→  アタック1レベルKSC （→ P. 180）

F7 ↓ ↑ F6

　Attack2 Rate → F7 （ EXIT で戻る）→  アタック2レイトKSC （→ P. 181）

F7 ↓ ↑ F6

　Decay Rate → F7 （ EXIT で戻る）→  ディケイレイトKSC （→ P. 182）

F7 ↓ ↑ F6

　Sustain Level → F7 （ EXIT で戻る）→  サステインレベルKSC （→ P. 183）

F7 ↓ ↑ F6

　Release Rate → F7 （ EXIT で戻る）→  リリースレイトKSC （→ P. 184）
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EDIT / E1 or E2 / ENV / AMPLITUDE & FILTER / KSC：アンプリチュード＆フィルターKSC（アタック1レイト）

EDIT  → F2 （E1）または F3 （E2）→ F4 （Env）→ 5: Amplitude & Filter → ENTER  → Rate Attack 1 → F7 （KSC）

アタック1レイトのキースケールを設定します。

A1Rate 0 ～ 127
BP1、2の音程 C-2 ～ G8
BP1、2の変化幅 -64 ～ 63

解　説

・アンプリチュード＆フィルターのアタック1レイトを、キースケール（音階）で変化
させるための設定を行います。

・アタック1レイト（A1Rate）では、アタック1のレイトを設定します。この数値は、
キースケール設定に入る前の、EG設定画面の「Rate Attack 1」の数値と連動してい
ます。また、この数値がブレークポイントの基準値となります。

・アタック1レイトのキースケールは、2つのブレークポイント（BP）で設定します。
各ブレークポイントは、「音程」と「基準値からの変化量」で設定します。（→ P.
33）

・画面には、音程による変化幅を示すグラフが表示されます。横軸が音程、縦軸がレ
イトです。点線の横線は「A1Rate」の設定値（基準値）を示します。

・各ブレークポイントの音程の部分が反転表示になっているときには、鍵盤を使って
音程を入力することができます。 F8 （Kbd）を押した後、MIDIキーボードの任
意の鍵盤を弾いてください。

注　意

・ブレークポイント1、2は、順番に音程が上がっていくようにしか設定できません。
・基準値に変化幅を加えた値が、設定範囲（グラフの下端から上端までの範囲）を超
える場合には、最小または最大の設定値となります。

参　考

・ F7 （FPag: Forward Page）を押すと、アタック1レベルのキースケール設定画面に移りま
す。
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EDIT / E1 or E2 / ENV / AMPLITUDE & FILTER / KSC：アンプリチュード＆フィルターKSC（アタック1レベル）

EDIT  → F2 （E1）または F3 （E2）→ F4 （Env）→ 5: Amplitude & Filter → ENTER  → Level Attack 1 → F7 （KSC）

アタック1レベルのキースケールを設定します。

A1Lvl 0 ～ 127
BP1、2の音程 C-2 ～ G8
BP1、2の変化幅 -64 ～ 63

解　説

・アンプリチュード＆フィルターのアタック1レベルを、キースケール（音階）で変化
させるための設定を行います。

・アタック1レベル（A1Lvl）では、アタック1のレベルを設定します。この数値は、
キースケール設定に入る前の、EG設定画面の「Level Attack 1」の数値と連動してい
ます。また、この数値がブレークポイントの基準値となります。

・アタック1レベルのキースケールは、2つのブレークポイント（BP）で設定します。
各ブレークポイントは、「音程」と「基準値からの変化量」で設定します。（→ P.
33）

・画面には、音程による変化幅を示すグラフが表示されます。横軸が音程、縦軸がレ
ベルです。点線の横線は「A1Lvl」の設定値（基準値）を示します。

・各ブレークポイントの音程の部分が反転表示になっているときには、鍵盤を使って
音程を入力することができます。 F8 （Kbd）を押した後、MIDIキーボードの任
意の鍵盤を弾いてください。

注　意

・ブレークポイント1、2は、順番に音程が上がっていくようにしか設定できません。
・基準値に変化幅を加えた値が、設定範囲（グラフの下端から上端までの範囲）を超
える場合には、最小または最大の設定値となります。

参　考

・ F6 （BPag: Backward Page）を押すと、アタック1レイトのキースケール設定画面に移り
ます。

・ F7 （FPag: Forward Page）を押すと、アタック2レイトのキースケール設定画面に移りま
す。

エレメントエディット － エンベロープの機能
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EDIT / E1 or E2 / ENV / AMPLITUDE & FILTER / KSC：アンプリチュード＆フィルターKSC（アタック2レイト）

EDIT  → F2 （E1）または F3 （E2）→ F4 （Env）→ 5: Amplitude & Filter → ENTER  → Rate Attack 2 → F7 （KSC）

アタック2レイトのキースケールを設定します。

A2Rate 0 ～ 127
BP1、2の音程 C-2 ～ G8
BP1、2の変化幅 -64 ～ 63

解　説

・アンプリチュード＆フィルターのアタック2レイトを、キースケール（音階）で変化
させるための設定を行います。

・アタック2レイト（A2Rate）では、アタック2のレイトを設定します。この数値は、
キースケール設定に入る前の、EG設定画面の「Rate Attack 2」の数値と連動してい
ます。また、この数値がブレークポイントの基準値となります。

・アタック2レイトのキースケールは、2つのブレークポイント（BP）で設定します。
各ブレークポイントは、「音程」と「基準値からの変化量」で設定します。（→ P.
33）

・画面には、音程による変化幅を示すグラフが表示されます。横軸が音程、縦軸がレ
イトです。点線の横線は「A2Rate」の設定値（基準値）を示します。

・各ブレークポイントの音程の部分が反転表示になっているときには、鍵盤を使って
音程を入力することができます。 F8 （Kbd）を押した後、MIDIキーボードの任
意の鍵盤を弾いてください。

注　意

・ブレークポイント1、2は、順番に音程が上がっていくようにしか設定できません。
・基準値に変化幅を加えた値が、設定範囲（グラフの下端から上端までの範囲）を超
える場合には、最小または最大の設定値となります。

参　考

・ F6 （BPag: Backward Page）を押すと、アタック1レベルのキースケール設定画面に移り
ます。

・ F7 （FPag: Forward Page）を押すと、ディケイレイトのキースケール設定画面に移りま
す。
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EDIT / E1 or E2 / ENV / AMPLITUDE & FILTER / KSC：アンプリチュード＆フィルターKSC（ディケイレイト）

EDIT  → F2 （E1）または F3 （E2）→ F4 （Env）→ 5: Amplitude & Filter → ENTER  → Rate Decay → F7 （KSC）

ディケイレイトのキースケールを設定します。

DcRate 0 ～ 127
BP1、2の音程 C-2 ～ G8
BP1、2の変化幅 -64 ～ 63

解　説

・キースケール（音階）によって、アンプリチュード＆フィルターのディケイレイト
を変化させるための設定を行います。

・ディケイレイト（DcRate）では、ディケイのレイトを設定します。この数値は、キー
スケール設定に入る前の、EG設定画面の「Rate Decay」の数値と連動しています。
また、この数値がブレークポイントの基準値となります。

・ディケイレイトのキースケールは、2つのブレークポイント（BP）で設定します。各
ブレークポイントは、「音程」と「基準値からの変化量」で設定します。（→ P. 33）

・画面には、音程による変化幅を示すグラフが表示されます。横軸が音程、縦軸がレ
イトです。点線の横線は「DcRate」の設定値（基準値）を示します。

・各ブレークポイントの音程の部分が反転表示になっているときには、鍵盤を使って
音程を入力することができます。 F8 （Kbd）を押した後、MIDIキーボードの任
意の鍵盤を弾いてください。

注　意

・ブレークポイント1、2は、順番に音程が上がっていくようにしか設定できません。
・基準値に変化幅を加えた値が、設定範囲（グラフの下端から上端までの範囲）を超
える場合には、最小または最大の設定値となります。

参　考

・ F6 （BPag: Backward Page）を押すと、アタック2レイトのキースケール設定画面に移り
ます。

・ F7 （FPag: Forward Page）を押すと、サステインレベルのキースケール設定画面に移り
ます。

エレメントエディット － エンベロープの機能
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EDIT / E1 or E2 / ENV / AMPLITUDE & FILTER / KSC：アンプリチュード＆フィルターKSC（サステインレベル）

EDIT  → F2 （E1）または F3 （E2）→ F4 （Env）→ 5: Amplitude & Filter → ENTER  → Level Sustain → F7 （KSC）

サステインレベルのキースケールを設定します。

SusLvl 0 ～ 127
BP1、2の音程 C-2 ～ G8
BP1、2の変化幅 -64 ～ 63

解　説

・アンプリチュード＆フィルターのサステインレベルを、キースケール（音階）で変
化させるための設定を行います。

・サステインレベル（SusLvl）では、サステインのレベルを設定します。この数値は、
キースケール設定に入る前の、EG設定画面の「Level Sustain」の数値と連動してい
ます。また、この数値がブレークポイントの基準値となります。

・サステインレベルのキースケールは、2つのブレークポイント（BP）で設定します。
各ブレークポイントは、「音程」と「基準値からの変化量」で設定します。（→ P.
33）

・画面には、音程による変化幅を示すグラフが表示されます。横軸が音程、縦軸がレ
ベルです。点線の横線は「SusLvl」の設定値（基準値）を示します。

・各ブレークポイントの音程の部分が反転表示になっているときには、鍵盤を使って
音程を入力することができます。 F8 （Kbd）を押した後、MIDIキーボードの任
意の鍵盤を弾いてください。

注　意

・ブレークポイント1、2は、順番に音程が上がっていくようにしか設定できません。
・基準値に変化幅を加えた値が、設定範囲（グラフの下端から上端までの範囲）を超
える場合には、最小または最大の設定値となります。

参　考

・ F6 （BPag: Backward Page）を押すと、ディケイレイトのキースケール設定画面に移りま
す。

・ F7 （FPag: Forward Page）を押すと、リリースレイトのキースケール設定画面に移りま
す。
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EDIT / E1 or E2 / ENV / AMPLITUDE & FILTER / KSC：アンプリチュード＆フィルターKSC（リリースレイト）

EDIT  → F2 （E1）または F3 （E2）→ F4 （Env）→ 5: Amplitude & Filter → ENTER  → Rate Release → F7 （KSC）

リリースレイトのキースケールを設定します。

RlRate 0 ～ 127
BP1、2の音程 C-2 ～ G8
BP1、2の変化幅 -64 ～ 63

解　説

・アンプリチュード＆フィルターのリリースレイトを、キースケール（音階）で変化
させるための設定を行います。

・リリースレイト（RlRate）では、リリースのレイトを設定します。この数値は、キー
スケール設定に入る前の、EG設定画面の「Rate Release」の数値と連動しています。
また、この数値がブレークポイントの基準値となります。

・リリースレイトのキースケールは、2つのブレークポイント（BP）で設定します。各
ブレークポイントは、「音程」と「基準値からの変化量」で設定します。（→ P. 33）

・画面には、音程による変化幅を示すグラフが表示されます。横軸が音程、縦軸がレ
イトです。点線の横線は「RlRate」の設定値（基準値）を示します。

・各ブレークポイントの音程の部分が反転表示になっているときには、鍵盤を使って
音程を入力することができます。 F8 （Kbd）を押した後、MIDIキーボードの任
意の鍵盤を弾いてください。

注　意

・ブレークポイント1、2は、順番に音程が上がっていくようにしか設定できません。
・基準値に変化幅を加えた値が、設定範囲（グラフの下端から上端までの範囲）を超
える場合には、最小または最大の設定値となります。

参　考

・ F6 （BPag: Backward Page）を押すと、サステインレベルのキースケール設定画面に移り
ます。



この章では、マスターチューニング、MIDIのセッティングや、外部機器と
のバルクデータのやりとり、フロッピーディスクへのボイスの保管や読み
込み、ボイスのリコール、デモ演奏などの機能を説明します。
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ユーティリティモードについて
ユーティリティモードに入ると、次のような画面が表示されます。

画面の一番下の行には、5種類の機能が表示されています。ファンクションボタンを使って、次の中から目的の
機能を選択します。

F1 （Sys） ‥マスターチューニングやMIDI、プログラムチェンジテーブル、
　　　　WXリップなどをセッティングします。

F2 （Bulk） ‥MIDIを使って、外部機器とボイスデータなどをやりとりしま
　す。

F3 （Disk） ‥フロッピーディスクにデータを保管したり、フロッピーディス
　　　　クからデータを読み込んだりします。

F4 （Recl） ‥直前にエディットしていたボイスを呼び出します。
F5 （Demo） ‥デモを演奏します。

ユーティリティモードについて
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システムの機能
ユーティリティモードの F1 （Sys）：システムでは、マスターチューニングやMIDI、プログラムチェンジ
テーブルなどをセッティングします。

・システムの機能

1: TG Setting （→ P. 188）
2: MIDI Setting （→ P. 189）
3: PGM Change Table （→ P. 190）
4: BC Curve （→ P. 191）
5: Miscellaneous （→ P. 193）
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UTIL / SYSTEM / TG SETTING：トーンジェネレーターセッティング

UTILITY  → F1 （Sys）→ 1: TG Setting → ENTER

マスターチューニング、リバーブのオン／オフ、アウトプットモード、WXリップを設定します。

Master Tuning -64 ～ 63
Reverb off, on
Output Monaural, Stereo
WX Lip Normal, Expand

解　説

・マスターチューニング（Master Tuning）は、全てのボイスに影響を与えるチューニ
ングです。プラスの数値で音程が上がり、マイナスの数値で音程が下がります。

・リバーブ（Reverb）では、リバーブレーションのオン／オフを最終的に選択します。
・アウトプット（Output）では、ボイスをモノラルで出すか、ステレオで出すかを、最
終的に選択します。「Monaural」を選択した場合には、エフェクトなどを含めてパン
の設定は全て無効となり、アウトプットL端子、R端子から同じ信号が出力されま
す。また、本機の電源を入れたとき、それを示すメッセージが表示されます。

・WXリップ（WX Lip）は、本機をWXシリーズ（WX7、 WX11など）のタイトリップ
のとき、ピッチベンドの変化幅を拡げる機能です。

・WX7、 WX11でタイトリップを使う場合、そのピッチベンドデータは-16～32の範囲
で出力されます。「Expand」を選択すると、これを内部的に-64～63に拡張します。

参　考

・マスターチューニングは、ステージなどの生ピアノのチューニングに合わせるような場合に
使います。マスターチューニングを「0」以外に設定すると、正しい音程にならないボイスが
あります。

・リバーブのオン／オフは、スタジオで別のリバーブが用意されている場合や、広いホールで
リバーブが必要ない場合などに「off」に切り換えます。

・本機をWX7、WX11で使用する場合、タイトリップを設定し、本機のWX Lipを「Expand」に設
定することをおすすめします。ルーズリップを設定した場合には、本機のWX Lipは「Normal」
に設定してください。ただし、ボイスによっては、WX Lipが「Expand」だと、演奏が困難にな
るものがあります。その場合には、ピッチベンドにアサインされているコントローラーディ
スティネーションのデプスを小さくするなどのエディットを行ってください。

システムの機能
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UTIL / SYSTEM / MIDI SETTING：MIDIセッティング

UTILITY  → F1 （Sys）→ 2: MIDI Setting → ENTER

MIDIトランスミットチャンネル、レシーブチャンネル、ローカルオン／オフ、デバイスナンバーを設定します。

Transmit Channel 1 ～ 16
Receive Channel 1 ～ 16, Omni
Local on/off off, on
Device Number off, 1 ～ 16, All

解　説

・トランスミットチャンネル（Transmit Channel）では、本機のブレスコントローラー
によるコントロール情報を出力するMIDI送信チャンネルを設定します。

・レシーブチャンネル（Receive Channel）では、本機が外部機器からの演奏情報で発
音するためのMIDI受信チャンネルを設定します。「Omni」を選択すると、1～16の
どのチャンネルで送られた情報でも発音する状態となります。

・ローカルオン／オフ（Local on/off）では、本機のブレスコントローラーと音源部分
とを切り離すかどうかを選択します。「on」が通常の状態で、内部的にブレスコント
ローラーと音源がつながった状態となります。「off」を選択すると、内部的な接続
が切り離され、MIDI端子の「OUT」に直接ブレスコントローラー情報が出力されま
す。

・デバイスナンバー（Device Number）では、バルクデータをやりとりするときに使用
するデバイスナンバーを設定します。「off」を選択するとバルクデータを一切送受
信しません。「All」を選択すると、どのデバイスナンバーで送られたバルクデータ
でも受信します。ただし、送信はデバイスナンバー＝1を使います。

注　意

・外部機器とバルクデータをやりとりする場合には、両機器のデバイスナンバーが一
致していなければなりません。

参　考

・ローカルオン／オフで「off」を選択することで、本機をブレスコントローラーの入力装置と
して使うことも可能です。

・システムエクスクルージブなどを使ってVL1のデータを本機で使ったり、本機のデータを
VL1で使うことができます。ただし、本機特有のWXリップやプログラムチェンジテーブルの
設定は、VL1側では無視されます。同様にVL1特有のパラメーターは本機では無視します。
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UTIL / SYSTEM / PGM CHANGE TABLE：プログラムチェンジテーブル

UTILITY  → F1 （Sys）→ 3: PGM Change Table → ENTER

プログラムチェンジテーブルを設定します。

001 ～ 128 A01（001） ～ H16（128）

解　説

・プログラムナンバーと、本機内のボイス番号との対応を設定します。
・たとえば、「001」のプログラムナンバーに対して、「A12」のボイス番号を設定して
おけば、外部MIDI機器から「000」のプログラムチェンジデータを受信したとき、本
機は「A12」のボイスに切り換えます。

・複数のプログラムナンバーに、同じボイス番号を対応させることもできます。
・ F6 （▲） F7 （▼）を使って、画面を上下にスクロールすることができま
す。

・ F8 （Init）を使うと、1～128のプログラムナンバーに対して、ボイス通し番号
001～128のボイスを対応させることができます。確認のメッセージが出ます（エ
ディットコンファームがオンの場合）ので、 ENTER を押します。

注　意

・プログラムチェンジは、送信側と受信側のMIDIチャンネルが合っていないと機能
しません。

・本機のプログラムナンバー（001～128）は、MIDIプログラムチェンジ（000～127）
に対応しています。送信側の機器によっては、プログラムナンバーで入力するもの
とプログラムチェンジナンバーで入力するものの2タイプがありますのでご注意く
ださい。

システムの機能
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UTIL / SYSTEM / BC CURVE：ブレスコントロールカーブ

UTILITY  → F1 （Sys）→ 4: BC Curve → ENTER

ブレスコントローラーの感度を設定します。

 Curve Normal, Soft, Wide, Hard

解　説

・本機に接続されたブレスコントローラーに関して、入力値と出力値のカーブを設定
します。たとえば、全体に弱く吹くタイプの方は、弱い吹き込みで大きな表現がで
きるように「Soft」を選択します。逆に全体に強く吹くタイプの方は、強い吹き込み
で大きな表現ができるように「Hard」を選択します。

・ブレスコントロールカーブ（Breath Control Curve）では、次の中からカーブを選択
します。（グラフの「入力」は実際の息を吹き込む強さ、「出力」は実際に音源に伝
えられる量です）

　ノーマル（Normal） 入力値と出力値が比例します。
　ソフト（Soft） 全体に音が出やすい（変化させやすい）カーブです。
　ワイド（Wide） ダイナミックレンジが広く感じられるカーブです。
　ハード（Hard） 全体に音が出にくい（変化させにくい）カーブです。
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・ブレスコントローラーから息を吹き込むと、そのときのブレス量が画面のグラフ上
に表示されます。また、グラフに入力値と出力値が数字で表示されます。

参　考

・ブレスコントロールカーブは、ブレスアタックの感度にも影響します。（→ 別冊のベーシッ
クガイド：P. 45）

システムの機能
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UTIL / SYSTEM / MISCELLANEOUS：ミスレイニアス

UTILITY  → F1 （Sys）→ 5: Miscellaneous → ENTER

ディスプレイ、コンファーム、メモリープロテクト、グリーティングメッセージを設定します。

Display Reverse, Normal
Confirm off, on
Memory Protect off, on
Greeting Message 20文字まで

解　説

・ディスプレイ（Display）では、画面の表示方法を選択します。「Normal」を選択する
と、白地に黒文字という表示に変わります。「Reverse」が黒地に白文字という工場
出荷時の状態です。

・コンファーム（Confirm）では、「Are you sure?」という確認のメッセージを表示する
かしないかを選択します。このメッセージが表示されるのは次の操作をしたときで
す。「off」を選択すると、このメッセージを表示しなくなります。

ボイスのストア
ディスクのセーブ、ロード、デリート、フォーマット
プログラムチェンジテーブルのイニシャライズ
バルクデータの送信
エディットリコール
デモンストレーションの状態に入るとき

・メモリープロテクト（Memory Protect）では、本体内に記憶されているボイスやシス
テムのデータを守るための設定です。「on」になっている場合には、外部機器からバ
ルクデータを受信したり、ディスクからデータをロードしたり、ボイスをストアし
たりすることができません。電源をオン／オフしても設定が変わることはありませ
ん。ただし、メモリープロテクトをオンに設定してセーブされたデータをロードし
た場合には、メモリープロテクトが「on」になります。

・グリーティングメッセージ（Greeting Message）では、電源を入れたとき、最初に表
示されるメッセージを設定します。この部分に反転表示を移動し、 F8 （Name）
または ENTER を押すと、文字入力のウィンドウが表示されます。このウィンドウで
文字を入力します。文字を入力する方法については、第1章「文字を入力する」（→
P. 20）をご覧ください。
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注　意

・コンファームを「off」にすると、作業の手順を1つ減らすことができますので、とて
も便利ですが、大切なデータを消してしまったりしないよう十分ご注意ください。

参　考

・外部機器（コンピューターやシーケンサーなど）から、本機用のバルクデータを送信し、本機
のインターナルボイスやシステムデータを変更するときは、メモリープロテクトを「off」に
します。

・外部機器からエディットバッファーへボイスデータを送信するときは、メモリープロテクト
の設定に関係なくデータを受信します。

システムの機能
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MIDIバルクダンプの機能

MIDIバルクダンプの機能
ユーティリティモードの F2 （Bulk）：MIDIバルクダンプには、本機のボイスデータやシステムデータを外
部のコンピューターやシーケンサーに送信する機能が集められています。

・MIDIバルクダンプの機能

1: System （→ P. 197）
2: All Voice （→ P. 198）
3: Current Voice （→ P. 199）
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MIDIバルクダンプの機能

解　説

・バルクデータを外部機器と送受信する場合には、次の点を必ず確認してください。

■バルクデータの送受信可能な機器であること

バルクデータは、原則として製品ごとに異なる固有のデータです。したがって、本機
とバルクデータをやりとりできるのはもう一台のVL1-mやVL1、またはバルクデータ
の受信、送信のできるシーケンサーもしくはMIDIデータファイラーに限られます。

■MIDIケーブルの接続

バルクデータを送信する側のMIDI OUT端子と、受信する側のMIDI IN端子がMIDI
ケーブルで接続されていなければなりません。また、双方向の送受信を行う場合に
は、MIDI OUT端子とMIDI IN端子が2本のMIDIケーブルで接続されていなければな
りません。

■デバイスナンバー

バルクデータを送受信する場合には、両方の機器のデバイスナンバーが一致していな
ければなりません。（→ P. 189）

■メモリープロテクト

外部機器からバルクデータを受信する場合には、本機のメモリープロテクトを「off」
にしておかなければなりません。（→ P. 193）
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UTIL / BULK DUMP / SYSTEM：システム

UTILITY  → F2 （Bulk）→ 1: System

本機のシステムデータを外部MIDI機器に送信します。

設定項目はありません

解　説

・システムデータ（ユーティリティのシステムで設定したデータとマイクロチューニ
ングのI-1, I-2のデータおよびプログラムチェンジテーブルデータ）を外部のコン
ピューターやシーケンサーに送信します。

注　意

・外部MIDI機器にバルクデータを送信するときには、両機器のデバイスナンバー（→
P. 189）が一致していなければなりません。

・VL1にシステムデータを送信する場合、プログラムチェンジテーブルデータとWX
リップの設定は無視されます。

・VL1のシステムデータを受信する場合、アサイナブルコントローラーやベロシティ
カーブ、アフタータッチカーブの設定は無視します。

手　順

1. 本機のデバイスナンバーが正しく設定されていることを確認します。

2. 外部MIDI機器を、バルクデータ受信可能な状態に切り換えます。
この操作については、外部MIDI機器の説明書をご覧ください。

3. ENTER を押します。
▼「Are you sure?」という確認のメッセージが表示されます。（ただし、コン

ファームが「off」の場合には表示されずに、すぐにシステムデータの送信が
実行されます）

4. INC を押します。
▼システムデータが、外部MIDI機器に送信されます。

参　考

・バルクダンプを実行すると、プログラムチェンジテーブルデータ、マイクロチューニングI-1デー
タ、マイクロチューニングI-2データ、システムデータの順で送信されます。

MIDIバルクダンプの機能
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UTIL / BULK DUMP / ALL VOICE：オールボイス

UTILITY  → F2 （Bulk）→ 2: All Voice

本機の全てのボイスデータを外部MIDI機器に送信します。

設定項目はありません

解　説

・128個のボイスデータを外部のコンピューターやシーケンサーに送信します。

注　意

・外部MIDI機器にバルクデータを送信するときには、両機器のデバイスナンバー（→
P. 189）が一致していなければなりません。

手　順

1. 本機のデバイスナンバーが正しく設定されていることを確認します。

2. 外部MIDI機器を、バルクデータ受信可能な状態に切り換えます。
この操作については、外部MIDI機器の説明書をご覧ください。

3. ENTER を押します。
▼「Are you sure?」という確認のメッセージが表示されます。（ただし、コン

ファームが「off」の場合には表示されずに、すぐに128ボイスのデータの送
信が実行されます）

4. INC を押します。
▼128ボイスのデータが、外部MIDI機器に送信されます。

参　考

・128ボイスのデータを送信している最中に EXIT を押すと、送信を中断することができます。
中断したときは、「Canceled!」と表示され、その時点のボイスデータまでは送信されます。

MIDIバルクダンプの機能
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MIDIバルクダンプの機能

UTIL / BULK DUMP / CURRENT｠VOICE：カレントボイス

UTILITY  → F2 （Bulk）→ 3: Current Voice

現在選択されているボイスのデータを外部MIDI機器に送信します。

設定項目はありません

解　説

・現在、選択されているボイス（エディットバッファーのボイス）のデータを外部の
コンピューターやシーケンサーに送信します。

注　意

・外部MIDI機器にバルクデータを送信するときには、両機器のデバイスナンバー（→
P. 189）が一致していなければなりません。

手　順

1. 本機のデバイスナンバーが正しく設定されていることを確認します。

2. あらかじめ、プレイモードで送信するボイスを選択した後、この機能に入りま
す。

3. 外部MIDI機器を、バルクデータ受信可能な状態に切り換えます。
この操作については、外部MIDI機器の説明書をご覧ください。

4. ENTER を押します。
▼「Are you sure?」という確認のメッセージが表示されます。（ただし、コン

ファームが「off」の場合には表示されずに、すぐにボイスのデータの送信が
実行されます）

5. INC を押します。
▼ボイスデータが、外部MIDI機器に送信されます。

参　考

・この機能では、エディットバッファーのデータを外部機器に送信します。送信先の機器がも
う一台のVL1-mまたはVL1の場合には、その機器のエディットバッファーのボイスデータが
書き換えられます。このとき、送信先の機器のメモリープロテクトは「on」でもかまいませ
ん。
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ディスクの機能

ディスクの機能
ユーティリティモードの F3 （Disk）：ディスクには、フロッピーディスクとデータのやりとりを行うための
機能が用意されています。

・ディスクの機能

1: Disk Status （→ P. 201）
2: Load From Disk （→ P. 202）
3: Save To Disk （→ P. 204）
4: Rename File （→ P. 206）
5: Delete File （→ P. 208）
6: Format Disk （→ P. 209）

注　意

・フロッピーディスクのライトプロテクトタブがオン（窓が開いている状態）になっ
ている場合には、データを変更する作業（セーブ、リネーム、デリート、フォーマッ
ト）はできません。

・フロッピーディスクの出し入れは、フロッピーディスクドライブのユーズランプが
消えている状態で行ってください。点灯中に出し入れすると、データが破壊される
ことがあります。

参　考

・本機は、2DDタイプ（MF2DD）と2HDタイプ（MF2HD）の2種類のディスクが使用可能です。
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ディスクの機能

UTIL / DISK / DISK STATUS：ディスクステータス

UTILITY  → F3 （Disk）→ 1: Disk Status → ENTER

フロッピーディスクに保存されているファイル数や空き容量などを表示します。

設定項目はありません

解　説

・セットされているフロッピーディスクに入っている各種ファイルの数、使っている
容量と空いている容量を表示します。

・トータル（Total）には、全ファイルの数を表示します。
・ユーズド（Used）には、現在使用中の容量をキロバイト単位で表示します。
・フリー（Free）には、空き容量をキロバイト単位で表示します。
・オール（All）、システム（System）、オールボイス（All Voice）、1バンク（1 Bank）、
1ボイス（1 Voice）には、各データ形式でセーブされているファイルの数を表示しま
す。（下記の参考を参照）

・アザース（Others）には、上記のデータ形式に含まれないタイプのファイルの数を表
示します。

参　考

・本機で扱うことのできるデータには、次のような種類があります。また、各ファイルには自
動的に次のような拡張子（ファイル名の後ろに付けられる「.」＋3文字）が付けられます。た
だし、本機ではこの拡張子を見ることはできません。

1: All 拡張子：.ALL
System＋All Voiceのデータ

2: System 拡張子：.SYS
システムデータ＋マイクロチューニングI-1, I-2のデータ+プログラムチェンジテーブルデータ

3: All Voice 拡張子：.AVC
128個分のボイスデータ

4: 1 Bank 拡張子：.1BK
1バンク（ボイス16個分）のデータ

5: 1 Voice 拡張子：.1VC
1ボイスのデータ
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ディスクの機能

UTIL / DISK / LOAD｠FROM｠DISK：ロードフロムディスク

UTILITY  → F3 （Disk）→ 2: Load From Disk → ENTER

フロッピーディスクに保存されているファイルを読み込みます。

読み込むデータの種類 1: All
2: System
3: All Voice
4: 1 Bank
5: 1 Voice

解　説

・セットされているフロッピーディスクから任意のデータをロード（読み込み）しま
す。

・ロードするデータは、次の中から選択します。
1: All System＋All Voiceのデータ
2: System システムデータ＋マイクロチューニングI-1, I-2のデータ+

プログラムチェンジテーブルデータ
3: All Voice 128個分のボイスデータ
4: 1 Bank 1バンク分の16ボイスデータ
5: 1 Voice 1ボイスデータ

・「All」ファイルの中から、1バンク分のボイスデータや1ボイスデータだけをロード
したり、システムデータだけをロードしたりすることもできます。同様に、「All
Voice」ファイルの中から、1バンク分のボイスデータや1ボイスデータだけをロード
したり、「1 Bank」ファイルの中から、1ボイスデータだけをロードしたりすること
もできます。

注　意

・フロッピーディスクからデータを読み込むと、もともと本機に入っていたデータは
読み込んだデータに置き換えられてしまいます。必要なデータの場合には、あらか
じめフロッピーディスクにセーブしておいてください。

・メモリープロテクト（→ P. 193）が「on」になっている場合には、それを示すメッ
セージが表示されます。

・データのロード実行中に作業を中止することはできません。無理に電源を切ったり
すると、データが壊れてしまう場合があります。

参　考

・次ページの手順の操作中、 EXIT を押すと、1手順前に戻ることができます。
・また、ロードするボイスを選択するとき、 F6 （123...）、 F7 （ABC...）で、番号順表
示か、アルファベット順表示かを選択することができます。（このとき「Now sorting!」と表示
され、少し時間がかかる場合があります）
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手　順

1. ロードするデータの種類（1～5）を選択し、 ENTER を押します。
▼そのデータを含んでいるファイルの一覧が表示されます。

2. ロードするファイルを選択し、 ENTER を押します。
選択したデータの種類によっては、この操作の後、ロードするボイスやバンク
を選択するウィンドウ、また、どこにロードするかを選択するウィンドウなど
が表示されます。状況に応じて、選択、 ENTER の操作を繰り返してください。
なお、「～～ SRC ～～」がロード元の選択、「～～ DST ～～」がロード先の選
択です。
▼必要な選択が終わると、「Are you sure?」という確認のメッセージが表示さ

れます。（ただし、コンファームが「off」の場合には表示されずにすぐに
ロードが実行されます）

3. INC を押します。
▼これで、データのロードが実行されます。

ディスクの機能
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ディスクの機能

UTIL / DISK / SAVE｠TO｠DISK：セーブトゥーディスク

UTILITY  → F3 （Disk）→ 3: Save To Disk → ENTER

フロッピーディスクにデータを保存します。

保存するデータの種類 1: All
2: System
3: All Voice
4: 1 Bank
5: 1 Voice

解　説

・セットされているフロッピーディスクに任意のデータをセーブ（保存）します。
・セーブするデータは、次の中から選択します。

1: All System＋All Voiceのデータ
2: System システムデータ＋マイクロチューニング I-1,  I-2 のデータ+

プログラムチェンジテーブルデータ
3: All Voice 128個分のボイスデータ
4: 1 Bank 1バンク分の16ボイスデータ
5: 1 Voice 1ボイスデータ

注　意

・セーブするフロッピーディスクは、あらかじめフォーマット（→ P. 209）されてい
なければなりません。

・フロッピーディスクのライトプロテクトタブがオン（窓が開いている状態）になっ
ている場合には、データはセーブできません。

・データのファイル名を入力するとき、ファイル名の途中にスペースは使わないよう
にしてください。

参　考

・次ページの手順の操作中、 EXIT を押すと、1手順前に戻ることができます。
・また、セーブするボイスを選択するとき、 F6 （123...）、 F7 （ABC...）で、番号順表
示か、アルファベット順表示かを選択することができます。（このとき「Now sorting!」と表示
され、少し時間がかかる場合があります）

・本機でセーブしたデータには、自動的に拡張子（ファイル名の後ろに付けられる「.」＋3文
字）が付けられます。（→ P. 201）
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手　順

1. セーブするデータの種類（1～5）を選択し、 ENTER を押します。
▼「All」「System」「All Voice」を選択した場合には、ディスクのファイル一覧

が表示されます。このまま手順3に進んでください。「1 Bank」「1 Voice」を
選択した場合には、手順2に進んでください。

2. セーブするバンクまたはボイスを選択し、 ENTER を押します。
▼選択すると、ディスクのファイル一覧が表示されます。

3. データを新しいファイルとして保存する場合には、「000: ～～～ : NewFile」
に反転表示を合わせます。
（～～～の部分には、ボイス名、グリーティングメッセージ、または先頭のボ
イス名の8文字が入ります）

すでにセーブされているファイルと置き換える場合には、そのファイルに反転
表示を合わせます。
▼この場合には、ファイル名を入力する必要はありませんので、手順7に進ん

でください。

4. F5 （Name）を押します。
▼ファイル名を入力するウィンドウが表示されます。

5. ファイル名を入力します。
文字を入力する操作については、第1章「文字を入力する」（→ P. 20）をご覧く
ださい。（ファイル名は最大8文字です）
ファイル名の途中にスペースは使わないようにしてください。

6. ENTER を押します。
▼ウィンドウが閉じます。

7. ENTER を押します。
▼「Are you sure?」という確認のメッセージが表示されます。（ただし、コン

ファームが「off」の場合には表示されずにすぐにセーブが実行されます）

8. INC を押します。
▼入力したファイル名でデータのセーブが実行されます。

ディスクの機能
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ディスクの機能

UTIL / DISK / RENAME FILE：リネームファイル

UTILITY  → F3 （Disk）→ 4: Rename File → ENTER

フロッピーディスクのファイルのファイル名を変更します。

データの種類 1: All
2: System
3: All Voice
4: 1 Bank
5: 1 Voice

解　説

・フロッピーディスクのファイルのファイル名を変更（リネーム）します。
・リネームするデータは、次の中から選択します。

1: All System＋All Voiceのデータ
2: System システムデータ＋マイクロチューニングI-1, I-2のデータ+

プログラムチェンジテーブルデータ
3: All Voice 128個分のボイスデータ
4: 1 Bank 1バンク分の16ボイスデータ
5: 1 Voice 1ボイスデータ

注　意

・本機で扱うことのできないファイルのリネームはできません。
・フロッピーディスクのライトプロテクトタブがオン（窓が開いている状態）になっ
ている場合には、ファイルはリネームできません。

・データのファイル名を入力するとき、ファイル名の途中にスペースは使わないよう
にしてください。

参　考

・次ページの手順の操作中、 EXIT を押すと、1手順前に戻ることができます。
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手　順

1. リネームするデータの種類（1～5）を選択し、 ENTER を押します。
▼ファイルの一覧が表示されます。

2. リネームするファイルを選択し、 F5 （Rnam）を押します。
▼ファイル名を入力するウィンドウが表示されます。

3. ファイル名を入力します。（最大8文字）
文字を入力する操作については、第1章「文字を入力する」（→ P. 20）をご覧く
ださい。
ファイル名の途中にスペースは使わないようにしてください。
▼ファイル名を入力し終わったら次の手順に進みます。

4. ENTER を押します。
▼ウィンドウが閉じます。

5. ENTER を押します。
▼「Are you sure?」という確認のメッセージが表示されます。（ただし、コン

ファームが「off」の場合には表示されずにすぐにリネームが実行されます）

6. INC を押します。
▼リネームが実行されます。

ディスクの機能
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ディスクの機能

UTIL / DISK / DELETE FILE：デリートファイル

UTILITY  → F3 （Disk）→ 5: Delete File → ENTER

フロッピーディスクのファイルを削除します。

データの種類 1: All
2: System
3: All Voice
4: 1 Bank
5: 1 Voice
6: Others

解　説

・セットされているフロッピーディスクにセーブされているファイルを削除（デリー
ト）します。

・デリートするデータは、次の中から選択します。
1: All System＋All Voiceのデータ
2: System システムデータ＋マイクロチューニングI-1, I-2のデータ+

プログラムチェンジテーブルデータ
3: All Voice 128個分のボイスデータ
4: 1 Bank 1バンク分の16ボイスデータ
5: 1 Voice 1ボイスデータ
6: Others 上記以外のデータ

注　意

・フロッピーディスクのライトプロテクトタブがオン（窓が開いている状態）になっ
ている場合には、ファイルをデリートできません。

参　考

・次ページの手順の操作中、 EXIT を押すと、1手順前に戻ることができます。

手　順

1. デリートするデータの種類（1～6）を選択し、 ENTER を押します。
▼ファイルの一覧が表示されます。

2. デリートするファイルを選択し、 ENTER を押します。
▼「Are you sure?」という確認のメッセージが表示されます。（ただし、コン

ファームが「off」の場合には表示されずにすぐにデリートが実行されます）

3. INC を押します。
▼デリートが実行されます。
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第
５
章

UTIL / DISK / FORMAT DISK：フォーマットディスク

UTILITY  → F3 （Disk）→ 6: Format Disk → ENTER

フロッピーディスクをフォーマットします。

設定項目はありません

解　説

・セットされているフロッピーディスクをフォーマット（初期化）します。

注　意

・新しいフロッピーディスクは、あらかじめこのフォーマットを実行しておかない
と、データをセーブできません。

・すでにデータの入っているフロッピーディスクをフォーマットすると、中のデータ
は全て消えてしまいます。

・フロッピーディスクのライトプロテクトタブがオン（窓が開いている状態）になっ
ている場合には、フォーマットできません。

手　順

1. ENTER を押します。
▼「Are you sure?」という確認のメッセージが表示されます。（ただし、コン

ファームが「off」の場合には表示されずにすぐにフォーマットが開始されま
す）

2. INC を押します。
▼フォーマットが実行されます。フォーマットにはしばらく時間がかかりま

す。

参　考

・本機は、2DDタイプ（MF2DD）と2HDタイプ（MF2HD）の2種類のディスクが使用可能です。

MF2DD ：　720KBytes （MS-DOS 9セクターフォーマット）
MF2HD ：　1.44MBytes （MS-DOS 18セクターフォーマット）

ディスクの機能
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エディットリコールの機能

エディットリコールの機能
ユーティリティモードの F4 （Recl）：エディットリコールには、直前にエディットしていたボイスを呼び戻
す機能があります。

プレイモード�

エディットモード�

ユーティリティモード�

コモンエディット�

エレメントエディット�

モディファイア�

デモ�

ミスレイニアス�

エフェクト�

コントローラー�

ミスレイニアス�

エンベロープ�

システム�

MIDIバルクダンプ�

ディスク�

エディットリコール�
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第
５
章

エディットリコールの機能

UTIL / EDIT RECALL：エディットリコール

UTILITY  → F4 （Recl）

直前にエディットしていたボイスを呼び戻します。

設定項目はありません

解　説

・エディットしたボイスをストアする前に、プレイモードに戻してボイスを切り換え
ると、エディット中だったボイスは消えてしまいます。（エディット前のボイスに
戻ってしまいます）そのボイスをエディット中の状態に戻すのがこの「エディット
リコール（あるいはリコール）」の機能です。

・また、エディット中やユーティリティの設定中に、外部MIDI機器からプログラム
チェンジを受信すると、ボイスが切り換わってしまいます。このような場合にも、
このエディットリコールでエディット中だったボイスを呼び戻すことができます。

・画面には、エディットしていたボイス（Recall Memory Voice）と現在のボイス
（Current Voice）が表示されます。

・現在のボイスが何もエディットされていない場合、5、6行目は表示されません。
・本体内部でのボイスデータの格納場所、移動については、第1章のリコールについて
の説明をご覧ください。（→ P. 31）

手　順

1. ENTER を押します。
▼「Are you sure?」という確認のメッセージが表示されます。（ただし、コン

ファームが「off」の場合には表示されずにすぐにリコールが実行されます）

2. INC を押します。
▼リコールが実行されます。

3. PLAY を押します。
▼「E」の反転表示のついたボイスが表示され、リコールが行われたことがわか

ります。
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デモの機能

デモの機能
ユーティリティモードの F5 （Demo）：デモには、デモンストレーション演奏の機能があります。

プレイモード�

エディットモード�

ユーティリティモード�

コモンエディット�

エレメントエディット�

モディファイア�
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エフェクト�

コントローラー�
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エンベロープ�

システム�

MIDIバルクダンプ�

ディスク�

エディットリコール�

デモ�
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第
５
章

デモの機能

UTIL / DEMO：デモ

UTILITY  → F5 （Demo）

デモンストレーションの演奏を行います。

Top Song 1 ～ 16

解　説

・本体内に内蔵されているデモンストレーションの演奏を実行します。
・一番最後の曲（16曲目）は、GM音源（たとえばTG300）をバックに本機のデモンス
トレーション演奏を行う設定になっています。MIDI OUT端子からバックの演奏情
報が送信されます。

手　順

1. ENTER を押します。
▼「Are You Sure ?」と確認のメッセージが表示されます。ただし、コンファー

ムが「off」の場合には表示されずにすぐに手順3に進みます。

2. INC を押します。
▼デモ曲の選択、再生、停止を行う画面に変わります。

3. デモ曲を選択します。

4. F8 （Run）を押します。
▼デモの演奏がはじまります。曲が終わると、自動的に次の曲がはじまりま

す。デモ演奏を終わるときは、次の手順に進みます。

5. F7 （Stop）を押します。
▼デモ演奏が終了します。

参　考

・デモンストレーションの演奏に使用している音色は、同梱ディスクの内容と違う音色も使わ
れています。演奏の途中で F7 （Stop）を押し EXIT を押すと、プレイモードで使用する
ことが可能です。気にいった音色は、ストアの操作を行うことで、ご自分の音色として使用
することができます。

注　意

・エディット中（あるいはエディットしてまだストアしていない）の状態でこのデモ
を実行すると、エディット中のボイスは消えてしまいます。残しておきたいボイス
は、デモ演奏をする前にストアしておいてください。（→P. 23）
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MEMO
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機能一覧
VL1-mの持つすべての機能の一覧です。

Play Mode

ボイスを選ぶ。（→ P. 41）

外部MIDI機器の鍵盤やコントローラー、またはシーケンサーなどを使って演奏する。

クイックエディットを行う。（→ P. 40）

ボイスデータをストアする。（→ P. 23）

　　Cnt1　 Controller View 1 プレッシャー、アンブシュア、ピッチ、ビブラートがどのコント

ローラーに割り当てられているか表示します。（→ P. 44）

　　Cnt2　 Controller View 2 タンギング、アンプリチュード、スクリーム、ブレスノイズがど

のコントローラーに割り当てられているか表示します。   　　　

（→ P.45）

　　Cnt3　 Controller View 3 グロウル、スロートフォルマント、ダイナミックフィルター、

ハーモニックエンハンサーがどのコントローラーに割り当てられ

ているか表示します。（→ P. 46）

　　Cnt4　 Controller View 4 ダンピング、アブソープションがどのコントローラーに割り当て

られているか表示します。（→ P. 47）

　　Cnt5　 Controller View 5 ポリフォニー、サステイン、ピッチベンドモード、ポルタメント

モード、エフェクトの設定を表示します。（→ P. 48）

　　QED　 Quick Edit View クイックエディットの設定および状態を表示します。（→ P. 49）

　　Moni　 Monitor ブレスコントローラーや外部MIDI機器から送られてくるMIDI

データを表示します。（→ P. 50）

　　Dir  　 Directory ボイスの一覧を表示し、ボイスを切り換えます。（→ P. 42）

機能一覧



付録　　217

機能一覧

Edit Mode

ボイスのエディットを行う。（→ P. 21）

ボイスデータをストアする。（→ P. 23）

ボイスの任意のデータをコピーする。（→ P. 26）

ボイス名、キーモード、ボイスモード、エレメント名を設定する。（→ P. 53）

　　Com　 Common Edit エレメント1、2に共通の設定を行います。（→ P. 55）

　Misc　 Miscellaneous 1: Setting アサインモード、ピッチベンドモード、サステインを設定しま

す。（→ P. 57）

2: Controller ブレスアタックとタッチEGの特性、ポリフォニーコントロール

を設定します。（→ P. 58）

3: Element Pitch 各エレメントのデチューンとノートシフト、ランダムピッチを設

定します。（→ P. 59）

4: Element Level & Pan 各エレメントのレベルとパンを設定します。（→ P. 60）

5: Portamento ポルタメントを設定します。（→ P. 62）

6: Micro Tuning 各エレメントごとにマイクロチューニングを設定します。　　

（→P. 63）

7: Quick Edit Assign クイックエディットの対象となる設定項目を設定します。　　

（→ P. 65）

　Efct　 Effect 1: Setting フィードバックディレイとリバーブレーションの接続方法とエ

フェクトコントローラーを設定します。（→ P. 67）

2: Modulation Effect モジュレーションエフェクトを選択し、細かい設定を行います。

（→ P. 69）

3: Feedback Delay フィードバックディレイのタイプを選択し、細かい設定を行いま

す。（→ P. 76）

4: Reverberation リバーブのタイプを選択し、細かい設定を行います。（→ P. 84）
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機能一覧

　　E1／E2　 Element Edit それぞれのエレメントをエディットします。（→ P. 88）

　Ctrl　 Controller 1: Pressure プレッシャーのコントローラーを設定します。（→ P. 92）

2: Embouchure アンブシュアのコントローラーを設定します。（→ P. 93）

3: Pitch ピッチのコントローラーを設定します。（→ P. 95）

4: Vibrato ビブラートのコントローラーを設定します。（→ P. 97）

5: Tonguing タンギングのコントローラーを設定します。（→ P. 98）

6: Amplitude アンプリチュードのコントローラーを設定します。（→ P. 99）

7: Scream スクリームのコントローラーを設定します。（→ P. 100）

8: Breath Noise ブレスノイズのコントローラーを設定します。（→ P. 101）

9: Growl グロウルのコントローラーを設定します。（→ P. 102）

10: Throat Formant スロートフォルマントのコントローラーを設定します。　　

（→ P.104）

11: Dynamic Filter ダイナミックフィルターのコントローラーを設定します。　　

（→ P.106）

12: Harmonic Enhancer ハーモニックエンハンサーのコントローラーを設定します。　　

（→ P. 107）

13: Damping ダンピングのコントローラーを設定します。（→ P. 109）

14: Absorption アブソープションのコントローラーを設定します。（→ P. 110）

S&R Search & Replace コントローラーの設定状況を確認したり、変更したりします。

（→ P. 90）

　Misc　 Miscellaneous 1: Setting トリガーモード、クロスフェードスピード、インターポレートス

ピードを設定します。（→ P. 112）

2: Breath Noise ブレスノイズを設定します。（→ P. 113）

3: Throat Formant スロートフォルマントを設定します。（→ P. 118）

4: Mixing ドライバー出力、パイプ／ストリング出力、タップアウト出力の

ミキシングバランスを設定します。（→ P. 125）

5: Amplitude エレメントのアウトプットレベルを設定します。 （→ P. 131）
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機能一覧

　Modi　 Modifier 1: Harmonic Enhancer ハーモニックエンハンサーのキャリアとモジュレーターを設定し

ます。（→ P. 134）

2: Dynamic Filter ダイナミックフィルターを設定します。（→ P. 147）

3: Equalizer Auxiliary イコライザーを設定します。（→ P. 151）

4: Equalizer Band パラメトリックイコライザーを設定します。（→ P. 154）

5: IE & RSN Setting インパルスエキスパンダー、レゾネーターのオン／オフおよび各

種レベルを設定します。（→ P. 155）

6: Impulse Expander インパルスエキスパンダーを設定します。（→ P. 157）

7: Resonator レゾネーターを設定します。（→ P. 159）

　Env　 Envelope 1: Pressure プレッシャーの変化のしかたや、ベロシティによるプレッシャー

の変化を設定します。（→ P. 161）

2: Embouchure & Pitch ベロシティによるアンブシュアとピッチの変化のしかたを設定し

ます。（→ P. 163）

3: Vibrato ビブラートのゆれの速さや効果の深さ、効果の対象などを設定し

ます。（→ P. 168）

4: Growl グロウルのゆれの速さや効果の深さ、効果の対象などを設定しま

す。（→ P. 174）

5: Amplitude & Filter アンプリチュードとフィルターの時間的変化、ベロシティによる

変化を設定します。（→ P. 176）

●エディットモードで使用できるその他の機能

Store エディットしたボイスを本体内に保存します。（→ P. 23）

Compare エディット中のボイスと、エディット前のボイスとを聴き比べま

す。（→ P. 25）

Copy エディット中に、別のボイスなどからさまざまなデータをコピー

します。（→ P. 26）

Element Select エレメントエディット中に、エレメント1と2の画面を交互に切り

換えます。（→ P. 32）

Element On / Off エディット中に、どちらか片方のエレメントの音を確認します。

（→ P. 32）
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機能一覧

Utility Mode

　　Sys　 System 1: TG Setting マスターチューニング、リバーブのオン／オフ、アウトプット

モード、WXリップを設定します。（→ P. 188）

2: MIDI Setting MIDIトランスミットチャンネル、レシーブチャンネル、ローカル

オン／オフ、デバイスナンバーを設定します。（→ P. 189）

3: PGM Change Table プログラムチェンジナンバーとボイス番号の対応を設定します。

（→ P. 190）

4: BC Curve ブレスコントローラーの感度を設定します。（→ P. 191）

5: Miscellaneous ディスプレイ、コンファーム、メモリープロテクト、グリーティ

ングメッセージを設定します。（→ P. 193）

　　Bulk　 MIDI BulkDump 1: System 本機のシステムデータなどを外部MIDI機器に送信します。　　

（→ P.197）

2: All Voice 本機の全てのボイスデータを外部MIDI機器に送信します。　　

（→ P.198）

3: Current Voice 現在選択されているボイスのデータを外部MIDI機器に送信しま

す。（→ P. 199）

　　Disk　 Disk 1: Disk Status フロッピーディスクに保存されているファイル数や空き容量など

を表示します。（→ P. 201）

2: Load From Disk フロッピーディスクに保存されているファイルを読み込みます。

（→ P. 202）

3: Save To Disk フロッピーディスクにデータを保存します。（→ P. 204）

4: Rename File フロッピーディスクのファイルのファイル名を変更します。　　

（→ P. 206）

5: Delete File フロッピーディスクのファイルを削除します。（→ P. 208）

6: Format Disk フロッピーディスクをフォーマットします。（→ P. 209）

　　Recl　 Recall 直前にエディットしていたボイスを呼び戻します。（→ P. 211）

　　Demo　 Demo デモンストレーションの演奏を行います。（→ P. 213）
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故障かな？と思ったら
「音が出ない」「音が変」「音程がおかしい」などといった状況になってしまったら、機械の故障を疑う前に、こ
の説明をご覧ください。多くの場合、解決への糸口を見つけられることでしょう。

まず、トラブルに遭遇したら、次の3つのテストを行って、原因をおおまかにさぐってください。

■本機にヘッドフォンを差し込み、プレイ画面で ENTER を押して正常な音が出てい
るか確認します。

これで正常な音が聴こえるならば、原因はアンプやMIDIキーボード、ミキサー、ケー
ブル、本機のコントローラーの設定などにあります。

■外部MIDI機器のすべてのコントローラーを動かして、正常な音に戻るかどうか確
認します。

本機はコントローラーの状態によって、音が出なくなったり、音程が変化したりしま
す。これで正常な音が出るようであれば、ユーティリティの設定やコントローラーの
状態の問題です。

■ボイスを切り換えても同じ症状が出るかどうか確認します。

特定のボイスだけでトラブルが起こる場合は、ボイスの設定に原因があります。どの
ボイスでも同じトラブルが起こる場合は、ユーティリティの設定に原因があります。

原因のおおよその見当がついたら以下の中から、該当する症状をさがし、原因を究明
してください。

アンプやミキサー、ケーブルなどに原因がある場合

音が出ない

・アンプの電源は入っていますか？

・アンプやミキサーのボリュームは上がっていますか？

・本機のアウトプット端子とアンプ（またはミキサー）とが正しく接続されています
か？（→ 別冊のベーシックガイド：P. 21）

・ケーブルは断線していませんか？別のケーブルで試してみてください。

・モニター画面で、Main Volume=127になっていますか？（→P. 50）

音が割れる

・アンプなどのマイク入力端子に接続されていませんか？

音の定位がおかしい

・アウトプット端子L、Rと接続したミキサーのチャンネルのパンを、それぞれ左と右
に振り分けてありますか？

故障かな？と思ったら
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故障かな？と思ったら

ユーティリティの設定に原因がある場合

音が出ない

・ローカルオン／オフが、オフになっていませんか？（→ P. 189）

・外部機器のMIDIトランスミットチャンネルと本機のMIDIレシーブチャンネルが
合っていますか？（→ P. 189）

・ロードされているデータが、キーボードの持っているコントローラーの条件に合致
していますか？（→別冊のベーシックガイド：P.17）

MIDIキーボードの弾いた鍵盤の音程が出ない

・マスターチューニングが「0」以外に設定されていませんか？（→ P. 188）

リバーブがかからない

・TGセッティングのリバーブが、オフになっていませんか？（→ P. 188）

思ったようなモノラル音が出ない

・本機は基本的にステレオ出力です。モノラルで使う場合には、アウトプット端子L、
Rのどちらかににケーブルを接続した後、TGセッティングのアウトプットをモノラ
ルにしてください。（→ P. 188）

ボイスをコントローラーでうまくコントロールできない

・WXリップの設定は正しいですか？（→ P. 188）

・ブレスコントローラーのカーブは適切になっていますか？（→P.191）

・使用されているコントローラーにあった設定のボイスデータがロードされています
か？（→別冊のベーシックガイド：P.22）
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故障かな？と思ったら

ボイスの設定に原因がある場合

音が出ない

・エレメントは選択されていますか？（→ P. 53）

・エレメントレベルが、「0」に設定されていませんか？（→ P. 60）

・アンプリチュードレベルが、「0」に設定されていませんか？（→ P. 131）

・ドライブ、パイプ／ストリング、タップアウトのミキシングが全て「0」になってい
ませんか？（→ P. 125）

・アンプリチュード＆フィルターのサステインレベルが「0」になっていませんか？
（→ P. 177）

・プレッシャーのコントローラーを確認してください。（→ P. 92）

・アンプリチュードのコントローラーを確認してください。（→ P. 99）

・アンブシュアのコントローラーを確認してください。（→ P. 93）

・ダンピングのコントローラーを確認してください。（→ P. 109）

・アブソープションのコントローラーを確認してください。（→ P. 110）

・極端に高い音域や低い音域では、鳴らないように設定されたボイスもあります。

音が出つづける

・プレッシャーのEGモードが「Disable」になっていませんか？（→ P. 161）

外部MIDIキーボードの弾いた鍵盤の音程が出ない

・エレメントデチューン、ノートシフト、ランダムピッチが、「0」以外に設定されて
いませんか？（→ P. 59）

・マイクロチューニングで平均律以外の調律が選択されていませんか？（→ P. 63）

・エフェクトのピッチチェンジの設定を確認してください。（→ P. 72）

・ピッチのコントローラーを確認してください。（→ P. 95）

・ボイスによっては、プレッシャー、アンブシュアなどによって、音程が変化するも
のもあります。

・極端に高い音域や低い音域では、正しい音程が出ない場合もあります。

音が歪む

・エフェクトのディストーションの設定を確認してください。（→ P. 74）

・スクリームのコントローラーを確認してください。（→ P. 100）

・グロウルのコントローラーを確認してください。（→ P. 102）

・スロートフォルマントのコントローラーを確認してください。（→ P. 104）
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故障かな？と思ったら

音の定位が左または右にかたよる

・エレメントのパンL、Rが、「-64」「63」以外に設定されていませんか？（→ P. 60）

・エフェクトのフィードバックディレイの設定を確認してください。（→ P. 76）

2つの和音を出したいのに、思った和音が出ない

・キーモード、ボイスモードは正しく設定されていますか？（→ P. 53）

・ポリフォニーコントロールが割り当てられているコントローラーの状態を確認して
ください。（→ P. 58）
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エラーメッセージ一覧

エラーメッセージ一覧
ここでは、画面に表示されたエラーメッセージの原因と対処方法を説明します。（エラーメッセージのアルファ
ベット順に記載します）

Bad disk!
フロッピーディスクが壊れています。
他のフロッピーディスクを使ってください。

Change battery!
ボイスバックアップ用の電池がなくなってきました。
電池を交換してください。（→ 別冊のベーシックガイド： P. 8）

Data not found!
ロードすべきデータが選んでいるファイルの中にありません。
ファイルを確認してロードしなおしてください。（→ P. 202）

Device number is off!
デバイスナンバーが「off」になっているため、MIDIバルクデータを送受信できませ
ん。
デバイスナンバーを送信側の機器に合わせてください。（→ P. 189）

Device number mismatch!
デバイスナンバーが送信側の機器と合っていないため、MIDIバルクデータを受信で
きません。
デバイスナンバーを送信側の機器に合わせてください。（→ P. 189）

Disk full!
フロッピーディスクがいっぱいでデータをセーブできません。
不要なファイルを消すか（→ P. 208）、別のフロッピーディスクを使ってください。

Disk not formatted!
フロッピーディスクがフォーマットされていません。
フォーマットを行ってください。（→ P. 209）

Disk not ready!
フロッピーディスクがセットされていません。
フロッピーディスクをドライブに挿入してください。
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エラーメッセージ一覧

File not found!
フロッピーディスクにファイルが見つかりません。
ファイル名を確認してください。

Illegal disk!
本機では扱えないフォーマットのフロッピーディスクです。
別のフロッピーディスクを使うか、中のデータが不要な場合にはフォーマットを行っ
てください。（→ P. 209）

Illegal file!
本機では扱えない形式のファイルです。
ファイルを確認してください。

Memory protected!
メモリープロテクトが「on」になっています。
メモリープロテクトを「off」にして操作しなおしてください。（→ P. 193）

MIDI buffer full!
MIDIの受信バッファーがあふれました。
送信するデータ量を減らしてください。

MIDI checksum error!
外部機器から受信したMIDIデータに不具合があります。
送信側の外部機器やMIDIケーブルなどを確認してください。

MIDI data error!
外部機器から受信したMIDIデータに不具合があります。
送信側の外部機器やMIDIケーブルなどを確認してください。

Same file name exists!
フロッピーディスクに同じファイル名のファイルがあります。
ファイル名を変更してください。

Write protected!
フロッピーディスクのライトプロテクトタブが「on」の位置になっています。
ライトプロテクトタブを「off」にしてください。
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コントロールフロー図

コントロールフロー図
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仕様

仕様

機能

■音源

音源形式

音源部
S / VA方式（Self oscillation type / VA Synthesis system）
モディファイア

ハーモニックエンハンサー
ダイナミックフィルター（LPF, HPF, BPF, BEF レゾナンス付）
イコライザー（5バンド　フリケンシー、レゾナンス、ブースト、カット変更可）
インパルスエキスパンダー
レゾネーター

エフェクト部
32bit DSP
次の3パートで構成（基本的にステレオイン、ステレオアウト）

モジュレーションエフェクト（フランジャー､ピッチチェンジ､ディストーション）
フィードバックディレイ
リバーブレーション

プレイモード
ボイスモードのみ

音源の最小単位はエレメント
2つのエレメントを使ってボイスを作成
ボイスは、コモンデータとエレメントデータにより構成される

同時発音数
2

キーアサインモード
モノ、ポリ、ユニゾン

■メモリー

インターナルメモリー
128ボイス

ディスク
3.5 " フロッピーディスクドライブ （2HD または 2DD）
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仕様

コントローラー

■コントローラー
マスターボリュームツマミ
ダイアル
LCDコントラスト調整ツマミ

■パネルスイッチ
Play LED付
Edit LED付
Utility LED付
Copy
Store
Data Entry ×2
Cursor ×4
Function ×8
Exit
Enter/Sound
計21 Switches 計4LED（MIDIランプ含む）

ディスプレイ

240×64 ドット
バックライト付グラフィックLCD

接続端子

■フロント
ステレオヘッドフォン端子
ブレスコントローラー端子

■リア
アウトプット端子 ×2（L, R）
MIDI IN
MIDI OUT
MIDI THRU

出力レベル

■アウトプット出力
2.5±2dBm （10KΩ）

■ヘッドフォン出力
2.0±2dBm （33Ω）
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電源（日本国内）

100V 消費電力13W

寸法、重量

■寸法
430（W）×360（D）×132（H）mm（3Uラックマウントサイズ）

■重量
7.5 kg

付属品

■電源ケーブル（3P － 2P変換器付）

■MIDIケーブル（3m）

■フロッピーディスク（2HD）

■取扱説明書セット オーナーズマニュアル　セッティングリスト

オーナーズマニュアル　ベーシックガイド

オーナーズマニュアル　リファレンス

■保証書

（仕様および外観は、改良のため予告なく変更する場合があります）

仕様
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MIDIデータフォーマット

MIDIデータフォーマット

1. MIDI 受信

注) <Rch> ：MIDI receive channel switch
<Dev No> ：Device number switch
n ：MIDI channel
m ：Device number

Note Offの3byte目 は無視する。
Pitch Bendの2byte目は無視する。
Demo modeではいっさいのMIDIを受信しない。
Program Changeを受信するとdataに応じてVoice numberが変更される。

Progaram Change data Voice number
$00～$7F A01(001)～H16(128)

Bulk DumpのなかにはMemory protectがonになっていると受信できないものがある。
System Exclusive Messageの詳細は後述する。
Active Sensingを1度受信すると、約330msec以上MIDIから何も信号が来ないと
MIDI 受信バッファーをクリアし、発音中の音を止める。

   MIDI�
                      <Rch>                        $8n ...                                          Note Off�
                      <Rch>                        $9n ...                                          None On�
                      <Rch>                        $Bn $01～$1F ...                        Control Change�
                                                         $Bn $21～$77 ...�
                      <Rch>                        $Bn $79 $00                               Reset All Controllers�
                      <Rch>                        $Cn ...                                         Program Change�
                      <Rch>                        $Dn ...                                         Channel Aftertouch�
                      <Rch>                        $En ...                                         Pitch Bend�
                      <Dev No>                  $F0 $43 $0m $7A ...                  Universal Bulk Dump�
                                                                                                            With Additional Header�
                      <Dev No>                  $F0 $43 $1m  ...                         Parameter Change�
                      <Dev No>                  $F0 $43 $2m  ...                         Dump Request�
                                                         $FE                                            Active Sensing�
�
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2. MIDI 送信

注) <Tch> ：MIDI transmit channel switch
<Dev No> ：Device number switch
n ：MIDI channel
m ：Device number

Demo modeではDemo sequence data以外は送信しない。
System Exclusive Messageの詳細は後述する。

MIDIデータフォーマット

   �
   Breath Controller�
   Universal Bulk Dump�
   With Additional Header�
   Parameter Change�
   

�
$Bn $02 ... �
$F0 $43 $0m $7A ...�
�
$F0 $43 $1m  ...�
�

                        MIDI�
<Tch>�
<Dev No>�
�
<Dev No>�
�
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3. ブレスコントローラー部と音源との構成図

通常のモード

注) 本機のブレスコントローラー情報は、 Transmit channelとReceive channelの設定いか
んに関わらず受信する。

デモ時

注) デモ時は本機のコントローラー情報を送受信しない。また、MIDI in 情報も受信しな
い。

MIDIデータフォーマット

Breath�
Controller

(Note Shift)�
Tone Generator

Tch MIDI out

Local on/offRch

MIDI in

(Note Shift)�
Tone Generator

MIDI out

Rch

Demo
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4. システムエクスクルーシブメッセージ

4.1　Bulk Dump
送受信とも行う。Universal Bulk Dump With Addtional Headerを用
いる。
Count Value Description
0 11110000 F0
1 01000011 43
2 0000nnnn n = device number
3 01111010 7A
4 0bbbbbbb b = MSB of byte count
5 0bbbbbbb b = LSB of byte count

byte countはcount6からcheck sum の手前
まで

6 01001100 4C ascii"L"
7 01001101 4D ascii"M"
8 00100000 20 ascii"   "
9 00100000 20 ascii"   "
10 00110000 30 ascii"0"
11 00110001 31 ascii"1"
12 00110001 31 ascii"1"
13 00110111 37 ascii"7"
14 0aaaaaaa a = data type
15 0aaaaaaa a = data type

56,43(ascii"VC") : Voice
53,59(ascii"SY") : System
50,52(ascii"PR") : Program Change Table

16 0ttttttt t = memory type
0 : Memory、7F : Edit Buffer

17 0uuuuuuu u = memory number
memory type = 7Fのときは無視。
memory type = 0  のときはボイス番号を
表す
0～7F : A01(001) ～ H16(128)

18 00000000 00
↓
31 00000000 00
32 0ddddddd d = data
↓ ↓

0sssssss s = check sum  (dataの7bit sumの2's
compliment)

11110111 F7 EOX

"SY","PR"受信時、count16,17は無視する。
count18 ～ 31は送信側は0とし、受信側では無視する。

4.2　Parameter Change
送受信とも行う。parameter offsetについては、5. parameter change
tabelに記す。
Count Value Description
0 11110000 F0
1 01000011 43

MIDIデータフォーマット

2 0001nnnn n = device number
3 01000000 40
4 000000tt t = parameter type

0 : Common parameter
1 : Element parameter
2 : System parameter
5 : SW remote (device numberは無視する)
7 : Program Change Table parameter
8: Element Effect Modifier on/off
Element Effect Modifier on/offは、
PlayModeでは無効(常にon)。

5 0000000e e = element number
0 : element 1
1 : element 2
element numberはparameter type = 1の時
有効で、その他では無視。

6 000000cc c = data count
1 : 1byte parameter
2 : 2byte parameter

7 0ppppppp p = MSB of parameter offset
8 0ppppppp p = LSB of parameter offset

data countが2のときは先頭parameter の
offset とする。

9 0vvvvvvv v =  parameter value
(10 0vvvvvvv v =  parameter value      data countが2のとき)

11110111 F7 EOX

但し、System parameterの"Device Number"は、Parameter Changeの
送受信を行わない。

4.3　Bulk Dump Request
受信のみ行う。
Count Value Description
0 11110000 F0
1 01000011 43
2 0010nnnn n = device number
3 01111010 7A
4 01001100 4C ascii"L"
5 01001101 4D ascii"M"
6 00100000 20 ascii"   "
7 00100000 20 ascii"   "
8 00110000 30 ascii"0"
9 00110001 31 ascii"1"
10 00110001 31 ascii"1"
11 00110111 37 ascii"7"
12 0aaaaaaa a = data type
13 0aaaaaaa a = data type

56,43(ascii"VC") : Voice
53,59(ascii"SY") : System
50,52(ascii"PR" ): Program Change Table

14 0ttttttt t = memory type
0 : Memory、7F : Edit Buffer

15 0uuuuuuu u = memory number
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 memory type = 7Fのときは無視。
 memory type = 0  のときはボイス番号を
表す
 0～7F : A01(001) ～H16(128)

16 00000000 00
↓
29 00000000 00
30 11110111 F7 EOX

"SY","PR"のときのcount14,15は無視する。
count16～29は送信側はゼロ(0)とし、受信側では無視する。

4.4　DX1 Master Tuning Compatibility
UTILITYのMaster Tuning Parameter ChangeはDX1 互換フォーマッ
トで送受信を行う。
Count Value Description
0 11110000 F0
1 01000011 43
2 0001nnnn n = device number
3 00000100 04
4 01000000 40
5 0vvvvvvv v = parameter value

-64～+63 (o/b)
6 11110111 F7 EOX

(o/b): offset binary (2's compliment のsign bitを反転したもの)

4.5　SY77/99 Micro Tuning Compatibility
Micro TuningのBulk Dump、Bulk Dump Request、Parameter Change
はSY77/99互換フォーマットで行う。

4.5.1　Bulk Dump
送受信を行う。
Count Value Description
0 11110000 F0
1 01000011 43
2 0000nnnn n = device number
3 01111010 7A
4 0bbbbbbb b = MSB of byte count
5 0bbbbbbb b = LSB of byte count

byte countはcount6からcheck sum の手前
まで

6 01001100 4C ascii"L"
7 01001101 4D ascii"M"
8 00100000 20 ascii"   "
9 00100000 20 ascii"   "
10 00111000 38 ascii"8"
11 00110001 31 ascii"1"
12 00110000 30 ascii"0"
13 00110001 31 ascii"1"
14 01001101 4D ascii"M"
15 01010100 54 ascii"T"
16 00000000 00

MIDIデータフォーマット

↓
30 00000000 00
31 0uuuuuuu u = memory number

 0 : I-1 , 1 : I-2 , 2 : P-1～37 : P-54
32 0vvvvvvv v = data
↓
297 0vvvvvvv v
298 0sssssss s = check sum
299 11110111 F7 EOX
受信時、memory number 2～:P-1～ は 1:I-2 として受信する。

4.5.2　Parameter Change
受信のみ行う
Count Value Description
0 11110000 F0
1 01000011 43
2 0001nnnn n = device number
3 00110100 34
4 00001011 0B
5 0000000u u = memory number

0 : I-1 , 1 : I-2
6 000000pp p = MSB of parameter offset
7 0ppppppp p = LSB of parameter offset
8 0vvvvvvv v = parameter value
9 0vvvvvvv v = parameter value
10 11110111 F7 EOX

4.5.3　Bulk Dump Request
受信のみ行う
Count Value Description
0 11110000 F0
1 01000011 43
2 0010nnnn n = device number
3 01111010 7A
4 01001100 4C ascii"L"
5 01001101 4D ascii"M"
6 00100000 20 ascii"   "
7 00100000 20 ascii"   "
8 00111000 38 ascii"8"
9 00110001 31 ascii"1"
10 00110000 30 ascii"0"
11 00110001 31 ascii"1"
12 01001101 4D ascii"M"
13 01010100 54 ascii"T"
14 00000000 00
↓
28 00000000 00
29 0uuuuuuu u = memory number

 0 : I-1 , 1 : I-2 , 2 : P-1～ 37 : P-54
30 11110111 F7 EOX
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MIDIデータフォーマット

5. parameter change table
parameter change table を以下に示す。ここで

no. parameter number 10進
c data count 10進
p offset (MSB,LSB) 16進
v value 10進

  valueは値の範囲によって次の4種類があり、それぞれの MIDI data
表現を16進で示す。

0～127 00～7F
0～127～128～16383 00 00～00 7F～01 00～7F 7F
-64～-1～0～1～63 40～7F～00～01～3F
-128～-1～0～1～127 01 00～01 7F～00 00～00 01～00 7F

表5.1 Common parameter
no. c     p   v name
0 1   00 00 32～126 Voice Name 1
↓ 10までVoice Name 1と同
10～15 reserve
16 1   00 10 0～2 Key Mode
17 1   00 11 0～1 Voice Mode
18 1   00 12 0～119 Polyphony Ctrl
19 1   00 13 0～1 Sustain
20 1   00 14 0～2 Pitch Bend Mode
21 1   00 15 0～2 Assign Mode
22 1   00 16 0～127 Brth Atck Time
23 1   00 17 0～127 Brth Atck Gain
24 1   00 18 0～127 Touch EG Time
25 1   00 19 0～1 Portamento Time MIDI Ctrl
26 1   00 1A 0～1 Portamento Mode
27 1   00 1B 0～127 Portamento Time
28 1   00 1C 0～1 Elem1 Portamento
29 1   00 1D 0～1 Elem2 Portamento
30 1   00 1E -7～7 Elem1 Detune
31 1   00 1F -7～7 Elem2 Detune
32 1   00 20 -64～63 Elem1 NoteShft
33 1   00 21 -64～63 Elem2 NoteShff
34 1   00 22 0～7 Elem1 RandPtch
35 1   00 23 0～7 Elem2 RandPtch
36 1   00 24 0～56 Elem1 Micro Tuning
37 1   00 25 0～56 Elem2 Micro Tuning
38 1   00 26 0～127 Elem1 Level
39 1   00 27 0～127 Elem2 Level
40 1   00 28 -64～63 Elem1 Pan L
41 1   00 29 -64～63 Elem1 Pan R
42 1   00 2A -64～63 Elem2 Pan L
43 1   00 2B -64～63 Elem2 Pan R
44 1   00 2C 0～4 (0～2) QED1 Class(VoiceMode=0)
45 2   00 2D 0～150 (0～45) QED1 Assign(QED1 Class=1)
47 1   00 2F 0～4 (0～2) QED2 Class(Voice Mode=0)
48 2   00 30 0～150 (0～45) QED2 Assign(QED2 Class=1)
50 1   00 32 0～3 Destination Effect
51 1   00 33 0～122 Effect Controller
52 1   00 34 0～3 MOD Effect Type

別表3.1.1 Modulation Effect 参照
65 1   00 41 0～1 FBD/REV Mode
66 1   00 42 0～3 FBD Type
↓ 別表3.1.2 Feedback Delay 参照
86 1   00 56 0～8 REV Type
↓ 別表3.1.3 Reverberation 参照
97～101 reserve

表5.1.1 Modulation Effect
Flanger
no. c   p v name
53 1   00 35 0～1 Elem1 on/off
54 1   00 36 0～1 Elem2 on/off
55 1   00 37 0～2 Flanger Wave
56 1 00 38 0～127 Flanger Freq
57 1 00 39 0～100 Flanger Depth
58 1 00 3A 0～126 Flanger Delay
59 1 00 3B          -8～8 Flanger Phase

60 2 00 3C -100～100 Flanger FBGain
62 1 00 3E 0～9 Flanger High
63 1 00 3F 0～10 Flanger Feel
64 1 00 40 0～100 Flanger WetDry

Pitch Change
no. c p v name
53 1 00 35 0～1 Elem1 on/off
54 1 00 36 0～1 Elem2 on/off
55 1 00 37 0～1 PtchChg Mode
56 1 00 38          -12～12 PtchChg Pitch1
57 2 00 39 -100～100 PtchChg Fine 1
59 1 00 3B 0～100 PtchChg Out 1
60 1 00 3C         -12～12 PtchChg Pitch2
61 2 00 3D -100～100 PtchChg Fine 2
63 1 00 3F 0～100 PtchChg Out 2
64 1 00 40 0～100 PtchChg WetDry

Distortion
no. c p v name
53 1 00 35 0～1 Elem1 on/off
54 1 00 36 0～1 Elem2 on/off
55 1 00 37 0～100 Dist Overdrive
56～57 reserve
58 1 00 3A 0～4 Dist Device
59 1 00 3B 0～5 Dist Speaker
60 1 00 3C         -10～10 Dist Presence
61 1 00 3D 0～100 Dist OutputLvl
62～64 reserve

表5.1.2 Feedback Delay
Mono
no. c p v name
67 1 00 43 0～100 FBD Return
68～73 reserve
74 2 00 4A 0～1024 FBD Delay Time
76 1 00 4C 0～100 FBD Level
77 2 00 4D 0～1024 FBD FB DlyTime
79 1 00 4F 0～100 FBD FB Gain
80 1 00 50 0～9 FBD High
81～85 reserve

L/R
no. c p v name
67 1 00 43 0～100 FBD Return
68 2 00 44 0～512 FBD Lch DT
70 1 00 46 0～100 FBD Lch FBGain
71 1 00 47 0～9 FBD Lch High
72 1 00 48 0～100 FBD Lch Level
73 2 00 49 0～512 FBD Rch DT
75 1 00 4B 0～100 FBD Rch FBGain
76 1 00 4C 0～9 FBD Rch High
77 1 00 4D 0～100 FBD Rch Level
78～85 reserve

L/C/R
no. c p v name
67 1 00 43 0～100 FBD Return
68 2 00 44 0～1024 FBD Lch DT
70 1 00 46 0～100 FBD Lch Level
71 2 00 47 0～1024 FBD Rch DT
73 1 00 49 0～100 FBD Rch Level
74 2 00 4A 0～1024 FBD Cch DT
76 1 00 4C 0～100 FBD Cch Level
77 2 00 4D 0～1024 FBD FB DlyTime
79 1 00 4F 0～100 FBD FB Gain
80 1 00 50 0～9 FBD High
81～85 reserve

表5.1.3 Reverberation
no. c p v name
87 1 00 57 0～100 REV Return
88 1 00 58 0～ 95 REV Time
89 1 00 59 0～  9 REV High Ctrl
90 1 00 5A 0～10 REV Diffusion
91 2 00 5B 0～405 REV Init Delay
93 1 00 5D -21～12 REV Treble
94 1 00 5E -21～12 RV Bass
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95 1 00 5F 0～  3 REV Feel
96 1 00 60 0～ 10 REV Time Boost

表5.2 Element parameter
no. c p v name
0 1 00 00 0～124 Pressure Ctrl
1 1 00 01 -16～16 Pressure Curve
2 2 00 02 -127～127 Pressure Depth
4 1 00 04 0～124 Embchr Ctrl
5 1 00 05 0～1 Embchr Mode
6 2 00 06 -127～127 Embchr UpDepth
8 2 00 08 -127～127 Embchr LoDepth
10 1 00 0A 0～124 Pitch Ctrl
11 1 00 0B 0～1 Pitch Mode
12 1 00 0C -12～12 Pitch Up Depth
13 1 00 0D -12～12 Pitch Lo Depth
14 1 00 0E 0～124 Vibrato Ctrl
15 reserve
16  2 00 10 -127～127 Vibrato Depth
18 1 00 12 0～124 Tonguing Ctrl
19 1 00 13 -16～16 Tonguing Curve
20 2 00 14 -127～127 Tonguing Depth
22 1 00 16 0～124 Amplitud Ctrl
23 1 00 17 -16～16 Amplitud Curve
24 2 00 18 -127～127 Amplitud Depth
26 1 00 1A 0～124 Scream Ctrl
27 1 00 1B 0～127 Scream Value
28 1 00 1C -16～16 Scream Curve
29  2 00 1D -127～127 Scream Depth
31 1 00 1F 0～124 B.Noise Ctrl
32 1 00 20 0～127 B.Noise Value
33 1 00 21 -16 ～16 B.Noise Curve
34 2 00 22 -127～127 B.Noise Depth
36 1 00 24 0～124 Growl Ctrl
37 1 00 25 0～127 Growl Value
38 1 00 26 -16 ～16 Growl Curve
39 2 00 27 -127～127 Growl Depth
41 1 00 29 0～124 Throat Ctrl
42 1 00 2A 0～127 Throat Value
43 1 00 2B -16 ～16 Throat Curve
44 2 00 2C -127～127 Throat Depth
46 1 00 2E 0～124 D.Filter Ctrl
47 1 00 2F -16 ～16 D.Filter Curve
48 2 00 30 -127～127 D.Filter Depth
50 1 00 32 0～124 H.Enhanc Ctrl
51 1 00 33 -16 ～16 H.Enhanc Curve
52 2 00 34 -127～127 H.Enhanc Depth
54 1 00 36 0～124 Damping Ctrl
55 1 00 37 -16 ～16 Damping Curve
56 2 00 38 -127～127 Damping Depth
58 1 00 3A 0～124 Absorptn Ctrl
59 1 00 3B -16 ～16 Absorptn Curve
60 2 00 3C -127～127 Absorptn Depth
62 1 00 3E 0～1 Trigger Mode
63 1 00 3F 0～ 96 Xfade Speed
64 1 00 40 0～ 50 Interplt Speed
65 1 00 41 0～127 B.Noise Level
66 1 00 42 0～127 Break Point 1
67 1 00 43 -64～ 63 BREAK_POINT_LEVEL 1
↓ 6までBreak Point/LEVEL 1と同
78 1 00 4E 0～125 B.Noise HPF
79 1 00 4F 0～127 Break Point 1
80 1 00 50 -64～63 BREAK_POINT_LEVEL 1
↓ 2までBreak Point/LEVEL 1と同
83 1 00 53 0～127 B.Noise LPF
84 1 00 54 0～127 Break Point 1
85 1 00 55 -64～63 BREAK_POINT_LEVEL 1
↓ 2までBreak Point/LEVEL 1と同
88 reserve
89 1 00 59 0～1 B.Noise KonRst
90 1 00 5A 0～ 32 B.Noise SltDrv
91 1 00 5B -64～ 63 B.Noise Balanc
92 1 00 5C 0～1 Throat Pitch Track
93 2 00 5D 0～176(-128～127)

Throat Pitch (PitchTrack=1)
95 1 00 5F 0～127 Break Point 1
96 2 00 60 -127～127 Offset 1
↓ 4までBreak Point/Offset 1と同
107 2 00 6B -127～127 Throat Intens

109 1 00 6D 0～127 Break Point 1
110 2 00 6E -127～127 Offset 1
↓ 4までBreak Point/Offset 1と同
121 1 00 79 -64～63 Throat Amount
122 1 00 7A 0～127 Break Point 1
123 1 00 7B -64～63 Offset 1
↓ 4までBreak Point/Offset 1と同
130 1 01 02 0～125 Throat HPF
131 1 01 03 0～127 Break Point 1
132 1 01 04 -64～63 Offset 1
↓ 3までBreak Point/Offset 1と同
137 1 01 09 0～127 Throat LPF
138 1 01 0A 0～127 Break Point 1
139 1 01 0B -64～63 Offset 1
↓ 3までBreak Point/Offset 1と同
144 1 01 10 0～127 Driver Output
145 1 01 11 0～127 Break Point 1
146 1 01 12 -64～63 Offset 1
↓ 6までBreak Point/Offset 1と同
157 1 01 1D 0～127 Pipe/Strng Out
158 1 01 1E 0～127 Break Point 1
159 1 01 1F -64～63 Offset 1
↓ 6までBreak Point/Offset 1と同
170 1 01 2A 0～127 Tap Output
171 1 01 2B 0～127 Break Point 1
172 1 01 2C -64～63 Offset 1
↓ 6までBreak Point/Offset 1と同
183 1 01 37 0～1 Tap Sign
184 1 01 38 0～1 Tap Setting
185 1 01 39 0～127 Tap Location
186 1 01 3A 0～127 Break Point 1
187 1 01 3B  -64～63 Offset 1
↓ 6までBreak Point/Offset 1と同
198 1 01 46 0～127 Total Amp Levl
199 1 01 47 0～127 Break Point 1
200 1 01 48 -64～63 Offset 1
↓ 8までBreak Point/Offset 1と同
215 1 01 57          32～126 Element Name 1
↓ 10までElement Name 1と同
225～595 Reserve
596 1 04 54 0～5 HE Crr Signal
597 1 04 55 0～127 HE Crr HPF
598 1 04 56 0～127 Break Point 1
599 1 04 57  -64～63 Offset 1
↓ 2までBreak Point/Offset 1と同
602 1 04 5A -64～63 HE Crr Overdrv
603 1 04 5B 0～127 Break Point 1
604 1 04 5C  -64～63 Offset 1
↓ 2までBreak Point/Offset 1と同
607 1 04 5F 0～127 HE Crr Level
608 1 04 60 0～127 Break Point 1
609 1 04 61 -64～63 Offset 1
↓ 4までBreak Point/Offset 1と同
616 1 04 68 0～5 HE Mod Signal
617 1 04 69 0～127 HE Mod HPF
618 1 04 6A 0～127 Break Point 1
619 1 04 6B -64～63 Offset 1
↓ 2までBreak Point/Offset 1と同
622 1 04 6E -64～63 HE Mod Overdrv
623 1 04 6F 0～127 Break Point 1
624 1 04 70 -64～63 Offset 1
↓ 2までBreak Point/Offset 1と同
627 1 04 73 0～127 HE Mod Phase
628 1 04 74 0～127 HE Mod Index
629 1 04 75 0～127 Break Point 1
630 1 04 76 -64～63 Offset 1
↓ 4までBreak Point/Offset 1と同
637 1 04 7D -64～63 HE Balance
638 1 04 7E 0～127 Break Point 1
639 1 04 7F -64～63 Offset 1
↓ 2までBreak Point/Offset 1と同
642 1 05 02 0～3 DF Filter Mode
643 1 05 03 0～127 DF Input Gain
644 1 05 04 0～1 DF Cutoff Track
645 1 05 05 0～127(-64～63)

DF Cutoff Freq (Cutoff Track=1)
646 1 05 06 0～127 Break Point 1
647 1 05 07 -64～63 Offset 1
↓ 3までBreak Point/Offset 1と同
652 1 05 0C 0～127 DF Resonance
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653 1 05 0D 0～127 Break Point 1
654 1 05 0E -64～63 Offset 1
↓ 3までBreak Point/Offset 1と同
659 1 05 13 -64～63 DF Balance
660 1 05 14 0～127 EQ Input Gain
661 1 05 15 0～127 EQ HPF
662 1 05 16 0～127 Break Point 1
663 1 05 17 -64～63 Offset 1
↓ 3までBreak Point/Offset 1と同
668 1 05 1C 0～127 EQ LPF
669 1 05 1D 0～127 Break Point 1
670 1 05 1E -64～63 Offset 1
↓ 3までBreak Point/Offset 1と同
675 1 05 23 0～ 48 EQ Band1 Freq
676 1 05 24 0～127 EQ Band1 Q
677 1 05 25 -64～63 EQ Band1 Level
678 1 05 26 22～70 EQ Band2 Freq
↓ Q,LevelはEQ1と同
681 1 05 29 42～90 EQ Band3 Freq
↓ Q,LevelはEQ1と同
684 1 05 2C 64～112 EQ Band4 Freq
↓ Q,LevelはEQ1と同
687 1 05 2F 84～127 EQ Band5 Freq
↓ Q,LevelはEQ1と同
690 1 05 32 0～1 IE on/off
691 1 05 33 0～127 IE Density
692 1 05 34 0～127 IE Dispersion
693 1 05 35 0～16 IE Roughness
694 1 05 36 0～127 IE Wet Level
695 1 05 37 -64～63 IE Level Bal
696 1 05 38 0～1 RSN on/off
697 1 05 39 0～127 RSN Input Gain
698 1 05 3A 0～127 RSN DL1 Length
↓ DL5までDL1と同
703 1 05 3F 0～127 RSN Decay Time
704 1 05 40 0～127 RSN LPF
705 1 05 41 0～16 RSN Diffusion
706 1 05 42 -16～16 RSN Phase
707 1 05 43 0～127 RSN Wet Level
708 1 05 44 -64～63 RSN Level Bal
709 1 05 45 0～127 IE&RSN Dry Lvl
710 1 05 46 -16～16 PresEG AR Ofst
711 1 05 47 -16～16 PresEG RR Ofst
712 1 05 48 0～16 PresEG VelToLv
713 1 05 49 0～16 PresEG VelToRt
714～767 Reserve
768 1 06 00 0～2 Pres EG Mode
769 reserve
770 1 06 02 0 ～16 E&P EG VelToLv
771 1 06 03 -16～16 E&P EG VelToRt
772 1 06 04 0～127 E&P EG HoldTim
773 1 06 05 0～127 Break Point 1
774 1 06 06 -64～63 Offset 1
↓ 2までBreak Point/Offset 1と同
777 1 06 09 -64～63 E&P EG InitLvl
778 1 06 0A 0～127 Break Point 1
779 1 06 0B -64～63 Offset 1
↓ 2までBreak Point/Offset 1と同
782 1 06 0E 0～127 E&P EG DecayRt
783 1 06 0F 0～127 Break Point1
784 1 06 10 -64～63 Offset 1
↓ 2までBreak Point/Offset 1と同
787 1 06 13 0～ 64 E&P EG DpToEmb
788 1 06 14 0～ 64 E&P EG DpToPch
789 1 06 15 0～127 VibEG DelayTim
790 1 06 16 0～127 Break Point 1
791 1 06 17 -64～63 Offset 1
↓ 2までBreak Point/Offset 1と同
794 1 06 1A 0～127 VibEG AttackRt
795 1 06 1B 0～127 Break Point 1
796 1 06 1C -64～63 Offset 1
↓ 2までBreak Point/Offset 1と同
799 1 06 1F 0～127 VibEG Sus Levl
800 1 06 20 0～127 VibEG Depth
801 1 06 21 0～127 Break Point 1
802 1 06 22 -64～63 Offset 1
↓ 2までBreak Point/Offset 1と同
805 1 06 25 0～127 Vib DpthToEmb
806 1 06 26 0～127 Vib DpthToPtch
807 2 06 27 -127～127 Vib Offset
809 1 06 29 0～127 Vib Speed

810 1 06 2A 0～127 Break Point 1
811 1 06 2B -64～63 Offset 1
↓ 2までBreak Point/Offset 1と同
814 1 06 2E 0～8 Vib Speed Shft
815 1 06 2F 0～10 Vib Randomness
816 1 06 30 0～127 Growl DpToPres
817 1 06 31 0～127 Growl DpToBNse
818 2 06 32 -127～127 Growl Offset
820 1 06 34 0～127 Growl Speed
821 1 06 35 0～127 Break Point 1
822 1 06 36 -64～63 Offset 1
↓ 2までBreak Point/Offset 1と同
825 1 06 39 0～10 Growl Randomns
826 1 06 3A 0～1 Growl Vib Sync
827 1 06 3B 0～16 A&F EG VelToLv
828 1 06 3C 0～16 A&F EG VelToRt
829 1 06 3D 0～127 A&F EG AR1
830 1 06 3E 0～127 Break Point 1
831 1 06 3F -64～63 Offset 1
↓ 2までBreak Point/Offset 1と同
834 1 06 42 0～127 A&F EG AL1
↓ Break Point/OffsetはAR1と同
839 1 06 47 0～127 A&F EG AR2
↓ Break Point/OffsetはAR1と同
844 1 06 4C 0～127 A&F EG DecayRt
↓ Break Point/OffsetはAR1と同
849 1 06 51 0～127 A&F EG Sus Lvl
↓ Break Point/OffsetはAR1と同
854 1 06 56 0～127 A&F EG Rel Rat
↓ Break Point/OffsetはAR1と同
859 1 06 5B 0～127 A&F EG DpToAmp
860  2 06 5C -127～127 A&F EG DpToFlt
862～1283 Reserve

表5.3 System parameter
no. c p v name
0 1 00 00 32～126 Greeting Message 1
↓ 20までGreeting Message 1と同
20 1 00 14 reserve
21 1 00 15 0～1 Local on/off
22 1 00 16 reserve
23 1 00 17 -64～63 Master Tuning
24 1 00 18 0～1 Memory Protect
25 1 00 19 0～1 Rreverb
26 1 00 1A 0～1 Output
27 1 00 1B reserve
28 1 00 1C reserve
29 1 00 1D 0～3 Breath Control Curve
30 1 00 1E reserve
31 1 00 1F reserve
32 1 00 20 reserve
33 1 00 21 reserve
34 1 00 22 0～15 Transmit Channel
35 1 00 23 0～16 Receive Channel
36 1 00 24 0～17 Device Number
37 1 00 25 0～1 Display
38 1 00 26 0～1 Confirm
39 1 00 27 0～1 WX Lip
40～63 reserve

表5.4 Micro tuning
no.  c p v name
0 2 00 00 0～10794 C -2
↓ ↓
254 2 01 7E 0～10794 G 8
256 1 02 00 32～126 Table Name 1
↓ ↓
265 1 02 09 32～126 Table Name 10
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表5.5 SW remote
c=1
p name p name p name
00 00 PLAY 00 01 EDIT 00 02 UTILITY
00 03 COPY 00 04 STORE 00 05 DIAL -1
00 06 DIAL +1 00 07 DIAL -16 00 08 DIAL +16
00 09 DEC 00 11 F1 00 12 F2
00 13 F3 00 14 F4 00 15 F5
00 16 F6 00 17 F7 00 18 F8
00 0A UP 00 0B INC 00 0C LEFT
00 0D DOWN 00 0E RIGHT 00 0F EXIT
00 10 ENTER

表5.6 Program change table
no.  c p v name
0 1 00 00 0～127 001
↓ ↓
127  1 00 7F 0～127 128

表5.7 Element Effect Modifier on/off
no. c p v name
0 1 00 00 0～127 E1 on/off (0～63:off, 64～127:on)
1 1 00 01 0～127 E2 on/off (0～63:off, 64～127:on)
2 1 00 02 0～127 Modulation Effect on/off

(0～63:off, 64～127:on)
3 1 00 03 0～127 Feedback Delay on/off

(0～63:off, 64～127:on)
4 1 00 04 0～127 Reverberation on/off

(0～63:off, 64～127:on)
5 1 00 05 0～127 Harmonic Enhancer on/off

(0～63:off, 64～127:on)
6 1 00 06 0～127 Dinamic Filter on/off

(0～63:off, 64～127:on)
7 1 00 07 0～127 Equalizer on/off

(0～63:off, 64～127:on)
8 1 00 08 0～127 Inpulse Expander on/off

(0～63:off, 64～127:on)
9 1 00 09 0～127 Resonator on/off

(0～63:off, 64～127:on)

MIDIデータフォーマット
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  YAMAHA  [ Virtual Acoustic Tone Generator ]          Date:14-JUN-1994
          Model  VL1-m MIDI Implementation Chart       Version : 1.0
+----------------------------------------------------------------------+
: :  Transmitted :   Recognized :    Remarks :
:      Function ... : : : :
:-------------------+----------------+----------------+----------------:
:Basic    Default : 1 - 16 : 1 - 16 : Memorized :
:Channel  Changed : 1 - 16 : 1 - 16 : :
:-------------------+----------------+----------------+----------------:
:         Default : 3 : 1 - 4 : Memorized :
:Mode     Messages : x : x : :
:         Altered : ************** : x : :
:-------------------+----------------+----------------+----------------:
:Note : x : 0 - 127 : :
:Number : True voice: ************** : 0 - 127 : :
:-------------------+----------------+----------------+----------------:
:Velocity Note ON : x : o v=1-127 : :
:         Note OFF : x : x : :
:-------------------+----------------+----------------+----------------:
:After    Key’s : x : x : :
:Touch    Ch’s : x : o : :
:-------------------+----------------+----------------+----------------:
:Pitch Bender : x : o 0-12 semi :7 bit resolution:
:-------------------+----------------+----------------+----------------:
:                 1 : x : o :Mod. wheel :
:                 2 : o : o :Breath cont. :
:                 4 : x : o :Foot cont. :
: Control         5 : x : o :Portamento time :
:                 7 : x : o :Main volume :
: Change         16 : x : o :Gen.pur.cont.1 :
:                17 : x : o :Gen.pur.cont.2 :
:                64 : x : o :Sustain :
:                65 : x : o :Portamento SW :
:       1-31,33-119 : x : o : :
: : : : :
: : : : :
:               121 : x : o :Reset All Cntrls:
:-------------------+----------------+----------------+----------------:
:Prog : x : o 0 - 127 : :
:Change : True # : *********** :   0 - 127 : :
:-------------------+----------------+----------------+----------------:
:System Exclusive : o           *1 : o           *1 :Voice,System :
:-------------------+----------------+----------------+----------------:
:System : Song Pos : x : x : :
:       : Song Sel : x : x : :
:Common : Tune : x : x : :
:-------------------+----------------+----------------+----------------:
:System    :Clock : x : x : :
:Real Time :Commands: x : x : :
:-------------------+----------------+----------------+----------------:
:Aux  :Local ON/OFF : x : x : :
:     :All Notes OFF: x : x : :
:Mes- :Active Sense : x : o : :
:sages:Reset : x : x : :
:-------------------+----------------+----------------+----------------:
:Notes:*1 Transmit/receive if device No is not off. :
: :
: :
: :
: :
+----------------------------------------------------------------------+
  Mode 1 : OMNI ON,  POLY    Mode 2 : OMNI ON,  MONO            o : Yes
  Mode 3 : OMNI OFF, POLY    Mode 4 : OMNI OFF, MONO            x : No



ここでは、本機を使う上で覚えておいて欲しい用語を解説します。
五十音順に並んでいますので、辞書のようにお使いください。
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あ行

アブソープション

管から出る音の空気中でのエネルギー損失や、弦を指でミュートしたときのエネル
ギー損失をシミュレートする設定項目です。特に高域の減衰が大きくなります。
（→ P. 110）

アンブシュア

管楽器では、口の構えを示す設定項目です。たとえばサックスなどのリード楽器で
は、マウスピースを唇または歯で締める強さを示します。ゆるめるとだらけた多少下
品な音になります。また、擦弦楽器では弓圧にあたります。
アンブシュアは、音色に対して大きな影響を与えるとともに、ボイスによっては音程
にも影響を与えます。（→ P. 93, 163）

アンプリチュード

エレメントの出力レベルの設定項目です。原則的に音色や音程は変化しません。ただ
し、この変化は、モディファイアのダイナミックフィルターとイコライザーの間で行
われますので、インパルスエキスパンダーやレゾネーター、エフェクトなどの効果に
は多少影響が出てきます。（→ P. 131）

イコライザー

ハイパスフィルターやローパスフィルター、イコライザーバンド（パラメトリックイ
コライザー）を使って、エレメント出力の周波数特性を変更します。イコライザーは
モディファイアのひとつです。（→ P. 151, 154）

インパルスエキスパンダー

管や胴の共鳴をシミュレートする機能です。金属的な共鳴を付加するのがインパルス
エキスパンダーの特徴です。
特に音のアタック部やビブラートに影響を与え、音の拡がりやつややかさを増すこと
ができます。インパルスエキスパンダーはモディファイアのひとつです。（→ P. 157）

エフェクト

エレメントの出力に対して最終的に特殊効果を付加する装置です。本機のエフェクト
はモジュレーションエフェクト、フィードバックディレイ、リバーブレーションの3
つに分かれており、それぞれ同時に使用することができます。（→ P. 66）

LFO（エルエフオー）

周期的なゆれを作り出す装置です。本機では、ビブラートやグロウルなどにこのLFO
を使います。（→ P.168, 174）

用語解説
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エレメント

音を生み出す部分です。ボイスは1つまたは2つのエレメントを使って作ります。この
エレメントの重要な部分（楽器らしい振動を生み出す部分）は、あらかじめ用意され
ているもので、本機でエディットすることはできません。（→ 別冊のベーシックガイ
ド：P. 42）

か行

カーブ

ブレスコントローラーの感度を示す曲線です。（→ P. 191）

キースケール

さまざまな機能の効果を、弾く鍵盤の音階に応じて変化させる機能です。たとえば、
音程が高いほどフィルターの効果が増すように設定したり、特定の音程で音量のピー
クを持たせるような設定が可能です。（→ P. 33）

キーモード

同時発音数を設定する機能です。「Mono」を選択すると同時発音数は1となります。
「Poly」または「Unison」を選択すると2になります。（→ P. 53）

キャリア

ハーモニックエンハンサーで使います。ドライバーやパイプ／ストリングから送られ
た6種類の信号の中から選んだ1つの信号です。このキャリアの信号に対してモジュ
レーターの信号が変調を与え、特殊な倍音効果を生み出します。（→ P. 134）

クイックエディット

プレイモードで行うことのできるエディットです。（エディットモードでも可）
クイックエディットは、コントロールナンバー＝016、017のコントロールチェンジ
データを使って行います。クイックエディットで何が変化するかは、クイックエ
ディットビューで確認することができます。（→ P. 49）  クイックエディットへの機
能の割り当ては、コモンエディットで行います。（→ P. 65）

グロウル

LFOを使って、プレッシャーの大きさを周期的にゆらす効果を作る設定項目です。ゴ
ロゴロといった感じの音色のゆれを作り出します。また、ボイスによっては音程にも
影響があります。（→ P. 102, 174）

クロスフェード

直前に鳴っていた音と、新しく鳴りはじめる音を、すりかえるように自然に切り換え
る機能です。管楽器のトーンホール（穴）の切り換えの感じを生み出すときに有効な
機能です。（→ P. 112）

コピー

他のボイスのコモンデータや、エレメントデータなどを、現在エディット中のボイス
にコピーしてくる機能です。（→ P. 26）
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コントローラー

本機に接続したブレスコントローラーや外部MIDI機器のモジュレーションホイー
ル、ピッチベンドホイール、フットコントローラー、フットスイッチなどのことで
す。

コントローラーソース

コントローラーと同じ意味です。設定項目に対してコントロールデータを送り出す部
分ということです。
「コントロールデータの送り側」と覚えてください。

コントローラーデスティネーション

コントローラーから送られたコントロールデータを受けて、音に変化を与える設定項
目のことです。
「コントロールデータの受け側」と覚えてください。

コントロールチェンジ

モジュレーションホイールやブレスコントローラー、フットコントローラーなど、コ
ントローラーの演奏情報を示すデータです。実際にデータをやりとりするときには、
各装置を「コントロールチェンジナンバー」という番号で区別します。

コンペア

エディット中の音と、エディット前の音を聴き比べるための機能です。コンペア中
（エディット前の音が出ているとき）には、エディットはできません。（→ P. 25）

さ行

サステイン

「音の持続」といった意味です。サステインが「on」に設定されているボイスでは、外
部MIDI機器のサステイン情報で「キーオンの持続」をコントロールできます。　　
（→ P. 57）

スクリーム

混沌とした倍音を生み出すことで、「キャー」とか「ゴー」などといった叫び声にも似
た音を生み出す設定項目です。（→ P. 100）

ストア

エディットした音（あるいはクイックエディットした音）を本体内に保存する作業の
ことです。（→ P. 23）

スロートフォルマント

口、喉、肺での音の共鳴（空気の振動、流入）をシミュレートするための設定項目で
す。（→ P. 104, 118）
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ダイナミックフィルター

ハイパスフィルターまたはローパスフィルター、バンドパスフィルター、バンドエリ
ミネートフィルターを使って、動的に音色を変化させるための設定項目です。フィル
ターのフリケンシーは、固定することも、音程に合わせて変化させることも可能で
す。
ダイナミックフィルターはモディファイアのひとつです。（→ P. 147）

タッチEG

鍵盤から送り出されるベロシティとアフタータッチのデータを使って、この2つの信
号を捕間する（連続的に変化させる）コントローラーソースです。（→ 別冊のベー
シックガイド：P. 47）

タップアウト

パイプ／ストリングの音を生み出す回路の途中から拾い出した出力です。パイプ／ス
トリングのアウトプットとほとんど同じ音ですが位相が異なります。このため、タッ
プのアウトプットとパイプ／ストリングのアウトプットを混ぜるとフェーズキャン
セルの効果が生まれます。（→ P. 125）

タンギング

舌を使って、リードの振動を強制的に規制する表現（ハーフタンギング）をシミュ
レートする設定項目です。（→ P. 98）

ダンピング

振動が管内の壁、あるいは弦と空気との摩擦で損失する状況をシミュレートする設定
項目です。ほぼ全周波数帯域に渡って減衰し、一般に弱々しい音になります。
また、持続系の音では、音程が変化することもあります。（→ P. 109）

チャンネル

MIDIでは1本のケーブルを使って、最大16楽器分のデータを送受信することができま
す。このとき16台の楽器を区別するために使う番号のことをチャンネルと呼びます。
また、送信するチャンネルのことをMIDIトランスミットチャンネル、受信するチャ
ンネルのことをMIDIレシーブチャンネルと呼びます。（→ P. 189）

デバイスナンバー

MIDIを使って、外部機器とバルクデータをやりとりする際、お互いの機器を認識す
るための番号です。バルクデータの送受信を行うときには、両機器のデバイスナン
バーを一致させておきます。（→ P. 189）

ドライバー

管楽器のマウスピースや擦弦楽器の弓に相当する部分です。（→ 別冊のベーシック
ガイド：P. 65）
この部分の微少な空気の振動、あるいは弦と弓との接点の振動が、管や弦（パイプ／
ストリング）に送られて楽器のメインの音が作られます。
また、このドライバー自身の音（リードの振動音やブレスノイズの音など）も、自然
な楽器の音をシミュレートする上で重要な要素となります。
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ノートナンバー

MIDIで音程を示すデータです。C-2～G8の音程が、0～127の数値で表されます。

は行

ハーモニックエンハンサー

ドライバーやパイプ／ストリングから送られた6種類の信号から任意の信号を選び、
基となる音に混ぜることで倍音を増加させる装置です。（→ P. 107, 134）
ハーモニックエンハンサーは、モディファイアのひとつです。

HPF（ハイパスフィルター）

任意の周波数（フリケンシー）以上の音だけを通過させ、それ以下の周波数成分を
カットする装置です。（→ 別冊のベーシックガイド：P. 74）

パイプ／ストリング

ドライバーから送り込まれた空気または弦の振動を共鳴させ、楽器のメインとなる音
を生み出す部分です。（→ 別冊のベーシックガイド：P. 68）

バックアップバッテリー

電源コードがコンセントからはずされている状態のときでも、ボイスやシステムの
データを本体内に保存しておくためのバッテリーです。このバッテリーが少なくなっ
てくると、画面に「Change battery!」と表示されます。

パラメトリックイコライザー

複数の周波数において、その帯域の成分をブーストしたりカットしたりする装置で
す。本機には「イコライザーバンド」として、5素子のパラメトリックイコライザーが
用意されています。（→ P. 154）

バルクデータ

楽器固有のボイスやシステムのデータです。原則的に他の機種との互換性はありませ
ん。同じ機種同士やバルクデータの受信可能なシーケンサー、MIDIファイラーなど
を使ってデータの送受信を行います。（→ P. 195）

パン

ステレオ出力する際のエレメントの定位のことです。（→ P. 60）

バンク

本体内の128個のボイスを16個ずつに分けたものです。バンクにはA～Hの8つがあ
り、それぞれ1～16の番号が付いています。

BEF（バンドエリミネートフィルター）

任意の周波数（フリケンシー）帯域の音だけをカットし、それ以上、それ以下の周波
数成分を残す装置です。（→ 別冊のベーシックガイド：P. 74）

BPF（バンドパスフィルター）

任意の周波数（フリケンシー）帯域の音だけを通過させ、それ以上、それ以下の周波
数成分をカットする装置です。（→ 別冊のベーシックガイド：P. 74）
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ピッチ

音程のことです。本機では、仮想的な管または弦の長さに相当します。（→ P.95）

ビブラート

周期的にアンブシュアまたはピッチ（あるいは両方）をゆらすための設定項目です。
アンブシュアとピッチの両方をうまくバランスをとって設定することで、非常にリア
ルなビブラートを作り出すことができます。（→ P. 97, 168）

フィードバックディレイ

元の音を繰り返して、やまびこのような効果を生み出すエフェクトです。フィード
バックディレイには、「Mono」「L, R」「L, C, R」の3種類があります。

VA音源

実際の生楽器のしくみを、電子的にシミュレートすることで音を生み出す音源です。
特に本機では、S/VA方式（Self Oscillation type / VA Synthesis System：自励発振型VA
音源方式）という方式のVA音源を搭載しています。

ブレスアタック

ブレスコントローラーへ息を吹き込む量の、時間的な変化量（微分値）を示すコント
ローラーソースです。息を吹き込む量に変化があったときに数値が上がり、一定の息
を吹き込み続けているとき（あるいは息を吹き込んでいないとき）には、0となりま
す。（→ 別冊のベーシックガイド：P. 45）

ブレスコントローラー（別売：BC2）

息を吹き込む強弱で、プレッシャーやアンブシュアなどさまざまな演奏表現を可能に
するコントローラーソースです。

ブレスノイズ

管楽器の息もれの音を再現するための設定項目です。その周波数特性なども細かく設
定することができます。（→ P. 101, 113）

プレッシャー

管楽器では、ドライバー（マウスピース）に息を吹き込む強さ（圧力）を示す設定項目
です。また、擦弦楽器の場合には、弓を動かす速度に相当します。（→ P. 92, 161）
プレッシャーは、音量、音色、音程に複雑に影響します。

プログラムチェンジ

MIDIでボイスを切り換えるときに使うデータです。本機では、1～128のボイスナン
バーが0～127のデータで切り換わります。

フロッピーディスク

本体内のシステムデータやボイスデータを保存するメディアです。
本機では、2DD、2HDのタイプのフロッピーディスクを使用することができます。

ベロシティ

鍵盤を弾く強さを表すデータです。弱～強が、0～127の数値で表されます。
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ボイス

1つまたは2つのエレメントで作られる「ひとつの音色」のことです。本機にはボイス
を128種類保存しておくことができます。

ボイスモード

ボイスの発音のしかたを設定する機能です。「Single」と「Dual」の2種類があります。
（→ P. 53）

ポルタメント

直前の音程から新しい音程まで、連続的に変化させる機能です。本機では、仮想の管
または弦の長さを連続的に変化させることでポルタメントを再現しています。
（→ P. 62）

ま行

マイクロチューニング

調律のことです。本機では、一般的な平均律以外に、純正律や調性的音律などさまざ
まな調律を使うことができます。（→ P. 63）

ミキシング

ドライバー、パイプ／ストリング、タップの3種類の音を最終的に混ぜる割合です。エ
レメント出力の音色を決定します。（→ P. 125）

MIDI（ミディ）

ミュージカル・インストゥルメント・デジタル・インターフェースの略で、楽器間の
デジタル通信という意味です。電子楽器間、あるいは電子楽器とコンピューターなど
を相互に接続して、さまざまな情報をやりとりするための規格です。

モジュレーションエフェクト

エフェクトのひとつです。フランジャー、ディストーション、ピッチチェンジの3種類
の中からひとつを選んで使用することができます。（→ P. 69）

モジュレーター

ハーモニックエンハンサーで使います。ドライバーやパイプ／ストリングから送られ
た6種類の信号の中から選んだ1つの信号です。このモジュレーターの信号を使って、
キャリアの信号に変調を与え、特殊な倍音効果を生み出します。

モディファイア

ドライバー、パイプ／ストリングの出力に対して、さまざまな効果を与える装置で
す。本機には「ハーモニックエンハンサー」「ダイナミックフィルター」「イコライ
ザー」「インパルスエキスパンダー」「レゾネーター」の5つのモディファイアが用意
されています。（→ P. 133）

用語解説
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リード

サックスやオーボエなどのマウスピースに付いている竹や金属などで作られた薄片
です。このリードが空気の流入で振動し、音が生まれます。

リコール

直前にエディットしていたボイスを、呼び戻す機能です。
エディット後、ストアするのを忘れてボイスを切り換えてしまった場合などに使いま
す。（→ P. 30, 211）

リバーブレーション

ホールやスタジオなどの残響を作り出すエフェクトです。（→ P. 84）

レゾナンス

ハイパスフィルター、ローパスフィルター、バンドパスフィルターなどで、その効果
を強調するために、カットオフフリケンシーの近辺の出力を大きくする機能です。
（→ 別冊のベーシックガイド：P. 75）

レゾネーター

管や胴の共鳴をシミュレートする機能です。木質的な共鳴を付加するのがレゾネー
ターの特徴です。（→ P. 159）

ローカルオン／オフ

本機のコントローラー部（ブレスコントローラー）と音源部との接続を設定する機能
です。ローカルオンにすると、内部的に接続された状態に、ローカルオフにすると切
り離された状態になります。
（→ P. 189）

LPF（ローパスフィルター）

任意の周波数（フリケンシー）以下の音だけを通過させ、それ以上の周波数成分を
カットする装置です。（→ 別冊のベーシックガイド：P. 74）
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ABSORPTION ‥‥‥‥‥‥‥‥‥‥リファレンス 110
Amount ‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 118
AMPLITUDE ‥‥‥‥‥‥‥‥‥リファレンス 99, 131
AMPLITUDE & FILTER（EG） ‥‥‥リファレンス 177
AMPLITUDE & FILTER（Sens） ‥‥リファレンス 176
Assign Mode ‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 57
ASSIGNABLE CONTROLLER ‥‥‥‥リファレンス 190
Auto ‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 54

B

Beat ‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 135, 140
BEF（バンドエリミネートフィルター）
‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥ベーシックガイド 75
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Breath Noise Amp. ‥‥‥‥‥‥‥リファレンス 134, 140
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Confirm ‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 193
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Controller Source ‥‥‥‥‥‥‥‥ ベーシックガイド 44
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DAMPING ‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 109
DEC（デクリメント）ボタン ‥‥ ベーシックガイド 13
DELETE FILE‥‥‥‥‥‥‥‥‥‥‥リファレンス 208
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Device Number ‥‥‥‥‥‥‥‥‥‥リファレンス 189
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ELEMENT ON/OFF ‥‥‥‥‥‥‥‥‥リファレンス 32
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ELEMENT SELECT ‥‥‥‥‥‥‥‥‥リファレンス 32
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ENTER（エンター）ボタン ‥‥‥ ベーシックガイド 14
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EQUALIZER BAND ‥‥‥‥‥‥‥‥リファレンス 154
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EXIT（エグジット）ボタン ‥‥‥ ベーシックガイド 14
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F1～F8（ファンクションボタン）  ベーシックガイド 13
FEEDBACK DELAY ‥‥‥‥‥‥‥‥リファレンス 76
Feel ‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 85
Filter Mode ‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 147
Flanger ‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 69, 70
Flow Rate Saturation ‥‥‥‥‥‥リファレンス 135, 140
FORMAT DISK ‥‥‥‥‥‥‥‥‥‥リファレンス 209
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Greeting Message ‥‥‥‥‥‥‥‥‥リファレンス 193
GROWL ‥‥‥‥‥‥‥‥‥‥‥リファレンス 102, 174
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HARMONIC ENHANCER‥‥‥‥‥‥リファレンス 107
HARMONIC ENHANCER（Carrier） ‥リファレンス 134
HARMONIC ENHANCER（Modulator）
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Key Mode ‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 53
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LFO（エルエフオー） ‥‥‥‥‥‥‥リファレンス 242
LOAD｠FROM｠DISK ‥‥‥‥‥‥‥‥リファレンス 202
Local on/off ‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 189
LPF（ローパスフィルター） ‥‥ ベーシックガイド 75
‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 147, 249

M

Master Tuning ‥‥‥‥‥‥‥‥‥‥‥リファレンス 188
Memory Protect ‥‥‥‥‥‥‥‥‥‥リファレンス 193
MICRO TUNING ‥‥‥‥‥‥‥‥‥‥リファレンス 63
MIDI ‥‥‥‥‥‥‥‥‥‥‥‥‥ ベーシックガイド 26
MIDI SETTING ‥‥‥‥‥‥‥‥‥‥リファレンス 189
MIDI端子 ‥‥‥‥‥‥‥‥‥‥‥ ベーシックガイド 15
MIDIバルクダンプ ‥‥‥‥‥‥‥‥リファレンス 195
MIDIランプ ‥‥‥‥‥‥‥‥‥‥ベーシックガイド 13
MIXING ‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 125
MODE（モード）ボタン ‥‥‥‥ ベーシックガイド 12
MODULATION EFFECT‥‥‥‥‥‥‥リファレンス 69
Modulation Effect Type‥‥‥‥‥‥‥‥リファレンス 69
Mono ‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 53

N

Name ‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 20
Normal ‥‥‥‥‥‥‥‥‥‥‥リファレンス 134,  140
Note Shift ‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 59

O

Output ‥‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 188
OUTPUT（アウトプット）端子 ‥ ベーシックガイド 15

P

Parallel ‥‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 67
Pipe / String Output ‥‥‥‥‥‥‥‥‥リファレンス 125
PITCH ‥‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 95
Pitch Change ‥‥‥‥‥‥‥‥‥‥リファレンス 69, 72
Pitchbend Mode ‥‥‥‥‥‥‥‥‥‥‥リファレンス 57
PLAY‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 40
Poly ‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 53
Polyphony Ctrl ‥‥‥‥‥‥‥‥‥‥‥リファレンス 58
PORTAMENTO ‥‥‥‥‥‥‥‥‥‥リファレンス 62
POWER（パワー）スイッチ ‥‥ ベーシックガイド 12
PRESSURE ‥‥‥‥‥‥‥‥‥‥リファレンス 92, 161
PROGRAM CHANGE TABLE ‥‥‥‥リファレンス 190

Q

Q ‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 154
QED（クイックエディット）
‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 22, 40, 41, 243

QUICK EDIT ASSIGN ‥‥‥‥‥‥‥‥リファレンス 65
QUICK EDIT VIEW ‥‥‥‥‥‥‥‥‥リファレンス 50

R

Random Pitch‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 59
Receive Channel ‥‥‥‥‥‥‥‥‥‥リファレンス 189
Reed ‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 135, 141
RENAME FILE ‥‥‥‥‥‥‥‥‥‥リファレンス 206
Resonance ‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 147
RESONATOR ‥‥‥‥‥‥‥‥‥‥‥リファレンス 159
Reverb ‥‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 188
Reverb Time Boost ‥‥‥‥‥‥‥‥‥リファレンス 84
REVERBERATION ‥‥‥‥‥‥‥‥‥リファレンス 84
Roughness ‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 157

S

S&R ‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 91
SAVE｠TO｠DISK ‥‥‥‥‥‥‥‥‥リファレンス 204
SCREAM‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 100
SEARCH & REPLACE‥‥‥‥‥‥‥‥リファレンス 90
Serial ‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 67
Single ‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 53
Slit / Friction ‥‥‥‥‥‥‥‥‥リファレンス 135, 140
Slit Drive ‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 113
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Speed Shift ‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 169
STORE ‥‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 23
STORE（ストア）ボタン ‥‥‥‥ ベーシックガイド 13
Sustain ‥‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 57
Swap ‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 54

T

Tap Location ‥‥‥‥‥‥‥‥‥‥‥リファレンス 125
Tap Output ‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 125
Tap Position Fix ‥‥‥‥‥‥‥‥‥‥リファレンス 125
Tap Sign ‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 125
TG SETTING ‥‥‥‥‥‥‥‥‥‥‥リファレンス 188
THROAT FORMANT‥‥‥‥‥‥リファレンス 104, 118
TIME CALCULATION ‥‥‥‥‥‥‥リファレンス 77
Time MIDI Control ‥‥‥‥‥‥‥‥‥リファレンス 62
TONGUING ‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 98
Touch Time ‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 58
Transmit Channel‥‥‥‥‥‥‥‥‥‥リファレンス 189
Trigger Mode ‥‥‥‥‥‥‥‥‥‥‥リファレンス 112

U

Unison ‥‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 53

V

VA音源 ‥‥‥‥‥‥‥‥‥‥ ベーシックガイド 42, 62
VIBRATO ‥‥‥‥‥‥‥‥‥‥‥リファレンス 97, 168
Vibrato Sync ‥‥‥‥‥‥‥‥‥‥‥リファレンス 174
Voice Mode ‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 53
Voice Name ‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 53
VOLUME（ボリューム）ツマミ ‥ベーシックガイド 12

X

Xfade Speed‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 112

W

WXシリーズ‥‥‥‥‥‥‥‥‥‥ベーシックガイド 35
WXリップ ‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 188
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ア行

アウトプット ‥‥‥‥‥‥‥‥‥‥‥リファレンス 188
アサイナブルコントローラー ‥リファレンス 190,  242
アサインモード ‥‥‥‥‥‥‥‥‥‥リファレンス 57
アブソープション ‥‥‥‥‥‥‥ ベーシックガイド 69
‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 110, 242
アフタータッチ ‥‥‥‥‥‥‥‥ ベーシックガイド 47
アマウント ‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 118
アンブシュア ‥‥‥‥‥‥‥‥‥ ベーシックガイド 66
‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 93, 242

アンブシュア＆ピッチ ‥‥‥‥‥‥‥リファレンス 163
アンブシュア＆ピッチKSC（イニシャルレベル）
‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 166
アンブシュア＆ピッチKSC（ディケイレイト）
‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 167
アンブシュア＆ピッチKSC（ホールドタイム）
‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 165
アンプリチュード ‥‥‥‥‥リファレンス 99, 131, 242
アンプリチュード＆フィルター（EG）
‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 177
アンプリチュード＆フィルター（センシティビティ）
‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 176
アンプリチュード＆フィルターKSC（アタック1レイト）
‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 179
アンプリチュード＆フィルターKSC（アタック1レベル）
‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 180
アンプリチュード＆フィルターKSC（アタック2レイト）
‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 181
アンプリチュード＆フィルターKSC（サステインレベル)
‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 183
アンプリチュード＆フィルターKSC（ディケイレイト）
‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 182
アンプリチュード＆フィルターKSC（リリースレイト）
‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 184
アンプリチュードKSC（レベル） ‥‥リファレンス 132
イコライザー ‥‥‥‥‥‥‥‥‥ ベーシックガイド 77
‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 242
イコライザーオグジリアリー ‥‥ ベーシックガイド 77
‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 151
イコライザーオグジリアリーKSC（HPF）
‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 152
イコライザーオグジリアリーKSC（LPF）
‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 153

イコライザーバンド ‥‥‥‥‥‥ ベーシックガイド 77
‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 154
イジェクトボタン ‥‥‥‥‥‥‥ ベーシックガイド 13
インターポレートスピード ‥‥‥‥‥リファレンス 112
インテンシティ ‥‥‥‥‥‥‥‥‥‥リファレンス 118
インパルスエキスパンダー ‥‥‥ ベーシックガイド 78
‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 157, 242
インパルスエキスパンダー＆レゾネーターセッティング
‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 155
ウィンドウ ‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 14
エディットモード ‥‥‥‥‥‥‥ ベーシックガイド 50
‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 10, 52
エディットリコール ‥‥‥‥‥‥‥‥リファレンス 210
エフェクト ‥‥‥‥‥‥‥‥‥ベーシックガイド 64, 79
‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 66, 242

エレメント ‥‥‥‥‥‥‥‥‥‥ ベーシックガイド 42
‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 243
エレメントエディット ‥‥‥‥‥‥‥リファレンス 88
エレメントオン／オフ ‥‥‥‥‥‥‥リファレンス 32
エレメントセレクト ‥‥‥‥‥‥‥‥リファレンス 32
エレメントピッチ ‥‥‥‥‥‥‥‥‥リファレンス 59
エレメント名 ‥‥‥‥‥‥‥‥‥‥‥リファレンス 54
エレメントレベル＆パン ‥‥‥‥‥‥リファレンス 60
エンベロープ ‥‥‥‥‥‥‥‥‥‥‥リファレンス 160
お手入れ ‥‥‥‥‥‥‥‥‥‥‥ ベーシックガイド 8
音源部 ‥‥‥‥‥‥‥‥‥‥‥‥ベーシックガイド 40
音色ディスク ‥‥‥‥‥‥‥‥‥ベーシックガイド 22

カ行

カーソル移動 ‥‥‥‥‥‥‥‥‥‥‥リファレンス 18
カーソルボタン ‥‥‥‥‥‥‥‥ ベーシックガイド 13
カーブ ‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 191, 243
階層構造 ‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 10
階層をさかのぼる ‥‥‥‥‥‥‥‥‥リファレンス 16
カットオフトラッキング ‥‥‥‥‥‥リファレンス 147
カットオフフリケンシー ‥‥‥‥‥‥リファレンス 147
画面 ‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 12
カレントボイス ‥‥‥‥‥‥‥‥‥‥リファレンス 199
キーオンリセット ‥‥‥‥‥‥‥‥‥リファレンス 113
キースケール ‥‥‥‥‥‥‥‥‥リファレンス 33, 243
キーモード ‥‥‥‥‥‥‥‥‥‥リファレンス 53, 243
キャリア ‥‥‥‥‥‥‥‥‥‥‥ ベーシックガイド 72
‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 243
クイックエディット ‥‥‥リファレンス 22, 40,  41, 243



256　　索引

五十音順索引

クイックエディットアサイン ‥‥‥‥リファレンス 65
クイックエディットビュー ‥‥‥‥‥リファレンス 50
グリーティングメッセージ ‥‥‥‥‥リファレンス 193
グロウル ‥‥‥‥‥‥‥‥‥‥‥ ベーシックガイド 67
‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 102, 174, 243
グロウルKSC（スピード） ‥‥‥‥‥リファレンス 175
クロスフェード ‥‥‥‥‥‥‥‥‥‥リファレンス 243
クロスフェードスピード ‥‥‥‥‥‥リファレンス 112
鍵盤 ‥‥‥‥‥‥‥‥‥‥‥‥‥ベーシックガイド 46
コピー ‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 26, 243
コピー（エレメントデータ） ‥‥‥‥リファレンス 28
コピー（コモンデータ） ‥‥‥‥‥‥リファレンス 26
コモンエディット ‥‥‥‥‥‥‥‥‥リファレンス 55
コントローラー ‥‥‥‥‥‥‥‥ ベーシックガイド 43
‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 244
コントローラー（エレメントエディット）
‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 89

コントローラー（コモンエディット） リファレンス 58
コントローラーソース ‥‥‥‥‥ ベーシックガイド 44
‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 244
コントローラーデスティネーション
‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥ベーシックガイド 44

コントローラービュー ‥‥‥‥‥‥‥リファレンス 44
コントローラー部 ‥‥‥‥‥‥‥ ベーシックガイド 40
コントロールチェンジ ‥‥‥‥ベーシックガイド 26, 44
‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 244
コントロールナンバー「016」「017」のコントローラー
‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥ベーシックガイド 48

コンファーム ‥‥‥‥‥‥‥‥‥‥‥リファレンス 193
コンペア ‥‥‥‥‥‥‥‥‥‥‥リファレンス 25, 244

サ行

サーチ＆リプレース ‥‥‥‥‥‥‥‥リファレンス 90
サステイン ‥‥‥‥‥‥‥‥‥‥リファレンス 57, 244
シグナルセレクト ‥‥‥‥‥‥‥‥‥リファレンス 134
システム ‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 187
シリアル ‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 67
数値の変更 ‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 18
スクリーム ‥‥‥‥‥‥‥‥‥‥ ベーシックガイド 67
‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 100, 244
ストア ‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 23, 244
スピードシフト ‥‥‥‥‥‥‥‥‥‥リファレンス 169
スリットドライブ ‥‥‥‥‥‥‥‥‥リファレンス 113
スロートフォルマント ‥‥‥‥‥ ベーシックガイド 67
‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 104, 118, 244
スロートフォルマントKSC（HPF） ‥リファレンス 123
スロートフォルマントKSC（LPF） ‥リファレンス 124

スロートフォルマントKSC（アマウント）
‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 121
スロートフォルマントKSC（インテンシティ）
‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 122
スロートフォルマントKSC（ピッチ）
‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 120
スロープ ‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 148
スワップ ‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 54
セーブトゥーディスク ‥‥‥‥‥‥‥リファレンス 204
接続 ‥‥‥‥‥‥‥‥‥‥‥‥ベーシックガイド 16, 17
設定値の変更 ‥‥‥‥‥‥‥‥‥‥‥リファレンス 19
セッティング（エフェクト） ‥‥‥‥リファレンス 67
セッティング（エレメントエディット）
‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 112
セッティング（ミスレイニアス ） ‥‥リファレンス 57

タ行

ダイアル ‥‥‥‥‥‥‥‥‥‥‥ ベーシックガイド 13
ダイナミックフィルター ‥‥‥‥ ベーシックガイド 74
‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 106, 147, 245
ダイナミックフィルターKSC（カットオフ）
‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 149
ダイナミックフィルターKSC（レゾナンス）
‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 150
タイムMIDIコントロール ‥‥‥‥‥‥リファレンス 62
タッチEG ‥‥‥‥‥‥‥‥‥‥‥ ベーシックガイド 47
‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 245
タッチタイム ‥‥‥‥‥‥‥‥‥‥‥リファレンス 58
タップアウト ‥‥‥‥‥‥‥‥‥‥‥リファレンス 245
タップアウトプット ‥‥‥‥‥‥‥‥リファレンス 125
タップ音 ‥‥‥‥‥‥‥‥‥‥‥ ベーシックガイド 70
タップサイン ‥‥‥‥‥‥‥‥‥‥‥リファレンス 125
タップポジションフィックス ‥‥‥‥リファレンス 125
タップロケーション ‥‥‥‥‥‥‥‥リファレンス 125
タンギング ‥‥‥‥‥‥‥‥‥‥ ベーシックガイド 67
‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 98, 245

ダンピング ‥‥‥‥‥‥‥‥‥‥ ベーシックガイド 69
‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 109, 245
チャンネル ‥‥‥‥‥‥‥‥‥‥ ベーシックガイド 26
‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 245
チャンネルアフタータッチ ‥‥‥ ベーシックガイド 26
チューニング ‥‥‥‥‥‥‥‥‥‥‥リファレンス 188
ディスク ‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 200
ディスクステータス ‥‥‥‥‥‥‥‥リファレンス 201
ディストーション ‥‥‥‥‥‥‥ ベーシックガイド 79
‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 69, 74
ディスパージョン ‥‥‥‥‥‥‥‥‥リファレンス 157
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ディスプレイ ‥‥‥‥‥‥‥‥‥ ベーシックガイド 13
‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 193
ディフュージョン ‥‥‥‥‥‥‥‥‥リファレンス 159
ディレクトリー ‥‥‥‥‥‥‥‥‥‥リファレンス 42
デスティネーションエフェクト ‥‥‥リファレンス 68
デチューン ‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 59
デバイス ‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 74
デバイスナンバー ‥‥‥‥‥‥‥リファレンス 189, 245
デモ演奏 ‥‥‥‥‥‥‥‥‥‥‥ ベーシックガイド 37
‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 212
デリートファイル ‥‥‥‥‥‥‥‥‥リファレンス 208
電源端子 ‥‥‥‥‥‥‥‥‥‥‥ベーシックガイド 15
デンシティ ‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 157
トーンジュネレーターセッティング ‥リファレンス 188
同時発音数 ‥‥‥‥‥‥‥‥‥‥ベーシックガイド 42
ドライバー ‥‥‥‥‥‥‥‥‥ベーシックガイド 63, 65
‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 245
ドライバーアウトプット ‥‥‥‥‥‥リファレンス 125
ドライバー音 ‥‥‥‥‥‥‥‥‥ ベーシックガイド 70
トランスミットチャンネル ‥‥‥‥‥リファレンス 189
トリガーモード ‥‥‥‥‥‥‥‥‥‥リファレンス 112

ナ行

ノートシフト ‥‥‥‥‥‥‥‥‥‥‥リファレンス 59
ノートデータ ‥‥‥‥‥‥‥‥‥ ベーシックガイド 26
ノートナンバー ‥‥‥‥‥‥‥‥ ベーシックガイド 46
‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 246

ハ行

ハーモニックエンハンサー ‥‥‥ ベーシックガイド 72
‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 107, 246
ハーモニックエンハンサー（キャリア）
‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 134
ハーモニックエンハンサー（モジュレーター）
‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 140
ハーモニックエンハンサーKSC（インデックス）
‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 145
ハーモニックエンハンサーKSC（キャリアHPF）
‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 137
ハーモニックエンハンサーKSC
（キャリアオーバードライブ） ‥‥‥リファレンス 138
ハーモニックエンハンサーKSC（キャリアレベル）
‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 139
ハーモニックエンハンサーKSC（バランス）
‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 146
ハーモニックエンハンサーKSC（モジュレーターHPF）
‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 143

ハーモニックエンハンサーKSC
（モジュレーターオーバードライブ） リファレンス 144
ハイパスフィルター ‥‥‥‥‥‥ ベーシックガイド 75
‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 147
パイプ／ストリング ‥‥‥‥‥ベーシックガイド 63, 68
‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 246
パイプ／ストリングアウトプット ‥‥リファレンス 125
パイプ／ストリング音 ‥‥‥‥‥ ベーシックガイド 70
バックアップバッテリー ‥‥‥‥ ベーシックガイド 8
‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 246
パラメトリックイコライザー ‥‥ ベーシックガイド 77
‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 154, 246
パラレル ‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 67
バルクデータ ‥‥‥‥‥‥‥‥‥ ベーシックガイド 26
‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 246
パン ‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 246
バンク ‥‥‥‥‥‥‥‥‥‥‥‥ ベーシックガイド 41
‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 246
バンドエリミネートフィルター ‥ ベーシックガイド 75
‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 147
バンドパスフィルター ‥‥‥‥‥ ベーシックガイド 75
‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 147
パンポット ‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 60
ピッチ ‥‥‥‥‥‥‥‥‥‥‥‥ ベーシックガイド 69
‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 95, 247

ピッチチェンジ ‥‥‥‥‥‥‥‥ ベーシックガイド 79
‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 69, 72
ピッチベンド ‥‥‥‥‥‥‥‥ベーシックガイド 26, 44
ピッチベンドホイール ‥‥‥‥‥ ベーシックガイド 48
ピッチベンドモード ‥‥‥‥‥‥‥‥リファレンス 57
ビブラート ‥‥‥‥‥‥‥‥‥ベーシックガイド 66, 69
‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 97, 168, 247

ビブラートKSC（アタックレイト） ‥リファレンス 171
ビブラートKSC（スピード） ‥‥‥‥リファレンス 173
ビブラートKSC（ディレイタイム） ‥リファレンス 170
ビブラートKSC（ビブラートデプス）
‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 172
ビブラートシンク ‥‥‥‥‥‥‥‥‥リファレンス 174
フィードバックディレイ ‥‥‥‥ ベーシックガイド 80
‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 76, 247

フィール ‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 85
フィルターモード ‥‥‥‥‥‥‥‥‥リファレンス 147
フォーマットディスク ‥‥‥‥‥‥‥リファレンス 209
フットコントローラー ‥‥‥‥‥ ベーシックガイド 48
フットスイッチ ‥‥‥‥‥‥‥‥ ベーシックガイド 48
物理モデル ‥‥‥‥‥‥‥‥‥‥ベーシックガイド 62
フランジャー ‥‥‥‥‥‥‥‥‥ ベーシックガイド 79
‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 69, 70
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ブレークポイント ‥‥‥‥‥‥‥‥‥リファレンス 33
プレイ ‥‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 40
プレイモード ‥‥‥‥‥‥‥‥‥ ベーシックガイド 50
‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 10, 38
ブレスアタック ‥‥‥‥‥‥‥‥ ベーシックガイド 45
‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 247
ブレスアタックゲイン ‥‥‥‥‥‥‥リファレンス 58
ブレスアタックタイム ‥‥‥‥‥‥‥リファレンス 58
ブレスコントローラー ‥‥‥‥‥ ベーシックガイド 45
‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 247
ブレスコントローラー端子 ‥‥‥ ベーシックガイド 12
ブレスコントローラーの調整 ‥‥ ベーシックガイド 24
ブレスコントロールカーブ ‥‥‥‥‥リファレンス 191
ブレスノイズ ‥‥‥‥‥‥‥‥‥ ベーシックガイド 67
‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 101, 113, 247
ブレスノイズKSC（HPF） ‥‥‥‥‥リファレンス 116
ブレスノイズKSC（LPF） ‥‥‥‥‥リファレンス 117
ブレスノイズKSC（レベル） ‥‥‥‥リファレンス 115
プレッシャー ‥‥‥‥‥‥‥‥‥ ベーシックガイド 66
‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 92, 161, 247

プログラムチェンジ ‥‥‥‥‥‥ ベーシックガイド 26
‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 247
プログラムチェンジテーブル ‥‥‥‥リファレンス 190
プログラムチェンジナンバー ‥‥ ベーシックガイド 41
プログラムナンバー ‥‥‥‥‥‥ ベーシックガイド 41
プログラム番号 ‥‥‥‥‥‥‥‥ ベーシックガイド 41
フロッピーディスク ‥‥‥‥‥‥リファレンス 200, 247
フロッピーディスク挿入口 ‥‥‥ ベーシックガイド 13
ページ移動 ‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 17
ヘッドフォン端子 ‥‥‥‥‥‥‥ ベーシックガイド 12
ベロシティ ‥‥‥‥‥‥‥‥‥‥ ベーシックガイド 47
‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 247
ボイス ‥‥‥‥‥‥‥‥‥‥‥‥ ベーシックガイド 41
‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 248
ボイスエディット ‥‥‥‥‥‥‥‥‥リファレンス 21
ボイス通し番号 ‥‥‥‥‥‥‥‥ ベーシックガイド 41
ボイス名 ‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 53
ボイスモード ‥‥‥‥‥‥‥‥‥リファレンス 53, 248
保証書 ‥‥‥‥‥‥‥‥‥‥‥‥‥ベーシックガイド 9
ポップアップウィンドウ ‥‥‥‥‥‥リファレンス 14
ポリフォニーコントロール ‥‥‥‥‥リファレンス 58
ポルタメント ‥‥‥‥‥‥‥‥‥リファレンス 62, 248

マ行

マイクロチューニング ‥‥‥‥‥リファレンス 63, 248
マスターチューニング ‥‥‥‥‥‥‥リファレンス 188
ミキシング ‥‥‥‥‥‥‥‥‥‥ ベーシックガイド 70
‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 125, 248

ミキシングKSC（タップアウトプット）
‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 129
ミキシングKSC（タップロケーション）
‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 130
ミキシングKSC（ドライバーアウトプット）‥‥‥‥‥
‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 127
ミキシングKSC（パイプ／ストリングアウトプット）
‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 128
ミスレイニアス（エレメントエディット）
‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 111
ミスレイニアス（コモンエディット）
‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 56

ミスレイニアス（システム） ‥‥‥‥リファレンス 193
メニュー ‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 15
メモリープロテクト ‥‥‥‥‥‥‥‥リファレンス 193
モード ‥‥‥‥‥‥‥‥‥‥‥‥ ベーシックガイド 50
‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 10

文字入力 ‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 20
モジュレーション ‥‥‥‥‥‥‥ ベーシックガイド 79
モジュレーションエフェクト ‥‥リファレンス 69, 248
モジュレーションエフェクトタイプ ‥リファレンス 69
モジュレーションホイール ‥‥‥ ベーシックガイド 48
‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 248
モジュレーター ‥‥‥‥‥‥‥‥ ベーシックガイド 72
‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 248
モディファイア ‥‥‥‥‥‥‥ベーシックガイド 64, 71
‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 133, 248
モニター機能 ‥‥‥‥‥‥‥‥‥ ベーシックガイド 49

ヤ行

ユーズランプ ‥‥‥‥‥‥‥‥‥ ベーシックガイド 13
ユーティリティモード ‥‥‥‥‥ ベーシックガイド 50
‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 10, 186

ラ行

ライトプロテクトタブ ‥‥‥‥‥ ベーシックガイド 14
ラフネス ‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 157
ランダムピッチ ‥‥‥‥‥‥‥‥‥‥リファレンス 59
リード ‥‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 249
リコール ‥‥‥‥‥‥‥‥‥リファレンス 30, 210, 249
リネームファイル ‥‥‥‥‥‥‥‥‥リファレンス 206
リバーブ ‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 188
リバーブタイムブースト ‥‥‥‥‥‥リファレンス 84
リバーブレーション ‥‥‥‥‥‥ ベーシックガイド 81
‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 84, 249

レシーブチャンネル ‥‥‥‥‥‥‥‥リファレンス 189
レゾナンス ‥‥‥‥‥‥‥‥‥‥ ベーシックガイド 75
‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 147, 249
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レゾネーター ‥‥‥‥‥‥‥‥‥ ベーシックガイド 78
‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 159, 249
ローカルオン／オフ ‥‥‥‥‥‥リファレンス 189, 249
ロードフロムディスク ‥‥‥‥‥‥‥リファレンス 202
ローパスフィルター ‥‥‥‥‥‥ ベーシックガイド 75
‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥‥リファレンス 147
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ユーザーサポートサービスのご案内

このたびは、ヤマハVL1-mをお買い求めいただきましてありがとうございます。
ヤマハデジタル商品は、常に新技術・高機能を搭載し技術革新を進める一方、お使いになる方々の負担とわず
らわしさを軽減できるような商品づくりを進めております。また取扱説明書の記載内容も、よりわかりやすく
使いやすいものにするため、研究、改善いたしております。
しかし、一部高機能デジタル商品では、取扱説明書だけでは説明しきれないほどのいろいろな知識や経験を必
要としてしまうものがあります。
実際の操作に関して、基本項目は取扱説明書に解説いたしておりますが、「記載内容が理解できない」「手順通
りに動作しない」「記載が見つからない」といったさまざまな問題が起こる場合があります。
そのようなお客様への一助となるよう弊社では、デジタルインフォメーションセンターを開設いたしておりま
す。
お気軽にご利用いただきますようご案内いたします。

デジタルインフォメーションセンターについて

ヤマハデジタルインフォメーションセンターでは、デジタル楽器の使用方法やトラブルなどについて、電話に
よる質問をお受けいたします。
お問い合わせの際には、「製品名」「製造番号」「ご住所」「お名前」「電話番号」を必ずお知らせください。

ヤマハデジタルインフォメーションセンター

TEL.   03 - 3770 - 4486

受付日 月曜日～金曜日
（祝日および弊社の休業日を除く）

受付時間 10：30 ～ 13：00 ／ 14：00 ～ 17：00
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サービスについて
本機の保証期間は、保証書によりご購入から１ヶ年です。（現金、ローン、月賦などによる区別はございません。）
また保証は日本国内においてのみ有効です。

●保証書
保証書をお受け取りのときは、お客様のご住所、お名前、お買い上げ月日、販売店名などを必ずご確認ください。無記名
の場合は無効になりますので、くれぐれもご注意ください。

●保証書は大切にしましょう！
保証書は弊社が、本機をご購入いただいたお客様にご購入の日から向こう１ヶ年間の無償サービスをお約束申し上げるも
のですが、万一紛失なさいますと保証期間中であっても実費を頂戴させていただく場合があります。万一の場合に備え
て、いつでもご提示いただけますよう充分ご配慮のうえで保管してください。
また、保証期間が切れましてもお捨てにならないでください。後々のサービスに際しての機種の判別や、サービス依頼店
の確認など便利にご利用いただけます。

●保証期間中のサービス
保証期間中に万一故障が発生した場合、お買い上げ店にご連絡頂きますと、技術者が修理・調整致します。この際必ず保
証書をご提示ください。保証書無き場合にはサービス料金を頂く場合もあります。
またお買い上げ店より遠方に移転される場合は、事前にお買い上げ店あるいは下記のヤマハ電気音響製品サービス拠点に
ご連絡ください。移転先におけるサービス担当店をご紹介申し上げますと同時に、引続き保証期間中のサービスを責任
もって行うよう手続き致します。

●保証期間後のサービス
満1ヶ年の保証期間を過ぎますとサービスは有料となりますが、引続き責任をもってサービスをさせていただきます。な
お、補修用性能部品の保有期間は製造打切り後最低８年となっています。（性能部品とは、その製品の機能を維持するた
めに必要な部品のことです。）
そのほかご不明な点などございましたら、下記のヤマハ電気音響製品サービス拠点までお問い合わせください。

■ヤマハ電気音響製品サービス拠点〔修理受付および修理品お持込み窓口〕
北海道サービスセンター 〒064 札幌市中央区南10条西１丁目1-50　ヤマハセンター内 Tel　011-513-5036
仙台サービスセンター 〒983 仙台市若林区卸町5-7　仙台卸商共同配送センター3F Tel　022-236-0249
首都圏サービスセンター 〒211 川崎市中原区木月1184 Tel　044-434-3100
東京サービスステーション＊ 〒108 東京都港区高輪2-17-11 Tel　03-5488-6625
　　(＊修理品お持込み窓口)
浜松サービスセンター 〒435 浜松市上西町911　ヤマハ（株）宮竹工場内 Tel　053-465-6711
名古屋サ－ビスセンタ－ 〒454 名古屋市中川区玉川町2-1-2　ヤマハ（株）名古屋流通センター3F Tel　052-652-2230
大阪サービスセンター 〒565 吹田市新芦屋下1-16　ヤマハ（株）千里丘センター内 Tel 　 06-877-5262
四国サービスセンター 〒760 高松市丸亀町8-7　ヤマハ（株）高松店内 Tel　0878-22-3045
広島サービスセンター 〒731-01 広島市安佐南区西原6-14-14 Tel　082-874-3787
九州サービスセンター 〒812 福岡市博多区博多駅前2-11-4 Tel　092-472-2134
　　　　
［本社］
カスタマーサービス部 〒435 浜松市上西町911　ヤマハ（株）宮竹工場内 Tel　053-465-1158

■デジタル楽器に関するお問い合わせ窓口
北海道支店 LM営業課 〒064 札幌市中央区南10条西１丁目1-50　ヤマハセンター内 Tel　011-512-6113
仙台支店 LM営業課 〒980 仙台市青葉区大町2-2-10 Tel　022-222-6147
東京支店 LM営業課 〒108 東京都港区高輪2-17-11 Tel　03-5488-5471
関東支店 LM営業課 〒108 東京都港区高輪2-17-11 Tel　03-5488-1688
名古屋支店 LM営業課 〒460 名古屋市中区錦1-18-28 Tel　052-201-5199
大阪支店 LM営業課 〒542 大阪市中央区南船場3-12-9　心斎橋プラザビル東館 Tel　  06-252-5231
広島支店 LM営業課 〒730 広島市中区紙屋町1-1-18　ヤマハビル Tel　082-244-3749
九州支店 LM営業課 〒812 福岡市博多区博多駅前2-11-4 Tel　092-472-2130

LM営業部
デジタル楽器営業課　 〒430 浜松市中沢町10-1 Tel　053-460-2431

●所在地・電話番号などは変更されることがあります。

M.D.G.,EMI Division  Yamaha Corporation 1994




